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Сокращения и условные обозначения 
АС переменное напряжение, переменный ток 
ACP(R) мощность в соседнем канале (коэффициент) 
ALC автоматическая стабилизация мощности 
АМ амплитудная модуляция 
ARB сигнал произвольной формы 
AWG генератор сигналов произвольной формы 
BBG генератор модулирующих сигналов 
bps бит в секунду 
CW немодулированный (непрерывный) сигнал 
dB децибел (дБ) 
dBm децибел от милливатта (дБм) 
DAC цифро-аналоговый преобразователь (ЦАП) 
DC постоянное напряжение, постоянный ток 
Dual ARB сдвоенный проигрыватель сигналов произвольной формы (режим модуляции) 
DMOD цифровая модуляция 
DUT объект измерений, испытываемое устройство 
EVM  модуль вектора погрешности 
FFT быстрое преобразование Фурье 
FIR  конечная импульсная характеристика 
FM частотная модуляция 
FSK частотная манипуляция 
Hex шестнадцатиричный формат 
I/Q синфазно-квадратурная (модуляция) 
LAN локальная сеть 
LF низкая частота, низкочастотный 
LO гетеродин 
MIMO система со многими входами и (многими) выходами 
MSK манипуляция с минимальным сдвигом 
ppm промиль (одна миллионная доля), 1 ppm = 10-6 
PSK фазовая манипуляция 
QAM квадратурная амплитудная модуляция 
RF высокая частота, высокочастотный 
sps символ в секунду 
usec микросекунда 
WB широкая полоса, широкополосный 
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ФМ фазовая модуляция 
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1  Общее описание генераторов сигналов 

  ПРЕДОСТЕРЕЖЕНИЕ    
Во избежание повреждения прибора или ухудшения его характеристик не допускайте превышения 
максимально допустимого уровня 33 дБм (2 Вт) мощности обратного сигнала на ВЧ входе. См. также 
документ Tips for Preventing Signal Generator Damage на сайте www.agilent.com. 

1.1 Особенности генераторов сигналов 
 Аналоговые ВЧ генераторы N5171B/N5181B: от 9 кГц до 1 ГГц (только N5171B), до 3 ГГц или до 6 ГГц 

(опции 501, 503 и 506, соответственно) 
 Векторные ВЧ генераторы: от 9 кГц до 3 ГГц или до 9 ГГц (опции 503 и 506, соответственно) 
 Развертка по списку и ступенчатая развертка частоты, мощности или частоты и мощности 
 Векторные генераторы могут включать модулирующие сигналы в развертку по списку 
 Автоматическая стабилизация мощности (ALC) 
 Фильтрация модуляции в реальном масштабе времени 
 Кодовая совместимость с языком команд 8648/ESG 
 Генератор опорной частоты 10 МГц с внешним выходом 
 Индикация двухканального измерителя мощности 
 Возможность пользовательской установки предельного значения максимальной мощности 
 Пользовательская коррекция неравномерности частотной характеристики 
 Входы внешней аналоговой I/Q-модуляции (векторные генераторы) 
 Усовершенствованная замена узлов 
 Интерфейсы GPIB, USB 2.0 и 100Base-T LAN 
 Глубокая амплитудная модуляция, обеспечивающая широкий динамический диапазон 
 Ручной поиск мощности (при выключенной системе ALC) 
 Драйвер SCPI и IVI-COM  
 Синхронизация нескольких генераторов модулирующих сигналов в случае применения нескольких 

генераторов сигналов (конфигурация типа "ведущий-ведомый") 
 Векторные генераторы с программой Signal Studio могут генерировать сигналы 802.11 WLAN, W-CDMA, 

cdma2000, 1xEV-DO, GSM, EDGE и другие. 
 Генератор модулирующих сигналов в реальном масштабе времени (опция 660) 
 Генератор импульсных пакетов (опция 320) 
 Многофункциональный НЧ генератор (опция 303) 
 Модуляция короткими импульсами, в том числе внутренний генератор импульсов (опция UNW) 
 Аналоговые дифференциальные выходы I/Q (векторные генераторы, опция 1EL) 
 Аналоговая модуляция: амплитудная, частотная и фазовая (опция UNT) 
 Воспроизведение сигналов I/Q произвольной формы до 200 Мвыб/с (векторные модели, опция 656/657) 
 Входы внешней амплитудной, частотной и фазовой модуляции (опция UNT) 
 Широкополосная амплитудная модуляция (векторные генераторы, опция UNT) 
 Универсальный вход сигнала опорной частоты 1 ÷ 50 МГц (опция 1ER) 
 Вход-выход гетеродина для фазовой когерентности (опция 012) 
 Подмешивание фазового шума (векторные генераторы, опция 432) 
 Расширенные возможности обновления лицензионного ключа (опция 009) 
Дополнительную информацию о генераторах сигналов, их программном обеспечении и документации вы 
можете найти в прилагаемых к генераторам Бюллетенях технических данных (Data Sheets) и на нашем сайте: 
http://www.agilent.com/find/X-Series_SG. 

http://www.agilent.com/
http://www.agilent.com/find/X-Series_SG
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1.2 Режимы работы 
В зависимости от модели и установленных опций генератор сигналов Agilent серии Х обеспечивает до 
четырех основных режимов работы: генерирование немодулированных сигналов (CW), сигналов с 
разверткой частоты и амплитуды, сигналов с аналоговой модуляцией и сигналов с цифровой модуляцией. 

Генерирование немодулированных сигналов 
В этом режиме выводится непрерывный немодулированный сигнал с заданными значениями частоты и 
уровня мощности. Немодулированный сигнал могут генерировать как аналоговые, так и векторные 
генераторы. 

Генерирование сигналов с разверткой частоты и амплитуды 
В этом режиме выводится сигнал с разверткой частоты в определенном диапазоне и/или с разверткой 
уровня мощности в определенном диапазоне. Как аналоговые, так и векторные генераторы обеспечивают 
ступенчатую развертку и развертку по списку. 

Аналоговая модуляция 
В этом режиме производится модуляция ВЧ сигнала аналоговым сигналом. Реализуемые типы модуляции 
зависят от установленных опций. 
Опция UNT обеспечивает амплитудную, частотную и фазовую модуляцию. Некоторые типы модуляции 
можно использовать совместно. 

      ПРИМЕЧАНИЕ        
Клавиша Mod On/Off и соответствующий индикаторный светодиод действуют только у приборов с 
установленной опцией UNT. См. описание поз. 14 в разделе 1.3. 
Опция 303 реализует многофункциональный генератор, который состоит из семи генераторов сигналов. 
Опция UNW обеспечивает возможность стандартной импульсной модуляции и модуляции короткими 
импульсами. 

Цифровая модуляция (только векторные генераторы с опцией 65х) 
В этом режиме генератор сигналов осуществляет модуляцию ВЧ сигнала сигналом I/Q произвольной 
формы. I/Q-модуляция возможна только у векторных генераторов. Внутренний генератор модулирующих 
сигналов (опция 65х) добавляет следующие форматы цифровой модуляции: 
 В режиме генератора специальных сигналов произвольной формы (Custom Arb Waveform Generator) 

может формироваться несущая, модулированная одним сигналом, или несколько модулированных 
несущих. Каждый модулирующий сигнал должен быть рассчитан и сформирован, прежде чем он сможет 
выводиться; этот сигнал генерируется внутренним генератором модулирующих сигналов. После того, как 
будет создана форма сигнала, эти данные можно будет занести в память и вызывать из памяти, что 
обеспечивает периодическое воспроизведение тестовых сигналов. За дополнительной информацией 
обращайтесь к разделу 11.4. 

 В режиме генератора специальных сигналов в реальном масштабе времени (Custom Real-Time Wave-
form Generator) может формироваться несущая, модулированная одним сигналом, или несколько 
модулированных несущих. Каждый модулирующий сигнал должен быть рассчитан и сформирован, 
прежде чем он сможет выводиться; этот сигнал генерируется внутренним генератором модулирующих 
сигналов. После того, как будет создана форма сигнала, эти данные можно будет занести в память и 
вызывать из памяти, что обеспечивает периодическое воспроизведение тестовых сигналов. За 
дополнительной информацией обращайтесь к разделу 11.4. 

 В режиме многотональной (Multitone) модуляции формируется до 64 непрерывных сигналов (или 
тонов). Как и в режиме двухтональной модуляции, здесь регулируется частотное разнесение этих 
сигналов и их амплитуды. 

 В режиме двухтональной (Two Tone) модуляции формируются два раздельных немодулированных 
сигнала (или тона) с разными частотами. Регулируется частотное разнесение этих сигналов и их 
амплитуды. 

 Режим Dual ARB (сдвоенный проигрыватель сигналов произвольной формы) используется для 
управления последовательностью воспроизведения сегментов модулирующих сигналов, записанных в 
память ARB внутреннего генератора модулирующих сигналов.  
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Эти сигналы могут генерироваться внутренним генератором модулирующих сигналов с использованием 
режима специального генератора сигналов произвольной формы или загружаться в память ARB через 
интерфейс дистанционного управления. За дополнительной информацией обращайтесь к подразделу 
8.1.2. 

1.3 Описание передней панели 

 
 
1 Порт USB Host 
2 Дисплей 
3 Функциональные клавиши 
4 Цифровая клавиатура 
5 Клавиши со стрелками и клавиша Select 
6 Клавиша Page Up 
7 Группа клавиш MENUS 
8 Клавиша Trigger 
9 Клавиша Local Cancel/(Esc) 
10 Клавиша Help 
11. Клавиши Preset и User Preset 

12 Соединитель RF Output (выход ВЧ) 
13 Клавиша RF On/Off и соответствующий светодиод 
14 Клавиша Mod On/Off и соответствующий светодиод 
15 Клавиша Page Down 
16 Вход сигнала I 
17 Вход сигнала Q 
18 Поворотная ручка 
19 Клавиша Incr Set 
20 Клавиша Return 
21 Клавиша More и соответствующий светодиод 
22 Сетевой выключатель и индикаторные светодиоды 

1. Порт USB Host 
Соединитель:  типа А 
Протокол USB: 2.0 
К этому порту присоединяют флэш-накопитель USB для переноса данных. Вы можете присоединять и 
отсоединять USB-накопитель без выключения или перезапуска генератора сигналов. Еще один 
соединитель USB (см. стр. 18) находится на задней панели и служит для дистанционного управления 
прибором. 

2. Дисплей 
Жидкокристаллический экран отображает информацию о текущей функции (индикаторы состояния, 
установки значений частоты и амплитуды, а также сообщения об ошибках). Вдоль правой кромки экрана 
отображаются наименования (метки) функциональных клавиш. Более подробное описание дисплея 
приведено в разделе 1.4. 

3. Функциональные клавиши 
Функциональные клавиши активизируют функцию, которая отображается слева от каждой клавиши. 
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4. Цифровая клавиатура 
Цифровая клавиатура содержит клавиши от 0 до 9, клавишу децимальной точки и клавишу забоя (Bk Sp). 
См. раздел 3.3. 

5. Клавиши со стрелками и клавиша Select 
Клавиши со стрелками [] [] [] [] и клавиша Select позволяют вам выбирать пункты на дисплее 
генератора сигналов для редактирования (см. раздел 3.3). 

6. Клавиша Page Up 
Этой клавишей пользуются в табличном редакторе для вывода на экран предыдущей страницы (см. 
подраздел 3.3.3). Когда текст не помещается на одной экранной странице, пользуйтесь этой клавишей 
вместе с клавишей Page Down для прокрутки текста. 

7. Группа клавиш MENUS 
Эти клавиши открывают различные меню функциональных клавиш, что позволяет вам конфигурировать 
функции прибора или обращаться к интересующей вас информации. 
 
 См. стр. 74 См. главу 5 См. стр. 56 См. стр. 45 

 
 Действует только у векторных генераторов См. стр. 63 См. стр. 51 

7. Клавиша Trigger 
Когда режим запуска установлен на Trigger Key, эта клавиша инициирует событие немедленного запуска 
для такой функции, как развертка по списку или ступенчатая развертка. 

9. Клавиша Local Cancel/(Esc) 
Нажатие этой клавиши отменяет дистанционное управление и возвращает генератор сигналов в режим 
управления с передней панели, отменяет ввод активной функции и отменяет такие продолжительные 
операции, как калибровка IQ. 

10. Клавиша Help 
При нажатии этой клавиши на экране появляется краткое описание аппаратной или функциональной 
клавиши (см. раздел 3.2). 

11. Клавиши Preset и User Preset 
Нажатие этих клавиш устанавливает генератор сигналов в известное состояние (заводская или пользова-
тельская установка параметров) – см. раздел 3.1. 

См. стр. 33 

См. стр. 34 

См. стр. 37 

См. стр. 55 

См. стр. 21 

См. стр. 60 
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12. Соединитель RF Output 
Соединитель: Стандартный вариант: 

Опция 1ЕМ: 
Импеданс: 

Гнездовой соединитель типа N 
Гнездовой соединитель типа N на задней панели 
50 Ом 

Предельно допустимые уровни: 50 В постоянного тока,  
2 Вт максимальная ВЧ мощность 

13. Клавиша RF On/Off и соответствующий светодиод 
Эта клавиша является переключателем поочередного действия и используется для включения и 
выключения ВЧ сигнала на выходном соединителе RF OUTPUT. Светодиод RF On/Off светится, когда 
задействован выход ВЧ сигнала. 

14. Клавиша Mod On/Off и соответствующий светодиод 
Эта аппаратная клавиша служит для включения и выключения активного формата выходного сигнала 
несущей. Эта клавиша не настраивает и не вводит в действие формат модуляции. См. раздел 3.7. 
Светодиод MOD ON/OFF светится, когда задействована модуляция выходного сигнала. 

      ПРИМЕЧАНИЕ        
Клавиша Mod On/Off и соответствующий индикаторный светодиод действуют только у приборов с 
установленной опцией UNT. 

15. Клавиша Page Down 
Этой клавишей пользуются в табличном редакторе для вывода на экран следующей страницы (см. 
подраздел 3.3.3). Когда текст не помещается на одной экранной странице, пользуйтесь этой клавишей 
вместе с клавишей Page Up для прокрутки текста. 

16. Вход I (только векторные генераторы) 
Соединитель:   Гнездовой соединитель BNC; импеданс 50 Ом 
Сигнал:  Внешний аналоговый сигнал, синфазная составляющая I/Q-модуляции 
     Уровень сигнала равен  = 0,5 Вэфф для калиброванного выходного уровня. 
Предельно допустимый уровень: 1 Вэфф 
См. также раздел 8.10. 

17. Вход Q (только векторные генераторы) 
Соединитель:   Гнездовой соединитель BNC; импеданс 50 Ом 
Сигнал:  Внешний аналоговый сигнал, квадратурная составляющая I/Q-модуляции 
     Уровень сигнала равен  = 0,5 Вэфф для калиброванного выходного уровня. 
Предельно допустимый уровень: 1 Вэфф 
См. также раздел 8.10. 

18. Поворотная ручка 
Этой ручкой пользуются для увеличения и уменьшения численного значения или для перемещения 
выделения на следующий разряд, символ или пункт в списке. См. также подраздел 2.1.3. 

19. Клавиша Incr Set 
Эта аппаратная клавиша позволяет вам установить значение ступенчатого приращения у активной в 
данный момент функции. Значение приращения влияет также на размер изменения значения активной 
функции на каждый оборот поворотной ручки в соответствии с текущей установкой разрешения поворотной 
ручки (см. подраздел 2.1.3). 

20. Клавиша Return 
Эта клавиша позволяет вам отследить в обратном порядке последовательность нажатия клавиш. Если 
меню содержит несколько уровней, то клавиша Return возвращает вас на предыдущую страницу меню. 
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21. Клавиша More и соответствующий светодиод 
Когда меню содержит больше наименований функциональных клавиш, чем может поместиться на экране, 
то зажигается светодиод More и под наименованиями функциональных клавиш появляется сообщение 
More. Чтобы вывести на экран следующую группу наименований функциональных клавиш, следует нажать 
клавишу More. 

22. Сетевой выключатель и индикаторные светодиоды 
Этот выключатель служит для включения питания прибора и для переключения в дежурный режим. В 
положении "дежурный режим" (standby mode) светится желтый светодиод; при этом выведены из действия 
все функции генератора сигналов. В дежурном режиме генератор остается подключенным к электросети; 
при этом подается питание на некоторые внутренние схемы. В положении "ВКЛ." светится зеленый 
светодиод и активизированы все функции генератора сигналов. 

1.4 Дисплей на передней панели 

1. Область активной функции 2. Область инд. частоты 3. Вспомогательные индикаторы 4. Область индикации амплитуды 

  
5. Область сообщений об ошибках 6. Текстовая область 7. Область наименований функциональных клавиш 

1. Область активной функции 
В этой области отображается функция, которая является активной в данный момент. Например, если 
активной функцией является частота, то здесь индицируется текущая установка частоты. Если с активной 
функцией связано некоторое значение приращения, то оно также индицируется в этой области. 

2. Область индикации частоты 
В этой секции дисплея индицируется текущая установка частоты. 

3. Вспомогательные индикаторы 
Вспомогательные индикаторы отображают состояние некоторых функций генератора сигналов и 
индицируют состояния ошибок. Одна позиция вспомогательного индикатора может использоваться 
несколькими функциями. Это не создает проблем, поскольку одновременно может быть активной только 
одна из функций, которые делят между собой одну и ту же позицию вспомогательного индикатора. 
 
Этот вспомогательный индикатор появляется, когда … 

ФМ Включена фазовая модуляция. Когда включена частотная модуляция, то вместо этого 
индикатора появляется индикатор FM. 

ARB Включен генератор сигналов произвольной формы, который работает и не ожидает запуска. 

ALC OFF Выключена схема автоматической стабилизации мощности (ALC). На месте этого 
индикатора появляется индикатор UNLEVEL, когда включена схема ALC, но она не 
поддерживает заданный выходной уровень. 

AM Включена амплитудная модуляция. 

ARMED Инициализирована развертка и генератор сигналов ожидает события запуска развертки.  

  

Полоса прокрутки 
Если текст не помещается на 
экранной странице, то здесь 
появляется полоса прокрутки. 
Для прокрутки текста 
пользуйтесь клавишами Page 
Up и Page Down. 
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Этот вспомогательный индикатор появляется, когда … 

ATTNHOLD Включена функция удержания установки аттенюатора. Когда включена эта функция, 
удерживается текущая установка аттенюатора. 

AWGN Включен генератор аддитивного белого гауссовского шума (AWGN) в режиме I/Q-
модуляции в реальном масштабе времени. 

BBG DAC Возникает переполнение цифро-аналогового преобразователя. В этом случае следует 
скорректировать масштабирование рабочего цикла так, чтобы погас индикатор BBG DAC. В 
этой позиции появляется также другой вспомогательный индикатор UNLOCK, который 
имеет приоритет над индикатором BBG DAC (см. ниже описание вспомогательного 
индикатора UNLOCK). 

CHANCORR Задействована внутренняя коррекция канала. 

DETHTR Нагреватель детектора системы автоматической стабилизации мощности (ALC) не достиг 
заданной температуры, которая необходима для реализации номинальных технических 
характеристик ALC. 

DIGBUS Активна цифровая шина. 

DIGMOD Включен генератор специальных сигналов произвольной формы. 

ERR В очереди ошибок есть сообщение об ошибке. Этот индикатор не гаснет, пока вы не 
просмотрите все сообщения об ошибках или не очистите очередь ошибок (см. раздел 3.9). 

EXTREF Подается внешний сигнал опорной частоты. 

FM Включена частотная модуляция. Когда включена фазовая модуляция, то вместо этого 
индикатора появляется индикатор ФM. 

I/Q Включена синфазно-квадратурная (I/Q) модуляция. 

L Генератор сигналов находится в режиме приемника (listener) и принимает информацию или 
команды через интерфейс GPIB, USB или VXI-11/Sockets (LAN). 

M-TONE Включен генератор многотональных сигналов. 

MULT Задействован умножитель частоты. 

OFFS Установлено смещение выхода. 

PN Включено подмешивание фазового шума. 

PULSE Включена импульсная модуляция. 

R Генератор сигналов находится в режиме дистанционного управления через интерфейс 
GPIB, USB или VXI-11/Sockets (LAN). Когда генератор сигналов находится в режиме 
дистанционного управления, заблокирована клавиатура на его передней панели. Чтобы 
разблокировать клавиатуру, следует нажать клавишу Local. 

REF Установлено опорное значение выходного сигнала. 

RF OFF Не подается ВЧ сигнал на выходной соединитель RF OUTPUT. 

S Генератор сигналов подал запрос на обслуживание (SRQ) через интерфейс GPIB, USB или 
VXI-11/Sockets (LAN). 

SWEEP Генератор сигналов находится в режиме развертки по списку или ступенчатой развертки. 

SWMAN Генератор сигналов находится в режиме развертки с ручным управлением. 

T Генератор сигналов находится в режиме передатчика (talker) и передает информацию 
через интерфейс GPIB, USB или VXI-11/Sockets (LAN). 

T-TONE Включен генератор двухтональных сигналов. 

UNLEVEL Генератору не удается поддерживать надлежащий уровень выходного сигнала. Появление 
этого индикатора не обязательно служит признаком неисправности прибора. Такие 
состояния могут возникать и при нормальной работе генератора. Когда выключена схема 
ALC, в этой позиции появляется вспомогательный индикатор ALC OFF (см. выше). 
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Этот вспомогательный индикатор появляется, когда … 

UNLOCK Одна из схем фазовой синхронизации неспособна поддерживать фазовую синхронизацию. 
Чтобы определить эту схему, посмотрите сообщения об ошибках (см. раздел 3.9). 

WATRG В текущем режиме модуляции ожидается запуск Arb. 

WINIT Генератор сигналов ждет, чтобы вы инициировали однократную развертку. 

4. Область индикации амплитуды 
В этой секции дисплея индицируется текущая установка выходной мощности. Когда выключен ВЧ выход, 
эта область отображается серым фоном. 

5. Область отображения сообщений об ошибках 
В этой области отображаются сокращенные сообщения об ошибках. При возникновении нескольких ошибок 
отображается только последнее сообщение (см. раздел 3.9). 

6. Текстовая область 
Текстовая область дисплея отображает информацию о состоянии генератора сигналов, например, 
состояние модуляции, списки развертки и каталоги файлов. Эта область также позволяет вам выполнять 
операции по управлению информацией, по вводу данных, а также по отображению и удалению файлов. 

7. Область наименований функциональных клавиш 
В этой области отображаются наименования (метки) функциональных клавиш, расположенных справа от 
каждой метки. Метка функциональной клавиши может изменяться в зависимости от выбранной функции. 

1.5 Описание задней панели 
Соединители цифровой модуляции (только векторные генераторы) – стр. 18 1. Гнездо для сетевого кабеля 

 

1.  Гнездо для сетевого кабеля 
Это гнездо служит для присоединения трехпроводного сетевого кабеля, который прилагается к генератору 
сигналов. Обращайтесь к Руководству по установке (Installation Guide), где описаны требования к 
электропитанию и изложены указания по подключению прибора к электросети. 

  ПРЕДОСТЕРЕЖЕНИЕ    
Во избежание потери данных, установок параметров GPIB или текущей пользовательской настройки 
параметров прибора, которые не сохраняются в долговременной (энергонезависимой) памяти, для 
выключения прибора всегда следует пользоваться кнопкой выключателя на передней панели или 
соответствующей командой SCPI. Генераторы сигналов, которые установлены в стойках и выключаются 
общим выключателем питания стойки вместо собственного выключателя питания, выводят сообщение об 
ошибке Error -310 ввиду неправильного выключения питания. 

Только  
опция 1ЕМ  
см. стр. 13 
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2. Соединители ЕХТ1 и ЕХТ2 
Соединитель: Гнездовой соединитель BNC; номинальное значение импеданса 50 Ом 
Сигнал: Сигнал ± 1 Впик, который обеспечивает заданную глубину модуляции или девиацию 

частоты и фазы. 
Предельно допустимые уровни:  5 Вэфф и 10 Впик 

3. Соединитель LF OUT 
Соединитель: Гнездовой соединитель BNC; импеданс 50 Ом 
Сигнал: Диапазон напряжения: 0 ÷ +5 Впик 

Смещение: –5 В ÷ +5 В (номинально) 
За дополнительной информацией обращайтесь к разделу 4.6. 

4. Соединитель SWEEP OUT 
Соединитель: Гнездовой соединитель BNC; импеданс < 1 Ом 

Может работать на нагрузку 2 кОм 
Сигнал: Диапазон напряжения: 0 ÷ +10 В независимо от размаха развертки 

В режиме развертки: начало развертки = 0 В, конец развертки = 10 В 
В режиме генерирования немодулированного сигнала (CW) на этом выходе нет сигнала 
Это многофункциональный соединитель. За дополнительной информацией обращайтесь 
к подразделу 3.6.1. 

5. Соединитель PULSE 
Соединитель: Гнездовой соединитель BNC; номинальное значение импеданса 50 Ом 
Сигнал: Внешний сигнал: +1 В = ВКЛ.; 0 В = ВЫКЛ. 
Предельно допустимые уровни:   –0,3 В и  +5,3 В 

6. Соединители TRIG1 и TRIG2 
Соединитель: Гнездовой соединитель BNC; высокий импеданс (high Z) 
Сигнал: Внешний сигнал TTL или CMOS для поточечного запуска в режиме ручного управления 

разверткой или в режиме внешнего запуска развертки при низкочастотной модуляции 
(выход LF). Запуск может производиться по положительному или по отрицательному 
фронту сигнала. 

Предельно допустимые уровни:   –0,5 В и  +5,5 В 

7. Соединитель REF IN 
Соединитель: Гнездовой соединитель BNC; номинальное значение импеданса 50 Ом 
Сигнал: Внешний сигнал от –3,5 дБм до +20 дБм от источника опорной частоты, который имеет 

погрешность воспроизведения частоты ± 1 ppm (± 1  10-6). 
В принятой по умолчанию заводской установке параметров генератора сигналов он может обнаруживать 
действительный сигнал опорной частоты на этом соединителе и автоматически переключаться с 
внутреннего источника опорной частоты на внешний (см. подраздел 3.1). С опцией 1ER (универсальный 
вход сигнала опорной частоты) вы должны однозначно указать внешнюю опорную частоту, которую вы 
хотите применять. Это можно сделать как путем ввода с передней панели, так и через интерфейс 
дистанционного управления. 

8. Соединитель 10 MHz OUT 
Соединитель: Гнездовой соединитель BNC; номинальное значение импеданса 50 Ом 
Сигнал: Номинальный уровень сигнала > 4 дБм 
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9. Соединитель GPIB 
Этот соединитель обеспечивает взаимодействие с такими совместимыми устройствами, как внешние 
контроллеры. Это один из трех соединителей, предназначенных для дистанционного управления 
генератором сигналов (см. также описания "10. Соединитель LAN" и "11. Соединитель Device USB"). 

10. Соединитель LAN 
Через этот соединитель генератор сигналов поддерживает связь через локальную сеть (LAN), что 
позволяет дистанционно программировать генератор сигналов с помощью удаленного компьютера, 
подключенного к локальной сети. Интерфейс LAN поддерживает протокол auto-MDIX. Длина 
соединительного кабеля у генератора сигналов ограничена значением 100 метров (100Base-T). За 
дополнительной информацией относительно LAN обращайтесь к Руководству по программированию (Pro-
gramming Guide). 

11. Соединитель Device USB 
Соединитель: Типа В 
Протокол USB: Версия 2.0 
Пользуйтесь этим соединителем USB (USB = универсальная последовательная шина) для соединения с 
компьютером, с которого осуществляется дистанционное управление генератором сигналов. 

12. Соединитель Host USB 
Соединитель: Типа А 
Протокол USB: Версия 2.0 
К этому порту присоединяют флэш-накопитель USB для переноса данных. Вы можете присоединять и 
отсоединять USB-накопитель без выключения или перезапуска генератора сигналов. На задней панели 
находится еще один соединитель USB (см. выше), который служит для дистанционного управления 
прибором. 

13. Гнездо SD Card 
Предназначено для карты энергонезависимой памяти SD (Secure Digital). 

Соединители для цифровой модуляции (только векторные генераторы сигналов) 
Соединители I OUT, Q OUT,I  OUT, Q OUT 

      ПРИМЕЧАНИЕ        
Соединители I  OUT, иQ OUT требуют применения опции 1EL. 
 
Соединитель: Гнездовой соединитель BNC; импеданс 50 Ом 
Сигнал: 

I OUT Аналоговая синфазная составляющая I/Q-модуляции от внутреннего генератора 
модулирующих сигналов 

Q OUT Аналоговая квадратурная составляющая I/Q-модуляции от внутреннего генератора 
модулирующих сигналов 

I  OUT Используется в сочетании с соединителем I OUT для формирования балансного* 
возбуждения модуляции. 

Q OUT Используется в сочетании с соединителем Q OUT для формирования балансного* 
возбуждения модуляции. 

Предельно допустимые уровни: > 1 Вэфф Начальное смещение: тип. < 10 мВ 
Уровни выходных сигналов на нагрузке 50 Ом: 
  0,5 Впик (тип.), соответствует единичной длине вектора I/Q 

 0,69 Впик (2,84 дБ) (тип.), макс. пик-фактор для пиков у модуляции /4 DQPSK,  = 0,5 
 0,71 Впик (3,08 дБ) (тип.), макс. пик-фактор для пиков у модуляции /4 DQPSK,  = 0,35 
 Типичное значение 1 Впик-пик, максимум 
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* Балансными являются сигналы, действующие в раздельных проводах, симметричные относительно земли и 
сдвинутые по фазе на 180°. 
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Соединители BB TRIG1 и BB TRIG2 
Соединитель: Гнездовой соединитель BNC; номинальное значение импеданса 50 Ом 
Сигнал: Зарезервирован для входа-выхода генераторов модулирующих сигналов произвольной 

формы и модуляции в реальном времени (например, для маркеров или входов запуска). 

Соединитель EVENT 1 
Соединитель: Гнездовой соединитель BNC; номинальное значение импеданса 50 Ом 
Сигнал: Импульс, который можно использовать для запуска начала кодовой комбинации данных, 

кадра или таймслота. Регулируется в пределах ± 1 таймслот; разрешение = 1 бит. 
Маркеры 
Каждая точка сигнала произвольной формы имеет связанное с ней состояние маркера 
ВКЛ./ВЫКЛ.  
Уровень маркера 1 = +3,3 В (высокий уровень CMOS при выборе положительной 
полярности); –3,3 В (низкий уровень CMOS при выборе отрицательной полярности). 
На этот соединитель выводится сигнал всякий раз, когда маркер 1 на сигнале 
произвольной формы находится в состоянии ВКЛ. (см. раздел 8.5). 

Предельно допустимые уровни:  < –4 В и > +8 В 

Соединитель PAT TRIG 
Соединитель: Гнездовой соединитель BNC; номинальное значение импеданса 50 Ом 
Сигнал: – Низкий уровень TTL/CMOS для запуска по положительному фронту TTL/CMOS или 

– Высокий уровень TTL/CMOS для запуска по отрицательному фронту TTL/CMOS 
Подаваемый на этот соединитель входной сигнал запускает внутренний генератор 
кодовой комбинации для цифровой модуляции, чтобы начать вывод одиночной кодовой 
комбинации или чтобы остановить и заново синхронизировать непрерывно выводимую 
кодовую комбинацию. Чтобы синхронизировать запуск с генератором тактовой частоты 
битов данных, производится фиксация фронта запуска, затем его выборка на 
отрицательном фронте внутреннего сигнала тактовой частоты битов данных.  
Это и есть внешний запуск для всех видов запуска генератора сигналов произвольной 
формы. 
Минимальная длительность входного импульса запуска: 100 нс (высокий или низкий 
уровень) 
Минимальная задержка запуска (от фронта запуска до первого бита кадра) = 1,5 ÷ 2,5 
периода тактовой частоты битов. 

Предельно допустимые уровни:  < –4 В и > +8 В 

Соединитель DIGITAL BUS I/O 
Это фирменная цифровая шина, которая применяется с программным обеспечением Agilent Technologies 
для создания сигналов. Этот соединитель не задействован для общего применения. Сигналы присутствуют 
только тогда, когда установлена опция программного обеспечения для создания сигналов. За 
дополнительной информацией обращайтесь на сайт http://www.agilent.com/find/signalcreation.   

      ПРИМЕЧАНИЕ        
У генераторов сигналов серии Х соединитель DIGITAL BUS I/O можно использовать для разрешения 
работы с тестером Agilent Technologies N5106A PXB MIMO. 

http://www.agilent.com/find/signalcreation
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Соединитель AUX I/O 
Это экранированный соединитель серии .050 для монтажа на плате. 

  
 
Конт. 1 = событие 1 
Конт. 2 = событие 2 
Конт. 3 = событие 3 
Конт. 4 = событие 4 
Конт. 5 = выход хронирования частоты выборок 
Конт. 6 ÷ 36 = в зависимости от приложения 
(За дополнительной информацией обращайтесь к справочной системе приложения) 
 
Событие 1, 2, 3 и 4 (контактные выводы 1 ÷ 4) 
Импульс, который можно использовать для запуска начала кодовой комбинации данных, кадра или 
таймслота. Регулируется в пределах ± 1 таймслот; разрешение = один бит. 
Маркеры 
Каждая точка сигнала произвольной формы имеет связанное с ней состояние маркера ВКЛ./ВЫКЛ.  
Уровень маркера 1 = +3,3 В (высокий уровень CMOS при выборе положительной полярности); –3,3 В 
(низкий уровень CMOS при выборе отрицательной полярности). 
Выход хронирования частоты выборок (контактный вывод 5) 
Этот выход используется с внутренним генератором модулирующих сигналов. Этот контактный вывод 
выводит сигнал битовой синхронизации CMOS для синхронизации последовательных данных. 
Предельно допустимые уровни: < –0,5 В и > +5,5 В. 
 

Вид 36-контактного гнездового соединителя  
со стороны задней панели 
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2 Установка предпочтений и подключение опций 

Меню Utility обеспечивает доступ к предпочтительным установкам пользователя и дистанционного 
управления, а также к меню, в которых вы можете задействовать опции прибора. 
 

 
 

 

 Дистанционное управление 
 Адрес GPIB и язык дистанционного управления – стр. 25 
 Конфигурирование интерфейса LAN – стр. 25 
 Подключение услуг LAN: "Browser", "Sockets" и "VXI-11" – стр. 26 
 Конфигурирование языков команд дистанционного управления – стр. 26 
 
 
Пользовательские предпочтения 
Разрешающая способность поворотной ручки на передней панели – стр. 23 
Установка времени и даты – стр. 23 
Настройка генератора опорной частоты – стр. 24 

Установка параметров отображения – стр. 22 
 
Включение питания и предустановка параметров – стр. 22 
 
Подключение опций – стр. 28 
Обновление микропрограммы – стр. 24 
 
 
 
Установка аппаратных блоков и функциональные клавиши удаления блоков – 
стр. 29 

2.1 Пользовательские предпочтения 
Из меню Utility вы можете установить следующие пользовательские предпочтения: 
 Установка параметров отображения – подраздел 2.1.1 
 Включение питания и предустановка параметров – подраздел 2.1.2 
 Разрешающая способность поворотной ручки на передней панели – подраздел 2.1.3 
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2.1.1 Установка параметров отображения 
См. также раздел 13.2. 
 

 

Яркость 
Диапазон: 0 ÷ 100 

 

 

Хранитель экрана 

Light Only: Выключает подсветку дисплея, оставляя видимым текст при низкой интенсивности. 
Light & Text: Выключает подсветку дисплея и текст. Когда изображение остается неизменным 
долгое время, пользуйтесь этим режимом для защиты экрана от выгорания. 

Хранитель экрана 

Диапазон установки задержки: от 1 часа до 12 часов с дискретностью 1 час. 

 

 
Выбор  
палитры 

Темный текст на 
светлом фоне 
 
Светлый текст 
на темном фоне 
 
Монохромное 
отображение 

 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

      ПРИМЕЧАНИЕ        
Когда яркость установлена на минимум, отображение может оказаться таким темным, что трудно будет 
разглядеть функциональные клавиши. В таком случае обратитесь к показанному выше рисунку, чтобы 
найти функциональную клавишу регулировки яркости (Brightness) и отрегулировать яркость. 

2.1.2 Включение питания и предустановка параметров 

   

При установке на On команды, которые  
выполняются через шину дистанционного 
управления, соответствующим образом  
обновляют дисплей генератора сигналов. 
 
стр. 190 

Восстанавливает принятые по умолчанию 
заводские установки перманентных пара-
метров (т.е. тех параметров, на которые не 
влияет выключение-включение питания *, 
предустановка или вызов). 

* См. ПРЕДОСТЕРЕЖЕНИЕ на след. стр. 

Выбирает язык команд GPIB, который желателен после 
предустановки. Обращайтесь также к Справочнику по 
программированию (Programming Guide) и к Справочнику по 
командам SCPI (SCPI Command Reference). 
 
 Этот пункт доступен только тогда, когда 8648 является либо 

выбранным языком предустановки, либо выбранным языком команд 
дистанционного управления. 
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  ПРЕДОСТЕРЕЖЕНИЕ    
Во избежание потери данных, установок параметров GPIB или текущей пользовательской настройки 
параметров прибора, которые не сохраняются в долговременной (энергонезависимой) памяти, для 
выключения генератора сигналов серии Х всегда следует пользоваться кнопкой выключателя на передней 
панели или соответствующей командой SCPI. Генераторы сигналов серии Х, которые установлены в 
стойках и выключаются общим выключателем питания стойки вместо собственного выключателя питания, 
выводят сообщение об ошибке Error -310 ввиду неправильного выключения питания. 

      ПРИМЕЧАНИЕ        
Чтобы задать пользовательскую предустановку параметров, выполните желаемую настройку прибора и 
нажмите функциональные клавиши User Preset > Save User Preset. 

2.1.3 Разрешающая способность поворотной ручки на передней панели 

 
Эта клавиша позволяет вам установить значение ступенчатого приращения у активной в данный 
момент функции. 

 

 

 
Значение приращения (Increment Value) и разрешающая способность ручки 
(Knob Ratio) определяют размер изменения значения активной функции на 
каждый оборот поворотной ручки. 

Например, если значение приращения активной функции равно 10 дБ и 
параметр Knob Ratio равен 50:1, то каждый оборот ручки изменяет активную 
функцию на 0,2 дБ (одна пятидесятая доля от 10 дБ). 

Чтобы изменить размер приращения на каждый оборот ручки, следует 
изменить значение приращения, разрешающую способность ручки или и то, и 
другое. 

 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

2.1.4 Установка времени и даты 

 

  ПРЕДОСТЕРЕЖЕНИЕ    
Изменение времени или даты может ухудшить способность генератора использовать лицензии, основанные 
на времени, даже если такая лицензия не установлена. 
Микропрограмма генератора сигналов отслеживает время и дату, используя в качество опорной точки 
последнее время и дату. 

 стр. 23 

 
 стр. 24 

Выполняет настройку смещения модулятора ALC. При использовании ALC в режиме разомкнутого 
контура это компенсирует дрейф мощности в разомкнутом контуре вследствие изменения температуры и 
влажности. 

Команды SCPI: 

CALibration:ALC:MODulator:BIAS 
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Установка времени и даты с опережением 
Если вы установите время и дату с опережением, имейте в виду, что вы сокращаете время действия 
установленных лицензий, основанных на времени, переустанавливая опорную точку отсчета времени и 
даты у генератора сигналов. Когда вы устанавливаете новое время или новую дату на более позднее 
значение, чем текущая опорная точка генератора сигналов, эта дата становится новой опорной точкой. 
Если после этого вы установите дату назад, то рискуете оказаться в описанной ниже ситуации. 
 
Исходная опорная точка отсчета времени и даты Новая опорная точка отсчета времени и даты 

 
Время 
 
Установка времени и даты с отставанием 
Когда вы устанавливаете время назад, генератор замечает, что время сдвинулось назад от опорной точки. 
Если вы сдвинете время назад больше, чем на несколько часов, то аннулируете тем самым способность 
генератора использовать лицензии, основанные на времени, даже если в этот момент у генератора нет 
установленных лицензий. В этом случае вы можете восстановить способность генератора использовать 
лицензии, основанные на времени, для чего следует переустановить часы на первоначальное время или 
просто подождать, пока не пройдет разностное время. 

2.1.5 Настройка генератора опорной частоты 

 

 

 
 
Настройка частоты внутреннего генератора VCTXCO 

Пользовательское значение смещает значение, установленное на заводе.  
К заводской установке значения DAC прибавляется значение Tune.  
Значение Tune = 0 восстанавливает значение, установленное при калибровке на 
заводе. 

Диапазон от –8192 до 8192 можно установить через клавиатуру на передней 
панели, с помощью поворотной ручки или с помощью команды дистанционного 
управления. 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, 
как описано в разделе 3.2. 

Обращайтесь также к Справочнику по командам SCPI  
(SCPI Command Reference). 

2.2 Обновление микропрограммы 
За информацией о новых выпусках микропрограмм обращайтесь на страницу: 
 http://www.agilent.com/find/upgradeassistant.  

2.3 Предпочтения в режиме дистанционного управления 
За подробной информацией по дистанционному управлению генератором сигналов обращайтесь к 
Руководству по программированию (Programming Guide). 

 

http://www.agilent.com/find/upgradeassistant
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2.3.1 Адрес GPIB и язык команд дистанционного управления 

 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

      ПРИМЕЧАНИЕ        
Имеется также интерфейс USB, однако он не показан в меню, поскольку не требует конфигурирования. За 
подробной информацией в отношении дистанционного управления прибором обращайтесь к Руководству 
по программированию (Programming Guide). 

2.3.2 Конфигурирование интерфейса LAN 

 
Эти значения перечислены в Руководстве по программированию.   

 подраздел 2.3.2 
 

 подраздел 2.3.4 

Выберите нужный язык команд. 

Эта установка не сохраняется в энергонезависимой памяти и очищается 
при выполнении предустановки параметров прибора (Preset).  
В большинстве случаев для постоянной установки языка команд 
целесообразно пользоваться клавишами Utility > Power On/Preset >  
Language (см. подраздел 2.3.4) 

 

Для выяснения функций клавиш пользуйтесь 
встроенной справкой по клавишам, как 
описано в разделе 3.2. 

 стр. 26 
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      ПРИМЕЧАНИЯ        
Для присоединения генератора сигналов к локальной сети (LAN) пользуйтесь кабелем 100Base-T LAN. 
Для непосредственного присоединения генератора сигналов к компьютеру пользуйтесь кроссоверным 
кабелем. 
За подробной информацией в отношении дистанционного управления прибором обращайтесь к Руковод-
ству по программированию (Programming Guide), а также на сайт www.agilent.com с поиском по теме 
"Часто задаваемые вопросы": Hardware Configurations and Installation для генераторов Agilent MXG. 

2.3.3 Подключение услуг LAN: "Browser", "Sockets" и "VXI-11" 

 

 

 

Применение Web-браузера  
для управления генератором  
сигналов 

 
Установка License Manager  
Server (On) позволяет 
обновлять приборные 
лицензии. Отключить для 
дополнительной защиты 
прибора. 

Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
За дополнительной информацией обращайтесь к Руководству по программированию (Programming Guide). 

2.3.4 Конфигурирование языков команд дистанционного управления 
 Utility > I/O Config   Выберите нужный язык команд дистанционного управления 
 

 

Разрешение применения  
дистанционного доступа  
(через Web-браузер)  
к файловой системе прибора 
 

Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в 
разделе 3.2. 
 
Обращайтесь к Справочнику по командам SCPI (SCPI Command Reference). 

http://www.agilent.com/
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2.3.5 Конфигурирование языков команд предустановки (Preset) 
 Utility > Power On/Preset   Выберите нужный язык команд дистанционного управления 
 

 
 Рис. 2-1 N5171B/72B/81B/82B 

Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в 
разделе 3.2. 
 
Обращайтесь к Справочнику по командам SCPI (SCPI Command Reference). 

стр. 22 
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2.4 Подключение опции 
Существует два способа подключения опции: 
 Использовать программную утилиту License Manager: 

1. Запустить утилиту и следовать указаниям на экране. 
2. Загрузить утилиту с сайта www.agilent.com/find/LicenseManager и выбрать файлы лицензии (.lic) с 

внешнего флэш-накопителя USB. 
 Использовать команды SCPI, как описано в Руководстве по программированию. 

2.4.1 Просмотр опций и лицензий 

 
 
 

Здесь появляются лицензии  
сервисного программного обеспечения 

Здесь появляются лицензии формы сигналов 
от некоторых приложений Signal Studio Здесь появляются приборные опции. 

"Галочка" означает, что опция  
подключена (задействована). 

Для выяснения функций клавиш пользуйтесь 
встроенной справкой по клавишам, как описано 
в разделе 3.2. 

http://www.agilent.com/find/LicenseManager
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2.5 Установка аппаратных блоков и функциональные клавиши  
удаления блоков 

Utility > More 2 of 2 > Service 

 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

      ПРИМЕЧАНИЯ        
Каждая функциональная клавиша Remove Assembly (CPU/RF/BBG), когда она задействована, отображает в 
нижнем левом квадранте дисплея сообщение, указывающее блок, подготовленный для удаления, или на 
отмену удаления. 
Каждая функциональная клавиша Install Assembly (CPU/RF/BBG), когда она задействована, отображает в 
нижнем левом квадранте дисплея сообщение, указывающее блок, подготовленный для установки, или на 
отмену установки. 
См. также Сервисное Руководство (Service Guide). 
 

Только векторные  
генераторы сигналов 
 

Только векторные  
генераторы сигналов 
 

 
При нажатии открывается меню Confirm Removal для блоков RF и 
BBG, аналогичное тому, что показано здесь для блока CPU. 
 

При нажатии открывается меню Confirm Removal для блоков RF и 
BBG, аналогичное тому, что показано здесь для блока CPU. 
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3 Основные операции 

В этой главе описаны основные операции, выполняемые с помощью органов управления на передней 
панели. За подробной информацией по дистанционному управлению обращайтесь к Руководству по 
программированию (Programming Guide). 
Эта глава состоит из следующих разделов: 
3.1 Предустановка генератора сигналов – стр. 30 
3.2 Вывод на экран описаний клавиш – стр. 30 
3.3 Ввод и редактирование численных значений и текста – стр. 31 
3.4 Установка параметров частоты и мощности (амплитуды) – стр. 33 
3.5 Установка регулировки ширины полосы частот функции ALC – стр. 36 
3.6 Конфигурирование вывода сигналов в режиме развертки – стр. 37 
3.7 Модуляция сигнала несущей – стр. 44 
3.8 Работа с файлами – стр. 45 
3.9 Считывание сообщений об ошибках – стр. 55 

3.1 Предустановка генератора сигналов 

 

Чтобы вернуть генератор сигналов в известное состояние, нажмите клавишу Preset или 
User Preset. 
Preset – это заводская предустановка параметров. 
User Preset – это пользовательская предустановка параметров (см. ниже Примечание, 
также подраздел 2.1.2). 
Чтобы восстановить принятую по умолчанию заводскую установку перманентных 
параметров (т.е. тех параметров, на которые не влияют операции Preset, User Preset или 
выключение-включение питания), нажмите клавиши Utility > Power On/Preset > Restore 
System Defaults. 

  ПРЕДОСТЕРЕЖЕНИЕ    
Во избежание потери данных, установок параметров GPIB или текущей пользовательской настройки 
параметров прибора, которые не сохраняются в долговременной (энергонезависимой) памяти, для 
выключения прибора всегда следует пользоваться кнопкой выключателя на передней панели или 
соответствующей командой SCPI. Генераторы сигналов, которые установлены в стойках и выключаются 
общим выключателем питания стойки вместо собственного выключателя питания, выводят сообщение об 
ошибке Error -310 ввиду неправильного выключения питания. 

      ПРИМЕЧАНИЕ        
Вы можете создать несколько пользовательских предустановок (наборов параметров прибора) и присвоить 
свое имя каждому заносимому в память файлу состояния (набора параметров) прибора. См. рис. 3-9 на стр. 
53. 

3.2 Вывод на экран описаний клавиш 

 
Клавиша Help позволяет вам вывести на экран описание любой аппаратной или 
функциональной клавиши. 

1. Нажмите клавишу Help. 
2. Нажмите интересующую вас клавишу. 

На экране отображается описание клавиши, а обычная функция этой клавиши не выполняется. 
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3.3 Ввод и редактирование численных значений и текста 
3.3.1 Ввод численных значений и перемещение курсора 
Для ввода численных данных и децимальной точки пользуйтесь  
цифровыми клавишами. 

 

 
 
 
Клавиши Page Up и Page Down служат для перемещения таблиц данных 
вверх и вниз в пределах области дисплея. 
 
Клавиши [] и [] перемещают курсор по горизонтали. 

Пользуйтесь аппаратной клавишей Select для выбора части ввода, как при 
вводе буквенных символов. В некоторых меню клавиша Select действует 
также в качестве клавиши завершения ввода, которая равнозначна 
клавише Enter. 

 

 

Вращение поворотной ручки вызывает увеличение или уменьшение численного значения, изменяет выделенную 
цифру или символ, либо вызывает ступенчатое перемещение по спискам или по пунктам в строке. 

См. также подраздел 2.1.3 "Разрешающая способность поворотной ручки на передней панели". 

Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

3.3.2 Ввод буквенных символов 

 

 
 
 
 
 
Для перемещения курсора  
в пределах активного значения  
вместо таблицы символов  
отключите таблицу символов  
(установите на Off пункт  
Show Alpha Table) 

Функциональные клавиши ввода данных появляются в раз-
личных меню. Если вам не ясно их назначение в данном 
контексте, пользуйтесь клавишей Help, чтобы вывести на 
экран пояснения (см. раздел 3.2). Чтобы получить справочную 
информацию по таблице символов, пользуйтесь 
расположенной рядом с ней функциональной клавишей. 
При выборе данных, которые воспринимают буквенные сим-
волы, появляется меню, аналогичное тому, что показано 
слева. 
Чтобы выделить нужный символ, пользуйтесь клавишами со 
стрелками или поворотной ручкой, затем нажмите аппаратную 
клавишу Select или функциональную клавишу рядом с 
таблицей символов. 

Чтобы исправить ошибки ввода, нажмите клавишу Bk Sp или Clear Text. 
Для завершения ввода нажмите функциональную клавишу Enter. 
Для шестнадцатиричных символов появляется сокращенный вариант этого меню, который содержит только 
буквы от А до F (для ввода остальных значений пользуйтесь цифровой клавиатурой). 
Добавление и редактирование комментариев для заносимых в память файлов наборов параметров 
прибора описано в подразделе 3.8.6. 

      ПРИМЕЧАНИЕ        
Максимально приемлемая длина имени файла составляет 25 символов. 

Клавиши [] и [] служат для увеличения и уменьшения выделенного численного  
значения, а также для перемещения курсора по вертикали 

Чтобы ввести отрицательное значение, введите знак "–" перед численным значением или после него 
(эта клавиша действует как  переключатель поочередного действия). 
 

Клавиша забоя Bk Sp перемещает курсор влево, стирая символы по мере перемещения. 
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3.3.3 Пример: Применение табличного редактора 
Табличные редакторы упрощают выполнение задач конфигурирования. Ниже описана процедура 
конфигурирования развертки по списку, демонстрирующая функциональные возможности табличного 
редактора на примере табличного редактора List Mode Values. 
1. Выполните предустановку генератора сигналов: нажмите клавишу Preset. 
2. Откройте табличный редактор: нажмите клавиши Sweep > More > Configure List Sweep. 
 На экране появляется табличный редактор List Mode Values, как показано на рисунке. 
 
 
Область активной функции 
Отображает активный элемент таблицы,  
когда вы редактируете его значение. 

Курсор 
Выделение указывает выбранный элемент. Чтобы превратить его  
в активный (редактируемый) элемент, нажмите клавишу Select  
или просто введите нужное значение. 

 
Номер  
страницы 

Имя табличного  
редактора 

Элементы таблицы 
Элементы таблицы  
называют также  
полями данных. 

Функциональные клавиши табличного 
редактора 
Применяются для загрузки, навигации,  
изменения и занесения в память элементов 
таблицы. Чтобы выяснить назначение  
каждой функциональной клавиши, нажмите 
клавишу Help, затем интересующую вас  
функциональную клавишу. 

Указывает на наличие 
еще одного меню.  

Чтобы вызвать его  
на экран, нажмите 

функциональную  
клавишу More. 

 
3. Выделите нужный элемент: пользуйтесь клавишами со стрелками или поворотной ручкой для 

перемещения курсора. 
4. (Необязательно) Выведите на экран выбранный элемент в область активной функции: нажмите клавишу 

Select. 
5. Измените значение: 

 Если значение индицируется в области активной функции, измените это значение с помощью 
поворотной ручки, клавиш со стрелками или цифровой клавиатуры. 

 Если значение не индицируется в области активной функции, введите с помощью цифровой 
клавиатуры нужное значение (которое теперь появляется в области активной функции). 

6. Завершите ввод: 
 Если необходимо, выберите нужную единицу измерения. 
 Если на экране не отображаются единицы измерений, нажмите функциональную клавишу Enter (если 

она имеется), либо клавишу Select. 
Теперь в таблице отображается измененный вами элемент. 
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3.4 Установка параметров частоты и мощности (амплитуды) 
Установка частотных параметров 

  
В режиме Frequency автоматически отображается это меню при вводе  
численного значения с цифровой клавиатуры на передней панели. 

 
Вводит в действие этот режим для улучшения негармонических  
характеристик (режим низкого уровня паразитных составляющих). 

Примечание: Когда задействован этот режим, это оказывает влияние на скорость  
переключения прибора и поведение установившегося сигнала источника. 

 
 Рис. 3-1а Функциональные клавиши частотных параметров 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
Обращайтесь также к Справочнику по командам SCPI (SCPI Command Reference). 

 

 

Устанавливает текущее значение относительной фазы  
выходного ВЧ сигнала в качестве нулевого опорного  
значения.  
Все дальнейшие подстройки выполняются относительно  
этого значения. 
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Установка амплитудных параметров 

  
В режиме Amplitude автоматически отображается это меню при вводе  
численного значения с цифровой клавиатуры на передней панели. 

 
Оптимизирует установки параметров аттенюатора и ALC. 
Не изменяет мощность выходного ВЧ сигнала. 

 
 

 Рис. 3-1б Функциональные клавиши амплитудных параметров 

  ПРЕДОСТЕРЕЖЕНИЕ    
Когда задействовано состояние оптимизации отношения сигнал/шум, могут возникать повышенные уровни 
нелинейных искажений. Это может привести к ухудшению характеристик ACPR и EVM. 

      ПРИМЕЧАНИЕ        
Этот режим взаимно исключает применение функции удержания установки аттенюатора (Atten Hold) и 
любого типа модуляции. Когда задействован (On) режим оптимизации отношения сигнал/шум, то при 
включении функции Atten Hold или какой-либо модуляции генерируется ошибка (конфликт установки 
параметров). 

 

 
Функциональная клавиша dBuVemf завершает ввод значения электро-
движущей силы, выраженного в децибелах от микровольта (dBuV). 
Электродвижущая сила – это выходное напряжение в режиме холостого 
хода (без нагрузки). Эта единица измерений служит только для внешних 
значений. Внутреннее представление, а также значения приращения 
(инкремента и декремента) выражаются в децибелах от милливатта 
(dBm).  

Примечание: Аналогичным образом ведут себя функциональные кла-
виши dBuV, mV и nVemf (т.е. только внешние значения). Внутреннее 
представление, а также значения приращения (инкремента и декре-
мента) выражаются в децибелах от милливатта (dBm). 

Открывает  
меню  
Atten/ALC  
Control. 
 

 
Чтобы вызвать на экран  
следующее меню, нажмите  
функциональную клавишу  
More. 
 

  см. раздел 3.5 

 

 

Эта функциональная клавиша устанавливает перманентный  
максимальный уровень мощности, заданный пользователем. 

 

Имеется у векторных моделей с генератором модулирующих  
сигналов (BBG). Позволяет прибору выбирать между двумя  
уровнями мощности с помощью аппаратного маркера или  
внешнего сигнала на соединителе BNC. 
 

Вводит в действие состояние оптимизации отно-
шения сигнал/шум (Optimize S/N). Эта функцио-
нальная клавиша изменяет установку аттенюатора 
и ALC для оптимизации сигнально-шумовых 
характеристик, но не изменяет мощность выход-
ного ВЧ сигнала. См. ниже ПРЕДОСТЕРЕЖЕНИЕ 
и ПРИМЕЧАНИЕ. 
 

глава 5 
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3.4.1 Пример: Конфигурирование вывода немодулированного ВЧ сигнала 
Ниже рассмотрен пример конфигурирования вывода немодулированного ВЧ сигнала 700 МГц, –20 дБм. 
1. Выполните предустановку генератора сигналов. 
 На дисплее индицируется максимально возможная частота и минимальный уровень мощности (области 

дисплея описаны в разделе 1.4). 
2. Установите частоту на 700 МГц. Для этого нажмите клавиши Freq > 700 > MHz. 
 На дисплее индицируется значение 700 МГц как в области FREQUENCY, так и в области активного 

элемента. 
3. Установите амплитуду на –20 дБм. Для этого нажмите клавиш Ampl > –20 > dBm. 
 В области AMPLITUDE меняется индикация на –20 dBm, и это значение амплитуды становится 

активным элементом. 
4. Включите выход ВЧ сигнала. Для этого нажмите клавишу RF On/Off. 
 Зажигается индикаторный светодиод RF Output и на соединителе RF OUTPUT появляется 

немодулированный сигнал с частотой 700 МГц и с уровнем –20 дБм. 

3.4.2 Применение внешнего генератора опорной частоты 
При применении внешнего генератора опорной частоты вы можете выбрать либо узкополосный (Narrow), 
либо широкополосный (Wide) режим. 
 

 

 

 

Использует внутренний генератор опорной частоты. 

Использует внешний сигнал опорной частоты на соединителе 
REF IN. Примечание: Если внешний сигнал отсутствует или 
имеет неправильную частоту, появляется экран ошибок. 

Использует внутренний генератор опорной частоты, пока не 
появится сигнал на соединителе RF IN на задней панели, 
который будет использоваться в качестве опорного. 

Использует генератор тактовой частоты генератора модули-
рующих сигналов в качестве источника опорной частоты. 
Этот вариант доступен у векторных генераторов с BBG. 

 
 
 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

Диапазон: 1 ÷ 50 МГц 

Для гарантированного функционирования ниже 2 МГц выберите узкополосный 
режим (Narrow); в широкополосном режиме (Wide) не гарантируется работа с 
частотами ниже 2 МГц. 

Рис. 3-2 иллюстрирует более узкий спектр фазового шума в широкополосном 
режиме. Если применяемый вами внешний источник опорной частоты генерирует 
зашумленный сигнал, то лучше применять узкополосный режим. 

Если выбрать частоту < 2 МГц, когда установлен широкополосный режим, то на 
дисплее генератора сигналов появится предупредительное сообщение. 
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Спектр фазового шума у генераторов серии MXG на частоте 1 ГГц 

 
Отстройка частоты 

 Рис. 3-2 Применение внешнего генератора опорной частоты 
а) Узкополосный режим, внешний генератор опорной частоты 
б) Широкополосный режим, внешний генератор опорной частоты 

3.5 Установка регулировки ширины полосы частот функции ALC 

 

 
 
 
 
 
 
 
Вводит в действие 
режим  
автоматической  
регулировки  
ширины полосы  
частот функции  
ALC (Auto). 

Для вызова на экран следующего меню   
нажмите функциональную клавишу More.  

 Рис. 3-3 Функциональные клавиши Amplitude 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
Обращайтесь также к Справочнику по командам SCPI (SCPI Command Reference). 

а) 
 

б) 
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3.6 Конфигурирование вывода сигналов в режиме развертки 
Генератор сигналов реализует два способа развертки сигнала по набору точек частоты и амплитуды: 
 Ступенчатая развертка (подраздел 3.6.2) обеспечивает линейное или логарифмическое продвижение 

от одного выбранного значения частоты, амплитуды (или того и другого) к другому значению, задержи-
ваясь при этом на точках (ступенях), распределенных в линейном или логарифмическом масштабе по 
оси развертки. Развертка может производиться в сторону увеличения значения, в сторону уменьшения 
или управляться вручную. 

 Развертка по списку (подраздел 3.6.3) позволяет вам вводить значения частоты и амплитуды с 
неодинаковыми интервалами в направлении возрастания, убывания или в произвольном порядке. 
Развертка по списку позволяет вам также копировать текущие значения ступенчатой развертки (включая 
сигнал произвольной формы) в список развертки и сохранять данные развертки по списку в каталоге 
файлов (подраздел 3.8.4). 

 

 
 
 Рис. 3-4 Функциональные клавиши Sweep 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

Во время развертки индикация соответствующего параметра (частота, амплитуда) становится серой и изменяется в ходе развертки. 

Выбранный тип развертки определяет индицируемый параметр. При выборе  
ступенчатой развертки индицируется также ее характер (Lin или Log). 

 

Прогресс-индикатор: Имейте в виду, что  
при очень быстрой развертке может  
показаться, что индикатор изменяется  
хаотически или в обратном направлении. 

 

подраздел  
3.6.2 

 

У векторных генераторов этот пункт  
доступен, когда выбрана развертка  
по списку (Sweep Type = List). 

 

Развертка без ожидания запуска в каждой  
точке. Точка запуска задерживается на  
время задержки перед первым тактом  
развертки. 
 
 
Запуск по команде дистанционного  
управления. 
 
Подать сигнал TTL/CMOS на соединитель  
Trigger In. 

 

Периодический вывод события  
запуска на любое устройство,  
которое выбирает его в качестве  
источника. 

Применение запуска по таймеру  
(Timer Trigger) с однократной  
разверткой приводит к задержке  
перед первым тактом развертки. 

 

 подраздел 3.6.1 

 

Развертка вниз (Down) 
с конца до начала 
списка значений  
частоты/амплитуды. 
 
Развертка вверх (Up)  
с начала до конца  
списка значений  
частоты/амплитуды.  

 

стр. 40 

 

  стр. 43 
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3.6.1 Маршрутизация сигналов 
Sweep > More > More > Route Connectors 
 

 

 
 
 Рис. 3-5 Функциональные клавиши маршрутизации сигналов 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

Эти функциональные   
клавиши доступны  
только у векторных  
генераторов с BBG. 

 

Открывает меню для  
маршрутизации   
маркеров 1 ÷ 4 на 
соединители BNC на  
задней панели  
(для генератора   
модулирующих  
сигналов). 
 

 

Маршрутизация  
сигналов ступенч.  
развертки или  
развертки по списку. 
Маршрутизация 
прочих сигналов  
(например, команд  
разработки SCPI) 
 
На пункт Source  
Settled не влияет  
выбор  
функциональных  
клавиш Trig Out  
Polarity и Neg Pos. 

 
Направляет сигнал на соединители Trig Out (Trig 1 или Trig 2)  
на задней панели следующим образом: 

None: На соединители BNC Trig 1 и Trig 2 не подаются никакие  
сигналы. 

Sweep Trigger Out: Сигнал Sweep Trigger Out (квитирование  
запуска) 

Source Settled: Сигнал Source Settled  

Pulse Sync: Сигнал синхронизации импульсной модуляции 

Pulse Video: Видеосигнал импульсной модуляции 

LXI: Выход запуска LXI 

Sweep Run: Сигнал Sweep Run (работает развертка) 

Other Trigger BNC: Сигнал на другом соединителе запуска BNC 

Pulse BNC: Сигнал на соединителе BNC PULSE IN 

Swept Func Done: Сигнал завершения развертки Swept Done 
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3.6.2 Ступенчатая развертка (Step Sweep) 
Ступенчатая развертка (подраздел 3.6.2) обеспечивает линейное или логарифмическое продвижение от 
одного выбранного значения частоты, амплитуды или того и другого к другому значению, задерживаясь при 
этом на точках (ступенях), распределенных в линейном или логарифмическом масштабе по оси развертки. 
Развертка может производиться в сторону увеличения значения, в сторону уменьшения значения или 
управляться вручную. 
 

 

Dwell Time – время выдержки, необходимое для 
установления сигнала, чтобы вы смогли выполнить 
измерение до того, как развертка переместится в 
следующую точку. 

(Point to point time – это сумма значений, установлен-
ных для времени выдержки, времени обработки, вре-
мени переключения и времени установления). 

Значения времени выдержки в режимах ступенчатой 
развертки и развертки по списку устанавливаются  
независимым образом. 

 
 
 
 Рис. 3-6 Функциональные клавиши развертки 

Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

Пример: Конфигурирование периодической линейной ступенчатой развертки 
В этом примере показано, как сконфигурировать периодическую линейную ступенчатую развертку от 500 
МГц до 600 МГц и от –20 дБм до 0 дБм при времени выдержки 500 мс в каждой из шести равномерно 
распределенных точек. 
1. Выполните предустановку прибора и откройте меню Sweep/List: нажмите клавиши Preset > SWEEP. 
 Поскольку по умолчанию принята непрерывная (continuous) линейная развертка, то вам не нужно 

устанавливать эти параметры. 
2. Откройте меню ступенчатой развертки: нажмите функциональную клавишу Configure Step Sweep. 
3. Установите следующие параметры: 

Начальная частота 500 МГц: Нажмите клавиши Freq Start > 500 > MHz. 
Конечная частота: 600 МГц Нажмите клавиши Freq Stop > 600 > MHz. 
Амплитуда в начале развертки: –20 дБм Нажмите клавиши Amptd Start > –20 > dBm. 
Амплитуда в конце развертки: 0 дБм Нажмите клавиши Amptd Stop > 0 > dBm. 
Шесть точек развертки: Нажмите клавиши # Points > 6 > Enter. 
Время выдержки в каждой точке: 500 мс Нажмите клавиши More > Step Dwell > 500 > msec. 

 
4. Включите развертку частоты и амплитуды: нажмите клавиши Return > Return > Sweep > Freq Off On > 

Amptd Off On. 
 Начинается периодическая развертка от начальной частоты и амплитуды до конечной частоты и 

амплитуды. На дисплее появляется вспомогательный индикатор SWEEP, а процесс развертки 
отображается на индикаторе частоты, индикаторе амплитуды и на линейном прогресс-индикаторе. 

5. Включите выход ВЧ сигнала. Для этого нажмите клавишу RF On/Off. 
Зажигается индикаторный светодиод RF и на соединителе RF Output появляется сигнал с периодической 
разверткой. 

Lin – одинаковые интервалы между ступенями в развертке; 
выход изменяется по линейному закону. 
Log – интервалы между ступенями изменяются по логариф-
мическому закону; выход изменяется экспоненциально. 
 

Устанавливает размер ступени для линейной развертки частоты  
(разность между точками частоты). 

Примечание: Установка размера ступени определяет количество точек в 
ступенчатой развертке на основе текущих значений начальной и конечной 
частоты. Ввиду целочисленного количества точек может быть 
скорректирован размер ступени для получения действительно линейной 
развертки между начальной и конечной частотой. 
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3.6.3 Развертка по списку (List Sweep) 
Развертка по списку позволяет вам вводить значения частоты и амплитуды с неодинаковыми интервалами 
в направлении возрастания, убывания или в произвольном порядке. Развертка по списку позволяет вам 
также копировать текущие значения ступенчатой развертки (в том числе сигнал произвольной формы у 
векторного генератора) в список развертки и сохранять данные развертки по списку в каталоге файлов (см. 
подраздел 3.8.4). Время выдержки можно устанавливать индивидуально в каждой точке. Для реализации 
максимальной скорости переключения применяйте развертку по списку. 
 

 
 
 Рис. 3-7 Функциональные клавиши конфигурирования развертки по списку и дисплей 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

Отображает параметры  
выбранного типа  
развертки (см. след. стр.) 
 

 
 

Доступно только у векторных генераторов  
и только тогда, когда Sweep Type = List  
(т.е. при развертке по списку). 
 

 стр. 38 

стр. 39 

Каждая строка определяет соответствующую 
точку в развертке.  
Например, строка 1 определяет точку 1. 
 

Только векторные генераторы 

см. след. стр. 

Выбраненный тип развертки определяет время выдержки, которое должно использо-
ваться генератором сигналов. Время выдержки при ступенчатой развертке одинаково 
в каждой точке. Время выдержки в режиме развертки по списку может быть разным в 
каждой точке. 

Dwell Time – время выдержки, необходимое для установления сигнала, чтобы вы 
могли выполнить измерение до того, как развертка переместится в следующую точку. 

Point-to-Point time – это сумма значений, установленных для времени выдержки, 
времени обработки, времени переключения и времени установления. 
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Пример: Конфигурирование развертки по списку на основе данных ступенчатой развертки 
1. Выполните желаемую установку параметров ступенчатой развертки, но не включайте развертку. В 

данном примере используется ступенчатая развертка, установка параметров которой описана на стр. 39. 
2. В меню SWEEP переключите тип развертки на развертку по списку: нажмите клавиши SWEEP > Sweep 

Type List Step, чтобы выделить вариант List. 
На дисплее отображаются параметры развертки по списку, как показано ниже: 

 
3. Откройте меню List Sweep: нажмите клавиши More > Configure List Sweep. 
4. Удалите из меню ранее установленные значения и загрузите в список точки, заданные в ступенчатой 

развертке: нажмите клавиши More > Preset List > Preset with Step Sweep > Confirm Preset. 
Дисплей обновляется значениями, загруженными из ступенчатой развертки, как показано ниже. 

 

Векторные генераторы: 

Предустановка списка удаляет ранее 
выбранные сигналы. 

За информацией по выбору сигналов для 
развертки по списку обращайтесь к 
примеру редактирования точек развертки 
по списку (см. ниже). 

 

5. Частота и амплитуда сигнала при развертке: нажмите клавиши SWEEP (аппаратная клавиша) > Sweep > 
Freq Off On > Amptd Off On. 

 Установка развертки включает функцию развертки; начинается периодическая развертка. На дисплее 
появляется вспомогательный индикатор SWEEP, а процесс развертки отображается на линейном 
прогресс-индикаторе. 

6. Включите выход ВЧ сигнала, если он еще не был включен. Для этого нажмите клавишу RF On/Off. 
 Зажигается индикаторный светодиод RF и на соединителе RF Output появляется сигнал с периодической 

разверткой. 

Пример: Редактирование точек развертки по списку 
Если вы еще не ознакомились с табличным редактором, обращайтесь к подразделу 3.3.3 (стр. 32). 
1. Создайте желаемую развертку по списку. В этом примере используется развертка по списку, созданная в 

предыдущем примере. 
2. Если развертка включена, выключите ее. Редактирование параметров развертки по списку при 

включенной развертке может привести к появлению сообщения об ошибке. 
3. Установите тип развертки на развертку по списку: нажмите клавиши SWEEP > Sweep Type List Step, 

чтобы выделить вариант List. 
4. В табличном редакторе List Mode Values измените время выдержки в точке 1 (заданной в строке 1) на 

100 мс: 
а) Нажмите клавиши More > Configure List Sweep. 
б) Выделите время выдержки в точке 1. 
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в) Нажмите клавиши 100 > msec. 
Выделяется следующий пункт в таблице (значение частоты в точке 2). 

5. Измените выбранное значение частоты на 445 МГц: нажмите клавиши 445 > MHz. 
6. Вставьте новую точку между точками 4 и 5: выделите любой элемент в строке 4 и нажмите клавишу In-

sert Row. 
 Это помещает копию строки 4 под строкой 4, образуя новую точку 5 с перенумерацией следующих строк. 
7. Сместите значения частоты на одну строку вниз, начиная с точки 5: выделите элемент частоты в строке 

5, затем нажмите клавиши More > Insert Item. 
 Это помещает копию выделенного значения частоты в строку 6, сдвигая на одну строку вниз значения 

для строк 6 и 7. Новая строка 8 содержит только значение частоты (значения мощности и времени 
выдержки не сдвигаются вниз). 

8. Измените все еще активное значение частоты в строке 5 на 590 МГц: нажмите клавиши 590 > MHz. 
Теперь активным параметром является значение мощности в строке 5. 

9. Вставьте новое значение мощности (–2,5 дБм) для точки 5 и сдвиньте на одну строку вниз 
первоначальные значения мощности для точек 5 и 6: нажмите клавиши Insert Item > –2.5 > dBm. 

10. Чтобы завершить ввод для точки 8, вставьте дубликат времени выдержки в точке 7 путем смещения 
вниз копии имеющегося значения: выделите значение времени выдержки в строке 7 и нажмите клавишу 
Insert Item. 

11. Для аналогового прибора переходите к пункту 14. Для векторного прибора переходите к пункту 12. 
12. Выберите сигнал (форму сигнала) для точки 2: 

а) Выделите элемент сигнала для точки 2 и нажмите клавиши More > Select Waveforms. 
 На дисплее отображаются варианты выбора модулирующего сигнала, как показано на следующем 

примере: 

  
б) Выделите желаемый сигнал (в этом примере SINE_TEST) и нажмите либо аппаратную клавишу Se-

lect, либо функциональную клавишу Select Waveform. 
13. При желании повторите пункт 12 для остальных точек, для которых вы хотите выбрать модулирующий 

сигнал. Это может выглядеть так, как показано на следующем рисунке. 

  
14. Включите развертку: 

Нажмите клавиши Return > Return > Sweep > Freq Off On > Amptd Off On > Waveform Off On. 
15  Включите выход ВЧ сигнала, если он еще не был включен. Для этого нажмите клавишу RF On/Off. 
 Зажигается индикаторный светодиод RF и на соединителе RF Output появляется сигнал с периодической 

разверткой. 
  

Выберите модулирующий сигнал 
 
 
или  
 

выберите отсутствие модуляции  
(немодулированный ВЧ сигнал). 
 

Пустой элемент эквивалентен  
выбору CW (без модуляции) 
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      ПРИМЕЧАНИЕ        
Если прибор находится в режиме ручного управления разверткой (подраздел 3.6.5), то выбранной точкой 
развертки является активная строка (строка 6 на предыдущем рисунке), и генератор при включении 
выводит сигнал с этими установками параметров. 

3.6.4 Пример: Применение однократной развертки 
1. Установите параметры ступенчатой развертки (стр. 39) или развертки по списку (стр. 41). 
2. В меню List/Sweep установите однократную развертку (Single):  

Нажмите клавишу Sweep Repeat Single Cont, чтобы выделить вариант Single. 
 Развертка не начинается, пока вы не запустите ее. 
 Обратите внимание на то, что на дисплее появляется вспомогательный индикатор WINIT, указывающий 

на то, что развертка находится в состоянии ожидания инициализации. 
3. Включите выход ВЧ сигнала, если он еще не был включен. Для этого нажмите клавишу RF On/Off. 
4. Чтобы инициализировать развертку, нажмите клавишу Single Sweep. 
 Выполняется однократная развертка выходного ВЧ сигнала в соответствии с установленными 

параметрами.  
 На месте индикатора WINIT появляется вспомогательный индикатор SWEEP на время действия 

развертки; продвижение развертки индицируется прогресс-индикатором. В конце развертки исчезает 
прогресс-индикатор, а вместо вспомогательного индикатора SWEEP появляется индикатор WINIT. 

3.6.5 Ручное управление разверткой 
1. Установите параметры ступенчатой развертки (стр. 39) или развертки по списку (стр. 41). 
2. В меню Sweep/List выберите подлежащий развертке параметр: нажмите клавиши Sweep > параметр > 

Return. 
3. Выберите режим ручного управления разверткой: нажмите клавиши More > Manual Mode Off On. 
 Когда вы выбираете режим ручного управления, текущая точка развертки становится выбранной точкой 

ручного управления. 
4. Включите выход ВЧ сигнала, если он еще не был включен. Для этого нажмите клавишу RF On/Off. 
5. Выберите нужную точку для вывода сигнала: нажмите клавиши Manual Point > номер > Enter. 
 Прогресс-индикатор сдвигается и указывает выбранную точку. 
6. Для перехода от точки к точке пользуйтесь поворотной ручкой или клавишами со стрелками. Как только 

вы выбираете каждую точку, изменяется выходной ВЧ сигнал в соответствии с установками параметров 
в выбранной точке. 

 
Вспомогательный индикатор  
SWMAN указывает, что развертка  
находится в режиме ручного  
управления. 

Останавливается  
развертка текущего  
параметра  
и индицируется  
выбранная точка. 

 
Когда вы выбираете точку  
вручную, прогрессс-индикатор 
сдвигается и останавливается  
в выбранной точке. 

 
Параметры выбранной точки развертки  
(точка 3 из 6 в данном примере) определяют  
сигнал, действующий на соединителе  
RF Output. 

  

Когда вы выбираете режим 
ручного управления, текущая 
точка развертки становится 
выбранной точкой ручного 
управления. 
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3.7 Модуляция сигнала несущей 
Для получения модулированного сигнала несущей необходимо выполнение двух условий: 
 должен иметься активный формат модуляции 
 и 
 должна быть задействована (включена) модуляция ВЧ выхода. 

3.7.1 Пример 
1. Выполните предустановку генератора сигналов. 
2. Включите амплитудную модуляцию: нажмите клавиши AM > AM Off On (требуется опция UNT). 
 Формат модуляции можно включить до или после установки параметров сигнала. 
 Формат модуляции генерируется, однако сигнал несущей пока еще не подвергается модуляции. 
 Когда начнется генерирование сигнала, на дисплее появится вспомогательный индикатор имени 

формата, указывающий на то, что активен этот формат модуляции. 
3. Включите модуляцию выходного ВЧ сигнала: нажимайте клавишу Mod On/Off, пока не засветится 

индикаторный светодиод. 
Если вы попытаетесь включить модуляцию в отсутствие активного формата модуляции, сигнал несущей 
не будет подвергаться модуляции, пока вы не включите формат модуляции. 

  
 
 

Вспомогательный индикатор указывает активный формат амплитудной модуляции 

  

 
Свечение этого светодиода 
указывает на возможность 
модуляции несущей любым 
активным форматом  
модуляции. 
 
 Включен формат  

амплитудной модуляции 

 

      ПРИМЕЧАНИЕ        
Чтобы выключить модуляцию, нажимайте клавишу Mod On/Off, пока не погаснет светодиод. 
Когда клавиша Mod On/Off находится в состоянии Off (ВЫКЛ.), сигнал несущей не модулируется даже 
при наличии активного формата модуляции. 

4. Чтобы вывести сигнал модулированной несущей на выходной соединитель RF Output, нажимайте 
клавишу RF On/Off, пока не засветится ее светодиод. 

См. также: 
 Глава 4 "Применение аналоговой модуляции (опция UNT)" 
 Глава  6 "Применение импульсной модуляции (опция UNW или 320)" 
 Раздел 8.10 "Синфазно-квадратурная (I/Q) модуляция" 
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3.7.2 Одновременное применение нескольких типов модуляции 
      ПРИМЕЧАНИЕ        
Генераторы сигналов Agilent серии Х допускают одновременное применение нескольких типов модуляции 
(амплитудная, частотная, фазовая и импульсная модуляция) с ограничениями, указанными в таблице 3-1. 
Таблица 3-1 Возможности одновременного применения нескольких типов модуляции 

 Амплитудная  
модуляция а) 

Частотная  
модуляция 

Фазовая  
модуляция 

Частотная  
модуляция б) 

Амплитудная модуляция –    

Частотная модуляция  в) – неприменимо  

Фазовая модуляция  в) неприменимо –  

Импульсная модуляция      – 

а) Невозможно одновременное применение линейной и экспоненциальной амплитудной модуляции (см. главу 4). 
б) Импульсная модуляция требует применения опции UNW (см. главу 6). 
в) Невозможно одновременное применение частотной и фазовой модуляции. 

3.8 Работа с файлами 
Этот раздел содержит следующие подразделы: 
3.8.1 Функциональные клавиши файлов – стр. 46 
3.8.2 Просмотр списка занесенных в память файлов – стр. 47 
3.8.3 Сохранение файлов – стр. 48 
3.8.4 Загрузка (вызов) файлов из памяти – стр. 49 
3.8.5 Перемещение файлов из одного накопителя на другой – стр. 49 
3.8.6 Работа с файлами состояния прибора – стр. 51 
3.8.7 Выбор принятого по умолчанию накопителя – стр. 54 
Генератор сигналов распознает несколько типов файлов: файлы состояний (наборов параметров) прибора, 
файлы лицензий и файлы данных развертки по списку. Файлы можно сохранять как во внутренней памяти 
генератора сигналов, так и на USB-накопителе. В этом разделе описано, как перемещаться по меню 
файлов генератора сигналов и как просматривать, сохранять в памяти, загружать и перемещать файлы. 
Долговременная (энергонезависимая) память генераторов сигналов Agilent MXG и EXG распределяется в 
соответствии с таблицей размещения файлов (FAT), совместимой с программным обеспечением Microsoft 
(см. Руководство по программированию). 
См. также раздел 8.2. 
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3.8.1 Функциональные клавиши файлов 

 
 
Когда вы присоединяете к прибору USB-накопитель, на экране появляется меню USB-накопителя и 
сообщение External USB Storage attached.  

Когда вы отсоединяете USB-накопитель, появляется сообщение External USB Storage detached.  

Когда вы открываете меню External Media без присоединенного USB-накопителя, появляется сообщение 
External Media Not Detected. 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

подраздел 3.8.2 

Отображение внутренних или  
USB файлов в зависимости  
от выбранного накопителя. 

 

Примечание: Имеющиеся типы файлов зависят от установленных опций. 

Операция удаления  
требует подтверждения. 

 

Рабочие параметры прибора (см. подраздел 3.8.6) 

Данные развертки из табл. редактора значений развертки по списку 

Поправки пользовательской коррекции неравномерности ЧХ 

Отображает  
файлы IQ 
 
Отображает  
файлы FSK 
 
Отображает  
файлы FIR 
 
Отображает   
список файлов  
 имп. пакетов 
 
Отображает  
битовые файлы 
 

подраздел 3.8.7 
  глава 13 

Показывает текущую  
директорию 

 

Эти функциональные клавиши доступны  
только с подключенным USB-накопителем. 
В противном случае они отображаются  
серым цветом. 
 

 

Генератор сигналов не форматирует  
USB-накопитель и не изменяет атрибуты  
файлов. Для выполнения этих операций  
следует пользоваться компьютером. 
 

 
Дисплей указывает, когда текущая директория является принятым  
по умолчанию местом сохранения файлов. Как выбрать принятый по  
умолчанию накопитель, описано в подразделе 3.8.7. 
 

 Эта клавиша изменяется в зависи-
мости от выбранного типа файла  
(см. подраздел 3.8.4). 

 
подраздел 3.8.5 
 
Эта клавиша доступна только тогда,  
когда текущая директория не является  
директорией верхнего уровня. 
 
Требует подтверждения 
 
 
 
подраздел 3.8.5 
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Функциональные клавиши файлов ARB 
Файлы формы сигналов и связанные с ними  
данные маркеров и заголовков 

  
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

3.8.2 Просмотр списка занесенных в память файлов 
В нижеследующем описании предполагается, что принятый по умолчанию накопитель установлен на Auto, 
как описано в подразделе 3.8.7. 

Просмотр списка файлов, занесенных в память генератора сигналов 
1. Если к генератору присоединен USB-накопитель, отсоедините его. Тогда прибор переключается на 

внутреннюю память, и вы сможете пользоваться каталогами файлов для просмотра файлов, 
хранящихся в памяти генератора сигналов. 

2. Выберите нужный каталог файлов. Для этого нажмите клавиши > Catalog Type > нужный каталог (в 
данном примере All). Имена выбранных файлов отображаются в алфавитном порядке, как показано на 
этом рисунке. 

   

Просмотр списка файлов на USB-накопителе 
Когда к прибору присоединен USB-накопитель, то вы можете просматривать файлы либо с использованием 
каталогов файлов, которые могут показывать только файлы выбранного типа, либо с помощью файлового 
менеджера USB, который показывает все файлы. 
Применение каталога файлов: 
 Когда к прибору присоединен USB-накопитель, выберите нужный каталог файлов. Для этого нажмите 

клавиши > Catalog Type > нужный каталог. Имена выбранных файлов отображаются в алфавитном 
порядке. 

Применение файлового менеджера USB: 
 Когда к прибору присоединен USB-накопитель, откройте окно файлового менеджера USB. Для этого 

нажмите клавиши File > More > USB File Manager. На экране появляется принятая по умолчанию 
директория на USB-накопителе, как показано на следующем рисунке. Обратите внимание на то, что 
когда вы присоединяете USB-накопитель, дисплей переходит прямо к этому меню. 

Примечание: Имеющиеся типы файлов  
зависят от установленных опций. 
 

Выбранный каталог  
файлов и накопитель   
(здесь это внутренняя  
память) 
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Для прокрутки содержания окна пользуйтесь клавишами Page Up и Page Down. 

3.8.3 Сохранение файлов 
Некоторые меню позволяют вам сохранять в памяти параметры прибора. Например, вы можете заносить в 
память файлы состояний прибора, файлы списков и файлы модулирующих сигналов. 
 Файлы состояний прибора содержат наборы параметров прибора. Для сохранения файлов этого типа 

пользуйтесь аппаратной клавишей Save, как показано на рис. 3-8 в подразделе 3.8.6. 
 Для сохранения данных других типов пользуйтесь функциональной клавишей Load/Store (см. ниже), 

которая имеется в меню, которые используются для создания файлов. 
 

  
Пользуйтесь этим меню для ввода имени файла,  
как описано в разделе 3.3. 

 
Тип файла  Сохранять из: 

List 
State 
Waveform 
User Flatness 
User Preset 
Pulse Train 

Список 
Состояние прибора 
Модулирующий сигнал 
Пользовательская коррекция неравномерности ЧХ 
Пользовательская предустановка 
Импульсный пакет 

меню Sweep 
меню Save 
меню Mode 
меню Amplitude 
меню User Preset 
меню Pulse Train 

 
Длина имени файла (включая расширение имени): 
Внутренняя память: 25 символов 
USB-накопитель: 39 символов 

Для выяснения функций клавиш пользуйтесь встроенной 
справкой по клавишам, как описано в разделе 3.2. 
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3.8.4 Загрузка (вызов) файлов из памяти 
Имеется несколько способов, позволяющих загрузить (вызвать) файл из памяти. 
 Для вызова файла состояния прибора пользуйтесь аппаратной клавишей Recall, как показано на рис. 3-8 

в подразделе 3.8.6. 
 Для вызова данных других типов пользуйтесь функциональной клавишей Load/Store (см. ниже), которая 

имеется в меню, которые используются для создания файлов. 

  
 
Тип файла  Вызывать из: 

List 
State 
Waveform 
User Flatness 
User Preset 
Pulse Train 

Список 
Состояние прибора 
Модулирующий сигнал 
Пользовательская коррекция неравномерности ЧХ 
Пользовательская предустановка 
Импульсный пакет 

меню Sweep 
меню Save 
меню Mode 
меню Amplitude 
меню User Preset 
меню Pulse Train 

Загрузка файла с USB-накопителя 
Чтобы загрузить файл с USB-накопителя, пользуйтесь файловым менеджером USB, как показано ниже. 
File > Catalog Type > <тип> > More > USB File Manager  
 или 
File > More > USB File Manager 
 или 
присоединить USB-накопитель. 

 
Если генератор сигналов не распознает файл, то вы должны выбрать,  
как должен использоваться этот файл (Use As). 

 
Тип файла Расширение  Нажатие клавиши Select с выделенным файлом: 

List 
State 
Waveform 
User Flatness 
User Preset 
License 
Pulse Train 

.list 

.state 

.waveform 

.uflat 

.uprst 

.lic 

.ptrain 

загружает список и начинает развертку 
загружает состояние (набор параметров) прибора 
загружает и воспроизводит модулирующий сигнал 
загружает и применяет пользовательскую коррекцию неравномерности ЧХ 
загружает и выполняет пользовательскую предустановку 
устанавливает приобретенную лицензию 
загружает и применяет импульсный пакет 

 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

Эта клавиша изменяется в  
зависимости от выбранного файла 
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3.8.5 Перемещение файлов из одного накопителя на другой 
Для перемещения файлов между USB-накопителем и внутренней памятью прибора пользуйтесь файловым 
менеджером USB. 
File > Catalog Type > <тип> > More > USB File Manager  
 или 
File > More > USB File Manager 
 или 
присоединить USB-накопитель. 
 

 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

 

Эта клавиша изменяется  
в зависимости от выбранного  
файла (см. стр. 49) 
 

Наличие меню здесь 
зависит от выбранного 

файла 
 
 

Переход к директории  
на один уровень выше 
 
Требует подтверждения 
 

Эта функциональная клавиша  
появляется при выборе файла  
модулирующего сигнала или  
файла неизвестного типа. 
 
 

Если распознается тип файла, то  
появляется сообщение:  
"Имя файла.ххх copied to Internal  
Storage". 
 
 
 

Требует подтверждения 

 Меню Catalog Type  
 (стр. 46) 
 

Эти функциональные  
клавиши доступны  
только у векторных  
генераторов с BBG. 
 

Эти функциональные  
клавиши доступны  
только у векторных  
генераторов с BBG. 
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3.8.6 Работа с файлами состояния прибора 
Ниже описаны следующие операции: 
 Сохранение состояния прибора – стр. 52 
 Сохранение пользовательской предустановки – стр. 52 
 Вызов из памяти состояния прибора – стр. 52 
 Вызов из памяти состояния прибора и связанного с ним файла модулирующего сигнала – стр. 52 
 Вызов из памяти состояния прибора и связанного с ним файла списка – стр. 53 
 Перемещение и копирование занесенного в память состояния прибора – стр. 53 
 

  

 

 

 

 

Состояния прибора (наборы параметров) сохраня-
ются во внутренней памяти прибора (см. ниже 
ПРЕДОСТЕРЕЖЕНИЕ). Память состояний прибора 
делится на 10 секций (с номерами от 0 до 9); 
каждая секция содержит 100 регистров (с 
номерами от 00 до 99). 

Функциональные клавиши Delete в меню Save и 
Recall позволяют вам удалять содержимое 
определенного регистра или содержимое всех 
секций в каталоге файлов состояния. 

Операция удаления требует подтверждения со 
стороны пользователя. 
 
Для выяснения функций клавиш пользуйтесь 
встроенной справкой по клавишам, как описано в 
разделе 3.2. 

 Рис. 3-8 Функциональные клавиши сохранения и вызова файлов 

  ПРЕДОСТЕРЕЖЕНИЕ    
Во избежание потери данных, установок параметров GPIB или текущей пользовательской настройки 
параметров прибора, которые не сохраняются в долговременной (энергонезависимой) памяти, для 
выключения генератора сигналов серии Х всегда следует пользоваться кнопкой выключателя на передней 
панели или соответствующей командой SCPI. Генераторы сигналов, которые установлены в стойках и 
выключаются общим выключателем питания стойки вместо собственного выключателя питания, выводят 
сообщение об ошибке Error -310 ввиду неправильного выключения питания. 
 
В файле состояния не сохраняется следующая информация: 
Уровень защищенности системы 
Индикация уровня защищенности системы 
Состояние уровня защищенности системы 
Web-сервер (HTTP) 
Sockets SCPI (TELNET) 
Списки развертки 
Списки импульсных пакетов 
Состояние дисплея ВКЛ./ВЫКЛ. 
Файлы данных калибровки I'Q 
Имя хоста 
IP-адрес 

Маска подсети 
Принятый по умолчанию межсетевой интерфейс 
Язык команд дистанционного управления 
FTP-сервер 
Ручной выбор DHCP 
VXI-11 SCPI 
Значения приращения ступеней 
Файлы ARB 
МАС 
Пользовательская коррекция мощности 
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Сохранение в памяти состояния прибора 
1. Выполните предустановку генератора сигналов и установите следующие параметры: 
 Частота: 800 МГц; амплитуда: 0 дБм; RF: On 
2. (Дополнительно, только векторные генераторы)  

Свяжите с этими установками параметров файл формы сигнала: 
а) Нажмите клавиши Mode > Dual ARB > Select Waveform. 
б) Выделите нужный файл и нажмите клавишу Select Waveform. Если нужного файла нет в списке, то 

сначала вы должны переместить его из внутренней или внешней памяти в память BBG (см. раздел 
8.2). 

3. Выберите нужный номер секции (sequence) в памяти (в этом примере номер 1): нажмите клавиши Save > 
Select Seq > 1 > Enter. 

4. Выберите нужный регистр (в этом примере 01): нажмите клавиши Select Reg > 1 > Save Reg. 
 Нажмите функциональную клавишу Add Comment to Seq[1] Reg[01], введите комментарий к регистру 01 

секции 1 и нажмите клавишу Enter. Этот комментарий появится в списке Saved States, когда вы нажмете 
клавишу Recall. Если состояние прибора имеет ассоциированную с ним форму сигнала, то ввод имени 
формы сигнала в комментарий облегчает идентификацию состояния прибора, которое относится к 
определенной форме сигнала. 

Сохранение в памяти пользовательской предустановки 
Пользовательская предустановка представляет собой особый тип файла состояния прибора. 
1. Выполните предустановку генератора сигналов и установите параметры согласно необходимости. 
2. Нажмите клавиши User Preset > Save User Preset. 
 Это приводит к сохранению файла с именем USER_PRESET. Генератор сигналов идентифицирует этот 

файл как файл, который содержит данные пользовательской предустановки. 
Вы можете выполнить настройку нескольких состояний предустановки с разными именами: 
1. После того, как вы сохраните в памяти файл пользовательской предустановки, присвойте ему другое 

имя, отличающееся от имени USER_PRESET.  
2. Вы можете занести в память сколько угодно файлов пользовательской предустановки, каждый раз 

присваивая файлу имя, отличающееся от имени USER_PRESET. 
3. Присвойте нужному файлу имя USER_PRESET. 

Вызов из памяти состояния прибора 
1. Выполните предустановку генератора сигналов. 
2. Нажмите клавишу Recall. 
 Функциональная клавиша Select Seq показывает последнюю секцию памяти, которой вы пользовались, 

а на дисплее отображается список состояний, занесенных в регистры этой секции; активным пунктом 
является RECALL Reg. 

3. Выберите интересующее вас состояние прибора: 
Если нужное состояние перечислено в выбранной в данный момент секции, нажмите клавиши нужный 
номер > Enter. 
Если нет, то нажмите клавиши Select Seq > нужный номер > Enter > RECALL Reg > нужный номер >  
Enter. 

Вызов из памяти состояния прибора и связанного с ним файла данных формы сигнала 
1. Убедитесь в том, что существует интересующий вас файл модулирующего сигнала, и он находится в 

памяти BBG (см. подраздел 8.2.1). 
 Если в памяти BBG нет этого файла, то в ходе выполнения этой процедуры появится сообщение об 

ошибке. 
 Вызов из памяти состояния прибора и связанного с ним файла модулирующего сигнала вызывает только 

имя модулирующего сигнала. Это не восстанавливает файл модулирующего сигнала, если он был 
удален, и не загружает файл в память BBG, если он записан во внутреннюю память или на USB-
накопитель. 

2. Вызовите из памяти интересующее вас состояние прибора (см. предыдущий пример). 
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3. Посмотрите имя файла модулирующего сигнала. вызванного вместе с данными состояния прибора: 
нажмите клавиши Mode > Dual ARB. 

 Это имя отображается как имя выбранного модулирующего сигнала. 
4. Включите файл модулирующего сигнала. Для этого нажмите клавиши Mode > Dual ARB > ARB Off On. 

Вызов из памяти состояния прибора и связанного с ним файла списка 
При вызове из памяти состояния прибора реально вызывается только установка параметров развертки по 
списку. При этом не вызываются значения частоты и/или амплитуды. Поскольку вы должны загрузить файл 
списка из каталога файлов, когда вы сохраняете в памяти файл списка, обязательно присвойте ему 
описательное имя (до 25 символов). 
1. Вызовите из памяти интересующее вас состояние прибора (см. предыдущий пример). 
2. Загрузите нужный файл списка: 

а) Нажмите клавиши Sweep > More > Configure List Sweep > More > Load/Store. 
б) Выделите имя нужного файла и нажмите клавиши Load From Selected File > Confirm Load From File. 

Редактирование комментария к состоянию прибора 
Пользуйтесь описанной ниже процедурой для изменения комментария к состоянию прибора, которое 
занесено в память с помощью клавиши Save. Это не то имя, которое появляется в каталоге State (который 
представляет собой ячейку памяти файла). 
1. Нажмите клавишу Save. 
2. Выделите нужный регистр. 
3. Нажмите клавишу Edit Comment in Seq[n] Reg[nn]. 
4. Нажмите клавишу Re-SAVE Seq[n] Reg[nn]. 
Тем самым записывается новый комментарий к ранее занесенному в память состоянию (набору парамет-
ров) прибора. 

Перемещение и копирование занесенного в память состояния прибора 

  
 В качестве файла пользовательской предустановки прибор распознает только файл с именем USER_PRESET 
 

 Рис. 3-9 Каталог файлов состояния прибора 
 
Принятым по умолчанию именем созданного пользователем состояния прибора является его место в 
памяти (секция и регистр). 
Чтобы переместить файл, следует присвоить ему имя другой секции и регистра. Вы не можете присвоить 
этому файлу имя уже существующего файла. Если вы присвоите файлу данных состояния прибора имя, не 
содержащее действительных номеров секции или регистра, то имя этого файла не будет отображаться в 
меню Save и Recall. 

 Секция      Регистр 
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3.8.7 Выбор принятого по умолчанию накопителя 
Вы можете сконфигурировать генератор сигналов на сохранение пользовательских файлов либо во 
внутренней памяти, либо на внешнем USB-накопителе. Для реализации автоматического выбора USB-
накопителя или внутренней памяти в зависимости от того, подключен ли к прибору USB-накопитель, 
выберите установку Automatically Use USB Media If Present. Для предотвращения записи 
конфиденциальной информации во внутреннюю память прибора выберите установку Use Only USB Media. 
Для предотвращения записи конфиденциальной информации на USB-накопитель выберите установку Use 
Only Internal Storage. 
На этот выбор не влияет выключение-включение питания и предустановка. 
 
File > More > 
 
 
 
 
 
 
 
 
 
 

Текущий выбор 
  

 
 
 
 
 
 
 
 
 
 

 

Это рекомендуемый выбор файла. Когда к соединителю USB 
на передней панели присоединен USB-накопитель, он явля-
ется выбранным накопителем. Если не присоединен USB-
накопитель, то используется внутренняя память. 

Используется внутренняя память прибора; USB-накопитель 
игнорируется. 

 

Используется накопитель, подключенный к соединителю 
USB на передней панели. Пользовательские данные не 
заносятся во внутреннюю память. 

 

Выберите на USB-накопителе директорию, которая должна 
использоваться для всех операций с файлами, когда под-
ключен и задействован USB-накопитель. 

 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
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3.9 Считывание сообщений об ошибках 
Когда возникает состояние ошибки, генератор сигналов посылает эту информацию в очередь ошибок как 
для отображения на дисплее, так и на интерфейс дистанционного управления (SCPI). Вы можете 
просматривать и контролировать эти две очереди независимым образом. За информацией в отношении 
очереди ошибок SCPI обращайтесь к Руководству по программированию (Programming Guide). 
 
Характеристика Отображение очереди ошибок на дисплее 
Макс. количество ошибок 30 
Обработка переполнения очереди Отбрасывает самую давнюю ошибку при возникновении новой. 
Просмотр данных Нажать клавиши Error > View Next (или Previous) Error Page 
Очистка очереди Нажать клавиши Error > Clear Error Queue(s). 
Не устраненные ошибки * Возобновляются сообщения об ошибках после очистки очереди. 
Нет ошибок Когда в очереди нет ошибок (считаны все ошибки в очереди или  

выполнена очистка очереди), появляется следующее сообщение: 
No Error Message(s) in Queue 0 of 0 

* Ошибки, которые должны быть устранены, например, разблокировка (unlock). 

Формат сообщений об ошибках 
 Номер ошибки Сообщение об ошибке Описание ошибки (может быть обрезано в конце) 

  
Указывает, что пользователь ввел значение девиации, глубины модуляции или  
частоты внутреннего источника, которое выходит за нормированные пределы. 

  
Объяснение приводится в файле сообщений об ошибках (см. раздел 14.7)  

(на дисплее не отображается)   
 

Этот вспомогательный индикатор указывает сообщение, которое вы еще не видели. 

 
 
 

Индикация new указывает сообщение 
 об ошибке, которое появилось после  
последнего просмотра сообщений об ошибках. 
 

Номер сообщения и полное описание 

Сообщения об ошибках появляются в нижнем левом углу  
экрана по мере их возникновения. 
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4 Применение аналоговой модуляции (опция UNT) 

      ПРИМЕЧАНИЕ        
Аппаратная клавиша Mod On/Off и соответствующий индикаторный светодиод действуют только у 
генераторов сигналов с установленной опцией UNT. 
Прежде чем приступать к изучению информации, изложенной в этой главе, вы должны освоить основные 
операции работы с генератором сигналов. Если вы недостаточно освоили такие функции, как установка 
уровня мощности или частоты, обращайтесь к главе 3 и ознакомьтесь с информацией, изложенной в этой 
главе. 
Глава 4 состоит из следующих разделов: 
4.1 Сигналы аналоговой модуляции – стр. 56 
4.2 Источники сигналов аналоговой модуляции – стр. 56 
4.3 Применение внутреннего источника модуляции – стр. 57 
4.4 Применение внешнего источника модуляции – стр. 58 
4.5 Конфигурирование низкочастотного выхода (опция 303) – стр. 60 

4.1 Сигналы аналоговой модуляции 
Для модуляции несущей на выходе генератора сигналов можно применять четыре типа аналоговой 
модуляции: амплитудная, частотная, фазовая и импульсная модуляция. За описанием импульсной 
модуляции обращайтесь к главе 6 "Применение импульсной модуляции (опция UNW или 320)". 
Ниже перечислены встроенные модулирующие сигналы. 
Синусоидальный сигнал (Sine) 
Синусоидальный сигнал с регулируемой амплитудой и частотой 

Сигнал треугольной формы (Triangle) 
Сигнал треугольной формы с регулируемой амплитудой и частотой 

Сигнал прямоугольной формы (Square) 
Сигнал прямоугольной формы (меандр) с регулируемой амплитудой и частотой 

Нарастающий сигнал пилообразной формы (Pos Ramp) 
Нарастающий сигнал пилообразной формы с регулируемой амплитудой и частотой 

Убывающий сигнал пилообразной формы (Neg Ramp) 
Убывающий сигнал пилообразной формы с регулируемой амплитудой и частотой 

4.2 Источники сигналов аналоговой модуляции 
Ниже перечислены внутренние и внешние источники модуляции, с которыми может работать генератор 
сигналов. Внутренние источники генерируют пять перечисленных выше сигналов, если не указано иное. 
Ext1 & Ext2 
Применяется внешний сигнал, который подается на вход модуляции. Этот сигнал подают на соединитель 
ЕХТ1 или ЕХТ2 на задней панели прибора. 

Func Gen 1 
Синусоидальный сигнал от внутреннего генератора функций. Приборы с опцией 303 имеют 
дополнительные варианты выбора формы сигнала, которые перечислены выше. 

Func Gen 2 
Такие же функциональные возможности, как у Func Gen 1. Реализуется у приборов с опцией 303. 

Dual Func Gen 
Двухтональный сигнал с независимой установкой частоты и процентного значения амплитуды для второго 
тонального сигнала (у приборов с опцией 303). 

Swept Func Gen 
Сигналы, формируемые в режиме развертки, с установкой начальной и конечной частоты, длительности 
развертки, а также с установкой параметров запуска развертки (у приборов с опцией 303). 
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Noise Gen 1 & 2 
Шум с регулируемой амплитудой, задаваемой как междупиковое значение (среднеквадратическое значение 
составляет примерно 80% от индицируемого значения). Возможно равномерное и гауссовское 
распределение (у приборов с опцией 303). 
 

     
 
 Рис. 4-1 Функциональные клавиши аналоговой модуляции 

4.3 Применение внутреннего источника модуляции 
1. Выполните предустановку генератора сигналов. 
2. Установите несущую частоту (ВЧ). 
3. Установите амплитуду ВЧ сигнала. 
4. Сконфигурируйте модуляцию. 
 Амплитудная модуляция 

а) Нажмите клавишу АМ. 
б) Установите тип амплитудной модуляции (линейная или экспоненциальная): 

Нажмите функциональную клавишу AM Type, чтобы выделить нужный тип модуляции. 
в) Установите режим амплитудной модуляции: обычная (Normal) или глубокая (Deep) модуляция. Чтобы 

выбрать Normal, нажмите функциональную клавишу More, чтобы выделить нужный тип модуляции. 
г) Установите глубину амплитудной модуляции:  

Нажмите функциональную клавишу AM Depth > значение. 
По умолчанию: 0,01%; диапазон значений: 0,01% ÷ 100% 

д) Установите частоту модулирующего сигнала: 
Нажмите клавиши More > Setup AM Source > AM Rate > значение > ед. измерения частоты. 

 

 раздел 4.4  раздел 4.4  раздел 4.4 
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Частотная модуляция 
а) Нажмите клавишу FM/ФМ. 
б) Установите девиацию частоты: FM Dev > значение > ед. измерения частоты. 
в) Установите частоту модулирующего сигнала: 

Нажмите клавиши More > Setup FM Source > FM Rate > значение > ед. измерения частоты. 
Фазовая модуляция 
а) Нажмите клавишу FM/ФМ. 
б) Установите ширину полосы частот BW (Normal или High): нажмите функциональную клавишу FM ФМ, 

чтобы выделить нужный вариант. 
в) Установите девиацию фазы: ФМ Dev > значение > pi rad. 
г) Установите частоту модулирующего сигнала: 

Нажмите клавиши More > Setup ФM Source > ФM Rate > значение > ед. измерения частоты. 
5. Включите модуляцию 

Амплитудная модуляция:  нажмите функциональную клавишу AM Off On на On. 
Частотная модуляция: нажмите функциональную клавишу FM Off On на On. 
Фазовая модуляция: нажмите функциональную клавишу ФM Off On на On. 
На дисплее появляется соответствующий вспомогательный индикатор модуляции, указывающий на то, 
что вы задействовали модуляцию. 

6. Включите выход ВЧ сигнала. 
 Зажигается индикаторный светодиод у соединителя RF Output, указывая на то, что на этом соединителе 

действует выходной ВЧ сигнал. 
Если вы сомневаетесь в правильности функционирования модуляции, обращайтесь к подразделу 14.3.3.  
См. также раздел 3.7. 

4.4 Применение внешнего источника модуляции 
 Выбран в данный момент 

  
 

 
  Входы АМ, FM или ФМ 

Входы на задней панели  
описаны в разделе 1.5. 

по  
умолчанию 
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4.4.1 Устранение смещения постоянной составляющей внешнего сигнала 
Для устранения смещения постоянной составляющей внешнего сигнала частотной или фазовой модуляции 
следует выполнить калибровку DCFM или DCФМ. 

      ПРИМЕЧАНИЕ        
Вы можете выполнить эту калибровку и для внутренних сигналов модуляции, однако смещение постоян-
ной составляющей обычно не присуще внутренним сигналам. 
1. Выполните установку параметров нужного типа модуляции и включите модуляцию. 
2. Нажмите клавиши FM/ФМ > FM Source > Ext1 or Ext2 > More > Setup FM Source > Ext DC Cal. 
Выполнение калибровки с подаваемым сигналом постоянного напряжения устраняет девиацию, вызванную 
этим сигналом; теперь приложенный уровень постоянного напряжения становится новой нулевой опорной 
точкой. Когда вы отсоедините сигнал постоянного напряжения, снова выполните калибровку, чтобы 
восстановить правильную нулевую опорную точку для несущей. 

4.4.2 Применение широкополосной амплитудной модуляции 
Широкополосная амплитудная модуляция использует вход I системы I/Q-модуляции. Когда включена 
широкополосная амплитудная модуляция, включена также I/Q-модуляция и установлен внешний (External) 
источник I/Q-модуляции. Если выключить I/Q-модуляцию или установить внутренний (Internal) источник I/Q-
модуляции, то выключается широкополосная амплитудная модуляция. 

      ПРИМЕЧАНИЕ        
Широкополосная амплитудная модуляция выключается для частот от 9 кГц до 5 МГц. 
 

 

Для выяснения функций  
клавиш пользуйтесь  
встроенной справкой  
по клавишам, как описано  
в разделе 3.2. 
 
 

Включает и выключает  
функцию широкополосной  
амплитудной модуляции. 

Примечание: Если выключить 
I/Q-модуляцию или установить 
внутренний (Internal) источник 
I/Q-модуляции, то выключается 
широкополосная амплитудная 
модуляция. 

Эти поля активны, когда задействована широкополосная амплитудная модуляция. 
 
 Рис. 4-2 Меню функциональных клавиш широкополосной амплитудной модуляции 

Установка широкополосной амплитудной модуляции 
1. Выполните установку параметров нужного типа модуляции и включите модуляцию. 
2. Нажмите клавиши AM > AM Path 1 2 WB на WB. 
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4.5 Конфигурирование низкочастотного выхода (опция 303) 
Генератор сигналов имеет низкочастотный (LF) выход. В качестве источника низкочастотного сигнала 
можно выбрать внутренний источник модуляции или внутренний генератор функций. 
При применении внутренней модуляции (Int Monitor) в качестве источника на выход LF OUT подается копия 
сигнала от внутреннего источника, который используется в данный момент для модуляции ВЧ сигнала. 
Параметры модуляции для этого сигнала устанавливают через меню АМ, FM или ФМ. Внутренний источник 
(АМ, FM или ФМ) должен быть сконфигурирован для вывода сигнала на выходе LF OUT. 
При применении генератора функций в качестве источника выход LF OUT возбуждается непосредственно 
от секции генератора функций внутреннего источника модуляции. Частоту и форму сигнала устанавливают 
через меню LF Out, а не через меню АМ, FM или ФМ. Для выбора формы сигнала имеются следующие 
варианты: 
Синусоидальный сигнал (Sine) 
Синусоидальный сигнал с регулируемой амплитудой и частотой 

Сигнал треугольной формы (Triangle) 
Сигнал треугольной формы с регулируемой амплитудой и частотой 

Сигнал прямоугольной формы (Square) 
Сигнал прямоугольной формы (меандр) с регулируемой амплитудой и частотой 

Нарастающий сигнал пилообразной формы (Pos Ramp) 
Нарастающий сигнал пилообразной формы с регулируемой амплитудой и частотой 

Убывающий сигнал пилообразной формы (Neg Ramp) 
Убывающий сигнал пилообразной формы с регулируемой амплитудой и частотой 

Импульсный сигнал (Pulse) 
Импульсы с регулируемым периодом и длительностью 

4.5.1 Источники модуляции для вывода через соединитель LF OUT 
Ниже перечислены внутренние источники модуляции, с которыми может работать генератор сигналов. 
Внутренние источники генерируют пять перечисленных выше сигналов, если не указано иное. 
Int Monitor 
Использует установки параметров АМ, FM и ФМ. 

Func Gen 1 
Сигналы от внутреннего генератора функций. 

Func Gen 2 
Сигналы от внутреннего генератора функций. 

Dual Func Gen 
Двухтональный сигнал с независимой установкой частоты и процентного значения амплитуды для второго 
тонального сигнала (у приборов с опцией 303). 

Swept Func Gen 
Сигналы, формируемые в режиме развертки, с установкой начальной и конечной частоты, длительности 
развертки, а также с установкой параметров запуска развертки (у приборов с опцией 303). 

Noise Gen 1 & 2 
Шум с регулируемой амплитудой, задаваемой как междупиковое значение (среднеквадратическое значение 
составляет примерно 80% от индицируемого значения). Возможно равномерное и гауссовское 
распределение (у приборов с опцией 303). 

Постоянное напряжение (DC) 
Уровень постоянного напряжения в качестве источника для выхода LF OUT. 

      ПРИМЕЧАНИЕ        
Рабочим состоянием выхода LF OUT управляет функциональная клавиша LF Out Off On. Однако когда в 
качестве источника сигнала выбран вариант Int Monitor, у вас есть три способа управления выходом. Вы 
можете пользоваться клавишей включения-выключения источника модуляции (АМ, FM или ФМ), 
клавишей включения-выключения выхода LF OUT или функциональной клавишей Mod On/Off. 
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4.5.2 Конфигурирование низкочастотного выхода с внутренним источником  
модуляции 

В этом примере источником выходного низкочастотного сигнала является внутренний источник сигнала 
частотной модуляции (см. рис. 4-3). 

      ПРИМЕЧАНИЕ        
Внутренняя модуляция (Int Monitor) принята по умолчанию в качестве источника низкочастотного выхода. 

Конфигурирование внутренней модуляции как источника низкочастотного выхода 
1. Нажмите клавишу Preset. 
2. Нажмите клавишу FM/ФМ. 
3. Нажмите клавиши FM Dev > 75 > kHz. 
4. Нажмите клавиши More > Setup FM Source > FM Rate > 10 > kHz. 
5. Нажмите клавиши Return > Return > FM Off On. 
Вы установили сигнал частотной модуляции с частотой модуляции 10 кГц и девиацией частоты 75 кГц. 
Вспомогательный индикатор FM указывает, что вы задействовали частотную модуляцию. 

Конфигурирование низкочастотного выхода 
1. Нажмите аппаратную клавишу LF Out. 
2. Нажмите клавиши LF OUT Amplitude > 3 > V. 
3. Нажмите клавишу LF Out Off On. 
Вы сконфигурировали выходной низкочастотный сигнал синусоидальной формы (принята по умолчанию) с 
амплитудой 3 В, который служит для частотной модуляции с помощью источника Int Monitor (этот источник 
принят по умолчанию). 
 

Вспомогательные индикаторы FM и LF указывают, что источником сигнала  
на выходе LF OUT является частотная модуляция 

 

 
 
 
 
 
 
 
 
 
Частотная модуляция как источник  
сигнала на выходе LF OUT 

Выход LF OUT использует источник Int Monitor (выбор по умолчанию)   

 Рис. 4-3 Конфигурирование источника сигнала с частотной модуляцией на выходе LF OUT  
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4.5.3 Конфигурирование низкочастотного выхода с генератором функций  
в качестве источника 

В этом примере источником выходного низкочастотного сигнала является генератор функций. 

Конфигурирование генератора функций как источника выходного НЧ сигнала 
1. Нажмите клавишу Preset. 
2. Нажмите аппаратную клавишу LF Out. 
3. Нажмите клавиши LF Out Source > Func Gen 1. 

Конфигурирование формы сигнала 
1. Нажмите клавиши Setup LF Out Source > LF Out Waveform > Sine. 
2. Нажмите клавиши LF Out Freq > 500 > Hz. 
3. Нажмите клавишу Return. Это возвращает вас в меню верхнего уровня LF Output. 

Конфигурирование низкочастотного выхода 
1. Нажмите клавиши LF Output Amplitude > 3 > V. 
 Это устанавливает амплитуду выходного НЧ сигнала на 3 В. 
2. Нажмите клавишу LF Out Off On. 

Рис. 4-4 показывает, что на выход LF OUT теперь подается сигнал, источником которого является 
генератор функций, генерирующий синусоидальный сигнал с амплитудой 3 В. 

 
Вспомогательный индикатор LF Out 

  
Конфигурация LF Out 

 Рис. 4-4 Отображение состояния LF Out 
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6 Применение импульсной модуляции (опция UNW или 320) 

Прежде чем приступать к изучению информации, изложенной в этой главе, вы должны освоить основные 
операции работы с генератором сигналов. Если вы недостаточно освоили такие функции, как установка 
уровня мощности или частоты, обращайтесь к главе 3 и ознакомьтесь с информацией, изложенной в этой 
главе. 
Глава 6 состоит из следующих разделов: 
6.1 Характеристики импульсной модуляции – стр. 63 
6.2 Основная процедура – стр. 65 
6.3 Пример – стр. 66 
6.4 Импульсные пакеты (опция 320 – требуется опция UNW) – стр. 66 

6.1 Характеристики импульсной модуляции 
      ПРИМЕЧАНИЕ        
При применении очень коротких импульсов с длительностью меньшей, чем это предусмотрено техничес-
кими характеристиками функции автоматической стабилизации мощности (ALC), или стабилизированных 
по амплитуде импульсов с необычайно большим коэффициентом заполнения рекомендуется отключить 
функцию ALC. 
 
Источник  
импульсов 

Тип Период * Длительность и задержка * Использует  
событие  

запуска ** 

Square Внутренняя несинхронизированная  
последовательность импульсов  
с коэффициентом заполнения 50% 

Определяется  
заданной  

пользователем  
частотой повторения 

– – 

Free Run  
(по умолчанию) 

Внутренняя несинхронизированная  
последовательность импульсов 

Определяется  
пользователем 

Определяется пользователем – 

Triggered Внутренняя последовательность  
импульсов 

– Определяется пользователем  

Adjustable  
Doublet 

Два внутренних импульсных пакета 
на каждое событие запуска 

– Определяется пользователем. 

Первый импульс генерируется  
относительно положительного  
фронта сигнала запуска. 

Второй импульс генерируется  
относительно положительного  
фронта первого импульса. 

См. рис. 6-2 на стр. 65. 

 

Trigger  
Doublet 

Два внутренних импульсных пакета 
на каждое событие запуска 

– Первый импульс следует за  
событием запуска. 

Второй импульс определяется  
пользователем. 

См. рис. 6-3 на стр. 65. 

 

Gated Импульсный пакет с внутренним  
стробированием 

– Определяется пользователем  

External Внешний импульсный сигнал  
на соединителе PULSE на задней  
панели 

– – – 

Pulse Train Внутренний импульсный пакет Определяется  
пользователем 

Определяется пользователем. 

См. рис. 6-4. 

 

* Все значения задержки, длительности импульсов и периода имеют разрешение 10 нс. 

** Все сигналы на соединителе PULSE на задней панели должны удерживаться в состоянии лог. 1 (высокий уровень) как минимум 
в течение 20 нс, чтобы запустить внутреннее генерирование импульсов. 

  



Глава 6: Применение импульсной модуляции (опция UNW или 320)  

Руководство по эксплуатации    66   N5171B, N5172B, N5181B, N5182В 
 

 
 
 Рис. 6-1 Функциональные клавиши Pulse 

Функциональные клавиши Pulse  
Period и Pulse Width недоступны,  
когда в качестве источника выбран  
вариант Pulse Train (импульсн. пакет). 
 

Эти функциональные клавиши доступны  
только тогда, когда источник импульсов  
(Pulse Source) установлен на Adjustable  
Doublet. 
 

Определяет реакцию генератора сигналов  
на внешний импульсный сигнал. 
Normal = лог. 1 (высокий уровень TTL) 
Invert = лог. 0  (низкий уровень TTL) 
 

См. также раздел 1.5 

 

Имеется у векторных  
генераторов с опцией BBG. 

 раздел 6.2 

 

 раздел 6.2 

 

 раздел 6.4 

 

Выбирает сигнал,  
направляемый на  
каждый выходной  
соединитель. 

 

Низкий уровень =  
установившееся состояние 
источника. 
Задержка от входа внешн. 
импульса до выхода  
сигнала синхронизации  
импульсной модуляции. 

Длит. Период 
50 нс > 50 нс 

20 нс  50 нс 
 

Для выяснения функций клавиш пользуйтесь 
встроенной справкой по клавишам, как описано в 
разделе 3.2. 
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Входные соединители на задней панели описаны в разделе 1.5. 
 
 Вход внешних импульсов 

 
 
 

 
Задержка второго импульса отсчитывается  
от переднего фронта первого импульса 

 
 Рис. 6-2 Регулируемый дублет (Adjustable Doublet) 
 
 

  
Задержка второго импульса отсчитывается  
от переднего фронта внешнего сигнала запуска 

 
 Рис. 6-3 Источник импульсов Trigger Doublet 

6.2 Основная процедура 
1. Выполните предустановку генератора сигналов. 
2. Установите частоту несущей (ВЧ). 
3. Установите амплитуду ВЧ сигнала. 
4. Сконфигурируйте модуляцию: 

а) Установите источник импульсов: нажмите клавиши Pulse > Pulse Source > выбор. 
б) Установите параметры для выбранного источника импульсов: 

Внешний запуск 

Выход RF OUT 

Задержка первого импульса отсчитывается  
от переднего фронта внешнего сигнала  
запуска 
 

Первый импульс следует  
за событием запуска 
 

Внешний запуск 

Выход RF OUT 
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Square Free Run  

(по умолчанию) 
Triggered Adjustable  

Doublet 
Trigger  
Doublet 

Gated Pulse Train * External 

Pulse Rate – – – – – – – 

– Pulse Period – – –  – – 

– Pulse Delay Pulse Delay Pulse Delay Pulse Delay – Pulse Delay – 

– Pulse Width Pulse Width Pulse Width Pulse Width Pulse Width – – 

– – – Pulse 2 Delay – – – – 

– – – Pulse 2 Width – – – – 

– – – – – – Pulse On ** – 

– – – – – – Pulse Off ** – 

* Требуется опция 320. 

** Пользователь может определить до 2047 импульсных циклов (элементов), составленных из состояний Pulse On и Pulse Off. 

5. Включите модуляцию: нажмите на On функциональную клавишу Pulse Off On. 
 Зажигается вспомогательный индикатор PULSE, указывающий на то, что вы задействовали модуляцию. 
6. Включите вывод модулированного сигнала с генератора сигналов: нажмите клавишу RF On Off. 

Зажигается индикаторный светодиод RF OUT, указывающий на то, что сигнал выводится с выходного 
соединителя RF OUT.  

См. также раздел 3.7. 

6.3 Пример 
В этом примере используется заводская предустановка источника импульсов и задержки. 
Выход:  
Сигнал несущей 2 ГГц, 0 дБм, модулированный импульсами длительностью 24 мкс с периодом 100 мкс. 
1. Выполните предустановку генератора сигналов. 
2. Установите частоту на 2 ГГц. 
3. Установите амплитуду на 0 дБм. 
4. Установите период повторения импульсов на 100 мкс: нажмите клавиши Pulse > Pulse Period > 100 > 

usec. 
5. Установите длительность импульсов на 24 мкс: нажмите клавиши Pulse > Pulse Width > 24 > usec. 
6. Включите импульсную модуляцию и выход ВЧ сигнала. 
 На дисплее появляется вспомогательный индикатор PULSE и зажигается индикаторный светодиод у 

соединителя RF OUT. 
Если вы сомневаетесь в правильности функционирования модуляции, обращайтесь к подразделу 14.3.3. 

6.4 Импульсные пакеты (опция 320 – требуется опция UNW) 
Опция 320 Pulse Train позволяет задействовать спецификацию до 2047 независимых импульсных циклов, 
каждый из которых имеет состояние "On Time", в течение которого измеряемой величиной является 
уровень мощности на соединителе RF OUT, и состояние "Off Time", в течение которого ослабляется 
выходной ВЧ сигнал. Каждый импульсный цикл аналогичен по своей функции импульсным режимам у 
других генераторов сигналов серии Х – функция Pulse Train имеет до 2047 циклов вместо двух циклов (с 
применением вариантов Doublet). Для каждого цикла можно задать также кратность повторения 
относительно общего количества 2047 циклов. 
Прибор может импортировать данные импульсных пакетов из файла формата .csv (значения, разделяемые 
запятой) или из другого файла распространенного формата ASCII. Можно также экспортировать файлы 
ASCII/CSV; при этом можно задать децимальный разделитель (чтобы можно было использовать запятую), 
однако разделитель столбцов определяется автоматически (см. рис. 6-4 и 6-6). 
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 Pulse > Pulse Source > More > Pulse Train 

 

  
 Рис. 6-4 Функциональные клавиши меню Pulse Train 
 
Субменю Train Trigger: 
 Вариант Free-Run непрерывно воспроизводит импульсный пакет, игнорируя все события запуска. 
 Вариант Triggered (ждущий запуск) запускает импульсный пакет (после ожидания задержки Pulse Delay) 

всякий раз при поступлении сигнала внешнего запуска на соединитель PULSE, при нажатии функцио-
нальной клавиши Trigger Immediately или при подаче команды запуска SCPI. 

 Вариант Gated генерирует импульсный пакет, пока на соединитель PULSE подается внешний сигнал 
запуска. Состояние запуска GATED обнаруживается только тогда, когда воспроизведение переходит в 
режим ожидания или находится в режиме ожидания. Это означает, что в случае запуска 
воспроизведения оно всегда завершается, даже если запуск GATE переключается в пассивное 
состояние. 

 
Команды SCPI: 

 
Обращайтесь также к Справочнику по командам SCPI (SCPI Command Reference). 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
  

 

Здесь индицируется Pulse Train (импульсный пакет)  
в качестве источника импульсной модуляции. 

 

Событие запуска вызывает незамедлительное  
однократное воспроизведение импульсного пакета. 
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Pulse > Pulse Source > More > Pulse Train > Edit Pulse Train 

Эти функциональные клавиши  
облегчают внесение изменений  
в установки параметров импульсного  
цикла в импульсном пакете. 

 
 
 Рис. 6-5 Функциональные клавиши меню редактирования импульсных пакетов 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
 
Команды SCPI Команды SCPI (продолжение) 

 

 
 
Обращайтесь также к Справочнику по командам SCPI (SCPI Command Reference). 
  

стр. 69 

стр. 70 

Этот столбец отображает кратность повторения  
каждого импульсного цикла (элемента)  
в импульсном пакете. 
 

Этот столбец  
отображает  
значения Off Time  
для каждого  
импульсного  
цикла (элемента)  
в имп. пакете. 
 

Этот столбец  
отображает  
значения On Time  
для каждого  
импульсного  
цикла (элемента)  
в имп. пакете. 
 

Этот столбец  
указывает строку  
в каждом цикле  
импульсного пакета  
(см. ниже   
Примечание). 

 

Примечание: Когда циклы (элементы повторяются, пропускается индикация номера строк  
с учетом кратности повторения импульсных циклов. 

Пример: В импульсном пакете, данные которого показаны выше, дважды повторяется  
импульсный цикл в строке 2 (2 мкс On Time и 2 мкс Off Time). Однако для этого импульсного  
цикла отображается только строка 2 (строка 3 пропущена). 
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 Рис. 6-6 Функциональные клавиши меню отображения импульсных пакетов 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

Эта функциональная клавиша  
изменяет временной сдвиг  
диаграммы от левой кромки экрана  
на заданное значение. Дискретность 
смещения вправо и влево равна  
1/20 от видимого импульсного  
пакета. 
 
Пользуйтесь этими клавишами для  
оптимизации отображения   
различных характеристик  
импульсного пакета. 
 

Это значение можно  
скорректировать с помощью  
функ. клавиши Time Offset. 

 

Это маркеры временного масштаба, которые сейчас установлены  
на 10 мкс/дел. для отображаемой в данный момент временной  
диаграммы. Для изменения временного масштаба пользуйтесь  
функциональными клавишами Zoom. 

 

2-й и 3-й  
имп. циклы  
(элементы)  

или  
строки 2 и 3 

 

 

5-й, 6-й и 7-й  
импульсные циклы  

(элементы)  
или строки 5, 6 и 7 

 
Четвертый  

импульсный  
цикл (элемент)  

или строка 4 

 

Последний импульсный цикл 
(элемент) в показанном выше  
импульсном пакете. Восьмой  
импульсный цикл или строка 8. 

 

Это начальный импульсный цикл  
(строка 1). Обратите внимание на то,  
что здесь не показана часть этого  
импульса "On Time" ввиду смещения  
на 2 мкс. 
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Pulse > Pulse Source > More > Pulse Train > Edit Pulse Train > More 

 
 
 Рис. 6-7 Импульсный пакет: функциональные клавиши импорта из выбранного файла 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

  Команды SCPI: 

  стр. 71 

При импорте файлов CSV/ASCII  
выбирает в качестве децимальной  
точки либо точку, либо запятую. 
Это значение остается   
перманентным во время циклов  
Preset/Recall и при выключении- 
включении питания. 

  стр. 71 

Эта структура файла данных использует десятичные  
дроби в числах, поэтому требует, чтобы параметр  
Import Decimal Separator был установлен на Dot (точка). 

 

Примечание: 
Прибор автоматически  
обнаруживает значения,  
разделяемые столбцами. 

 
После подтверждения импорта  
файла отображаются значения  
параметров импульсного пакета  
из нового файла. 

 

  подраздел 3.8.2 

 Эти функциональные клавиши  
удаляют отдельные элементы  
On Time и Off Time, а также 
значения кратности повторения  
Repeat. 
 
Удаление всех строк   
импульсных циклов требует  
подтверждения. 
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Pulse > Pulse Source > More > Pulse Train > Edit Pulse Train > More 

 
Примечание: Поскольку уже существует файл с именем PTRAIN.CSV, то имя нового файла должно быть другим  
во избежание перезаписи первоначального файла PTRAIN.CSV. 

 
 Рис. 6-8 Импульсный пакет: функциональные клавиши экспорта в файл 

      ПРИМЕЧАНИЕ        
Файлы можно переносить в директорию BIN (Binary) прибора. Для загрузки файлов в прибор можно 
пользоваться USB-накопителем (см. подраздел 3.8.4). 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
 

При экспорте файлов 
CSV/ASCII выбирает в каче-
стве децимальной точки либо 
точку, либо запятую. Это зна-
чение остается  перманентным 
во время циклов Preset/Recall и 
при выключении-включении 
питания. 

   Команды SCPI: 

При экспорте файлов CSV/ASCII 
выбирает в качестве разделителя  
столбцов табулятор, точку, либо 
запятую. Это значение остается  
перманентным во время циклов 
Preset/Recall и при выключении-
включении питания. 

 Команды SCPI: 

 стр. 70 

Меню функциональных клавиш  
Export to File записывает файл  
CSV/ASCII в директорию BINARY.  
Вы можете использовать свой  
собственный расширитель в  
качестве части имени файла. 

  Пример: 

 Команда SCPI: 

Пользуйтесь клавишами   
текстового редактора для  
переименования файла,  
подлежащего экспорту  
в директорию BIN (Binary). 
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7 Основные цифровые операции (без установленной опции BBG) 

Прежде чем приступать к изучению информации, изложенной в этой главе, вы должны освоить основные опе-
рации работы с генератором сигналов. Если вы недостаточно освоили такие функции, как установка уровня 
мощности или частоты, обращайтесь к главе 3 и ознакомьтесь с информацией, изложенной в этой главе. 

7.1 Синфазно-квадратурная (I/Q) модуляция 
Модуль вектора погрешности зависит от следующих факторов: 
 Различия в амплитуде, фазе и задержке между каналами I и Q 
 Смещение постоянной составляющей 
Меню I/Q обеспечивает элементы подстройки и калибровку для компенсации некоторых из этих различий 
между сигналами I и Q или для внесения искажений. За дополнительной информацией обращайтесь к 
разделу 8.10. См. также раздел 3.7. 
 

  

На этой панели отображается  
внешняя маршрутизация  
сигнала I/Q. 

На этой панели отображается текущее состояние и установки  
параметров подстройки I/Q. Серые надписи указывают,  
что элементы подстройки I/Q отключены. 

 
Переключает варианты калибровки: DC, User и Full IQ. 

DC: Калибруется смещение I/Q, усиление и квадратурная погрешность 
для одной частоты при текущих установках параметров генератора 
сигналов. 

Эта калибровка требует, чтобы была включена I/Q-модуляция, чтобы 
был установлен на RF Out оптимизированный тракт и чтобы источник 
был установлен на внутренний генератор модулирующих сигналов.  
Изменение какой-либо установки параметров прибора после 
выполнения калибровки DC аннулирует калибровку DC и вызывает 
возврат генератора сигналов к заводским данным калибровки. 

User: Калибруется смещение I/Q, усиление и квадратурная погреш-
ность для всех установок параметров генератора сигналов в заданном 
вами диапазоне частот. 

Full: Калибруется смещение I/Q, усиление и квадратурная погрешность 
для всех установок параметров генератора сигналов во всем 
диапазоне частот генератора сигналов.  

Запускает процедуру калибров-
ки для выбранного частотного 
диапазона. (Для выбора частот-
ного диапазона пользуйтесь кла-
вишей Calibration Type). Вы мо-
жете прервать калибровку путем 
нажатия функциональной клави-
ши Abort Cal или аппаратной 
клавиши Local Cancel/(Esc). 
Если прервать калибровку, то 
восстанавливаются данные 
предыдущей калибровки. 
Калибровку следует выполнять, 
когда температура окружающей 
среды изменится хотя бы на  
± 5°С от температуры, при кото-
рой выполнялась предыдущая 
калибровка. 

 
 Рис. 7-1 Дисплей и функциональные клавиши I/Q 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

 
Установка  

смещения DC 

 

Сдвигает фазу сигнала Q относительно  
фазы сигнала I.  
Квадратурная подстройка выражается  
в градусах.  
Эта подстройка не калибрована. 
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В следующей таблице перечислены обычно применяемые подстройки. 

Таблица 7-1 Обычно применяемые подстройки I/Q 

Подстройка I/Q Эффект Искажения 
Offset (смещение) Просачивание несущей Смещение постоянной составляющей 
Quadrature Angle  
(квадратурный угол) 

Погрешность EVM Фазовое рассогласование 
Карты состояний I/Q Задержка в тракте I/Q 

 

7.2 Конфигурирование входов на передней панели 
Генератор серии MXG/EXG принимает внешние сигналы I и Q для модуляции несущей через соединители 
на передней панели I Input и Q Input. 
1. Присоедините источник сигналов I и Q к соединителям на передней панели. Предельно допустимые 

уровни напряжения указаны в разделе 1.3. 
а) Подайте аналоговый сигнал I на вход I Input на передней панели генератора сигналов. 
б) Подайте аналоговый сигнал Q на вход Q Input на передней панели генератора сигналов. 

2. Включите I/Q-модулятор: нажмите клавишу I/Q Off/On на On. 
3. Сконфигурируйте выход ВЧ сигнала: 

а) Установите несущую частоту. 
б) Установите амплитуду несущей. 
в) Включите выход RF OUT. 

4. Выполните подстройку сигналов I/Q (если необходимо), как описано на предыдущей странице. 
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8 Основные цифровые операции (опция 653/655/656/657) 

Прежде чем приступать к изучению информации, изложенной в этой главе, вы должны освоить основные опе-
рации работы с генератором сигналов. Если вы недостаточно освоили такие функции, как установка уровня 
мощности или частоты, обращайтесь к главе 3 и ознакомьтесь с информацией, изложенной в этой главе. 
Здесь описаны функции, которые имеются только у векторных генераторов сигналов с опцией 653 или 655 
(N5172B) либо с опцией 656 или 657 (N5182B). 
Глава 8 состоит из следующих разделов: 
8.1 Файлы модулирующих сигналов  – стр. 75 
8.2 Сохранение, загрузка и воспроизведение сегмента модулирующего сигнала  – стр. 77 
8.3 Последовательности модулирующих сигналов – стр. 79 
8.4 Сохранение в памяти заголовков файлов модулирующих сигналов – стр. 82 
8.5 Применение маркеров модулирующего сигнала – стр. 87 
8.6 Запуск модулирующих сигналов – стр. 99 
8.7 Амплитудное ограничение модулирующих сигналов – стр.104 
8.8 Масштабирование модулирующих сигналов – стр. 110 
8.9 Установка смещения полосы частот модулирующих сигналов – стр. 115 
8.10 Синфазно-квадратурная (I/Q) модуляция – стр. 118 
8.11 Настройка I/Q-модуляции – стр.122 
8.12 Калибровка I/Q – стр. 124 
8.13 Применение корректирующего фильтра (Equalization Filter) – стр. 125 
8.14 Применение фильтров с конечной импульсной характеристикой (FIR) в фильтре модуляции Dual ARB 

в реальном времени – стр. 127 
8.15 Изменение параметров фильтра FIR с помощью табличного редактора FIR – стр. 132 
8.16 Установка параметров фильтра модуляции в реальном времени – стр. 134 
8.17 Синхронизация нескольких генераторов модулирующих сигналов – стр. 135 
8.18 Применение опции 012 (вход-выход гетеродина для фазовой когерентности) с синхронизацией 

нескольких генераторов модулирующих сигналов – стр. 141 
8.19 Приложения для создания сигналов в реальном времени – стр. 144 
8.20 Лицензирование модулирующих сигналов – стр. 145 
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8.1 Файлы модулирующих сигналов 
Существует два типа файлов модулирующих сигналов – сегменты и последовательности.  
 Сегмент – это файл модулирующего сигнала, который вы загружаете в генератор сигналов. 
 За информацией по созданию и загрузке файлов модулирующих сигналов обращайтесь к Руководству 

по программированию (Programming Guide). 
 Последовательность – это файл, который вы создаете в генераторе сигналов, который содержит 

указатели на один или несколько файлов сигналов (сегменты, другие последовательности или и то, и 
другое). 

За информацией о создании последовательностей обращайтесь к разделу 8.3. 

8.1.1 Память генератора сигналов 
Генератор сигналов имеет память двух типов: 
 Энергозависимая (временная) память генератора модулирующих сигналов (BBG), откуда воспроизводят 

и редактируют файлы модулирующих сигналов. 
 Энергонезависимая (долговременная) память; это либо внутренняя память (Int), либо внешний USB-

накопитель, где сохраняются файлы модулирующих сигналов. 

8.1.2 Сдвоенный проигрыватель сигналов произвольной формы (Dual ARB Player) 
      ПРИМЕЧАНИЕ        
Размер кэш-памяти файлов модулирующих сигналов произвольной формы (ARB) у генераторов сигналов 
MXG/EXG ограничен до 128 файлов. Поэтому как только будет достигнут предел кэш-памяти, значительно 
замедляется скорость переключения сигналов для дополнительных файлов, загружаемых в энергозависи-
мую память модулирующих сигналов (BBG). 
Сдвоенный проигрыватель сигналов произвольной формы позволяет вам воспроизводить (проигрывать), 
переименовывать, удалять, заносить в память и загружать (из внешнего или внутреннего накопителя) 
файлы модулирующих сигналов, а также формировать последовательности сигналов. Сдвоенный 
проигрыватель сигналов произвольной формы обеспечивает также функции маркеров (раздел 8.5), запуска 
(раздел 8.6) и масштабирования (раздел 8.8). 
Большая часть описанных в этом разделе процедур начинается с меню Dual ARB, которое показано на 
следующей странице. 
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 Рис. 8-1 Функциональные клавиши сдвоенного проигрывателя сигналов произвольной формы 

Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

Примечание:  
Это второе из двух  
меню ARB. 

 

Имеется у векторных  
генераторов с опцией 2хх. 

 

Эти функциональные  
клавиши доступны  
только в меню Arb Setup. 
 

 

Если вы установите тактовую частоту выборок  
ARB. когда выключен проигрыватель ARB, то  
новая установка применяется при включении  
сдвоенного проигрывателя ARB. Эта установка  
выдерживает включение и выключение  
сдвоенного проигрывателя ARB. 
 
 

  раздел 8.8 

 раздел 8.8 

  раздел 8.9 

 подраздел 8.9.1 

 раздел 8.17 

 раздел 8.17 

 раздел 8.2 

 раздел 8.6 

 раздел 8.3 

 раздел 8.4 

 раздел 8.20 

 раздел 8.5 

 подраздел  
 3.6.1 

 раздел 8.7 

 раздел 8.8 

 раздел 8.7 



Глава 8: Основные цифровые операции (опция 653/655/656/657)  

Руководство по эксплуатации    79   N5171B, N5172B, N5181B, N5182В 
 

8.2 Сохранение, загрузка и воспроизведение сегмента  
модулирующего сигнала 

      ПРИМЕЧАНИЕ        
Размер кэш-памяти файлов модулирующих сигналов произвольной формы (ARB) у генераторов сигналов 
MXG/EXG ограничен до 128 файлов. Поэтому как только будет достигнут предел кэш-памяти, значительно 
замедляется скорость переключения сигналов для дополнительных файлов, загружаемых в энергозависи-
мую память модулирующих сигналов (BBG). 
Прежде чем изучать эту информацию, вы должны ознакомиться с системой меню генератора сигналов. 
Если вы недостаточно владеете этой темой, обращайтесь к разделу 3.8 и ознакомьтесь с изложенной там 
информацией. См. также раздел 8.3. 
Генератор сигналов имеет память двух типов: энергонезависимая память (внутренняя или USB) и 
энергозависимая память (BBG), которая называется также рабочей памятью, поскольку для того, чтобы вы 
могли воспроизводить, редактировать или включать файл модулирующего сигнала в последовательность, 
необходимо загрузить его в память BBG. 
 

 
 Рис. 8-2 Функциональные клавиши сегментов модулирующего сигнала 

8.2.1 Загрузка сегмента модулирующего сигнала в память BBG 
Прежде чем можно будет воспроизводить, редактировать или включать файл модулирующего сигнала в 
последовательность, необходимо загрузить его в память BBG. Выключение-включение питания или 
перезагрузка генератора сигналов приводит к удалению файлов из памяти BBG. 

      ПРИМЕЧАНИЕ        
Всякий раз при включении прибора в памяти BBG автоматически создаются две поставляемые с завода 
последовательности: RAM_TEST_WFM и SINE_TEST_WFM. 
Во внутренней памяти имеются дополнительные образцы модулирующих сигналов, которые можно 
загрузить в рабочую память. Обращайтесь на сайт www.agilent.com и поищите информацию по ключевым 
словам "Factory Default N5182B" и "waveforms". 
1. Нажмите клавиши Mode > Dual ARB > Select Waveforms > Waveform Segments. 
2. Нажмите функциональную клавишу Load Store, чтобы выделить Store, затем выделите нужный сегмент 

сигнала с помощью клавиш со стрелками. 
3. Если в выбранном в данный момент устройстве памяти уже есть копия этого сегмента, и вы не хотите 

перезаписывать его, переименуйте сегмент сигнала, прежде чем загружать его (см. описание 
следующей процедуры). 

раздел 8.5 
 Примечание: Когда выбрана последовательность,   
 наименование этой клавиши меняется на  
 Show Waveform Sequence Contents. 

Эти клавиши изменяются для указания принятого по умолчанию устройства  
памяти. За информацией о выборе принятого по умолчанию устройства  
памяти обращайтесь к подразделу 3.8.7. 

Пользуйтесь клавишами со стрелками или поворотной  
ручкой, чтобы выделить букву или символ 

 

Для выяснения функций клавиш пользуйтесь  
встроенной справкой по клавишам, как описано  
в разделе 3.2. 

 

http://www.agilent.com/
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4. Нажмите функциональную клавишу Load Segment From выбранный в данный момент накопитель Me-
dia. 

 Чтобы загрузить все файлы из выбранного в данный момент накопителя (Media) в память BBG, нажмите 
функциональную клавишу Load All From выбранный в данный момент накопитель Media. 

8.2.2 Сохранение и переименование сегмента сигнала на внутреннем накопителе 
или USB-накопителе 

Действуйте, как описано ниже, чтобы сохранить копию файла, находящегося в памяти BBG, на выбранный в 
данный момент накопитель (см. подраздел 3.8.7). Если вы не загрузили сегмент сигнала, обращайтесь к 
Руководству по программированию (Programming Guide) или воспользуйтесь одним из загруженных на 
заводе сегментов. 
1. Нажмите клавиши Mode > Dual ARB > Select Waveform > Waveform Segments. 
2. Нажмите клавишу Load Store, чтобы выделить Store. 
3. С помощью клавиш со стрелками выделите сегмент, который вы хотите сохранить. 
4. При необходимости переименуйте сегмент. 
 Если в выбранном в данный момент устройстве памяти уже есть копия этого сегмента, и вы не хотите 

перезаписывать его, переименуйте сегмент сигнала, прежде чем сохранять: 
а) Нажмите клавиши More > Rename Segment > Clear Text. 
б) Введите имя для сегмента модулирующего сигнала. 
в) Нажмите клавиши Enter > More. 
г) Выделите сегмент сигнала, который был переименован. 

5. Нажмите функциональную клавишу Store Segment to выбранный в данный момент накопитель Media. 
6. Повторите операции по пунктам 3 – 5 для всех сегментов, которые вы хотите сохранить. 
 Чтобы сохранить все сегменты из памяти BBG на выбранном в данный момент накопителе, нажмите 

функциональную клавишу Store All to выбранный в данный момент накопитель Media. 

8.2.3 Воспроизведение сегмента модулирующего сигнала 
1. Нажмите клавиши Mode > Dual ARB > Select Waveform. 
2. В столбце Segment on BBG Media выделите сегмент модулирующего сигнала, который вы хотите 

воспроизводить (проигрывать). 
3. Нажмите функциональную клавишу Select Waveform. 
4. Установите ARB Off On на On. 

Теперь воспроизводится выбранный сегмент модулирующего сигнала. Светятся вспомогательные инди-
каторы I/Q и ARB, а несущая модулируется выбранным вами сигналом. 

Вспомогательные индикаторы с активным модулирующим сигналом (ARB On)   

  

5. Сконфигурируйте выход ВЧ сигнала. Установите частоту и амплитуду несущей; включите выход RF OUT. 
Теперь сегмент сигнала выводится на выходной соединитель генератора. 

Текущий выбор сигнала 
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8.3 Последовательности модулирующих сигналов 
 Имя последовательности 

 
 Рис. 8-3 Функциональные клавиши последовательностей модулирующих сигналов 
 
Последовательность сигналов – это файл, который содержит указатели на один или несколько сегментов 
сигналов либо на другие последовательности сигналов или на то и другое. Это позволяет генератору 
сигналов воспроизводить (проигрывать) несколько сегментов или другие последовательности, или то и 
другое, устраняя таким образом необходимость приостанавливать воспроизведение просто для выбора 
другого сигнала. 
Сегменты, на которые указывает последовательность сигналов, не сохраняются автоматически, когда вы 
сохраняете последовательность; вы должны также сохранить в памяти отдельные сегменты, иначе они 
будут утрачены при выключении или перезагрузке генератора сигналов. Если сегменты находятся на 
внутреннем или внешнем накопителе, то вы должны загрузить их в память BBG, прежде чем выбирать 
последовательность сигналов (см. подраздел 8.2.1). Если вы попытаетесь воспроизвести 
последовательность без сегментов, загруженных в память BBG, то появится сообщение об ошибке: 
ERROR: 629, File format invalid. В таком случае, если сегменты не хранятся на внутреннем или 
внешнем накопителе, то прежде чем вы сможете воспроизводить последовательность, вы должны 
восстановить сегменты, используя те же самые имена файлов, на которые указывает последовательность. 

8.3.1 Создание последовательности 
Последовательность модулирующих сигналов может содержать до 1024 сегментов, а также включать в 
себя сегменты и другие последовательности (вложенные последовательности). Генератор сигналов 
позволяет вам установить кратность повторения сегментов и вложенных последовательностей во время 
воспроизведения. Однако существует различие между повторением сегмента и повторением вложенной 
последовательности. Каждый сегмент может повторяться до 65535 раз, однако вне зависимости от 
кратности его повторения он считается одним сегментом. Напротив, каждое повторение вложенной 
последовательности считается как дополнительные сегменты. 
  

Чтобы появилась эта функциональная клавиша, выберите последовательность сигналов 

Содержание последовательности 

см. подраздел 8.5.9 

Для выяснения функций клавиш пользуйтесь  
встроенной справкой по клавишам, как описано  
в разделе 3.2. 
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Максимально возможная кратность повторения вложенной последовательности зависит от количества 
сегментов во вложенной последовательности и оставшегося количества сегментов из общего количества 
1024. Например, в последовательности, которая содержит 24 сегмента и одну вложенную последователь-
ность с четырьмя сегментами, максимально возможная кратность повторения вложенной последователь-
ности составляет 250 раз: 
 24 + (4  250) = 1024 максимальное количество сегментов в последовательности 
Даже несмотря на ограничение кратности повторения вложенной последовательности, каждый сегмент 
внутри вложенной последовательности может повторяться до 65535 раз. 

Пример 
Следуйте описанной ниже процедуре, чтобы создать и сохранить в памяти последовательность сигналов, 
используя одно повторение каждого из двух разных сегментов. 
Предположение: Сегменты сигнала находятся во временной памяти BBG. Обращайтесь к подразделу 8.2.1, 
где описано, как загружать сегменты сигнала в память BBG. 
1. Выберите первый сегмент: 

а) Нажмите клавиши Mode > Dual ARB > More > Waveform Sequences > Build New Waveform Se-
quence > Insert Waveform. 

б) Выделите нужный сегмент сигнала и нажмите клавишу Insert. 
2. Выберите второй сегмент: 

а) Выделите следующий интересующий вас сегмент сигнала и нажмите клавишу Insert. 
б) Нажмите клавишу Done Inserting. 

3. Присвойте имя последовательности сигналов и сохраните ее в каталоге файлов Seq: 
а) Нажмите клавиши More > Name and Store. 
б) Введите имя файла и нажмите клавишу Enter. 

См. также подразделы 8.3.2 и 8.5.5. 

8.3.2 Просмотр содержания последовательности 
Просмотреть содержание последовательности сигналов можно двумя способами: 
 Через функциональную клавишу Waveform Sequences 

1. Нажмите клавиши Mode > Dual ARB > More > Waveform Sequences. 
2. Выделите интересующую вас последовательность. 
3. Нажмите клавишу Show Waveform Sequence Contents. 

 С помощью функциональной клавиши Select Waveform 
1. Нажмите клавиши Mode > Dual ARB > Select Waveform. 
2. В столбце Sequence On выделите интересующую вас последовательность сигналов. 
3. Нажмите клавишу Show Waveform Sequence Contents. 

Последовательность А 

Последовательность В 

 Сегмент 1 

 Сегмент 2 

 Сегмент 3 

 
Последовательность А 

повторяется 4 раза 
 8 сегментов 

 2 сегмента 

 9 сегментов 

 11 сегментов 

Последовательность  
сигналов 
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8.3.3 Редактирование последовательности 
При редактировании последовательности вы можете: 
 изменять кратность повторения каждого сегмента или вложенной последовательности при 

воспроизведении; 
 удалять из последовательности сегменты или вложенные последовательности; 
 добавлять в последовательность сегменты или вложенные последовательности; 
 включать и выключать маркеры (см. подраздел 8.5.9); 
 сохранять изменения либо в текущей последовательности сигналов, либо в качестве новой 

последовательности. 
Внесенные вами изменения теряются, если вы выйдете из меню редактирования последовательности, не 
сохранив изменения. 
Последовательности сохраняются в каталоге файлов Seq. 

  ПРЕДОСТЕРЕЖЕНИЕ    
Если вы редактируете и сохраняете заново сегмент, который используется в последовательности, то 
последовательность не обновляет автоматически значение RMS в ее заголовке. Вы должны выбрать и 
обновить информацию в заголовке последовательности (см. раздел 8.4). 
Следуйте описанной ниже процедуре, чтобы отредактировать последовательность, содержащую два 
разных сегмента, чтобы первый сегмент повторялся 100 раз, а второй – 200 раз, затем сохранить 
изменения. 
Предположение: Последовательность сигналов содержит два сегмента, которые созданы и сохранены в 
памяти (см. стр. 80). 
1. Выберите последовательность:  

Нажмите клавиши Mode > Dual ARB > More > Waveform Sequences > выделите нужную последова-
тельность > Edit Selected Waveform Sequence. 

2. Измените первый сегмент так, чтобы он повторялся 100 раз: 
Выделите пункт первого сегмента и нажмите клавиши Edit Repetitions > 100 > Enter. 

 Курсор перемещается на следующий пункт. 
3. Измените кратность повторения для выбранного пункта на 200:  

Нажмите клавиши Edit Repetitions > 200 > Enter. 
4. Сохраните в памяти внесенные вами изменения:  

Нажмите клавиши More > Name and Store > Enter. 
Чтобы сохранить изменения в качестве новой последовательности: 
а) Нажмите клавиши More > Name and Store > Clear Text. 
б) Введите имя файла (например, SINE100+RAMP200). 
в) Нажмите клавишу Enter. 
Отредактированная последовательность сохраняется как новая последовательность сигналов. 

8.3.4 Воспроизведение последовательности 
Если вы еще не создали последовательность сигналов, обращайтесь к подразделу 8.3.1. 

      ПРИМЕЧАНИЕ        
Чтобы можно было воспроизводить (проигрывать) сегмент сигнала индивидуально или в качестве части 
последовательности сигналов, необходимо, чтобы этот сегмент находился в памяти BBG. См. также 
подраздел 8.2.1. 
1. Выберите последовательность сигналов: 

а) Нажмите клавиши Mode > Dual ARB > Select Waveform. 
б) В столбце Sequence On выделите последовательность сигналов  

(в этом примере SINE100+RAMP200). 
в) Нажмите клавишу Select Waveform. 
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На дисплее индицируется выбранный в данный момент сигнал  
(например, Selected Waveform: SEQ:SINE100+RAMP200): 

 

Вспомогательные индикаторы с активным модулирующим сигналом (ARB On)   

  

2. Включите генерирование  модулирующих сигналов. Для этого нажмите клавишу ARB Off On на On. 
Воспроизводится выбранная последовательность модулирующих сигналов. Во время генерирования 
последовательности сигналов отображаются вспомогательные индикаторы ARB и I/Q, а несущая 
модулируется выбранным вами сигналом. 

3. Сконфигурируйте выход ВЧ сигнала:  
а) Установите частоту несущей. 
б) Установите амплитуду выходного ВЧ сигнала. 
в) Включите выход RF OUT.  

Теперь последовательность сигналов выводится на выходной соединитель генератора. 

8.4 Сохранение в памяти заголовков файлов модулирующих сигналов 
В этом разделе описано, как редактировать и сохранять в памяти заголовок (header) файла. Когда вы 
загружаете только файл модулирующего сигнала (данные I/Q, которые генератор сигналов обрабатывает 
как сегмент сигнала), автоматически генерируется заголовок файла и файл маркеров с тем же именем, что 
и файл модулирующего сигнала. Первоначально заголовок файла не содержит заносимых в него установок 
параметров генератора сигналов, а файл маркеров содержит одни нули. Для данного сигнала вы можете 
записать настройки и параметры генератора сигналов в заголовок его файла, а установки параметров 
маркеров – в его файл маркеров (раздел 8.5); когда вы загружаете сохраненный файл сигнала а память 
BBG, установки параметров в заголовке файла и файле маркеров автоматически применяются к 
генератору сигналов, чтобы сдвоенный проигрыватель ARB настраивался таким же образом всякий раз при 
воспроизведении файла сигнала. 

 
 Рис. 8-4 Функциональные клавиши Header Utilities 

Текущий выбор сигнала 

 

 подраздел 8.4.1 
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Когда вы создаете последовательность модулирующих сигналов (как описано в подразделе 8.3.1), 
генератор сигналов автоматически создает заголовок последовательности сигналов, который имеет 
приоритет перед заголовками отдельных сегментов сигналов. Во время воспроизведения (проигрывания) 
последовательности сигналов игнорируются заголовки сегментов; проверяется лишь, установлены ли все 
необходимые опции. Сохранение в памяти последовательности сигналов сохраняет также заголовок ее 
файла. 
Некоторые из текущих установок параметров генератора сигналов, которые отображаются в заголовке 
файла, появляются как часть наименований функциональных клавиш, а другие появляются на сводном 
дисплее сдвоенного проигрывателя ARB, как показано на следующем примере. 
 
 
 

 
 Сводка ARB, установки заголовка файла 

 
 

раздел 8.9 
 

Все установки параметров в этом меню можно сохранить  
в заголовке файла  
(в таблице 8.1 перечислены все установки параметров,  
которые сохраняются в заголовке файла). 

 

 
Наименование  
функциональной клавиши, 
установка заголовка файла 
 
 
 
 
 
Функциональная клавиша  
Runtime Scaling доступна  
только под меню Dual ARB. 
 
 
 
 
Наименования  
функциональных клавиш,  
установки заголовка файла 
 

 
Таблица 8-1 Элементы заголовка файла 

Описание  
(Description)  
из 32 символов 

Описание, введенное для заголовка, например, функция модулирующего сигнала. 
Его редактируют и сохраняют с помощью функциональной клавиши Edit Descrip-
tion (см. рис. 8-4). 

Sample Rate Частота выборок при воспроизведении. Это частота синхронизации выборок ARB, 
установленная в меню Arb Setup (см. рис. 8-1 на стр. 76). 

Runtime Scaling Значение масштабирования модулирующего сигнала в реальном времени. Это 
значение применяется во время воспроизведения модулирующего сигнала в 
реальном масштабе времени. Эту установку можно изменить только для файлов, 
которые воспроизводятся в режиме Dual ARB Player. 

RMS Когда параметр Modulator Atten. установлен на Auto (см. стр. 76), это значение 
используется для вычисления установки ослабления I/Q-модулятора для 
оптимизации значения ACPR (относительной мощности в соседнем канале). 
Диапазон значений: 0 ÷ 1,414213562. 

Marker 1 – 4 Polarity Полярность маркеров может быть положительной или отрицательной – см. 
подраздел 8.5.8. 



Глава 8: Основные цифровые операции (опция 653/655/656/657)  

Руководство по эксплуатации    86   N5171B, N5172B, N5181B, N5182В 
 

Таблица 8-1 Элементы заголовка файла (продолжение) 

ALC Hold Routing Маркер, который реализует функцию блокировки ALC (см. подраздел 8.5.1), 
которая удерживает автоматическую стабилизацию мощности (ALC) на ее текущем 
уровне, когда сигнал маркера находится в состоянии лог. 0 (низкий уровень). Все 
сигналы, генерируемые генератором сигналов, имеют маркер в первой точке 
выборки. Чтобы посмотреть результаты из трех вариантов выбора маршрутизации, 
вы должны выбрать диапазон точек выборок (маркеров) – см. подраздел 8.5.5. 

RF Blank Routing Маркер, который реализует функцию подавления выходного ВЧ сигнала (см. 
подраздел 8.5.7), когда сигнал маркера находится в состоянии лог. 0 (низкий 
уровень). Функция подавления выходного ВЧ сигнала использует также блокировку 
ALC. Здесь нет необходимости выбирать функцию ALC Hold Routing для того же 
самого маркера, когда вы применяете функцию RF Blank Routing. Подавление 
выходного ВЧ сигнала прекращается, когда сигнал маркера переключается в 
состояние лог. 1. 

Mod Attenuation Установка ослабления I/Q-модулятора (устанавливается в меню Arb Setup, 
которое показано на рис. 8-1 на стр. 76). 

BB Freq Offset Смещение полосы частот модулирующих сигналов, выраженное в герцах  
(см. раздел 8.9). 

AWGN: State Указывает, включено ли (1) или выключено (0) подмешивание шума в реальном 
времени (глава 9). 

AWGN: C/N Ratio Отношение уровня несущей к шуму, выраженное в децибелах (глава 9). 
AWGN: Carrier BW Ширина полосы частот (в герцах), в пределах которой интегрируется шумовая 

мощность (глава 9). 
AWGN: Noise BW Ширина полосы частот шума, выраженная в герцах (глава 9). 
AWGN: Carrier RMS Среднеквадратическое значение уровня несущей в полосе частот несущей (гл. 9). 
Phase Noise State Указывает, включен ли (1) или выключен (0) фазовый шум (глава 10). 
Phase Noise F1 Начальная частота для плоской среднечастотной характеристики (глава 10). 
Phase Noise F2 Конечная частота для плоской среднечастотной характеристики (глава 10). 
Phase Noise Lmid Амплитуда для плоской среднечастотной характеристики (глава 10). 
Modulation Filter Выбранный тип фильтра модуляции в реальном времени (раздел 8.16). 
Over-Range Protect Указывает, включена ли (1) или выключена (0) защита ЦАП от перегрузки  

(глава 10). 
Unique Waveform Id Индивидуальный идентификатор (Id) модулирующего сигнала.  

0 = нет Id; когда назначен Id, его невозможно изменить. 
License Required Указывает, требуется ли лицензия для воспроизведения сигнала  

(см. также подраздел 2.4.1). 
Can be Read Out Указывает, может ли сигнал запрашиваться через SCPI или FTP. 

8.4.1 Просмотр и изменение информации заголовка 
В этом примере используется поставляемый с завода файл модулирующего сигнала RAMP_TEST_WFM. 

1. Выберите сигнал RAMP_TEST_WFM из памяти BBG: 
а) Нажмите клавиши Mode > Dual ARB > Select Waveform. 
б) В столбце Segment On выделите сигнал RAMP_TEST_WFM. 
в) Нажмите клавишу Select Waveform. 

2. Откройте меню Header Utilities: нажмите клавиши More > Header Utilities. 
 На рис. 8-5 показан принятый по умолчанию заголовок файла RAMP_TEST_WFM, который поставляется 

с завода. В столбце Header Field перечислены параметры заголовка файла; чтобы посмотреть все 
эти параметры, нажимайте клавишу Page Down. 
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Столбец Saved Header Settings показывает, что не задана (Unspecified) большая часть этих 
параметров, т.е. в память не занесены установки этих конкретных параметров. 
В столбце Current Inst. Settings показаны текущие установки параметров генератора сигналов. 
В данном примере это те установки, которые вы сохраните в заголовке файла. 

      ПРИМЕЧАНИЕ        
Если какая-то установка не задана в заголовке файла, то генератор сигналов использует текущее значение 
этой установки, когда вы выбираете и воспроизводите модулирующий сигнал. 
 
Mode > Dual ARB > More > Header Utilities Имя файла модулирующего сигнала 

 
 
 
 
 
 Рис. 8-5 Пример заголовка файла 
 
3. Сохраните в файле заголовка информацию в столбце Current Inst. Settings: 

Нажмите клавишу Save Setup To Header. 
Теперь в столбцах Saved Header Settings и Current Inst. Settings отображаются 
одинаковые значения; в столбце Saved Header Settings перечисляются установки параметров, 
сохраненные в заголовке файла. 

4. Редактирование и обновление установок параметров: 
а) Вернитесь в меню ARB Setup: 

Нажмите клавиши Return > More > ARB Setup. 
 Из этого меню вы можете обращаться к некоторым установкам параметров генератора сигналов, 

которые сохранены в заголовке файла. Функциональные клавиши, применяемые на следующих 
этапах, показаны на рис. 8-1 (стр. 76). 

б) Установите тактовую частоту выборок ARB на 5 МГц: 
Нажмите клавиши ARB Sample Clock > 5 > MHz. 

в) Установите масштабирование сигнала в реальном времени на 60%: 
Нажмите клавиши Waveform Runtime Scaling > 60 > %. 

г) Вернитесь в меню Header Utilities: 
Нажмите клавиши Return > More > Header Utilities. 
Как показано на следующем рисунке, столбец Current Inst. Settings отображает изменения в 
настройке генератора сигналов, однако сохраненные (Saved) значения заголовка не изменились. 

  

Описание может содержать  
до 32 символов 
 

Открывает меню для ручной  
установки значения RMS,  
необходимого для вычисления 
значения AWGN: Carrier RMS в 
столбце Header Field. 

Восстанавливает принятые  
по умолчанию установки  
параметров заголовка. 

 

Принятые по умолчанию установки заголовка  Текущие установки параметров  
генератора сигналов 

  Чтобы вычислить среднеквадратическое значение (RMS) напряжения сигнала:  
Нажмите клавишу Calculate. 

Затем обращайтесь к данным в столбце Header Field. 

Примечание: Если сигнал содержит пологие фронты, смещение постоянной составляющей 
или шум*, уже подмешанный к сигналу (у пакетного сигнала), то для достижения наилучшей 
точности измерений рекомендуется пользоваться функциональными клавишами Edit RMS и 
Edit AWGN RMS Override. 

* Опция 403 (AWGN в реальном времени) не влияет на значение Header Field RMS. Однако 
шум, подмешанный к сигналу до загрузки файла сигнала и воспроизведения в генераторе 
сигналов не влияет на значение Header Field RMS. 
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д) Сохраните текущие установки параметров в заголовке файла: 
Нажмите функциональную клавишу Save Setup To Header. 
Теперь установки параметров из столбца Current Inst. Settings отображаются в столбце 
Saved Header Settings. Это сохраняет новые текущие установки параметров прибора в 
заголовке файла. 

Если вы измените установку какого-либо параметра генератора сигналов из перечисленных в заголовке 
файла после того, как выберите файл модулирующего сигнала, то изменившееся значение появится в 
столбце заголовка файла Current Inst. Settings и будет использоваться вместо занесенных в 
память установок заголовка. Чтобы вернуться к сохраненным установкам заголовка, выберите заново 
сигнал для воспроизведения. 

8.4.2 Просмотр и редактирование заголовка без выбора модулирующего сигнала 
Как описано выше в подразделе 8.4.1, вы можете просматривать и редактировать информацию заголовка 
после выбора сигнала. Однако вы можете также редактировать информацию заголовка, не выбирая сигнал, 
или для другого сигнала (не того, который выбран в данный момент). 
1. Обратитесь к меню Header Utilities: 

Нажмите клавиши Mode > Dual ARB > More > Header Utilities > More > Select Different Waveform. 
На экране отображается алфавитный список файлов модулирующих сигналов на выбранном ранее 
накопителе. На следующем рисунке показан пример отображения поставляемых с завода файлов 
сигналов, находящихся в памяти BBG. 
 

  Активный каталог Активный накопитель (память) 

 

Различные значения  
в двух столбцах 
 

Активный  
каталог сигналов 
 

Файлы в памяти BBG 

Тип 
WFM1 = сегмент во временной памяти 
NVWFM = сегмент в энергонезависимой памяти 
SEQ = последовательность 
 

Для выяснения функций клавиш  пользуйтесь встроенной справкой  
по клавишам, как описано  в разделе 3.2. 
 

Каталоги, которые  
позволяют просматривать  
файлы на активном  
накопителе. 
Как выбрать активный  
накопитель, описано  
на стр. 47. 
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2. Если на экране не отображается интересующий вас каталог, выберите его. 
3. Выделите нужный файл модулирующего сигнала и нажмите функциональную клавишу Select Header. 
 На экране появляется заголовок для выбранного файла модулирующего сигнала. 
4. Чтобы отредактировать заголовок, нажмите функциональную клавишу More и действуйте, как описано в 

пункте 4 процедуры редактирования (стр. 85). 

8.5 Применение маркеров модулирующего сигнала 
Генератор сигналов обеспечивает четыре маркера модулирующего сигнала для маркировки определенных 
точек в сегменте модулирующего сигнала. Когда генератор сигналов встречает задействованный маркер, 
вспомогательный выходной сигнал выводится на соединитель на задней панели, который соответствует 
номеру маркера:  
 Сигнал Event 1 (событие 1) выводится на соединитель BNC "EVENT 1" (см. стр. 19) и на контактный 

вывод соединителя AUXILIARY I/O (см. стр. 20). 
 Сигнал Event 2 выводится на соединители TRIG 1 и TRIG 2 (см. стр. 17) и на контактный вывод 

соединителя AUXILIARY I/O (см. стр. 20). 
 Сигналы Event 3 и Event 4 выводятся на контактные выводы соединителя AUXILIARY I/O (см. стр. 20). 
Вы можете использовать вспомогательный выходной сигнал для синхронизации другого прибора с 
модулирующим сигналом или в качестве сигнала запуска измерения в заданной точке модулирующего 
сигнала. 
Вы можете также сконфигурировать маркеры на инициирование блокировки автоматической стабилизации 
мощности (ALC Hold) или для подавления выходного ВЧ сигнала (RF Blanking), что включает в себя 
функцию ALC Hold. 
Когда вы загружаете файл модулирующего сигнала, у которого нет связанного с ним файла маркеров, 
генератор сигналов создает файл маркеров без точек маркеров. Сегменты, поставляемые с завода 
(RAMP_TEST_WFM и SINE_TEST_WFM), имеют точку маркеров на первой выборке для всех четырех 
маркеров. 
Следующие процедуры демонстрируют, как пользоваться маркерами в режиме Dual ARB Player. В этих 
процедурах рассматривается два типа точек – точка маркера и точка выборки. Точка маркера – это точка, 
в которой данный маркер устанавливается на модулирующий сигнал; вы можете установить одну или 
несколько точек для каждого маркера. Точка выборки – это одна из множества точек, которые образуют 
форму модулирующего сигнала. 
Существует три основных этапа в применении маркеров модулирующего сигнала: 
1) Удаление точек маркеров из сегмента модулирующего сигнала – подраздел 8.5.4 
2) Установка точек маркеров в сегменте модулирующего сигнала – подраздел 8.5.5 
3) Управление маркерами в последовательности модулирующих сигналов – подраздел 8.5.9 
В этом разделе изложена также следующая информация: 
 Концепция маркеров модулирующего сигнала – подраздел 8.5.1 
 Обращение к утилитам маркеров – подраздел 8.5.2 
 Просмотр маркеров сегментов модулирующего сигнала – подраздел 8.5.3 
 Наблюдение импульса маркера – подраздел 8.5.6 
 Применение функции маркера RF Blanking (подавление выходного ВЧ сигнала) – подраздел 8.5.7 
 Установка полярности маркеров – подраздел 8.5.8 
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8.5.1 Концепция маркеров модулирующего сигнала 
Форматы ARB генератора сигналов обеспечивают четыре маркера модулирующего сигнала, которые 
маркируют определенные точки в сегменте модулирующего сигнала. Вы можете установить полярность 
каждого маркера и точки маркеров (на одну точку выборки или в некотором диапазоне точек выборки). 
Каждый маркер может также выполнять функцию ALC Hold или функции подавления выходного ВЧ сигнала 
и ALC Hold. 

 
 

Реакция на сигнал маркеров 
Генератор сигналов совмещает сигналы маркеров с сигналами I и Q у генератора модулирующих сигналов. 
Однако некоторые установки параметров (амплитуда, фильтры и т.д.) в тракте вывода ВЧ сигнала могут 
вносить задержки между выходным сигналом EVENT маркера и выходом модулированного ВЧ сигнала. При 
использовании выходного сигнала EVENT маркера проконтролируйте сигналы (маркер относительно 
модулированного ВЧ сигнала) на предмет выявления задержки и (если нужно) скорректируйте позиции 
точек маркеров, включая задержку (раздел 8.11), или и то, и другое. 

Создание файла маркеров 
Загрузка файла модулирующего сигнала (как описано в Руководстве по программированию), который не 
имеет ассоциированного с ним файла маркеров, создает файл маркеров, который не помещает куда-либо 
точки маркеров. 

Требования к редактированию точек маркеров 
Прежде чем вы сможете изменять точки маркеров сегмента модулирующего сигнала, необходимо занести 
файл сегмента в память BBG, как описано в подразделе 8.2.1. 

Сохранение в памяти установок полярности маркеров и маршрутизации 
Установки полярности маркеров и маршрутизации сохраняются неизменными, пока вы не измените их, не 
выполните предустановку (Preset) генератора сигналов или не выключите питание генератора сигналов. 
Чтобы обеспечить правильность установки параметров модулирующего сигнала при его воспроизведении, 
установите полярность маркеров и маршрутизацию (RF Blanking и ALC Hold) и сохраните эту информацию в 
заголовке файла (см. раздел 8.4).  

        У К АЗ АН И Е         
Когда вы используете модулирующий сигнал, у которого установки маршрутизации маркеров и 
полярности не занесены в заголовок файла, а предыдущий воспроизводимый модулирующий сигнал 
использовал функцию подавления выходного ВЧ сигнала, установите функцию RF Blanking на None. 
Несоблюдение этого указания может привести к отсутствию выходного ВЧ сигнала или к искажению 
формы сигнала. 

Когда генератор сигналов встречает задействованный маркер (см. подраздел 8.5.9), 
генерируется вспомогательный выходной сигнал, который выводится на соединитель на 
задней панели. 
Сигнал Event 1 (событие 1) выводится на соединитель BNC "EVENT 1" (см. стр. 19) и на 
контактный вывод соединителя AUXILIARY I/O (см. стр. 20). 
Сигналы Event 2 ÷ 4 выводятся на контактные выводы соединителя AUXILIARY I/O  
(см. стр. 20). 
Функция подавления выходного ВЧ сигнала включает в себя функцию ALC Hold. 

Маркер N  
подавляет ВЧ  
сигнал   
в сост. лог. 0  
 

Маркер N  
блокирует ALC  
в сост. лог. 0  
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Функция маркера ALC Hold 
Несмотря на то, что вы можете установить функцию маркера (под названием Marker Routing на 
функциональной клавише) как до, так и после того, как вы установите точки маркеров (подраздел 8.5.5), все 
же установка функции маркера до установки точек маркеров может вызвать броски мощности или потерю 
мощности на выходе ВЧ сигнала. 
Саму по себе функцию ALC Hold (блокировка автоматической стабилизации мощности) применяют в тех 
случаях, когда модулирующий сигнал содержит холостые периоды или фрагменты пилообразной формы, 
или когда нежелательно возникновение расширенного динамического диапазона с подавлением ВЧ сигнала 
на выходе (см. подраздел 8.5.7). 
Функция маркера ALC Hold удерживает схему автоматической стабилизации мощности на среднем 
(среднеквадратическом) значении точек выборки, установленных маркерами. Как при положительной, так и 
при отрицательной полярности маркеров схема ALC производит выборку уровня выходного ВЧ сигнала 
(несущая плюс модулирующий сигнал), когда сигнал маркера переключается в состояние логической 
единицы (высокий уровень). 
Положительная полярность – выборка сигнала производится, когда точки маркера находятся в состоянии 
лог. 1 (On). 
Отрицательная полярность – выборка сигнала производится, когда точки маркера находятся в состоянии 
лог. 0 (Off). 

        У К АЗ АН И Е         
Не применяйте блокировку ALC на время, превышающее 100 мс, поскольку это может сказаться на 
амплитуде выходного сигнала. 
 

  

  ПРЕДОСТЕРЕЖЕНИЕ    
Неправильная дискретизация ALC может создать состояние внезапного нарушения стабилизации 
мощности, которое может привести к броскам уровня выходного ВЧ сигнала с потенциальной опасностью 
повреждения объекта измерений или другого подключенного оборудования. Для предотвращения такого 
состояния устанавливайте маркеры так, чтобы обеспечить возможность избыточной дискретизации 
амплитуды для учета повышенных уровней мощности сигнала. 

Пример правильного применения 
Сигнал: 1022 точки 
Диапазон маркера: 95 ÷ 97 
Полярность маркера: положительная 
В этом примере показан маркер, установленный на выборку области 
сигнала с наибольшей амплитудой. Обратите внимание на то, что 
маркер установлен с достаточным запасом относительно области 
сигнала с наименьшей амплитудой. Это учитывает различие реакции 
маркера и сигнала. 

 

 

Маркеры установлены с опережением  
для компенсации задержки их реакции 

 

100 мс  
макс. время блокировки ALC 

RF OUTPUT 
 
 
 

Маркер  
положительной  

полярности 
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Пример правильного применения (продолжение) 
 
 
 
 
 
 
 
Функция ALC производит выборку контролируемого сигнала, когда 
сигнал маркера переключается на высокий уровень, и использует 
среднее значение выборок контролируемого сигнала для установки 
схемы ALC. 
Здесь функция ALC производит выборку во время точек On маркера 
(положительная полярность). 

 
 

Пример неправильного применения 
Сигнал: 1022 точки 
Диапазон маркера: 110 ÷ 1022 
Полярность маркера: положительная 
В этом примере маркер установлен на выборку низкоамплитудной 
части сигнала, которая устанавливает схему модулятора ALC на этот 
уровень. Обычно это приводит к нерегулируемому состоянию 
генератора сигналов, когда он встречает высокую амплитуду 
импульса.  

Нерегулируемый импульс 

Пример неправильного применения 
Сигнал: 1022 точки 
Диапазон маркера: 110 ÷ 1022 
Полярность маркера: отрицательная 
В этом примере показано, что маркер отрицательной полярности 
переключается на низкий уровень (лог. 0) во время точек "Marker 
On"; сигнал маркера переключается на высокий уровень (лог. 1) во 
время точек "Marker Off".  
Схема ALC производит выборки во время точек "Marker Off".  

Диапазон выборок начинается  
в первой точке сигнала 
 

Выборка в точках "On" и "Off" неправильно устанавливает схему 
модулятора для высоких уровней сигнала. Обратите внимание на 
повышенную амплитуду в начале импульса. 
 
 
 
 
 
 

 
Отрицательный диапазон установлен  
между сигналом и временем "Off". 

 

Увеличенный  
фрагмент  

усреднения 
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8.5.2 Обращение к меню Marker Utilities 

Mode > Dual ARB > More > Marker Utilities 

 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

Установки параметров в этом меню  
можно сохранить в файле заголовка  
(см. раздел 8.4). 

 Примечание:  
Это второе меню Arb. 

подраздел 3.6.1  

Ниже показаны  компоненты I и Q модулирующего сигнала, а также точки маркеров,  
установленные в поставляемом с завода сегменте. 

 
На дисплее показана 
первая точка  
выборки  

 
Эти функциональные  
 клавиши изменяют  
отображаемый на  
дисплее маркеров  
диапазон точек   
выборки сигнала.  
При каждом нажатии  
клавиши диапазон  
выборок изменяется  
примерно в два раза. 

 
Точки маркеров 
на первой точке  
выборки 
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8.5.3 Просмотр маркеров сегментов модулирующего сигнала 
Маркеры применяются к сегментам модулирующего сигнала. Для просмотра маркеров, установленных для 
некоторого сегмента, пользуйтесь описанной ниже процедурой. В этом примере используется 
поставляемый с завода сегмент SINE_TEST_WFM. 
1. Во втором меню Arb (стр. 91) нажмите функциональные клавиши Marker Utilities > Set Markers. 
2. Выделите нужный сегмент модулирующего сигнала (в данном примере сегмент SINE_TEST_WFM). 
3. Нажмите клавиши Display Waveform and Markers > Zoom in Max.  

Максимальное увеличение (Zoom) в диапазоне составляет 28 точек. 
Поэкспериментируйте с функциями Zoom, чтобы посмотреть, как они отображают маркеры. На дисплее 
может отображаться максимум 460 точек; отображаемые сигналы с диапазоном точек выборки более 460 
точек могут не показывать местонахождение маркеров. 

8.5.4 Удаление точек маркеров из сегмента модулирующего сигнала 
Когда вы устанавливаете точки маркеров, они не заменяют, а дополняют существующие точки. Ввиду 
кумулятивного характера маркеров просмотрите сегмент, как описано выше, и удалите нежелательные 
точки. Когда удалены все маркеры, уровень выходного сигнала события равен 0 В. Чтобы можно было уда-
лить точки маркеров на сегменте, необходимо, чтобы этот сегмент находился в памяти BBG (см. раздел 8.2). 

Удаление всех точек маркеров 
1. Во втором меню Arb (стр. 91) нажмите функциональнее клавиши Marker Utilities > Set Markers. 
2. Выделите нужный сегмент модулирующего сигнала (в данном примере сегмент SINE_TEST_WFM). 
3. Выделите номер нужного маркера. Для этого нажмите клавишу Marker 1 2 3 4. 
4. Удалите все точки выбранного номера маркера в выбранном сегменте: 

а) Нажмите клавишу Set Marker Off Range of Points. 
 Обратите внимание на то, что функциональные клавиши для первой и последней точки маркера соот-

ветствуют длине сигнала. Поставляемый с завода сегмент сигнала (SINE_TEST_WFM) содержит 200 
выборок. Для удаления всех установленных точек маркеров диапазон должен быть равен длине 
сигнала. 

б) Нажмите клавиши Apply to Waveform > Return. 
5. Повторяйте эти операции, начиная с пункта 3, для остальных точек маркеров, которые вы хотите 

удалить из других маркеров. 

Удаление точек маркеров в некотором диапазоне 
В следующем примере используется сигнал с точками маркера (маркер 1), установленными по точкам 10 ÷ 
20. Это облегчает наблюдение интересующих вас точек маркеров. Такая же процедура применяется, когда 
существующие точки установлены в некотором диапазоне или в виде отдельных точек (см. подраздел 
8.5.5). 
1. Во втором меню Arb (стр. 91) нажмите функциональные клавиши Marker Utilities > Set Markers, затем 

выберите маркер 1. 
2. Установите первую точку выборки, которую вы хотите выключить (Off), например, точку 13). 

Для этого нажмите клавиши Set Marker Off Range Of Points > First Mkr Point > 13 > Enter. 
3. Установите последнюю точку маркера в диапазоне, который вы хотите выключить, на значение меньшее 

или равное количеству точек в модулирующем сигнале, но большее или равное значению, 
установленному в пункте 2. В данном примере установите значение 17. 

 Нажмите клавиши Last Mkr Point > 17 > Enter > Apply To Waveform > Return. 

Это выключает все точки активного 
маркера в пределах диапазона, 
установленного в пунктах 2 и 3, как 
показано на этом рисунке.  
Как просматривать маркеры, описано 
выше в подразделе 8.5.3. 
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Удаление отдельной точки маркера 
Применяйте описанную выше процедуру, однако установите первую и последнюю точку маркера на 
значение точки, которую вы хотите удалить. Например, если вы хотите удалить маркер на точке 5, 
установите на 5 первое и последнее значение. 

8.5.5 Установка точек маркеров в сегменте сигнала 
Чтобы установить точки маркера в сегменте, необходимо загрузить сегмент в память BBG. 
Когда вы устанавливаете точки маркеров, они не заменяют, а дополняют существующие точки. Ввиду 
кумулятивного характера маркеров просмотрите сегмент, как описано выше в подразделе 8.5.3, и удалите 
нежелательные точки (см. подраздел 8.5.4). 

Помещение маркеров на ряд точек 
1. Во втором меню Arb (стр. 91) нажмите функциональные клавиши Marker Utilities > Set Markers. 
2. Выделите нужный сегмент модулирующего сигнала. 
3. Выделите номер нужного маркера. Для этого нажмите клавишу Marker 1 2 3 4. 
4. Установите первую точку выборки в ряду (в данном примере 10). 

Нажмите клавиши Set Marker On Range Of Points > First Mkr Point > 10 > Enter. 
5. Установите последнюю точку маркера в ряду на значение, меньшее или равное количеству точек в 

модулирующем сигнале, но большее или равное первой точке маркера (в данном примере 20). 
 Нажмите клавиши Last Mkr Point > 20 > Enter. 
6. Нажмите клавиши Apply To Waveform > Return. 

Это устанавливает ряд точек маркеров модулирующего сигнала. Сигнал маркера начинается в точке 
выборки 10 и завершается в точке выборки 20, как показано на этом рисунке. 

 
Как просматривать маркеры, описано выше в подразделе 8.5.3. 

Помещение маркера на отдельную точку 
На первую точку 
1. Во втором меню Arb (стр. 91) нажмите функциональные клавиши Marker Utilities > Set Markers. 
2. Выделите нужный сегмент модулирующего сигнала. 
3. Выделите номер нужного маркера. Для этого нажмите клавишу Marker 1 2 3 4. 
4. Нажмите клавишу Set Marker On First Point. 
 Это устанавливает маркер на первую точку в сегменте для номера маркера, выбранного в пункте 3. 

На любую точку 
Действуйте так же, как описано выше под заголовком "Помещение маркеров на ряд точек", но установите 
первую и последнюю точку маркера на нужную точку. Например, если вы хотите установить маркер на точку 
5, установите на 5 первую и последнюю точку маркера. 

Помещение маркеров с промежутками между точками 
В следующем примере показано, как установить маркеры в диапазоне точек с промежутками 
(пропущенными точками) между маркерами. Вы должны установить размер промежутка до применения 
установок параметров маркеров; вы не можете применять пропущенные точки к ранее установленному 
ряду точек. 

      ПРИМЕЧАНИЕ        
Значение пропущенных точек ограничено до размера диапазона точек. 
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1. Удалите все существующие точки маркеров (см. подраздел 8.5.4). 
2. Во втором меню Arb (стр. 91) нажмите функциональные клавиши Marker Utilities > Set Markers. 
3. Выделите нужный сегмент модулирующего сигнала. 
4. Выделите номер нужного маркера. Для этого нажмите клавишу Marker 1 2 3 4. 
5. Установите первую точку выборки в диапазоне (в данном примере 5): 

Нажмите клавиши Set Marker On Range Of Points > First Mkr Point > 5 > Enter. 
6. Установите последнюю точку маркера в диапазоне на значение, меньшее количества точек в модули-

рующем сигнале, но большее или равное первой точке маркера (в данном примере 25): 
 Нажмите клавиши Last Mkr Point > 25 > Enter. 
7. Введите количество точек выборок, которые вы хотите пропускать (в данном примере 1): 
 Нажмите клавиши # Skipped Points > 1 > Enter. 
8. Нажмите клавиши Apply To Waveform > Return. 

Это приводит к тому, что маркер появляется через одну точку (каждая вторая точка пропускается) в 
диапазоне точек маркера, как показано на этом рисунке. 

 
Как просматривать маркеры, описано выше в подразделе 8.5.3. 
Одним из применений функции пропуска точек является формирование сигнала тактирования в качестве 
выходного сигнала EVENT. 

8.5.6 Наблюдение импульса маркера 
Во время воспроизведения модулирующего сигнала (см. подраздел 8.3.4) вы можете обнаружить импульс 
установленного и задействованного маркера на соединителе EVENT или AUX I/O на задней панели, 
который соответствует номеру этого маркера. Данный пример показывает, как наблюдать импульс маркера, 
генерируемый сегментом модулирующего сигнала, у которого установлена хотя бы одна точка маркера (см. 
подраздел 8.5.5). Такая же процедура используется для последовательности модулирующих сигналов. 
В этом примере используется заводской сегмент SINE_TEST_WFM в режиме Dual ARB Player. Заводские 
сегменты имеют точку маркеров на первой точке выборки для всех четырех маркеров, как показано на этом 
рисунке. 

   
Как просматривать маркеры, описано выше в подразделе 8.5.3. 

1. В первом меню Arb (стр. 76) нажмите клавишу Select Waveform. 
2. Выделите сегмент SINE_TEST_WFM) и нажмите клавишу Select Waveform. 
3. Нажмите клавишу ARB Off On на On. 
4. Присоедините вход канала 1 осциллографа к выходному соединителю Q OUT на задней панели 

генератора сигналов. 
  

Точки маркеров на первой  
точке выборки сегмента  
модулирующего сигнала 
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5. Присоедините вход канала 2 осциллографа к выходному соединителю EVENT 1 на задней панели 
генератора сигналов. 
Когда присутствует маркер 1, генератор сигналов подает сигнал на выход EVENT 1, как показано ниже. 

 

  

8.5.7 Применение функции маркера RF Blanking 
Несмотря на то, что вы можете установить функцию маркера (под названием Marker Routing на 
функциональной клавише в меню Marker Utilities) как до, так и после того, как вы установите точки маркеров 
(подраздел 8.5.5), все же установка функции маркера до установки точек маркеров может изменять сигнал 
ВЧ на выходе генератора. Функция RF Blanking (подавление выходного ВЧ сигнала) включает в себя 
функцию ALC Hold, которая описана на стр. 89 (обратите внимание на предупреждение на этой странице в 
отношении нарушения стабилизации мощности). Функция RF Blanking подавляет выходной ВЧ сигнал, когда 
сигнал маркера переключается на низкий уровень (лог. 0). 
Следующий пример является продолжением предыдущего примера. 
1. Воспользуйтесь заводским сегментом SINE_TEST_WFM и установите маркер 1 по точкам 1 ÷ 180 (см. 

подраздел 8.5.5). 
2. Из меню функциональных клавиш Marker Routing назначьте маркеру 1 функцию RF Blanking: 

Во втором меню Arb (стр. 91) нажмите клавиши Marker Utilities > Marker Routing > Pulse/RF Blank > 
Marker 1. 

 

  
  

Q OUT 
 
Импульс маркера на сигнале Event 1 

Положительная полярность маркера 

При положительной полярности маркера  
(это установка по умолчанию) подавляется  
выходной ВЧ сигнал во время точек маркера Off. 
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8.5.8 Установка полярности маркеров 
Установка отрицательной полярности маркера инвертирует его сигнал. 
1. Во втором меню Arb (стр. 91) нажмите клавиши Marker Utilities > Marker Polarity. 
2. Выберите нужную полярность маркера для каждого номера маркера. 

 По умолчанию принята положительная полярность маркеров. 
 Полярность каждого маркера устанавливается независимым образом. 

См. также "Сохранение в памяти установок полярности маркеров и маршрутизации" на стр. 88. 
Как видно из приведенных выше осциллограмм: 
Положительная полярность: точки On маркеров соответствуют высокому уровню ( 3,3 В). 
Отрицательная полярность: точки On маркеров соответствуют низкому уровню 0 (0 В) 
Подавление ВЧ сигнала всегда происходит при низком уровне независимо от установки полярности. 

8.5.9 Управление маркерами в последовательности модулирующих сигналов 
В сегменте модулирующего сигнала точка задействованного маркера генерирует вспомогательный 
выходной сигнал, который выводится на соединитель EVENT на задней панели (см. раздел 1.5), 
соответствующий номеру этого маркера. Для последовательности модулирующих сигналов вы включаете и 
выключаете маркеры посегментно. Это позволяет вам выводить сигналы маркеров для определенных 
сегментов в последовательности, но не для других. Установка параметров маркеров для последнего 
отредактированного сегмента в последовательности применяется для всех сегментов следующей 
формируемой вами последовательности, пока вы не измените их или не выключите прибор. За 
информацией о построении последовательности модулирующих сигналов обращайтесь к подразделу 8.3.1. 
  

Отрицательная полярность маркера 

При отрицательной полярности маркера  
подавляется выходной ВЧ сигнал во время  
точек маркера On. 
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 Рис. 8-6 Система меню последовательностей модулирующих сигналов для включения  

и выключения маркеров сегментов 

Включение и выключение маркеров в последовательности модулирующих сигналов 
Выберите в последовательности модулирующих сигналов сегменты, чтобы включать и выключать маркеры 
в каждом сегменте независимым образом. Вы можете включать и выключать маркеры во время создания 
последовательности или после того, как последовательность будет создана и сохранена в памяти. Если 
последовательность уже занесена в память, то после внесения изменений необходимо снова сохранить эту 
последовательность в памяти. Включение маркера, у которого нет точек маркера, не оказывает влияния на 
вспомогательные выходы. Чтобы установить точки маркеров в сегменте, обращайтесь к подразделу 8.5.5. В 
данном примере предполагается, что уже существует последовательность сигналов. 
1. Убедитесь в том, что все сегменты модулирующего сигнала у данной последовательности находятся в 

памяти BBG (см. подраздел 8.2.1). 
2. Из второго меню Arb нажмите клавишу Waveform Sequences. 
3. Выделите нужный сегмент сигнала. 
4. Нажмите клавиши Edit Selected Waveform Sequence > Enable/Disable Markers. 
5. Включайте или выключайте маркеры: 

а) Выделите первый сегмент сигнала. 
б) Согласно необходимости нажимайте клавиши Toggle Marker 1, Toggle Marker 1, Toggle Marker 3 и 

Toggle Marker 4. 
 Элемент в столбце Mkr (см. следующий рисунок) указывает, что маркер включен для этого сегмента; 

отсутствие элементов в этом столбце означает, что для этого сегмента выключены все маркеры. 
в) Выделяйте поочередно остальные сегменты и повторяйте операции по пункту б). 

Примечание: Это второе меню Arb. 

Включение и выключение маркеров  
во время создания последовательности  
модулирующих сигналов 
 

Редактировать   
последовательность  
для включения-выключения  
маркеров 
 
 

Для выяснения функций клавиш пользуйтесь встроенной 
справкой по клавишам, как описано в разделе 3.2. 
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6. Нажмите клавиши Return > More > Name and Store. 
7. Либо переименуйте последовательность с помощью клавиш ввода текста (см. подраздел 8.2.2), либо 

просто нажмите клавишу Enter, чтобы сохранить последовательность под прежним именем. 
Внесенные вами изменения установок маркеров сохраняются в файле последовательности сигналов. 
На следующем рисунке показана последовательность, сформированная с использованием одного из 
сегментов, поставляемых с завода, который в исходном состоянии имеет точку маркера на первой выборке 
для всех четырех маркеров. В нашем примере для первого сегмента включен маркер 1, для второго 
сегмента включен маркер 2, для третьего сегмента включены маркеры 3 и 4 . 
 

 

Столбец маркеров  
последовательности 
Этот элемент показывает, что  
для этого сегмента включены  
маркеры 3 и 4. 

 
У каждого сегмента выходной сигнал на соединителе AUX OUT вызывают только маркеры, включенные для 
этого сегмента. В нашем примере вспомогательный сигнал маркера 1 появляется только для первого 
сегмента, поскольку этот маркер выключен у остальных сегментов. Вспомогательный сигнал маркера 2 
появляется только для второго сегмента, а вспомогательные сигналы маркеров 3 и 4 появляются только 
для третьего сегмента. 

8.5.10  Применение выходного сигнала EVENT в качестве сигнала приборного запуска 
Одним из применений выходного сигнала EVENT (сигнала маркера) является запуск измерительного 
прибора. Вы можете установить маркеры на запуск измерения в начале модулирующего сигнала, в любой 
точке или в нескольких точках модулирующего сигнала. Для оптимизации применения сигнала EVENT 
может потребоваться скорректировать частоту выборок. На следующем рисунке показано место установки 
частоты выборок в системе меню. 

  
 
Выходной сигнал EVENT может проявлять джиттер до ± 4 нс на положительном или отрицательном фронте 
импульса. Этот джиттер можно свести к минимуму одним из двух способов. 
Первый способ: Применять тактовую частоту выборок 125 МГц/N, где N – положительное целочисленное 
значение, которое может точно индицироваться на дисплее без округления. 
Пример: 125 МГц; 62,5 МГц; 31,25 МГц, 25 МГц и т.д. 
Если результат не может точно индицироваться на дисплее, то будет присутствовать джиттер. Например, 
при N = 6 появляется джиттер, поскольку 125/6 МГц = 20,833… МГц. Индикация точного этого значения 
невозможна без округления. 
Второй способ: Выбрать тактовую частоту выборок и длину модулирующего сигнала так, чтобы 
интервалы между маркерами были кратны 8 нс. 
Пример: При длине модулирующего сигнала 200 точек с маркером на первой точке и с тактовой частотой 
выборок 50 МГц получается расположение маркеров через каждые 4 мкс. Поскольку значение 4 мкс кратно 
значению 8 нс, то джиттер сводится к минимуму. 
Когда для запуска измерений используется сигнал EVENT, который имеет джиттер, то в результате запуска 
может отображаться осциллограмма сигнала с паразитным джиттером.  

Установки параметров в этом меню  
можно сохранить в файле заголовка  
(см. раздел 8.4) 

Установка  
частоты выборок 
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В таком случае вы можете скорректировать частоту выборок и установить такое ее значение (см. выше), 
при котором не возникает видимый джиттер. Для поддержания целостности исходной формы сигнала при 
изменении частоты выборок вам придется также заново вычислить значения выборок. Следующие 
осциллограммы иллюстрируют джиттер сигнала маркера и его влияние на отображаемый сигнал. 
 
Выходной сигнал EVENT проявляет  
джиттер вследствие неоптимальной  
частоты выборок 

При запуске сигналом EVENT с джиттером  
появляется джиттер на осциллограмме  
сигнала. 

Джиттер исчезает  
при оптимальной  
частоте выборок. 

   
Осциллограф запускается по  
модулирующему сигналу 

Осциллограф запускается по сигналу EVENT Осциллограф запускается по сигналу EVENT 

8.6 Запуск модулирующих сигналов 

 
 Рис. 8-7 Функциональные клавиши запуска 
 
Средства запуска управляют передачей данных, задавая моменты передачи модулирующего сигнала. В 
зависимости от установки параметров запуска передача данных может производиться однократно (режим 
Single), непрерывно (режим Continuous), или же в режиме многократного пуска-останова (режимы Gated и 
Segment Advance). 
Сигнал запуска содержит положительные и отрицательные состояния; вы можете использовать для запуска 
и те, и другие.  
Когда вы первоначально выбираете режим запуска или переключаете генератор из одного режима запуска 
в другой, может исчезать сигнал несущей на ВЧ выходе генератора сигналов, пока не произойдет запуск 
модулирующего сигнала. Это является следствием того, что генератор сигналов устанавливает сигналы I и 
Q на нуль вольт до первого события запуска. Чтобы поддержать сигнал несущей на выходе RF OUT, 
создайте комбинацию данных с начальными установками напряжения I и Q, не равными нулю.  
Когда вы первоначально устанавливаете Arb на On (см. рис. 8-7) или выбираете режим запуска, или 
переключаете генератор из одного режима запуска в другой, сигнал несущей на ВЧ выходе генератора 
сигналов может исчезать на несколько десятков миллисекунд. Проигрыватель ARB подает холостое 
значение IQrms следующего сигнала Arb на IQ-модулятор. Это обеспечивает правильный уровень 
амплитуды несущей на выходе RF OUT, пока проигрыватель ARB ожидает запуска.  

подраздел 8.6.1 
 

подраздел 8.6.2 
 

Для выяснения функций клавиш пользуйтесь встроенной 
справкой по клавишам, как описано в разделе 3.2. 
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При приеме сигнала запуска проигрыватель ARB начинает воспроизведение модулирующего сигнала, и 
модулированная несущая не проявляет нежелательных переходных процессов. 
Конфигурирование запуска модулирующих сигналов включает в себя две части: 
 Тип (Type) определяет поведение модулирующего сигнала во время его воспроизведения (см. 

подраздел 8.6.1). 
 Источник (Source) определяет, как генератор сигналов получает сигнал запуска, который инициирует 

воспроизведение модулирующего сигнала (см. подраздел 8.6.2). 

8.6.1 Тип запуска (Trigger Type) 
Тип запуска определяет режим запуска: как воспроизводится модулирующий сигнал при запуске. 

      ПРИМЕЧАНИЕ        
В следующем примере показан режим модуляции Dual ARB, однако запуск действует аналогичным 
образом и в других режимах модуляции. Доступные типы запуска зависят от выбранного режима 
модуляции. 
 

 
Сегмент в последовательности воспроизводится непрерывно  
(периодически), пока не поступит другой сигнал запуска. 

Если сигнал запуска поступает во время воспроизведения сегмента, то сегмент воспроизводится до  
завершения. Тогда сдвоенный проигрыватель ARB переходит к следующему сегменту и непрерывно  
(периодически) воспроизводит этот сегмент. 

Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
 
 Continuous – в этом режиме периодически повторяется модулирующий сигнал до того момента, когда 

вы выключите сигнал или выберите другой модулирующий сигнал, режим запуска или реакцию (Free 
Run, Trigger & Run, Reset & Run). 

 Single – это режим однократного воспроизведения (проигрывания) модулирующего сигнала. 

      ПРИМЕЧАНИЕ        
В варианте Single No Retrigger не применяйте режим Continuous Reset & Run ввиду переменной 
задержки этой настройки. 
No Retrigger – Поступление преждевременного запуска игнорируется. Пауза в воспроизведении зависит 
от периода запуска, по истечении которого ВЧ сигнал снова начинается там, где он ожидается. 
Buffered Trigger – Преждевременный запуск откладывается в ожидании завершения воспроизведения 
модулирующего сигнала, затем инициирует повторное однократное воспроизведение. ВЧ сигнал не 
совмещается с этим преждевременным запуском. 

Немедленный запуск и воспроизведение модулирующего  
сигнала. Сигналы запуска, принимаемые во время  
воспроизведения, игнорируются. 

Воспроизведение модулирующего сигнала при приеме  
сигнала запуска. Последующие сигналы запуска  
игнорируются. 

 

Воспроизведение модулирующего сигнала при приеме  
сигнала запуска. Последующие сигналы запуска  
приводят к перезапуску модулирующего сигнала. 

 
Сегмент последовательности 
воспроизводится однократно, игнорируя 
установку кратности повторения, после 
чего проигрыватель ARB 
останавливается и ждет запуска перед 
продвижением к следующему сегменту. 
Затем воспроизводится следующий 
сегмент до завершения. 
 
Если принимается сигнал запуска во 
время воспроизведения сегмента, 
сегмент воспроизводится до 
завершения. Затем проигрыватель ARB 
переходит к следующему сегменту и 
воспроизводит этот сегмент до 
завершения. 

Воспроизведение модулирующего сигнала 
останавливается во время пассивного  
состояния источника и действует во время 
активного состояния. 

 

Игнорирует 
преждевременный сигнал 
запуска, принимаемый во 
время воспроизведения 
модулирующего сигнала. 

Преждевременный сигнал 
запуска, принимаемый во 
время воспроизведения 
сигнала, придерживается 
в ожидании завершения 
текущего сигнала, затем 
инициирует однократное 
воспроизведение. 

 Преждевременный 
сигнал запуска, 
принимаемый во время 
воспроизведения 
сигнала, вызывает 
немедленный перезапуск. 
воспроизведения. 
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Restart on Trigger – Переустанавливается и снова запускается проигрыватель ARB, однако это 
приводит к некоторой паузе в воспроизведении. Проигрыватель ARB переустанавливается при каждом 
сигнале запуска, который он принимает. 

 Segment Advance – Воспроизведение сегмента в последовательности производится только по сигналу 
запуска. Продвижение воспроизведения от сегмента к сегменту определяется источником запуска (см. 
пример в подразделе 8.6.3). Сигнал запуска, поступающий во время воспроизведения последнего 
сегмента, закольцовывает воспроизведение на первый сегмент в последовательности. 

 Gated  – В этом режиме воспроизведение модулирующего сигнала запускается при первом активном 
состоянии сигнала запуска, затем повторяющимся образом начинается и останавливается в ответ на 
внешний стробирующий сигнал (см. пример в подразделе 8.6.4). 

8.6.2 Источник запуска (Trigger Source) 
Mode > Dual ARB > Trigger Source 

 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

Полярность сигнала внешнего запуска 
 В режимах Continuous, Single и Segment Advance для установки полярности сигнала внешнего запуска 

пользуйтесь функциональной клавишей Ext Polarity. 
 В режиме Gated полярность сигнала внешнего запуска определяют функциональные клавиши Active 

Low и Active High (см. стр. 100). 

8.6.3 Пример: Применение прогрессивного запуска сегментов 
Прогрессивный запуск сегментов (Segment Advance Triggering) позволяет вам управлять воспроизведением 
сегментов в пределах последовательности модулирующих сигналов. Этот тип запуска игнорирует установку 
кратности воспроизведения (см. подраздел 8.3.1). Например, если сегмент имеет значение кратности 
повторения 50, и вы выбираете Single в качестве режима прогрессивного запуска сегментов, то сегмент 
будет воспроизводиться лишь однократно. В следующем примере используется последовательность, 
состоящая из двух сегментов. 
Если вы еще не создали и не сохранили в памяти последовательность модулирующих сигналов, то 
выполните процедуры, описанные в подразделе 8.3.1. 
1. Выполните предустановку генератора сигналов. 
2. Сконфигурируйте выход ВЧ сигнала: 
 Установите нужное значение частоты. 
 Установите нужное значение амплитуды. 
 Включите выход ВЧ сигнала. 

3. Выберите последовательность модулирующих сигналов для воспроизведения: 
а) Нажмите клавиши Mode > Dual ARB > Select Waveform. 
б) Выделите файл последовательности модулирующих сигналов в столбце Sequence On.. 
в) Нажмите клавишу Select Waveform. 

Neg = генератор сигналов реагирует  
во время состояния низкого уровня 
сигнала запуска. 

Pos = генератор сигналов реагирует  
во время состояния высокого уровня 
сигнала запуска. 

 

Клавиша не действует, пока не будет  
включена внешняя задержка  
(Ext Delay) на On. 

 

Входной соединитель  
PAT TRIG 
(см. стр. 19) 
 
Соединитель AUX I/O  
(см. стр. 20) 
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4. Выберите тип запуска и источник запуска: 
 Тип запуска: периодический прогрессивный запуск сегментов. 

Нажмите клавиши Trigger Type > Segment Advance > Continuous. 
 Источник запуска: аппаратная клавиша Trigger. 

Нажмите клавиши Trigger Source > Trigger Key. 
5. Включите генерирование последовательности модулирующих сигналов: 

Нажмите клавишу ARB Off On на On. 
6. (Необязательно) Проконтролируйте модулирующий сигнал: 

Присоедините вход осциллографа к выходу генератора сигналов RF OUTPUT и сконфигурируйте 
осциллограф так, чтобы увидеть осциллограмму выходного сигнала генератора. 

7. Запустите первый сегмент, чтобы начать повторяющееся воспроизведение: 
Нажмите аппаратную клавишу Trigger. 

8. Запустите второй сегмент: 
Нажмите аппаратную клавишу Trigger. 
Нажатие клавиши Trigger приводит к окончанию текущего воспроизведения и к началу воспроизведения 
следующего сегмента. Если нажать клавишу Trigger во время воспроизведения последнего сегмента, то 
начнется воспроизведение первого сегмента в последовательности модулирующих сигналов, когда 
закончится воспроизведение текущего сегмента. 

8.6.4 Пример: Применение стробированного запуска 
Стробированный запуск позволяет вам задать состояния On и Off модулирующего сигнала. 
1. Присоедините выход генератора функций к соединителю PAT TRIG IN на задней панели генератора 

сигналов, как показано на следующем рисунке. Это соединение применимо ко всем методам внешнего 
запуска. Дополнительное подключение осциллографа позволяет вам видеть результат воздействия 
сигнала запуска на выходной ВЧ сигнал. 

 
 Генератор функций 

 
 
2. Выполните предустановку генератора сигналов. 
3. Сконфигурируйте выход ВЧ сигнала: 
 Установите нужное значение частоты. 
 Установите нужное значение амплитуды. 
 Включите выход ВЧ сигнала. 

4. Выберите сигнал для воспроизведения (последовательность или сегмент): 
а) Нажмите клавиши Mode > Dual ARB > Select Waveform. 
б) Выделите нужный файл в столбце Segment On или Sequence On.. 
в) Нажмите клавишу Select Waveform. 

Генератор сигналов Осциллограф 
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5. Установите параметры запуска следующим образом: 
 Тип запуска: стробированный запуск 

Нажмите клавиши Trigger Type > Gated. 
 Активное состояние: низкий уровень 

Нажмите функциональную клавишу Active Low. 
 Источник запуска: внешний 

Нажмите клавиши Trigger Source > Ext. 
 Входной соединитель: соединитель (BNC) на задней панели PAT TRIG. 

6. Включите генерирование модулирующего сигнала: нажмите клавиши Return > ARB Off On на On. 
7. На генераторе функций сконфигурируйте сигнал TTL для внешнего стробирующего запуска. 
8. (Дополнительно) Проконтролируйте форму модулирующего сигнала. 

Сконфигурируйте осциллограф на отображение выхода генератора сигналов и сигнала внешнего 
запуска. Вы увидите модуляцию выходного ВЧ сигнала во время пассивных периодов стробирования 
(при низком уровне). 

 На этом рисунке показаны осциллограммы сигналов. 

 

8.6.5 Пример: Внешний запуск 
В этом примере описано, как настроить генератор сигналов на вывод модулированного ВЧ сигнала через 
100 мс после того, как внешний сигнал TTL на соединителе PAT TRIG IN на задней панели переключится с 
уровня лог. 0 (низкий уровень) на уровень лог. 1 (высокий уровень). 
 

 
1. Присоедините генератор сигналов к генератору функций, как показано выше. 
2. Сконфигурируйте выход ВЧ сигнала: 
 Установите нужное значение частоты. 
 Установите нужное значение амплитуды. 
 Включите выход ВЧ сигнала. 

3. Выберите сигнал для воспроизведения (последовательность или сегмент): 

Модулирующий сигнал Выход ВЧ 

Внешний стробирующий сигнал 
Активный уровень строба = низкий 

 

Генератор сигналов 

Генератор  
функций 
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а) Нажмите клавиши Mode > Dual ARB > Select Waveform. 
б) Выделите нужный файл в столбце Segment On или Sequence On.. 
в) Нажмите клавишу Select Waveform. 

4. Включите генерирование модулирующего сигнала: нажмите клавишу ARB Off On на On. 
5. Установите параметры запуска следующим образом: 

а) Тип запуска: однократный 
Нажмите клавиши Trigger Type > Single > No Retrigger. 

б) Источник запуска: внешний 
Нажмите клавиши Trigger Source > Ext. 

в) Входной соединитель: соединитель (BNC) PAT TRIG на задней панели 
Нажмите клавиши Ext Source > Patt Trig In 1. 

г) Полярность внешнего запуска: положительная 
Нажимайте клавишу Ext Polarity, что выделить вариант Pos. 

д) Задержка внешнего запуска: 100 мс 
Нажмите клавиши More > Ext Delay, чтобы выделить вариант On. 
Нажмите клавиши Ext Delay Time > 100 msec. 

6. Сконфигурируйте генератор функций: 
 Сигнал: сигнал прямоугольной формы с частотой 0,1 Гц 
 Уровень выходного сигнала: от 3,5 В до 5 В 

8.7 Амплитудное ограничение модулирующих сигналов 
Модулирующие сигналы с большими пиками мощности могут вызывать интермодуляционные искажения, 
которые вызывают уширение спектра, т.е. состояние, которое создает помехи сигналам в соседних 
частотных диапазонах. Функция амплитудного ограничения позволяет уменьшить пики мощности путем 
ограничения данных I и Q до выбранного процентного значения от наибольшего пика, благодаря чему 
снижается спектральное уширение. 
В этом разделе рассмотрены следующие темы. 
 Как образуются пики мощности – подраздел 8.7.1 
 Как пики вызывают спектральное уширение – подраздел 8.7.2 
 Как действует амплитудное ограничение – подраздел 8.7.3 
 Конфигурирование кругового амплитудного ограничения – подраздел 8.7.4 
 Конфигурирование прямоугольного амплитудного ограничения – подраздел 8.7.5 
 
 
Mode > Dual Arb > More 

 

 
 
 
 
 
 
 
Доступны только тогда, 
когда тип амплитудного  
ограничения  
Clipping Type = | I |, |Q| 

 Рис. 8-8 Функциональные клавиши амплитудного ограничения 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

 



Глава 8: Основные цифровые операции (опция 653/655/656/657)  

Руководство по эксплуатации    107   N5171B, N5172B, N5181B, N5182В 
 

8.7.1 Как образуются пики мощности 
Чтобы понять, как амплитудное ограничение уменьшает большие пики мощности, важно знать, как 
образуются пики мощности при формировании сигнала. 

Суммирование нескольких каналов 
Модулирующие сигналы I/O могут быть результатом суммирования нескольких каналов, как показано на 
следующем рисунке. Всякий раз, когда в модулирующих сигналах нескольких каналов появляется бит в 
одинаковом состоянии (высокий уровень или низкий уровень), в суммарном модулирующем сигнале 
появляется необычно большой пик мощности (положительный или отрицательный). Это случается не часто 
ввиду случайного характера состояния битов в модулирующих сигналах этих каналов, вызывающего 
частичную компенсацию. 
 

   

Комбинирование модулирующих сигналов I и Q 
Когда сигналы I и Q комбинируются в I/Q-модуляторе для формирования ВЧ сигнала, амплитуда огибаю-
щей ВЧ сигнала определяется выражением  где возведение в квадрат I и Q всегда дает положитель-
ное значение. Как показано на следующем рисунке, одновременные положительные и отрицательные пики 
в составляющих I и Q не компенсируют друг друга, но комбинируются так, что формируется еще более 
высокий пик. 

   

Несколько каналов, подлежащих суммированию  
в одном канале модулирующего сигнала I или Q 

Суммарный модулирующий сигнал I или Q 

Векторное представление  
большого пика 

Подлежащие комбинированию  
составляющие I и Q 

Результирующий  
модулирующий сигнал  
определяется как  
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8.7.2 Как пики вызывают спектральное уширение 
Ввиду относительно редкого возникновения больших пиков модулирующий сигнал характеризуется 
высоким отношением пиковой мощности к средней мощности, как показано на следующем рисунке.  
 

   
 
Поскольку коэффициент усиления усилителя мощности передатчика установлен на обеспечение 
определенной средней мощности, высокие пики могут вводить усилитель мощности в состояние, близкое к 
насыщению. Это вызывает интермодуляционные искажения, приводящие к уширению спектра. 
Спектральное уширение захватывает частотную область по бокам от несущей (подобно боковым полосам) 
и простирается в соседние частотные диапазоны (см. следующий рисунок). В результате этого создаются 
помехи связи в соседних диапазонах. Решение этой проблемы может обеспечить амплитудное 
ограничение, позволяющее уменьшить отношение пиковой мощности к средней мощности. 
 
 Спектральное уширение 

   
 ВЧ сигнал Соседний диапазон 

8.7.3 Как действует амплитудное ограничение 
Отношение пиковой мощности к средней мощности (и как следствие, спектральное уширение) можно 
уменьшить путем амплитудного ограничения модулирующего сигнала до выбранного процентного значения 
от его пиковой мощности. Генератор сигналов реализует два разных способа амплитудного ограничения: 
круговое и прямоугольное. 
 Круговое амплитудное ограничение применяется к комбинированным данным I/Q (данные I и Q 

ограничиваются в равной мере)  
Как показано на рис. 8-9, уровень амплитудного ограничения является постоянным для всех фаз 
векторного представления сигнала, что проявляется в виде окружности на векторной диаграмме.  

 Прямоугольное амплитудное ограничение применяется раздельно к составляющим I и Q. 
Как показано на рис. 8-10, уровень ограничения различается для составляющих I и Q, поэтому на 
векторной диаграмме это проявляется в виде прямоугольника. 

При применении любого из этих способов важно ограничить модулирующий сигнал до уровня, которые 
эффективно уменьшает спектральное уширение, но не ухудшает целостность сигнала. На рис. 8-11 
показаны два графика комплементарной интегральной функции распределения, демонстрирующие 
уменьшение отношения пиковой мощности к средней мощности  в результате кругового амплитудного 
ограничения. 
Чем ниже вы установите уровень ограничения, тем меньше будет пиковая мощность (тем больше будет 
срезан сигнал). Зачастую можно успешно ограничить пики без существенного воздействия на остальную 
часть сигнала. Данные, которые могут быть потеряны в процессе амплитудного ограничения, восстанав-
ливаются благодаря коррекции ошибок, применяемой в кодированных системах. Однако при слишком 
сильном ограничении может оказаться  невозможным восстановление данных. Вы можете попробовать 
несколько вариантов установки амплитудного ограничения, чтобы найти оптимальный вариант. 
  

Пиковая мощность 

Средняя мощность 

Пиковая мощность без ограничения  
(ограничение установлено на 100%) 
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Векторное представление срезанных пиков   

 Рис. 8-9 Круговое амплитудное ограничение 
 
 

 
Ограниченный модулирующий сигнал I 

 
 

 

 
Векторное представление  

срезанных пиков I и Q 
 
а) | I |  ограничение установлено на 100% (нет ограничения) 

b) | I |  ограничение установлено на 75% от наибольшего пика 

с) | Q |  ограничение установлено на 100% (нет ограничения) 

d) | Q |  ограничение установлено на 50% от наибольшего пика 

 
 
 

 
Ограниченный модулирующий сигнал Q 

 
 Рис. 8-10 Прямоугольное амплитудное ограничение 

Ограниченный модулирующий сигнал 

Ограничение 80% 
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Комплементарная интегральная функция распределения (CCDF) 
  Вероятность Интегральное распределение при амплитудном ограничении 100% (без ограничения) 

  
 Рис. 8-11 Снижение отношения пиковой мощности к средней мощности 

8.7.4 Конфигурирование кругового амплитудного ограничения 
Эта пример показывает, как сконфигурировать круговое амплитудное ограничение и оценить его 
воздействие на отношение пиковой мощности к средней мощности в модулирующем сигнале. При круговом 
ограничении ограничиваются композитные данные I/Q (данные I и Q ограничиваются в равной мере). За 
дополнительной информацией о круговом амплитудном ограничении обращайтесь к подразделу 8.7.3. 

  ПРЕДОСТЕРЕЖЕНИЕ    
Амплитудное ограничение действует необратимо и кумулятивно. Прежде чем применять амплитудное 
ограничение, сохраните копию модулирующего сигнала. 

Копирование файла модулирующего сигнала 
1. Выведите на экран сводку файлов генератора сигналов. Нажмите клавиши File > Catalog Type > More > 

Volatile Segments. 
2. Выделите файл сигнала RAMP_TEST_WFM. 
3. Нажмите клавишу Copy File. 
4. Присвойте имя копии (в этом примере это имя MY_TEST_CIRC) и нажмите клавишу Enter. 

Применение кругового амплитудного ограничения к копии файла модулирующего сигнала 
1. Откройте меню DUAL ARB Waveform Utilities. Для этого нажмите клавиши Mode > Dual ARB > More > 

Waveform Utilities. 
2. В списке файлов выделите скопированный файл (в нашем примере это MY_TEST_CIRC). 
3. Создайте диаграмму функции CCDF: нажмите клавишу Plot CCDF. 
4. Посмотрите форму и положение графика CCDF для модулирующего сигнала (жирная линия на графике). 

  Вероятность Амплитудное ограничение 80% 

Снижение отношения пиковой мощности 
  к средней мощности 
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5. Включите круговое амплитудное ограничение. Для этого нажмите клавиши Return > Clipping > Clipping 
Type, чтобы выделить вариант |I+jQ|. 

6. Установите круговое амплитудное ограничение на 80%: нажмите клавиши Clip |I+jQ| To > 80 > %. 
7. Примените амплитудное ограничение 80% к данным I и Q: нажмите клавишу Apply to Waveform. 
8. Создайте диаграмму функции CCDF: нажмите клавишу Plot CCDF. 
9. Посмотрите график CCDF для модулирующего сигнала после амплитудного ограничения. 

Обратите внимание на снижение отношения пиковой мощности к средней мощности по сравнению с 
предыдущим графиком. 

 
Пример графика CCDF для модулирующего сигнала до амплитудного ограничения 

 
  

Пример графика CCDF для модулирующего сигнала после кругового амплитудного ограничения 

 

8.7.5 Конфигурирование прямоугольного амплитудного ограничения 
Этот пример показывает, как сконфигурировать прямоугольное амплитудное ограничение, при котором 
данные I и Q ограничиваются независимым образом. За дополнительной информацией о прямоугольном 
амплитудном ограничении обращайтесь к подразделу 8.7.3. 

  ПРЕДОСТЕРЕЖЕНИЕ    
Амплитудное ограничение действует необратимо и кумулятивно. Прежде чем применять амплитудное 
ограничение, сохраните копию модулирующего сигнала. 

Копирование файла модулирующего сигнала 
1. Выведите на экран сводку файлов генератора сигналов. Нажмите клавиши File > Catalog Type > More > 

Volatile Segments. 
2. Выделите файл сигнала RAMP_TEST_WFM. 
3. Нажмите клавишу Copy File. 
4. Присвойте имя копии (в этом примере это имя MY_TEST_REC) и нажмите клавишу Enter. 

Применение прямоугольного амплитудного ограничения к копии файла модулирующего  
сигнала 
1. Откройте меню DUAL ARB Waveform Utilities. Для этого нажмите клавиши Mode > Dual ARB > More > 

Waveform Utilities. 
2. В списке файлов выделите скопированный файл (в нашем примере это MY_TEST_REC). 
3. Создайте диаграмму функции CCDF: нажмите клавишу Plot CCDF. 
4. Посмотрите форму и положение графика CCDF для модулирующего сигнала (жирная линия на графике). 
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5. Включите прямоугольное амплитудное ограничение. Для этого нажмите клавиши Return > Clipping > 
Clipping Type, чтобы выделить вариант | I |, |Q|. 

6. Установите амплитудное ограничение 80% для данных I: нажмите клавиши Clip | I | To > 80 > %. 
7. Установите амплитудное ограничение 40% для данных Q: нажмите клавиши Clip |Q| To > 40 > %. 
8. Примените к модулирующему сигналу прямоугольное амплитудное ограничение. Для этого нажмите 

клавишу Apply to Waveform. 
9. Создайте диаграмму функции CCDF: нажмите клавишу Plot CCDF. 
10  Посмотрите график CCDF для модулирующего сигнала после амплитудного ограничения. 

Обратите внимание на снижение отношения пиковой мощности к средней мощности по сравнению с 
предыдущим графиком. 

 
Пример графика CCDF для модулирующего сигнала до амплитудного ограничения 

 
  

Пример графика CCDF для модулирующего сигнала после прямоугольного амплитудного ограничения 

 
 

8.8 Масштабирование модулирующих сигналов 
Генератор сигналов использует интерполяционный алгоритм (дискретизацию между точками данных I/Q) 
при восстановлении формы сигнала. Для распространенных модулирующих сигналов эта интерполяция 
может приводить к выбросам, вызывающим перегрузку цифро-аналогового преобразователя (ЦАП). В этом 
разделе описано, как возникают погрешности от перегрузки ЦАП и как применять масштабирование 
модулирующих сигналов для эффективного устранения этих погрешностей. 
 Как возникают погрешности от перегрузки ЦАП – подраздел 8.8.1 
 Как масштабирование устраняет погрешности от перегрузки ЦАП – подраздел 8.8.2 
 Масштабирование модулирующих сигналов в генераторах Agilent MXG/EXG: 

  Масштабирование модулирующего сигнала в реальном времени в процессе его воспроизведения – 
подраздел 8.8.3 

 Установка масштабирования модулирующего сигнала – подраздел 8.8.4 
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 Рис. 8-12 Функциональные клавиши масштабирования 

8.8.1 Как возникают погрешности от перегрузки ЦАП 
Генератор сигналов использует фильтр интерполятора в преобразовании цифровых модулирующих 
сигналов I и Q в аналоговые сигналы. Тактовая частота интерполятора в четыре раза превышает частоту 
выборок модулирующего сигнала. Поэтому интерполятор вычисляет точки сигнала между реальными 
точками выборки, что обеспечивает сглаживание формы сигнала, как показано на этом рисунке. 
 
 Интерполированные выборки 

 
 Реальные выборки модулирующего сигнала 

Установки параметров в этом меню  
можно сохранить в файле заголовка  
(см. раздел 8.4) 
 

Масштабирование модулирующего сигнала  
в процессе его воспроизведения 
(см. подраздел 8.8.3) 
 

Масштабирование файла модулирующего сигнала  
(см. подраздел 8.8.4) 

Для выяснения функций клавиш пользуйтесь встроенной справкой по 
клавишам, как описано в разделе 3.2. 
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Интерполяционные фильтры в цифро-аналоговых преобразователях имеют выбросы на переходной 
характеристике. Если модулирующий сигнал обладает крутым фронтом, то в интерполированный сигнал 
вносятся искажения в виде выброса и звона после крутого фронта. Если этот выброс со звоном превысит 
верхний предел динамического диапазона ЦАП, то интерполятор вычислит ошибочные интерполированные 
точки и окажется неспособным воспроизвести истинную форму затухающих колебаний (см. следующий 
рисунок). В результате этого появится сообщение об ошибке от перегрузки ЦАП. 
 

Неправильная интерполяция выборок  
за пределами динамического диапазона ЦАП 

  
 Реальные выборки модулирующего сигнала 

8.8.2 Как масштабирование устраняет погрешности от перегрузки ЦАП 
Масштабирование уменьшает или сжимает амплитуду модулирующего сигнала, сохраняя в основном 
форму сигнала и такие его характеристики, как отношение пиковой мощности к средней мощности. Если 
масштабировать модулирующий сигнал с крутым фронтом так, чтобы обеспечить достаточный запас для 
выброса, то фильтр интерполятора сможет правильно вычислить точки выборок, характеризующие выброс 
со звоном, устраняя таким образом погрешность от перегрузки ЦАП (см. следующий рисунок). 
 

Правильная интерполяция выборок  
в пределах динамического диапазона ЦАП 

 
 Реальные выборки модулирующего сигнала 
 
Несмотря на то, что масштабирование сохраняет в основном форму сигнала, чрезмерное 
масштабирование может ухудшить целостность данных вследствие того, что битовое разрешение может 
оказаться столь низким, что сигнал будет искажен шумом квантования. Максимальная точность и 
оптимальный динамический диапазон достигается при масштабировании сигнала ровно настолько, 
насколько это необходимо для устранения погрешности от перегрузки ЦАП. Оптимальное 
масштабирование зависит от контента модулирующего сигнала. 
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8.8.3 Масштабирование модулирующего сигнала в реальном времени 
Эта процедура позволяет вам осуществлять установку масштабирования данных воспроизводимого в 
данный момент модулирующего сигнала. Этот тип масштабирования не влияет на данные, занесенные в 
память. Вы можете применять масштабирование в реальном времени к сегменту или к последовательности 
и устанавливать масштабирующее значение, когда включен или выключен проигрыватель ARB. Этот тип 
масштабирования хорошо подходит для устранения погрешности от перегрузки ЦАП. Подстройка 
масштабирования воспроизведения в реальном времени не является кумулятивной; масштабирующее 
значение применяется к исходной амплитуде файла модулирующего сигнала.  
Существует два способа сохранения установки масштабирования в реальном времени: с применением 
функции сохранения данных (стр. 52) или путем сохранения этой установки в заголовке файла (подраздел 
8.4.1). Сохранение в заголовке файла сохраняет масштабный коэффициент с файлом модулирующего 
сигнала, а сохранение с использованием функции Save сохраняет масштабный коэффициент в качестве 
текущей установки параметров прибора. 
Этот пример поможет вам понять, как масштабировать выбранный в данный момент модулирующий сигнал. 
1. Выберите модулирующий сигнал, к которому вы хотите применить масштабирование. 

а) Нажмите клавиши Mode > Dual ARB > Select Waveform. 
б) Выделите нужный модулирующий сигнал (сегмент или последовательность). 
в) Нажмите клавишу Select Waveform. 

2. Нажмите клавишу ARB Off On на On, чтобы включить воспроизведение выбранного модулирующего 
сигнала. 

3. Установите масштабирующее значение для воспроизведения модулирующего сигнала в реальном 
времени: 
а) Нажмите клавиши ARB Setup > Waveform Runtime Scaling. 
б) Введите масштабирующее значение. 
 Генератор сигналов автоматически применяет новый масштабный коэффициент к модулирующему 

сигналу. Не существует масштабирующего значения, оптимального для всех модулирующих 
сигналов. Для достижения максимального динамического диапазона применяйте наибольшее 
масштабирующее значение, при котором еще не возникает погрешность от перегрузки ЦАП. 

в) Нажмите клавишу Return. 

8.8.4 Установка масштабирования модулирующего сигнала 
Масштабирование модулирующего сигнала отличается от масштабирования воспроизведения 
модулирующего сигнала тем, что оно реально изменяет данные модулирующего сигнала и применяется 
только к сегментам модулирующего сигнала, хранящимся в памяти BBG. Масштабирование производится 
относительно полной шкалы ЦАП (100%). Если вы масштабируете модулирующие сигналы этим методом, 
то может возникнуть необходимость изменения масштабирующего значения воспроизведения 
модулирующих сигналов для адаптации к этому масштабу. 
При применении масштабирования генератор сигналов вносит постоянно действующие изменения в  
значения выборок файла модулирующего сигнала так, чтобы они соответствовали желаемому 
масштабирующему значению. Когда вы инициируете масштабирование, генератор сигналов выполняет 
следующие действия: 
– находит значение выборки абсолютного пика в файле модулирующего сигнала; 
– определяет текущее процентное значение полной шкалы; 
– вычисляет отношение желаемого значения шкалы к найденному значению шкалы выборки абсолютного 

пика; 
– умножает на это отношение каждую выборку в файле модулирующего сигнала. 
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 Пиковая выборка 

  
 

Масштабированное значение выборки = масштабный коэффициент  начальное значение выборки 

Масштабный коэффициент = желаемое значение шкалы / текущее значение шкалы = 60 / 85 = 0,70588 

Каждая выборка в модулирующем сигнале умножается на 0,70588, чтобы получить амплитуду сигнала 60% после масштабирования. 

 
Когда вы масштабируете модулирующий сигнал, вы можете получать фрагментарные данные, терять 
данные, либо то и другое. Фрагментарные данные получаются почти каждый раз, когда вы увеличиваете 
или уменьшаете масштабный коэффициент; при этом возникают погрешности квантования. Погрешности 
квантования становятся более заметными, когда вы уменьшаете масштабный коэффициент, поскольку при 
этом происходит приближение к шумовому порогу. Потеря данных возникает, когда генератор сигналов 
округляет фрагментарные данные, или масштабный коэффициент вычисляется с использованием 
результатов из 2х. Это означает, что уменьшение амплитуды модулирующего сигнала вдвое при 
масштабировании (21 = 2) приводит к потере одного бита в каждой выборке модулирующего сигнала. 
Модификации данных модулирующего сигнала не поддаются исправлению и могут вызывать искажения 
формы модулирующего сигнала. Поэтому рекомендуется сделать копию исходного файла, прежде чем 
применять масштабирование. 
Пользуйтесь следующими примерами для применения масштабирования к модулирующим сигналам. В 
этих процедурах используется поставляемый с завода файл RAMP_TEST_WFM, однако их можно 
применять к любым файлам модулирующих сигналов. 

Копирование файла модулирующего сигнала 
1. Вызовите на экран список файлов в памяти BBG: нажмите клавиши File > Catalog Type > More > Volatile 

Segments. 
2. Выделите файл RAMP_TEST_WFM. 
3. Нажмите клавишу Copy File. 
4. Присвойте имя копии файла (в нашем примере это имя MY _TEST_SCAL) и нажмите клавишу Enter. 

Применение масштабирования к копии файла модулирующего сигнала 

  ПРЕДОСТЕРЕЖЕНИЕ    
Этот тип масштабирования является необратимым. Данные, потерянные при операции масштабирования, 
не могут быть восстановлены. Перед масштабированием сохраните копию файла модулирующего сигнала. 
1. Откройте меню DUAL ARB Waveform Utilities: 
 Нажмите клавиши Mode > Dual ARB > More > Waveform Utilities. 
2. Выделите скопированный файл (в нашем примере это файл MY _TEST_SCAL) в списке файлов 

сегментов в памяти BBG. 
3. Установите и примените значение масштабирования (в нашем примере применяется масштабирование 

70%): нажмите клавиши Scale Waveform Data > Scaling > 70 > % > Apply to Waveform. 

 = выборки 

Исходный  
пилообразный сигнал 
 

Масштабированный  
пилообразный сигнал 
 

 Полная шкала ЦАП 100% 
 
 85% от полной шкалы – начальное   
 масштабирование 
 60% от полной шкалы – конечное  
 масштабирование 

 



Глава 8: Основные цифровые операции (опция 653/655/656/657)  

Руководство по эксплуатации    117   N5171B, N5172B, N5181B, N5182В 
 

8.9 Установка смещения полосы частот модулирующих сигналов 
Смещение полосы частот модулирующих сигналов характеризует значение для смещения частоты 
модулирующих сигналов до ± 50 МГц в пределах сигнального частотного диапазона 100 МГц генератора 
модулирующих сигналов (BBG) в зависимости от варианта BBG. На следующем рисунке показано, как 
обратиться к элементам управления, используя меню сдвоенного проигрывателя Dual ARB, однако 
местонахождение функциональной клавиши Baseband Frequency Offset (смещение полосы частот 
модулирующих сигналов) одинаково в пределах каждого формата ARB (через функциональную клавишу 
ARB Setup). 
Когда смещение полосы частот модулирующих сигналов не равно нулю, аппаратный фазовращатель накап-
ливает фазовый сдвиг модулирующего сигнала. Эта остаточная фаза сохраняется, даже когда смещение 
полосы частот модулирующих сигналов возвращается к 0 Гц. Чтобы удалить это накопление фазы, следует 
либо переключиться в другой режим, либо нажать функциональную клавишу Baseband Frequency Offset 
Phase Reset. Эта функциональная клавиша не действует, когда равна нулю фаза, вызванная смешением 
частоты. Кроме того, когда в сигнале присутствует отличная от нуля остаточная фаза, функция защиты 
ЦАП от перегрузки автоматически обеспечивает применение ограниченного внутреннего масштабирования, 
которое отменяется, когда возвращается к нулю и смещение частоты, и фаза. 
 

 
  Рис. 8-13 Функциональная клавиша Baseband Frequency Offset для режима Dual ARB Player 
 
Обычные применения функции смещения включают в себя следующее: 
 смещение несущей от паразитного просачивания сигнала гетеродина (всплеск сигнала на несущей 

частоте); 
 суммирование модулирующего сигнала с внешними входами I и Q для формирования сигнала с 

несколькими несущими; 
 применение сигнала I/Q генератора сигналов в качестве сигнала промежуточной частоты (IF). 

      ПРИМЕЧАНИЕ        
Изменение смещения полосы частот модулирующих сигналов может привести к перегрузке ЦАП с 
выводом сообщения об ошибке 628, Baseband Generator DAC over range. Генератор сигналов 
имеет встроенную функцию автоматического масштабирования для минимизации вероятности 
возникновения такой ситуации. За дополнительной информацией обращайтесь к подразделу 8.9.1. 

Установки параметров в этом меню  
можно сохранить в заголовке файла  
(см. раздел 8.4) 

 

Устанавливает значение  
смещения полосы частот  
модулирующих сигналов. 
 
Обнуляет накопление фазы  
и фазовый сдвиг.  
Вызывает скачок фазы   
модулирующего сигнала. 
 
 
 
 
подраздел 8.9.1 
 
 
подраздел 8.17 
 
 
подраздел 8.16 

 

глава 9 
 
 
глава 9 

 
подраздел 8.8.3 

Для выяснения функций клавиш пользуйтесь встроенной справкой  
по клавишам, как описано в разделе 3.2. 
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Значение смещения частоты модулирующего сигнала является одним из параметров заголовка файла (см. 
раздел 8.4); это означает, что вы можете сохранить это значение в памяти с файлом модулирующего 
сигнала. Когда вы выбираете модулирующий сигнал с занесенным в память значением смещения частоты, 
генератор сигналов изменяет текущее значение для согласования со значением заголовка. Если для 
данного модулирующего сигнала нет занесенного в память значения смещения частоты, то генератор 
сигналов использует последнее установленное значение смещения частоты. 
Вы можете также пользоваться функцией Save (см. подраздел 3.8.6) для сохранения этого значения в 
качестве одного из параметров настройки генератора сигналов. Когда вы вызываете (Recall) набор 
параметров генератора сигналов, занесенный в память функцией Save, то это значение смещения частоты 
становится элементом текущей настройки прибора независимо от значения, занесенного в память с 
заголовком файла. 
Действуйте, как описано ниже, чтобы отстроить несущую от просачивания сигнала гетеродина. В этом 
примере используется заводской файл модулирующего сигнала SINE_TEST_WFM, доступный в режиме 
Dual ARB Player. Чтобы посмотреть выходной сигнал в этом примере, присоедините вход анализатора 
спектра к выходу RF OUTPUT генератора сигналов. 
1. Выберите модулирующий сигнал и включите его воспроизведение: 

а) Нажмите клавиши Mode > Dual ARB > Select Waveform. 
б) В столбце Segment On BBG Media выберите сегмент SINE_TEST_WFM. 
в) Нажмите клавишу Select Waveform. 

2. Включите генерирование модулирующего сигнала: нажмите клавишу ARB Off On на On. 
3. Сконфигурируйте сигнал несущей: 

а) Установите частоту несущей 1 ГГц. 
б) Установите амплитуду 0 дБм. 
в) Включите выход ВЧ сигнала RF OUTPUT. 

4. Нажмите клавиши Mode > Dual Arb > ARB Setup > More > Baseband Frequency Offset > 20 MHz. 
Теперь модулированный ВЧ сигнал смещен от несущей частоты на 20 МГц, как показано на следующих 
рисунках. 

 
Модулированная несущая с нулевым смещением  
полосы частот модулирующего сигнала 

Модулированная несущая со смещением  
полосы частот модулирующего сигнала  
на 20 МГц  Модулированный ВЧ сигнал 

    
У анализатора спектра установлена ширина обзора 100 МГц 

8.9.1 Условия перегрузки ЦАП и масштабирование 
При применении смещения полосы частот модулирующего сигнала (при установке отличного от нуля 
смещения) возможно возникновение состояния перегрузки ЦАП, которое приводит к появлению сообщения 
об ошибке. Для минимизации вероятности возникновения такого состояния с функцией смещения полосы 
частот в генераторах Agilent MXG/EXG используется встроенная функция защиты ЦАП от перегрузки, 
которая уменьшает масштаб данных I/Q в 1/2 раз, когда смещение не равно нулю. Поскольку такое 
уменьшение масштаба может быть чрезмерным, то при этом уменьшается динамический диапазон 
модулирующего сигнала. Особенно это заметно при применении такого сигнала с постоянной амплитудой, 
как GSM. 

Просачивание гетеродина/несущ. 
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В режиме Dual ARB Player можно выключить эту функцию защиты ЦАП от перегрузки. Когда эта функция 
включена, то она действует на сигнал Dual ARB только тогда, смещение не равно нулю. Местонахождение 
функциональной клавиши управления этой функцией показано на этом рисунке. 

  
 Рис. 8-14 Местонахождение функциональной клавиши DAC Over-Range Protection 
 
 Пояснение к рис. 8-14 

DAC Over-Range Protection – По умолчанию принята установка на On. Эта функциональная клавиша 
доступна только тогда, когда включен режим Phase Noise или AWGN, а также когда установлено 
отличное от нуля значение смещения полосы частот модулирующих сигналов. 
Устанавливайте на Off, когда вы хотите установить масштабирование вручную при использовании 
функции смещения полосы частот модулирующих сигналов. При ручной установке масштабирования 
пользуйтесь функциональной клавишей Waveform Runtime Scaling (см. выше). 
Функциональная клавиша DAC Over-Range Protection включает и выключает автоматическое 
внутреннее масштабирование для предотвращения появления сообщений о перегрузке ЦАП при 
использовании режимов Phase Noise, AWGN и функции Frequency Offset. Это автоматическое 
масштабирование может быть чрезмерным (особенно для сигнала с постоянной амплитудой), уменьшая 
таким образом динамический диапазон больше, чем это необходимо. 
Когда выключена эта защита ЦАП, автоматическое масштабирование не работает, поэтому следует 
применять масштабирование модулирующего сигнала в реальном времени (см. подраздел 8.8.3), чтобы 
скорректировать масштабный коэффициент до наибольшего значения, при котором не возникает 
перегрузка ЦАП. 
Поскольку защита от перегрузки ЦАП работает только с тремя перечисленными выше функциями, эта 
функциональная клавиша не действует (выделяется серым цветом), даже если включена защита. 

В режиме Dual ARB Player во избежание чрезмерного масштабирования или просто для выполнения 
масштабирования вручную выключите эту функцию и пользуйтесь функциональной клавишей Waveform 
Runtime Scaling для устранения состояний перегрузки ЦАП. 

Когда выключена функция защиты  
ЦАП от перегрузки, то для  
устранения перегрузки ЦАП  
следует уменьшить  
масштабирующее значение, как 
описано в подразделе 8.8.3. 
 

см. Пояснение к рис. 8-14 
 
 
 
раздел 8.17 Для выяснения функций клавиш пользуйтесь встроенной справкой  

по клавишам, как описано в разделе 3.2. 
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8.10 Синфазно-квадратурная (I/Q) модуляция 
Составляющие модуля вектора погрешности определяются следующими факторами: 
 Различия в амплитуде, фазе и задержке между каналами I и Q 
 Смещения постоянной составляющей 
Меню I/Q не только позволяет вам выбрать источник сигнала I/Q и выход, но и обеспечивает средства 
регулировки и калибровки для компенсации различий между сигналами I и Q. См. также раздел 3.7. 
 

 
 
 Рис. 8-15 Дисплей и функциональные клавиши 

Эта панель отображает текущие  
установки параметров для  
маршрутизации сигнала I/Q и  
оптимизированный тракт коррекции I/Q. 

 

Эта панель отображает текущее состояние и установки  
параметров регулировки I/Q. Для прокрутки списка этих  
параметров пользуйтесь клавишами Page Up и Page  
Down. Серым цветом обозначается незадействованная  
(Off) регулировка. 

 

Эти варианты 
 выбора  
отражаются на   
графике I/Q Routing  
& Optimization. 

 

 см. Пояснение 1) 
 
 
 см. Пояснение 2) 
 

 см. Пояснение 3) 
 
 
 см. Пояснение 4) 
 
 
 
 
 
 
 
 
 
 
 
 
 

 см. Пояснение 5) 

Каждый тракт требует различных значений оптимизации;  
когда вы выбираете тракт, то выбираете индивидуальные 
значения оптимизации, которые требует этот тракт. 

Генератор сигналов применяет выбранные значения  
оптимизации ко всем трактам, что ухудшает невыбранные 
тракты. 

 

 

 

Для выяснения функций клавиш пользуйтесь встроенной 
справкой по клавишам, как описано в разделе 3.2. 

 раздел 8.11 
 
 
 раздел 8.12 
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 Пояснения к рис. 8-15 
1) Int Phase Polarity Invert – Инвертирует генерируемый прибором сигнал Q так, чтобы составляющая I 

отставала на 90° от составляющей Q. 
2) Burst Envelope (огибающая пакета) – Применяется только с генерируемыми прибором форматами 

пакетной модуляции. Включает и выключает ВЧ пакетный модулятор. 
3) Int Equalization Filter – Открывает внутренний корректирующий фильтр, который можно использовать 

для коррекции и/или искажения выходов RF и External I/Q для внутреннего источника I/Q. 
4) Optimize Int I/Q Channel For EVM ACP – Выбирает вариант оптимизации внутреннего канала I/Q в 

отношении модуля вектора погрешности EVM (внутриканальная характеристика) за счет ухудшения 
показателя АСР (мощность в соседнем канале – внеканальная характеристика) либо вариант 
оптимизации АСР за счет ухудшения показателя EVM. 

 В варианте EVM применяется фильтр Найквиста 80% (ширина полосы 100 МГц) с широкой 
переходной полосой. Когда задействован корректирующий фильтр (Equalization Filter), данный 
фильтр не действует. 

 В варианте АСР также применяется фильтр Найквиста 80% (ширина полосы 100 МГц), но с очень 
узкой переходной полосой, благодаря чему уменьшается вклад зеркальных боковых компонентов у 
широкополосных сигналов. Этот фильтр подвергается свертке с действующим корректирующим 
фильтром и внутриканальным корректирующим фильтром (если он включен), результат которого 
отсекается до 256 центральных отводов. 

 Команды SCPI: 

  
5) Int Channel Correction –  Включает и выключает применение сигнала ВЧ внутреннего генератора 

модулирующих сигналов, а также коррекцию амплитуды и фазы модулирующего сигнала в полосе 
частот модулирующих сигналов 160 МГц на текущей частоте ВЧ сигнала. 

 Когда включена эта функция, то переключение на произвольную частоту при включенном генераторе 
модулирующих сигналов занимает дополнительно от 3,3 мс (тип.) до 6,8 мс, когда эта частота 
задается впервые. После этого переключение на эту частоту занимает дополнительно 1,3 мс. 

 В кэш-память можно занести до 1024 индивидуальных значений частоты, прежде чем из памяти будет 
вытеснено самое старое значение частоты. Если действует развертка частоты, то вычисление и 
кэширование производится авансом для первых 1024 индивидуальных значений частоты, а для всех 
последующих значений частоты будет действовать характеристика переключения на произвольную 
частоту. 

 Когда параметр I/Q Correction Optimized Path установлен на Ext I/Q Output, применяется только 
внутриполосная коррекция, и скорость переключения частоты не ухудшается. 

 Эта коррекция подвергается свертке с фильтром Optimize Int I/Q Channel For EVM ACP и корректи-
рующим фильтром (Equalization Filter), если они задействованы. Результирующий фильтр 
отсекается до 256 центральных отводов. 

 Команды SCPI: 
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8.10.1  Применение выходов I и Q на задней панели 
      ПРИМЕЧАНИЕ        
Соединители I и Q на задней панели выводят сигнал только при использовании внутреннего генератора 
модулирующих сигналов. 
Помимо модуляции несущей, генератор сигналов выводит на соединители I и Q на задней панели 
генерируемые внутри него сигналы I и Q. Эти сигналы выводятся после ЦАП, поэтому они являются 
аналоговыми. Вы можете использовать эти сигналы для следующих целей: 
 возбуждение каскада системного передатчика; 
 испытание отдельных I/Q-компонентов, например, I/Q-модуляторов; 
 подача сигналов I и Q на другой генератор сигналов. 
В принятой по умолчанию заводской установке параметров на выходные соединители I и Q на задней 
панели выводятся генерируемые прибором сигналы I и Q. Однако для оптимизации сигналов на задней 
панели (применения калибровочных коэффициентов) вы должны выбрать тракт внешнего вывода I/Q. 

Выбор и воспроизведение модулирующего сигнала 
1. Нажмите клавиши Mode > Dual ARB > Select Waveform. 
2. Выделите нужный модулирующий сигнал. 
3. Нажмите клавиши Select Waveform > ARB Off On на On. 

Оптимизация сигнального тракта 
1. Присоедините кабели от соединителей I и Q на задней панели к объекту испытаний или к другому 

генератору сигналов. 
 Когда вы включаете режим ARB, генератор автоматически выводит сигналы I и Q на соединители на 

задней панели. Вы можете использовать эти сигналы в качестве сигналов I и Q для другого генератора 
сигналов. Для этой цели генераторы сигналов серии MXG/EXG снабжены входными соединителями I и Q 
на передней панели. 

2. Нажмите клавиши I/Q > I/Q Correction Optimized Path > Ext I/O Output. 
Когда вы оптимизируете тракт, светится зеленый индикатор этого тракта. 

 

  

Заводская установка:  
оптимизирован тракт RF OUT 

 

Оптимизирован тракт I/Q OUT (задняя панель) 
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8.10.2  Конфигурирование входов на передней панели 
Генератор сигналов принимает внешние аналоговые сигналы I и Q через входные соединители I Input и Q 
Input на передней панели. Вы можете использовать внешние сигналы в качестве источника модуляции или 
суммировать внешние сигналы с сигналами внутреннего генератора модулирующих сигналов. 
1. Подайте внешние сигналы I и Q на соединители на передней панели. 

а) Подайте аналоговый сигнал I на вход I Input на передней панели генератора сигналов. 
б) Подайте аналоговый сигнал Q на вход Q Input на передней панели генератора сигналов. 

2. Установите генератор сигналов на распознавание сигналов, подаваемых на соединители на передней 
панели: 
 Для модуляции несущей 

Нажмите клавиши I/Q > I/Q Source > External. 
 

Дисплей генератора сигналов: калиброваны оба тракта, когда параметр I/Q 
Correction Optimized Path установлен на Ext I/Q Output (см. стр. 118 и 119). 

Примечание: Когда оптимизированный тракт установлен на RF, калиброван 
только тракт RF Out. 

 
 Для суммирования и модуляции несущей 

Нажмите клавиши I/Q > I/O Source > Sum. 
За информацией о том, как выбирать и воспроизводить 
модулирующий сигнал для тракта BB GEN, обращайтесь к 
подразделу 8.2.3. 

 
Дисплей генератора сигналов: калиброваны оба тракта ВЧ, когда параметр I/Q 
Correction Optimized Path установлен на RF Output (см. стр. 118 и 119). 

 
Имейте в виду, что только внутренний генератор модулирующих сигналов (BBG GEN) выводит сигналы 
на выходы I и Q на задней панели. 

3. Если вы используете только внешние сигналы I и Q (без суммирования), включите I/Q-модулятор. Для 
этого нажмите клавишу I/Q On Off на On. 

4. Сконфигурируйте выход ВЧ сигнала: 
а) Установите несущую частоту. 
б) Установите амплитуду несущей. 
в) Включите выход RF OUTPUT. 
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8.11 Настройка I/Q-модуляции 
Пользуйтесь элементами настройки I/Q-модуляции для коррекции сигналов I/Q или для внесения в них 
искажений. 

 
 Пояснение 5) Пояснение 6)   

 
 Пояснения к рисунку 

1) Значения постоянной составляющей (DC Offset) калибруются относительно среднеквадратического 
значения напряжения модулирующего сигнала, который воспроизводится и выводится 
проигрывателем ARB (см. подраздел 8.3.4). 

2) Сигнал I/Q масштабируется с коэффициентом 0,7071 для всех фазовых сдвигов, кроме 0. 
Применяйте значение –360 или +360, если желательно поддерживать постоянный уровень мощности 
при выключенной функции ALC во время подстройки фазы I/Q. 

3) Пункт Skew (рассогласование) обычно используется либо для внесения искажений, либо для 
снижения векторной погрешности на сигналах с широкой полосой частот. 
Обеспечивает коррекцию относительной задержки между сигналами I и Q. Различия трактов 
прохождения сигналов I и Q проявляются в различиях задержки, которые вызывают возникновение 
погрешности EVM у модулированных сигналов с широкой полосой частот. 
Внесение одинаковой и противоположной задержки (Skew) в сигналы I/Q во время генерирования 
модулирующих сигналов устраняет погрешность от задержки, компенсируя всякие задержки сигналов, 
которые генерируются внутренним генератором модулирующих сигналов. 

Регулирует амплитуду сигнала I относительно амплитуды сигнала Q. Пользуйтесь 
этой опцией для внутреннего внесения искажений или для  компенсации различий 
потерь в сигнальном тракте, которые возникают вследствие  неоднородностей 
тракта у внешних кабельных соединений выходов I и Q. 

 

Пояснение 1) 

Эта функция обеспечивает регулировку абсолютной фазы внутреннего канала I/Q  
за счет вращения обоих сигналов I и Q, благодаря чему регулируется относительная 
фаза ВЧ несущей. Для опции 012 это единственный способ подстройки фазы ВЧ  
сигнала для прибора с внешним гетеродином. 
 

 

Пояснение 2) 
 

 
Фазовые сдвиги сигнала Q относительно 
фазы сигнала I. Клавиша квадратурной 
подстройки калибруется в градусах. 
Квадратурная подстройка внешнего входного 
сигнала не калибруется. 
Функция, реализуемая этой клавишей, 
отличается от функции, реализуемой 
клавишей I/Q Skew. 

 

Доступны только при  
воспроизведении  

модулирующего сигнала 

 

 

Пояснение 3) 

  Пояснение 4) 
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4) Функциональная клавиша I/Q Attenuator влияет на сигнал I/Q на выходе RF OUTPUT и на выходах 
External I/Q. 
Эта функциональная клавиша действует, когда оптимизированный тракт I/Q установлен на Ext I/Q 
Output и включена функция цифровой модуляции. Это ослабление допускает подстройку с помощью 
функциональной клавиши Mod Attenuator, которая находится в меню Arb Setup у каждой функции. На 
эту подстройку не оказывает влияния клавиша I/Q Adjustments On/Off. 
Когда выбран режим Auto, генератор сигналов автоматически оптимизирует ослабление I/Q для 
текущих условий. Когда выбран режим Manual, функция I/Q Attenuation является активной функцией. 
Введенное вами значение устанавливает уровень ослабления сигнала I/Q. 
Команды SCPI (обращайтесь к командам для каждой функции): 

 
5) Параметры смещения (Offset) обычно используются либо для снижения просачивания несущей, либо 

для внесения искажения, имитирующего просачивание несущей. 
Common Mode I/Q Offset Range – Это переключает диапазон регулировки параметра Common Mode 
I/Q Offset (синфазное смещение I/Q) с грубой регулировки Coarse (принята по умолчанию) на точную 
регулировку (Fine) и обратно. Диапазон грубой регулировки соответствует принятому по умолчанию 
значению ± 2,5 В. Диапазон точной регулировки соответствует значению ± 100 мВ.  
Common Mode I/Q Offset – Это регулирует смещение постоянной составляющей одновременно у 
обоих сигналов I и Q. 
Diff Mode I Offset – Это регулирует смещение постоянной составляющей выходных сигналов I и I. 
Здесь невозможна независимая регулировка сигналов I и I. 
Diff Mode Q Offset – Это регулирует смещение постоянной составляющей выходных сигналов Q и Q. 
Здесь невозможна независимая регулировка сигналов Q и Q. 

6) I/Q Delay – Изменяет абсолютную фазу обоих сигналов I и Q по отношению к сигналам запуска и 
маркерам. 
Положительные значения вносят задержку, а отрицательные значения вызывают опережение 
сигналов. Это значение оказывает влияние на сигнал модуляции несущей и на внешние входные 
сигналы I и Q. Эту установку невозможно использовать при модуляции с постоянной огибающей, и 
она не влияет на внешние входы I и Q. 

 
Таблица 8-2 Использование регулировок I/Q 

Регулировка I/Q Эффект Искажения 
Offset (смещение) Просачивание несущей Смещение постоянной  

составляющей 
Quadrature Angle  
(квадратурный угол) 

Погрешность EVM Фазовое рассогласование 
Зеркальные боковые компоненты I/Q Задержка в тракте I/Q 

I/Q Skew (рассогласование I/Q) Погрешность EVM Фазовое рассогласование при  
высокой частоте выборок или  
задержка в тракте I/Q 

I/Q Gain Balance  
(баланс усиления I/Q) 

Различие амплитуд I/Q Отношение коэффициентов  
усиления I/Q 

I/Q Phase (фаза I/Q) Вращение фазы I/Q Подстройка фазы ВЧ сигнала 
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8.12 Калибровка I/Q 
Калибровку I/Q применяют для коррекции сигналов I и Q. Подлежащие коррекции аспекты сигналов I и Q 
зависят от того, генерируются ли сигналы внутри прибора, или же подаются извне. 

Коррекция Внутренние сигналы I и Q Внешние сигналы I и Q 
Смещение Х Х 
Баланс усиления Х Х 
Квадратурная погрешность Х Х 
 
Когда вы выполняете калибровку I/Q, эти данные калибровки приобретают приоритет над данными 
заводской калибровки. Процедура калибровки улучшает рабочие характеристики, которые могут 
ухудшаться с течением времени или вследствие изменений температуры. Калибровку I/Q следует 
выполнять при изменении температуры окружающей среды как минимум на ± 5°С от температуры, при 
которой производилась предыдущая калибровка. 
 Пользовательская калибровка является перманентной (постоянно действующей). Другими словами, 

выполнение предустановки прибора или выключение питания не удаляет из памяти данные 
пользовательской калибровки I/Q. 

 Если установить одинаковое значение начальной и конечной частоты, то калибровка будет выполнена 
точно на этой частоте, и данные будут сохраняться в элементах набора ограниченной калибровки. 

 

  
 
 Пояснение к рисунку  

Вариант DC оптимизирует характеристики I/Q для текущей установки набора параметров прибора. Эта 
калибровка обычно длится несколько секунд. Изменение установки какого-либо параметров прибора 
отменяет калибровку DC и восстанавливает данные пользовательской (User) калибровки (или данные 
заводской калибровки, если отсутствуют данные пользовательской калибровки). 
Вариант User обеспечивает быструю калибровку, когда не требуется полная (Full) калибровка. Вы 
можете ограничить объем калибровки, если зададите значения начальной и конечной частоты 
калибровки. 
Когда вы ограничиваете частотный диапазон калибровки, то для остальной части рабочего частотного 
диапазона прибора используются данные заводской калибровки. Если установить одинаковое значение 
начальной и конечной частоты, то калибровка будет выполнена точно на этой частоте, и данные будут 
сохраняться в элементах набора ограниченной калибровки. Эти данные остаются в памяти при 
выключении питания и выполнении предустановки прибора (см. ниже ПРЕДОСТЕРЕЖЕНИЕ). 
Полная калибровка (Full) занимает примерно минуту; при этом выполняются измерения во всем 
рабочем частотном диапазоне прибора. Эти данные остаются в памяти при выключении питания и 
выполнении предустановки прибора (см. ниже ПРЕДОСТЕРЕЖЕНИЕ). 

Примечание: Для калибровки DC требуются следующие установки параметров: 
 I/Q: On 
 Optimized Path: RF Output 
 Source: Internal   

см. Пояснение 

Эти функциональные клавиши доступны  
только тогда, когда Calibration Type = User. 
 

Удаляет данные пользовательской калибровки  
и восстанавливает данные заводской калибровки. 
 
 

Для выяснения функций клавиш пользуйтесь встроенной 
справкой по клавишам, как описано в разделе 3.2. 
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  ПРЕДОСТЕРЕЖЕНИЕ    
Во избежание потери данных, установок параметров GPIB или текущей пользовательской настройки 
параметров прибора, которые не сохраняются в долговременной (энергонезависимой) памяти, для 
выключения генератора сигналов всегда следует пользоваться кнопкой выключателя на передней панели 
или соответствующей командой SCPI. Генераторы сигналов, которые установлены в стойках и 
выключаются общим выключателем питания стойки вместо собственного выключателя питания, выводят 
сообщение об ошибке Error -310 ввиду неправильного выключения питания. 

8.13 Применение корректирующего фильтра (Equalization Filter) 
Файл корректирующего фильтра FIR можно создать на другом оборудовании, загрузить через SCPI, затем 
выбрать из файловой системы (см. раздел 3.8). За информацией о загрузке коэффициентов файла FIR 
обращайтесь к Руководству по программированию (Programming Guide). За информацией о ручной 
обработке коэффициентов файла FIR обращайтесь к разделу 8.15. 
Этот фильтр можно использовать для коррекции и/или искажения выходов RF и External I/Q для 
внутреннего источника I/Q. Этот фильтр подвергается свертке с фильтром оптимизации внутреннего канала 
I/Q в отношении АСР (если он задействован), результат которого отсекается до 256 центральных отводов. 
Этот корректирующий фильтр работает с частотой выборок 200 МГц, поэтому все корректирующие 
фильтры необходимо переключить на частоту выборок 200 МГц перед их выбором, если они работают с 
другой частотой выборок. 
Генератор сигналов MXG/EXG поддерживает корректирующие фильтры Complex или Real, которые 
представляют собой программируемые фильтры с конечной импульсной характеристикой (FIR), с двумя 
входами (I, Q) и двумя выходами (I, Q) на каждую выборку. Этот 256-отводный фильтр имеет два режима 
работы: 
 Real – Выборки I и Q фильтруются независимым образом с отдельным набором действительных 

(реальных) коэффициентов. 
 Complex – Выборки обрабатываются в виде комплексных величин (I + jQ) и подвергаются свертке с 

коэффициентами фильтра, которые задаются как (I + jQ) во временной области. 
Корректирующий фильтр можно включать и выключать. 

      ПРИМЕЧАНИЕ        
Максимальное количество отводов равно 256 (с двумя коэффициентами на каждый отвод у комплексного 
фильтра). Минимальное количество отводов равно 2. 
Корректирующие фильтры называют также фильтрами предискажений или фильтрами предварительной 
коррекции. 
 
 I/Q > More 

 
 
 Рис. 8-16 Функциональные клавиши Int Equalization Filter 

Включает внутренний корректирующий фильтр. 

 

см. Пояснение 

 

подраздел 8.14.1 

 

 

Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, 
как описано в разделе 3.2. 

 

 раздел 8.10 
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 Пояснение к рис. 8-16 
Select Filter – Открывает каталог файлов фильтров FIR для выбора корректирующего фильтра. 
Корректирующие фильтры являются обычно комплексными и должны иметь коэффициент избыточности 
выборок 1. Этот фильтр должен иметь не более 256 отводов (512 коэффициентов у комплексного 
фильтра). Корректирующий фильтр работает при частоте выборок 200 МГц, поэтому все 
корректирующие фильтры должны быть настроены на эту частоту выборок перед внесением их в 
генератор сигналов. 

      ПРИМЕЧАНИЕ        
Для просмотра коэффициентов фильтра пользуйтесь табличным редактором FIR (см. раздел 8.15). 
Команды SCPI: 
Состояние корректирующего фильтра: 

 
Выбор корректирующего фильтра: 

 
Добавление реального фильтра к файловой системе: 

 
Добавление комплексного фильтра к файловой системе: 

 
Добавление данных символов I/Q к файловой системе: 

 
За дополнительной информацией обращайтесь к Справочнику по командам SCPI (SCPI Command Refe-
rence). 
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8.14 Применение фильтров с конечной импульсной характеристикой 
(FIR) в фильтре модуляции Dual ARB в реальном времени 

Фильтры с конечной импульсной характеристикой можно применять для компрессирования сигналов I/Q с 
одной несущей до групповых точек I/Q с дальнейшим определением переходов аналогично тому, как это 
делается у фильтра модуляции в режиме специальной модуляции Arb Custom (см. раздел 11.5). Основной 
отличительной особенностью модуляции Dual ARB в реальном времени является то, что фильтр здесь 
применяется в процессе воспроизведения модулирующего сигнала, а не применяется к самим данным 
модулирующего сигнала. 
 
Mode > Dual ARB > Arb Setup > More > Real-Time Modulation Filter 

 
 Рис. 8-17 Меню Filter 
 
 Пояснение к рис. 8-17 

Select (Root Nyquist) – Включает и выключает фильтр модуляции. Этот фильтр обычно применяется к 
модулирующему сигналу произвольной формы (Arb), который содержит просто решающие точки 
символов I/Q. Тогда фильтр модуляции эффективно определяет переходы между решающими точками 
символов. Это означает, что фильтр должен иметь коэффициент избыточности выборок 2 или более. 
Когда задействована эта функция, частота следования символов (Symbol Rate) равна частоте 
синхронизации выборок (Sample Clock Rate). Кроме того, этот фильтр должен быть реальным (см. 
раздел 8.16). 

Открывает  
меню выбора  
фильтра IS-95. 
 
раздел 8.15 

 подраздел 8.14.1 

 раздел 8.13 

Эта функциональная клавиша  
изменяется в зависимости от  

выбранного типа фильтра. 
 

Доступно только тогда, когда  
выбран фильтр Gaussian. 
 

Доступно только тогда, когда выбран   
фильтр Root Nyquist или Nyquist. 

 

 см. Пояснение 

Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам,  
как описано в разделе 3.2. 
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8.14.1  Создание пользовательского фильтра FIR с помощью табличного редактора 
FIR 

В этой процедуре применяется табличный редактор FIR Values для создания и сохранения в памяти 
8-символьного взвешивающего фильтра типа sinc function с коэффициентом избыточности выборок 4. 

Обращение к табличному редактору 
1. Нажмите клавишу Preset. 
2. Нажмите клавиши Mode > Dual ARB > Arb Setup > More > Real-Time Modulation Filter > Select > 

Nyquist. 
3. Нажмите клавишу Define User FIR. 
4. Нажмите клавиши More 1 of 2 > Delete All Rows > Confirm Delete of All Rows. 
Это выводит на экран редактор табличных значений, как показано на рис. 8-18. 
 

 

 
 Рис. 8-18 Создание пользовательского фильтра FIR с помощью табличного редактора FIR 
 
 Пояснение к рис. 8-18 

Convert to Real Filter – Добавляет столбец для задания мнимых коэффициентов фильтра*. (Все мнимые 
коэффициенты первоначально равны нулю). Если была нажата функциональная клавиша Convert to 
Complex Filter, то становится доступной функциональная клавиша Convert to Real Filter. 
*  Предостережение: Выбор функциональной клавиши Convert to Real Filter удаляет столбец Imagi-

nary Values, в результате чего теряются мнимые значения. 
 

      ПРИМЕЧАНИЕ        
Фильтры модуляции должны быть реальными и иметь коэффициент избыточности выборок (OSR) 2 или 
выше. 
Корректирующие фильтры обычно являются комплексными и должны иметь коэффициент избыточности 
выборок (OSR), равный 1. 

Этот пункт активен только тогда,  
когда таблица коэффициентов FIR  
содержит минимум два видимых  
значения. 
 

Открывает меню, которое  
позволяет вам выбрать и  
загрузить файл  
во временную память  
(см. раздел 3.3). 

подраздел 8.15.1 
 
 
 
 
см. Пояснение 
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Ввод значений коэффициентов 
1. Нажмите функциональную клавишу Return, чтобы перейти на первую страницу табличного редактора. 
2. С помощью курсора выделите поле Value для коэффициента 0. 
3. С помощью цифровой клавиатуры введите первое значение (–0.000076) из таблицы 8-3. При нажатии 

цифровых клавиш появляются соответствующие цифры в поле ввода. Если вы сделаете ошибку, то ее 
можно исправить с помощью клавиши забоя Bk Sp.  

4. Продолжайте вводить значения из таблицы, пока не введете все 16 значений. 

Таблица 8-3 

 

Дублирование первых 16 коэффициентов с помощью зеркальной таблицы 
У взвешивающего фильтра типа sinc function вторая половина коэффициентов идентична первой половине, 
но в обратном порядке. Генератор сигналов обеспечивает функцию зеркальной таблицы, которая 
автоматически дублирует имеющиеся коэффициенты в обратном порядке. 
1. Нажмите клавишу Mirror Table. Теперь автоматически генерируются последние 16 коэффициентов 

(коэффициенты 16 ÷ 31) и выделяется первый из этих коэффициентов (номер 16), как показано на рис. 
8-19. 

 
Значения коэффициентов таб-
лицы FIR могут быть приня-
тыми по умолчанию заводскими 
значениями либо могут быть 
введены пользователем. 

 
Пользуйтесь меню Goto Row для перемещения по строкам и внесения  
изменений в таблицу коэффициентов FIR Values. 

 Рис. 8-19 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
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Установка коэффициента избыточности выборок 

      ПРИМЕЧАНИЕ        
Фильтры модуляции должны быть реальными и иметь коэффициент избыточности выборок (OSR) 2 или 
выше. 
Корректирующие фильтры обычно являются комплексными и должны иметь коэффициент избыточности 
выборок (OSR), равный 1 (см. разделы 8.13 и 8.16). 
Коэффициент избыточности выборок (OSR) представляет собой количество коэффициентов фильтра на 
каждый символ. Приемлемый диапазон значений составляет от 1 до 32; максимальное количество отводов, 
которое допускается табличным редактором, равно 1024. 
Реальные предельные значения OSR, количество коэффициентов и количество символов зависят от 
функции, с которой применяется фильтр FIR. См. таблицу 8-4. 

Таблица 8-4 

Тип фильтра Коэффициент 
избыточности  
выборок (OSR) 

Количество  
отводов  
(макс.) 

Количество  
символов/коэффициентов  

(макс.) 
Equalization 1) 1 256 – 
ARB Custom Modulation 2) 

 2 – 512 / 1024 
Dual ARB Real-Time Modulation 3) 

 2 – 32 / 1024 

1) Когда задействованы функции I/O Timing Skew , I/Q Delay или ACP Internal I/Q Channel Optimization, уменьшается 
эффективное количество отводов для корректирующего (Equalization) фильтра. 

2) Допускаются выборки фильтра с более высоким или более низким OSR. 
3) Фильтр будет подвергаться децимации до OSR = 16 или ниже в зависимости от частоты следования символов. 
 
Для фильтров модуляции: Если коэффициент OSR отличается от внутреннего оптимально выбранного 
коэффициента OSR, то у фильтра автоматически устанавливается оптимальное значение OSR. 
В этом примере нужное значение OSR равно 4 (принято по умолчанию), поэтому здесь не требуется 
никаких действий. 

Графическое отображение характеристики фильтра 
Генератор сигналов обладает способностью отображения характеристик фильтра как во временной, так и в 
частотной области. 
1. Нажмите клавиши More 1 of 2 > Display Filter > Display FFT (быстрое преобразование Фурье). 

На дисплее отображается график результата быстрого преобразование Фурье (см. рис. 8-20). 
 

  
 Рис. 8-20 
 
2. Нажмите клавишу Return. 
3. Нажмите клавишу Display Impulse Response. 

Теперь отображается график импульсной характеристики (см. рис. 8-21). 
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 Рис. 8-21 
 
4. Нажмите клавишу Return, чтобы вернуться к клавишам меню. 

Сохранение файла фильтра в памяти 
Чтобы сохранить файл фильтра в памяти, действуйте следующим образом: 
1. Нажмите клавиши Load/Store > Store To File. На экране появляется каталог файлов FIR с индикацией 

доступного размера памяти. 
2. Присвойте файлу имя FIR_1 и сохраните его в памяти, как описано в разделе 8.2. 
Файл FIR_1 является первым файлом в списке. (Если вы ранее занесли в память другие файлы FIR, то их 
имена перечисляются ниже имени файла FIR_1). В списке отображается тип файла (FIR) и его размер 
(268 байт). Отображается также размер использованной памяти (36kB used). Количество файлов, которые 
можно сохранить, зависит от размера файлов и от размера использованной памяти. См. рис. 8-22. 
 

  
Каталог отображает файлы FIR, которые были ранее занесены в память пользователем. 

 Рис. 8-22 
 
Память содержит также файлы состояний прибора и файлы развертки по списку. 
Теперь можно использовать этот фильтр для создания пользовательского (специального) формата 
модуляции, а также в качестве основы для разработки нового фильтра. 

Эти клавиши управляют  
таблицей файлов DMOD  
во внутренней памяти. 
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8.15 Изменение параметров фильтра FIR с помощью табличного  
редактора FIR 

Фильтры FIR, файлы которых хранятся в памяти генератора сигналов, можно модифицировать с помощью 
табличного редактора FIR. Вы можете загрузить табличный редактор FIR с коэффициентами из 
пользовательских файлов FIR, хранящихся в энергонезависимой памяти, или из одного принятых по 
умолчанию файлов FIR. Тогда вы сможете изменить значения и сохранить в памяти новые файлы. 

8.15.1  Загрузка принятого по умолчанию гауссовского фильтра FIR 

 
 Рис. 8-23 Загрузка принятого по умолчанию гауссовского фильтра FIR 
 
1. Нажмите клавишу Preset. 
2. Нажмите клавиши Mode > Dual ARB > Arb Setup > More > Real-Time Modulation Filter > Define User FIR 

> More > Load Default FIR > Gaussian. 
3. Нажмите клавиши Filter BbT > 0.300 > Enter. 
4. Нажмите клавиши Filter Symbols > 8 > Enter. 
5. Нажмите клавишу Generate. 

      ПРИМЕЧАНИЕ        
Реальный коэффициент избыточности выборок во время модуляции автоматически выбирается 
прибором. Выбирается значение от 4 до 16 в зависимости от частоты следования символов, количества 
битов на символ у данного типа модуляции и количества символов. 

6. Нажмите клавиши Display Filter > Display Impulse Response.  
 Отображается график импульсной характеристики (см. рис. 8-24). 
7. Нажмите клавишу Return. 

Для выяснения функций клавиш пользуйтесь встроенной   
справкой по клавишам, как описано в разделе 3.2. 
 

Эти функциональные клавиши  
выбирают функцию окна  

(функцию аподизации)  
для фильтра. 
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 Рис. 8-24 

8.15.2  Изменение коэффициентов фильтра 
1. С помощью клавиш со стрелками выделите коэффициент 15. 
2. Нажмите клавиши 0 > Enter. 
3. Нажмите клавишу Display Impulse Response. 
 Отображение графика (см. рис. 8-25) может оказаться полезным средством выявления неполадок. В 

данном случае по графику видно, что неправильно установлено значение коэффициента, в результате 
чего искажается форма гауссовской импульсной характеристики. 

 

  
 Рис. 8-25 
 
4. Нажмите клавишу Return. 
5. Выделите коэффициент 15. 
6. Нажмите клавиши 1 > Enter. 

8.15.3  Сохранение файла фильтра в памяти 
Максимальная длина имени файла составляет 23 символа (буквенно-цифровые и специальные символы). 
1. Нажмите клавиши Return > Return > Load/Store > Store To File. 
2. Присвойте файлу имя NEWFIR2. 
3. Нажмите клавишу Enter. 
Текущее содержание редактора значений FIR сохраняется в файле в каталоге памяти. В каталоге файлов 
FIR появляется новый файл. 



Глава 8: Основные цифровые операции (опция 653/655/656/657)  

Руководство по эксплуатации    136   N5171B, N5172B, N5181B, N5182В 
 

8.16 Установка параметров фильтра модуляции в реальном времени 
Фильтр модуляции в реальном времени эффективно компрессирует сигнал I/Q с одной несущей до 
групповых точек I/Q с дальнейшим определением переходов аналогично тому, как это делается у фильтра 
модуляции в режиме специальной модуляции Arb Custom. Основной отличительной особенностью этого 
фильтра является то, что он применяется в процессе воспроизведения модулирующего сигнала, а не 
применяется к самим данным модулирующего сигнала. Фильтр модуляции в реальном времени доступен 
только для модулирующих сигналов в режиме Dual ARB (сдвоенный проигрыватель сигналов произвольной 
формы). 
Когда включен этот фильтр, частота следования символов равна частоте синхронизации выборок. Частота 
синхронизации выборок должна быть установлена вдвое меньше частоты выборок, чтобы можно было 
включить функцию фильтра модуляции Arb. Частота выборок определяется генератором модулирующих 
сигналов (опция 65х). 

  ПРЕДОСТЕРЕЖЕНИЕ    
Поскольку формат Arb поддерживает только прямоугольные данные I/Q для определения решающей точки 
у символов I/Q, то здесь не поддерживается модуляция с постоянной огибающей, которая должна 
задаваться амплитудой и фазой. Примерами модуляции с постоянной огибающей являются MSK 
(манипуляция с минимальным сдвигом) и FSK (частотная манипуляция). 
Несущая частота должна быть одинаковой для всех применяемых частот. Другими словами, фильтры 
модуляции Arb в реальном времени могут применяться только с одной несущей. 
 
 
Mode > Dual ARB > Arb Setup > More 

 
 
 Рис. 8-26 Функциональные клавиши фильтра модуляции в реальном времени  

для режима Dual ARB Player 

Установки параметров в этом меню можно  
сохранить в заголовке файла (раздел 8.4). 

 

 раздел 8.14 

Это доступные фильтры  
модуляции в реальном  
времени, которые можно  
применять к модулирую-
щему сигналу. 
 

Для выяснения функций клавиш пользуйтесь встроенной   
справкой по клавишам, как описано в разделе 3.2. 
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Функцию фильтра модуляции в реальном времени обычно применяют в следующих случаях: 
 когда известны решающие точки у идеальных прямоугольных символов I/Q с одной несущей и должен 

применяться фильтр с избыточной дискретизацией; 
 когда требуется повышенный эффективный размер памяти MXG/EXG; 
 когда вы работаете с низкочастотным модулирующим сигналом, позволяющим использовать преиму-

щества высокого коэффициента избыточной дискретизации без удлинения модулирующего сигнала. 
Набор параметров фильтра модуляции в реальном времени является частью параметров заголовка файла 
(раздел 8.4); это означает, что вы можете сохранить этот набор параметров вместе с данными 
модулирующего сигнала. Когда вы выбираете модулирующий сигнал с занесенным в память набором 
параметров фильтра, генератор сигналов изменяет текущую настройку для согласования с набором 
параметров занесенного в память заголовка файла. Если для данного модулирующего сигнала нет 
занесенного в память набора параметров фильтра модуляции, то генератор сигналов применяет последний 
установленный набор параметров фильтра. 
Вы можете также пользоваться функцией Save (подраздел 3.8.6) для сохранения этого значения в качестве 
части набора параметров генератора сигналов. Когда вы вызываете (Recall) набор параметров, занесенный 
в память функцией Save, значение фильтра модуляции становится частью текущей настройки прибора 
независимо от занесенного в память значения в заголовке файла. 
Следуйте описанной ниже процедуре, чтобы применить фильтр модуляции в реальном времени к 
модулирующему сигналу, загруженному во временную память. В этом примере используется поставляемый 
с завода файл SINE_TEST_WFM, имеющийся у сдвоенного проигрывателя сигналов произвольной формы. 
Чтобы посмотреть спектр выходного сигнала в этом примере, присоедините вход анализатора спектра к 
выходу генератора RF OUTPUT. 

      ПРИМЕЧАНИЕ        
В следующем описании предполагается, что вы выполнили установку параметров, описанную в разделе 8.9 
для создания модулированного ВЧ сигнала, смещенного на 20 МГц от несущей частоты. 
1. Сконфигурируйте фильтр модуляции: 
 Нажмите клавиши Mode > Dual ARB > Arb Setup > More > Real-Time Modulation Filter > Select > Root 

Nyquist. 
2. Нажмите клавиши Filter Alpha > .4 > Enter. 

Теперь при модуляции ВЧ сигнала используется фильтр модуляции в реальном времени, 
представляющий собой корневой фильтр Найквиста с параметром Alpha = 0,400. 

8.17 Синхронизация нескольких генераторов модулирующих сигналов 
Эта функция в меню Dual ARB позволяет вам настроить систему типа Master/Slave (ведущий/ведомый), 
состоящую максимум из 16 генераторов сигналов Agilent MXG/EXG, чтобы синхронизировать генераторы 
модулирующих сигналов (BBG) при воспроизведении модулирующих сигналов. Один из этих генераторов 
сигналов используется в качестве ведущего прибора (Master). 
Генератор сигналов MSG/EXG с опцией 012 позволяет реализовать конфигурации оборудования 2х2, 3х3 
или 4х4 входа-выхода для совместного использования сигнала внешнего гетеродина с целью построения 
фазово-когерентной системы. За дополнительной информацией обращайтесь к разделу 8.18 и к 
Бюллетеню технических данных (Data Sheet). 

      ПРИМЕЧАНИЕ        
Функция синхронизации BBG автоматически конфигурирует установки параметров запуска, показанные на 
рис. 8-27. Во избежание ошибок от конфликта установок параметров в этом процессе, следует вручную 
установить параметры запуска, прежде чем устанавливать параметры синхронизации BBG, показанные на 
рис. 8-28. 
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 Рис. 8-27 Синхронизация нескольких генераторов модулирующих сигналов (синхронизация BBG): 

функциональные клавиши запуска и их местонахождение в меню 
 
 Пояснения к рис. 8-27 

1) Trigger Type –Синхронизация BBG автоматически переключает тип запуска на Trigger and Run, если 
текущей установкой является Free Run или Gated. При желании установите вручную иной вариант у 
главного прибора или у ведомых приборов (либо у тех, и других) до или после конфигурирования 
параметров настройки синхронизации BBG. 

 Варианты Free Run и Gated недоступны при применении синхронизации BBG. 
2) Примечание: Ошибка от конфликта установок параметров возникает, когда в момент выбора 

назначения Master/Slave действуют следующие установки параметров запуска: 
Master: 
 Тип запуска Free Run или Gated 
Slave: 
 Тип запуска Free Run или Gated 
 Источник запуска Ext Polarity Neg 

см. раздел 8.6  

см. раздел 8.2  

см. стр. 137 

Эта функциональная клавиша не  
действует у ведомых (Slave) приборов  
и действует только у главного прибора  
(Master). 
 

Принятые по умолчанию установки  
параметров ведомого прибора  
(Slave). Эти установки параметров 
недоступны после выбора прибора  
в качестве ведомого. 
 
 

Принятые по умолчанию установки  

параметров главного прибора (Master).  
Вы можете изменить эти установки   
параметров после назначения прибора  
в качестве главного (ведущего) прибора. 
 
 

 Neg – эта установка принята по  
умолчанию. При выборе прибора  
в качестве ведомого (Slave) эта  
установка меняется на Pos.  
При желании можно вручную изменить  
эту установку на Pos, прежде чем  
выбирать прибор в качестве ведомого. 
 
 

 
 
 
 см. Пояснение 2) 
 

 

 
  см. Пояснение 1) 
 
 

Для выяснения функций клавиш  
пользуйтесь встроенной справкой по 
клавишам, как описано в разделе 3.2. 
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Mode > Dual ARB > Arb Setup > More > Multi-BBG Sync Setup 

Экран ведущего прибора (Master) и доступные функциональные клавиши 

 

 
 
Выбрать Off, Master или Slave 

Это постоянно действующая уста-
новка, на которую не влияет пред-
установка (Preset) и выключение  
питания. 

Эта клавиша недоступна у главного  
прибора и действует только  
у ведомых приборов. 

 

Синхронизирует генераторы  
модулирующих сигналов у всех  
приборов в системе. 

Примечание: Нажимать только  
после нажатия клавиши Listen for  
Sync у всех ведомых приборов,  
у которых после этого должно  
отображаться состояние "Waiting For 
Sync" (ожидание синхронизации). 

Индикатор Master/Slave и блок-схема системы Главный прибор (Master) индицирует  
одно из следующих сообщений: 
  Out of Sync (нет синхронизации) 
  In Sync (есть синхронизация) 
   Отображается после нажатия клавиши Sync Slaves. 
 

Экран ведомого прибора (Slave) и доступные функциональные клавиши 

 

 
 
Выбрать Off, Master или Slave 

 

Это постоянно действующие уста-
новки, на которые не влияет пред-
установка (Preset) и выключение  
питания. 

 

 

 

После нажатия этой клавиши  
ведомый прибор ожидает сигнал  
синхронизации от главного прибора. 

Примечание: Нажать до нажатия 
клавиши Sync Slaves у главного  
прибора. 

Индикатор Master/Slave и блок-схема системы 
Нижний индикатор Slave является зеленым  
у последнего ведомого прибора в системе. 

Ведомый прибор (Slave) индицирует  
одно из следующих сообщений: 
  Out of Sync (нет синхронизации) 
  Waiting for Sync (ожидание синхронизации) 
   Отображается после нажатия клавиши Listen for Sync 
  In Sync (есть синхронизация) 
   Отображается после нажатия клавиши Sync Slaves  
   у главного прибора 

 
 Рис. 8-28 Экраны приборов при синхронизации нескольких генераторов модулирующих сигналов 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

8.17.1  Описание системы Master/Slave 
Системная задержка 
Функция синхронизации нескольких генераторов модулирующих сигналов обеспечивает возможность 
построения системы для синхронизации генерирования модулирующих сигналов у максимум 16 генерато-
ров сигналов с номинальной задержкой ± 8 нс между ведущим прибором и последним ведомым прибором. 
Эту небольшую задержку можно снизить до пикосекундного разрешения с помощью функциональной 
клавиши I/Q Delay, которая находится в меню I/Q. Для снижения задержки проверьте и скорректируйте 
фазирование сигналов BBG у каждого генератора сигналов в системе. За дополнительной информацией о 
подстройке задержки обращайтесь к разделу 8.11. 
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Значение задержки включает в себя компенсацию задержки распространения сигналов в кабелях (не более 
1 нс между соединителями EVENT 1 и PAT TRIG – см. подраздел 8.17.2). Рекомендуется применять кабели 
Agilent с соединителями BNC (номер для заказа 10502А). Применение кабелей с более высокой задержкой 
распространения сигналов может не позволить добиться надлежащей синхронизации генераторов 
сигналов. 

Системная синхронизация 
Синхронизация возникает после того, как ведущий (главный) генератор сигналов пошлет однократный 
импульс события, который распространяется к каждому ведомому прибору (и через каждый ведомый 
прибор) в системе. Перед этим событием каждый ведомый прибор должен распознать, что он ожидает этот 
импульс, который появляется во время конфигурирования системы (см. подраздел 8.17.3). Чтобы можно 
было правильно передать импульс синхронизации, должны быть выключены источник запуска и Dual ARB 
Player у каждого генератора сигналов. 
Система Master/Slave не содержит обратной связи между ведомыми приборами и генератором сигналов, 
выбранным в качестве ведущего прибора. Если после синхронизации появляются изменения в меню Multi-
BBG Sync Setup или в систему добавляют генератор сигналов, ведущий прибор не может автоматически 
заново синхронизировать систему. Это может привести к тому, что у генераторов сигналов в системе будет 
ошибочно индицироваться состояние In Sync. 
Система может также ошибочно интерпретировать другие сигналы (кроме импульса синхронизации), что 
проявляется в неправильной индикации состояния In Sync. К этим сигналам относятся сигналы 
периодического запуска или сигнал активного маркера, подаваемый на соединитель EVENT 1. Ошибки в 
подключении кабелей к соединителям на задней панели также могут быть причиной ошибочной индикации 
состояния. 
Вы должны заново синхронизировать всю систему после внесения изменений в одно или все меню Multi-
BBG Sync Setup, после добавления в систему генератора сигналов или в случае возникновения сомнений в 
правильности индикации состояния генератора сигналов. На системную синхронизацию не влияют 
изменения таких параметров, которые находятся вне меню Multi-BBG Sync Setup, например, файлы 
модулирующих сигналов, состояние Dual ARB, частота выборок, масштабирование, несущая частота или 
амплитуда несущей. Чтобы заново синхронизировать систему, обращайтесь к подразделу 8.17.4. 

Установка параметров системного запуска 
Функция синхронизации нескольких генераторов модулирующих сигналов ограничивает выбор вариантов 
запуска (см. рис. 8-27) у каждого генератора сигналов. У генераторов сигналов, выбранных в качестве 
ведомых приборов, вы можете изменять лишь тип запуска (да и то с ограничениями). Источник запуска 
фиксирован и установлен на прием сигнала запуска через соединитель PAT TRIG на задней панели. У 
ведущего прибора вы можете изменять как тип запуска (с ограничениями), так и источник запуска. У вас 
есть три варианта выбора источника запуска модулирующих сигналов: внешний запуск, клавиша Trigger на 
передней панели и запуск через шину GPIB. 
Если установлены параметры запуска, отличающиеся от тех, которые поддерживаются функцией 
синхронизации генераторов модулирующих сигналов, то эта функция изменяет параметры запуска на те, 
что показаны на рис. 8-27. Когда происходит это переключение, на дисплее генератора сигналов серии 
MXG/EXG появляется сообщение об ошибке от конфликта установок параметров для предупреждения 
пользователя об изменениях. Для предотвращения конфликта установок параметров следует 
соответствующим образом сконфигурировать установки параметров запуска до назначения генератору 
сигналов статуса ведущего или ведомого прибора. 
Сигнал системного запуска распространяется таким же образом, как и импульс синхронизации, 
инициированный ведущим прибором (см. выше описание "Системная синхронизация"). Поэтому если не 
выключить его во время внесения изменений в параметры синхронизации, он может вызвать ошибочную 
индикацию состояния In Sync. 
Генератор сигналов не переустанавливает параметры запуска после выключения функции синхронизации 
нескольких генераторов BBG. Для воспроизведения модулирующих сигналов после отключения этой 
функции вы должны либо установить тип запуска на Free Run, либо обеспечить запуск для возобновления 
воспроизведения модулирующих сигналов. 
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8.17.2  Структурная схема оборудования 
      ПРИМЕЧАНИЕ        
Для минимизации задержки синхронизации рекомендуется применять кабель Agilent BNC 10502А для 
гирляндного соединения соединителей на задней панели (см. подраздел 8.17.1). 
 
 

 

Если вы не пользуетесь клавишей Trigger, то 
следует обеспечить источник внешнего запуска.  
За описанием соединителя PAT TRIG 
обращайтесь к стр. 19. 
 
 
Эта система может включать в себя от одного до 
15 ведомых (Slave) приборов. 

 Рис. 8-29 Структурная схема оборудования для синхронизации нескольких генераторов модулирующих 
сигналов 

8.17.3  Конфигурирование системы 
Установка общих параметров 
Выполните следующие операции на всех генераторах сигналов: 
1. Установите частоту сигнала несущей. 
2. Установите уровень мощности сигнала несущей. 
3. Выберите интересующий вас модулирующий сигнал (см. раздел 8.2). 
 Не включайте Dual ARB. 
4. Установите такие параметры модулирующего сигнала (за исключением параметров запуска), как 

маркеры и частоту выборок. 
Функция синхронизации нескольких генераторов модулирующих сигналов ограничивает выбор 
вариантов запуска как для ведущего прибора, так и для ведомых приборов. Если установлены 
параметры запуска, отличающиеся от тех, которые поддерживаются функцией синхронизации 
генераторов модулирующих сигналов, то на дисплее генератора сигналов серии MXG/EXG появляется 
сообщение об ошибке от конфликта установок параметров и производится изменение параметров 
запуска. Для предотвращения конфликта установок параметров следует вручную установить параметры 
запуска, как показано на рис. 8-27, до установки параметров синхронизации нескольких генераторов 
модулирующих сигналов. 

5. Включите выход ВЧ сигнала (RF OUTPUT). 

Установка параметров синхронизации у ведущего прибора (Master) 
1. Нажмите клавиши Mode > Dual ARB > ARB SETUP > More > Multi-BBG Sync Setup > Multi-Bbg Sync 

Type > Master. 
2. Установите количество ведомых приборов с помощью функциональной клавиши Number of Slaves. 
3. Если нужно, измените параметры запуска (см. рис. 8-27). 
 Ведущий (Master) генератор сигналов допускает изменение типа запуска и источника запуска. 
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а) Вернитесь в меню Dual ARB (см. рис. 8-27). 
б) Установите желаемый тип запуска и источник запуска. 
в) Вернитесь в меню Multi-BBG Sync Setup. 

Установка параметров синхронизации у ведомых (Slave) приборов 
1. Нажмите клавиши Mode > Dual ARB > ARB SETUP > More > Multi-BBG Sync Setup > Multi-Bbg Sync 

Type > Slave. 
2. Установите количество ведомых приборов с помощью функциональной клавиши Number of Slaves. 
3. Установите позицию ведомого прибора в системе, которую занимает данный генератор сигналов. 
 В системе может быть до 15 ведомых приборов. 
4. Нажмите функциональную клавишу Listen for Sync и проследите за тем, чтобы на дисплее появилось 

сообщение Waiting for Sync в области индикации состояния (Status). 

5. Если нужно, выберите другой тип запуска. 
а) Вернитесь в меню Dual ARB (см. рис. 8-27). 
б) Установите желаемый тип запуска. 
в) Вернитесь в меню Multi-BBG Sync Setup. 

6. Повторите эти операции для каждого ведомого генератора сигналов в системе. 

Синхронизация системы 
Выполняйте эту процедуру только после установки параметров у ведущего и у ведомых генераторов 
сигналов. При повторной синхронизации системы действуйте, как описано в подразделе 8.17.4. 
1. Нажмите функциональную клавишу Sync Slaves у ведущего прибора. 

      ПРИМЕЧАНИЕ        
Все генераторы сигналов в системе Master/Slave должны быть синхронизированы заново после внесения 
изменений в параметры приборов и после добавления в систему ведомого прибора, даже если после 
нажатия функциональной клавиши Listen for Sync у ведомых приборов появляется сообщение In Sync. 

2. Проследите за тем, чтобы у всех генераторов сигналов индицировалось состояние In Sync. 

Запуск и воспроизведение модулирующего сигнала 
1. У всех генераторов сигналов нажмите клавиши Mode > Dual ARB > ARB On Off на On. 
2. Подайте сигнал запуска на ведущий генератор сигналов. 

8.17. 4  Внесение изменений в настройку синхронизации и повторная 
синхронизация   системы Master/Slave 

Система должна быть синхронизирована заново после внесения изменений в параметры Master/Slave и 
после добавления в систему ведомого прибора, даже если у приборов появляется сообщение In Sync в 
секции Status дисплея. 
1. Выключите источник запуска. Если вы пользуетесь для запуска клавишей Trigger, то ничего выключать 

не нужно. 
 Если включен источник запуска, посылающий непрерывную последовательность импульсов, то это 

может привести к ошибочной индикации состояния In Sync после нажатия функциональной клавиши 
Listen for Sync. 

2. На каждом генераторе сигналов нажмите клавиши Mode > Dual ARB > ARB Off On на Off. 
 Если во время внесения изменений у генератора сигналов будет включен режим Dual ARB, то у других 

приборов в цепочке может ошибочно индицироваться состояние In Sync после нажатия 
функциональной клавиши Listen for Sync. 

3. На каждом генераторе сигналов нажмите клавиши ARB Setup > More > Multi-BBG Sync Setup. 
4. Внесите изменения в меню Multi-BBG Sync Setup. 
 Появляется индикация состояния Out Of Sync. 
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5. На каждом генераторе сигналов нажмите клавишу Listen for Sync. 
6. Проследите за тем, чтобы у всех ведомых приборов индицировалось состояние Waiting for Sync. 

Если вместо этого индицируется состояние In Sync, действуйте следующим образом: 
а) Проверьте правильность присоединения кабелей к соединителям PATT TRIG и EVENT 1 на задней 

панели. Отсоединенный кабель может быть причиной ложной индикации состояния In Sync. 

б) Если кабели присоединены, выполните операции по пунктам 1 и 2. 
в) Нажмите функциональную клавишу Listen for Sync и убедитесь в наличии индикации состояния 

Waiting for Sync. 
7. На ведущем генераторе сигналов нажмите клавишу Sync Slaves. 
8. Проследите за тем, чтобы у всех генераторов сигналов в системе Master/Slave появилась индикация 

состояния In Sync. 

9. Выполните процедуру, описанную под заголовком "Запуск и воспроизведение модулирующего сигнала" 
на предыдущей странице. 

8.18 Применение опции 012 (вход-выход гетеродина для фазовой  
когерентности) с синхронизацией нескольких генераторов  
модулирующих сигналов 

      ПРИМЕЧАНИЕ        
Материал этого раздела составлен в предположении, что вы ознакомились с предыдущим разделом (8.17) и 
усвоили его содержание. Если нет, то прочтите сначала раздел 8.17, прежде чем приступать к изучению 
информации, представленной в настоящем разделе. 
Генератор сигналов MSG/EXG с опцией 012 позволяет реализовать конфигурации оборудования 2х2, 3х3 
или 4х4 MIMO для совместного использования сигнала внешнего гетеродина с целью построения фазово-
когерентной системы (см. также раздел 8.17). 
Фазовая когерентность ВЧ сигналов может не требоваться для общего тестирования приемника 
STC/MIMO, поскольку приемник MIMO воспринимает фазовые различия между источниками как часть 
состояний канала и вносит соответствующую коррекцию. Однако фазовая когерентность ВЧ сигналов 
может быть желательной в ряде применений, в частности, при исследованиях и разработках, а также в 
системах формирования диаграммы направленности. 

8.18.1  Конфигурирование опции 012 с MIMO 
Для стандартной системы синхронизации нескольких генераторов модулирующих сигналов рекомендуется 
применять кабель Agilent BNC (номер для заказа 10502А). Этот же кабель рекомендуется для применения с 
опцией 012 (см. также рис. 8-29 на стр. 139). Дополнительно для соединений 2х2, 3х3 и 4х4 MIMO от 
соединителей LO IN и LO OUT до делителя мощности требуются дополнительные кабели (см. таблицу 8-5, 
рис. 8-30 и рис. 8-31 на следующих страницах). 

        У К АЗ АН И Е         
Мы рекомендуем устанавливать заглушку на неиспользуемый выход LO OUT.  
Если удалить кабельную перемычку LO IN/OUT у прибора, который находится в режиме Dual ARB, то 
прибор становится разбалансированным и у него появляется сообщение об ошибке Unlevel. 
Все испытательное оборудование требует 12-часового прогрева для обеспечения необходимой точности. 
Конфигурирование фазовой когерентности требует выполнения следующих условий: 
 Рекомендуемый уровень возбуждения на входе LO должен находиться в диапазоне 0 ÷ 6 дБм. 

      ПРИМЕЧАНИЕ        
Уровень возбуждения 0 ÷ 6 дБм на входе LO обеспечивает работу приборов во всем частотном 
диапазоне и в полном температурном диапазоне 0 ÷ 55°С. 
(Необходимая входная мощность LO зависит от температуры. При температуре окружающей среды от 
20°С до 30°С может оказаться достаточным уровень мощности < 0 дБм – см. Бюллетень технических 
данных (Data Sheet)). 
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 Необходимо выполнить калибровку I/Q и самопроверку при установленной на место кабельной 
перемычке LO IN/OUT. Если нет возможности выполнить калибровку I/Q, то можно вручную 
скорректировать смещение (offset) у генератора модулирующих сигналов, чтобы свести к минимуму 
значения смещения I/Q. 

 Функция фазовой когерентности применяется только к режиму модуляции Dual ARB. 
 Все кабели от выхода делителя мощности до входов приборов должны иметь одинаковую длину. 
 
Таблица 8-5 Оборудование опции 012 (вход-выход гетеродина для фазовой когерентности) 

Конфигурация  
MIMO 

Номер  
для заказа 1) 

Длина  
кабеля 

Примечания 

2х2 – согласно   
необходимости 

Гибкие кабели SMA присоединяют от выходов дели-
теля мощности к входам LO на задней панели 
ведущего прибора и ведомых приборов MXG/EXG.  
См. рис. 8-30. 

 11636А – Делитель мощности 0 ÷ 18 ГГц (cм. www.agilent.com) 
3х3 – согласно   

необходимости 
Гибкие кабели SMA присоединяют от выходов дели-
теля мощности к входам LO на задней панели 
ведомых приборов MXG/EXG. См. рис. 8-31. 

 PS3-20-451/12 S – 3-Way Pulser Microwave Corp., трехканальные  
делители Wilkinson 

4х4 – согласно   
необходимости 

Гибкие кабели SMA присоединяют от выходов дели-
теля мощности к входам LO на задней панели 
ведомых приборов MXG/EXG. См. рис. 8-31. 

 PS4-16-452 S – 4-Way Pulser Microwave Corp., четырехканальные  
делители Wilkinson 

Все 10502А 22,86 см  
(9 дюймов) 

См. рис. 8-30 и 8-31. 
См. также раздел 8.17. 

1) У всех конфигураций MIMO от выхода делителя мощности к входам у ведущего и ведомых приборов присоединя-
ются гибкие кабели SMA одинаковой длины (см. рис. 8-30 и 8-31). 

Конфигурация 2х2 MIMO (вход-выход гетеродина для фазовой когерентности) 
Для системы 2х2 MIMO выходной сигнал гетеродина (LO) от ведущего генератора сигналов MXG/EXG 
может подаваться через делитель мощности и использоваться в качестве входного сигнала LO как для 
ведущего, так и для ведомых генераторов сигналов. Внешний источник здесь не требуется. 
Для генерирования фазово-когерентных сигналов в конфигурации 2х2 MIMO выход LO OUT ведущего 
генератора MXG соединяется через делитель мощности с входом LO IN ведомого прибора. Выход LO OUT 
при прямом соединении обеспечивает амплитуду сигнала гетеродина, достаточную для возбуждения 
ведомых генераторов MXG/EXG, обеспечивая таким образом фазовую когерентность выходных ВЧ 
сигналов. В этом примере показаны два генератора сигналов MXG с опцией 012, соединенные для 
реализации фазово-когерентной системы 2х2 MIMO (см. рис. 8-30). 

      ПРИМЕЧАНИЕ        
Для оптимизации фазовой когерентности рекомендуется применять гибкие кабели SMA одинаковой длины 
для соединения выхода двухканального делителя мощности с входами LO IN генераторов сигналов с 
опцией 012 (см. стр. 141). 
Для минимизации задержки синхронизации рекомендуется применять кабель Agilent BNC 10502А для 
гирляндных соединений соединителей EVENT 1 и PAT TRIG на задней панели (см. стр. 141). 
  

http://www.agilent.com/
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 Рис. 8-30 Схема соединений оборудования 2х2 MIMO 

Конфигурации 3х3 MIMO и 4х4 MIMO (вход-выход гетеродина для фазовой когерентности) 
Для построения системы 3х3 и 4х4 MIMO (вход-выход гетеродина для фазовой когерентности) необходим 
дополнительный аналоговый источник, чтобы обеспечить повышенный уровень мощности LO, 
необходимый для работы делителя мощности и дополнительных приборов. 
Разветвление выхода LO на четыре канала приводит к значительному снижению мощности возбуждения 
входа LO у генераторов N5172B/82B в этой системе. Кроме того, здесь отсутствует регулировка амплитуды 
на выходе LO генераторов N5172B/82B. Для генерирования фазово-когерентных сигналов в конфигурациях 
3х3 MIMO и 4х4 MIMO необходим внешний ведущий гетеродин (Master LO), чтобы обеспечить достаточную 
амплитуду входного сигнала LO у векторных генераторов MXG/EXG (см. рис. 8-31). 

      ПРИМЕЧАНИЕ        
Ведущий гетеродин (Master LO) не управляется программой Signal Studio, но должен быть настроен 
пользователем  вручную на нужную частоту и амплитуду через установки параметров на ведущем 
генераторе сигналов. 
 

 
 Рис. 8-31 Схема соединений оборудования 3х3 и 4х4 MIMO 

Делитель  
мощности 

 

Двухантенный  
объект испытаний 

 

Четырехканальный  
делитель мощности 
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      ПРИМЕЧАНИЕ        
Рекомендуется применять гибкий кабель SMA для соединений входа четырехканального делителя 
мощности и с соединителями LO IN и LO OUT генераторов сигналов с опцией 012 (см. стр. 141). 
Для оптимизации фазовой когерентности рекомендуется применять гибкие кабели SMA одинаковой длины 
для соединения выхода четырехканального делителя мощности с входами LO IN генераторов сигналов с 
опцией 012 (см. стр. 141). 
Для минимизации задержки синхронизации рекомендуется применять кабель Agilent BNC 10502А для 
гирляндных соединений соединителей EVENT 1 и PAT TRIG на задней панели (см. стр. 141). 

8.19 Приложения для создания сигналов в реальном времени 
Генераторы сигналов Agilent серии Х обеспечивают доступ к нескольким приложениям для создания 
сигналов в реальном времени. 
 

 
 Рис. 8-32 Функциональные клавиши приложений для создания сигналов в реальном времени 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

Здесь отображаются лицензированные приложения  
Signal Studio. 

Обращайтесь на сайт www.agilent.com/find/signalstudio.  

 раздел 8.1 
 

 раздел 11.1 
 

 раздел 11.1 

 глава 12 

 глава 9 
 
 
 глава 10 
 
 
 
 
 раздел 8.6 

http://www.agilent.com/find/signalstudio
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8.20 Лицензирование модулирующих сигналов 
Лицензирование модулирующих сигналов позволяет вам лицензировать сигналы, файлы которых 
загружаются из приложения Signal Studio для неограниченного воспроизведения вашим генератором 
сигналов. Каждая опция лицензирования (221 – 229) позволяет вам навсегда лицензировать до пяти 
файлов модулирующих сигналов или (250 – 259) навсегда лицензировать до 50 файлов модулирующих 
сигналов по вашему выбору. Другими словами, опция 22х и опция 25х являются бессрочными лицензиями 
на модулирующие сигналы. 
Сигналы, лицензированный с опцией 221 – 229 или с опцией 250 – 259, не подлежат замене на другие 
сигналы. Как только сигнал будет лицензирован, эта лицензия становится бессрочной и не подлежит отзыву 
или замене. Лицензии на сигналы (опции 22х и 25х) являются индивидуальными для данного генератора 
сигналов (т.е. для его серийного номера). Если лицензированный файл опции 22х или 25х переносится на 
другой генератор сигналов, то до того, как можно будет воспроизводить этот файл, он должен быть 
лицензирован отдельной опцией 22х или 25х, которая находится в другом генераторе сигналов. 
Чтобы выкупить опцию 22х или 25х, обращайтесь к документу N5182B-2xx Entitlement Certificate, который 
прилагается к заказу на N5182B-2xx. За дополнительной информацией об извлечении и загрузке файлов 
модулирующих сигналов обращайтесь к Руководство по программированию (Programming Guide). 

8.20.1  Описание лицензирования модулирующих сигналов 
Для построения и загрузки файлов модулирующих сигналов пользуйтесь любой программой из пакета 
N76xxB Signal Studio. Каждая опция 22х обеспечивает 5 доступных слотов, а лицензия опции 25х 
обеспечивает 50 доступных слотов, где вы можете добавить и воспроизводить модулирующие сигналы в 
течение пробного периода в 48 часов на каждый слот. В течение этого времени вы можете воспроизводить 
модулирующий сигнал сколько угодно раз, пока не поймете, подходит ли он к вашим потребностям. По 
истечении пробного периода исчезает возможность воспроизведения модулирующего сигнала в этом 
слоте, пока слот не будет заблокирован для неограниченного воспроизведения. Тем не менее вы можете 
заменить модулирующий сигнал в этом слоте другим сигналом по вашему выбору, прежде чем блокировать 
слот. 
Для лицензирования дополнительных модулирующих сигналов в количестве, превышающем допустимое 
количество для опции 22х или 25х, вы должны приобрести другую опцию 22х или 25х, которую вы еще не 
имеете. Например, если у вас уже есть опция 250, вы можете приобрести опцию 251 для добавления 
дополнительных 50 слотов. Добавление всех опций 250 – 259 обеспечивает максимум 500 слотов. 
Добавление всех опций 221 – 229 обеспечивает максимум 45 слотов. (Повторное приобретение одной и той 
же опции не дает вам дополнительных лицензий на модулирующие сигналы). 

8.20.2  Установка опции N5182-22х или опции N5182B-25х 
Загрузите в генератор сигналов лицензию на модулирующие сигналы (опция N5182-22x или N5182B-25х) с 
использованием утилиты License Manager или USB-накопителя. За дополнительной информацией о 
загрузке лицензии на модулирующие сигналы обращайтесь к документу N5182B-2xx Entitlement Certificate, 
который прилагается к вашему заказу.  

8.20.3  Лицензирование модулирующего сигнала на генераторе сигналов 
Создайте и загрузите в генератор сигналов файл модулирующего сигнала с использованием любой 
программы из пакета N76xxB Signal Studio. Обращайтесь к справочной системе программы Signal Studio, 
если вам нужна дополнительная информация по применению этого приложения. 
Обращайтесь к стр. 149 за описанием процедуры внесения модулирующего сигнала в слот лицензии на 48-
часовой пробный период. В течение пробного периода можно воспроизводить и заменять модулирующий 
сигнал сколько угодно раз. По истечении пробного периода исчезает возможность воспроизведения 
модулирующего сигнала в этом слоте, пока слот не будет заблокирован для неограниченного 
воспроизведения. 
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Обзор функциональных клавиш лицензирования модулирующих сигналов 

Mode > Dual ARB > More 

 

Примечание: Модулирующие сигналы, лицензированные с опцией 2хх, невозможно заменить 
другими сигналами. Как только модулирующий сигнал будет заблокирован в лицензионном 
слоте, эта лицензия становится бессрочной и не подлежит отзыву или замене. 
 
 
 
Эта функциональная клавиша доступна только тогда, когда на этом приборе установлена опция 2хх. 

При нажатии этой функциональной клавиши  на экране отображается лицензионный статус и связан-
ное с ним имя файла для каждого слота, а также пути доступа к вариантам выбора в меню лицензи-
рования модулирующих сигналов. 

Примечание: При первоначальном обращении к пункту Waveform Licensing все слоты индицируются 
как Available (доступны). Обращайтесь к таблице 8-6 (стр. 148) за описанием статуса лицензирования 
после добавления в слот модулирующих сигналов. 

 Пояснение 1) 

 

 
 
 
Пояснение 2) 
 
 
 
Пояснение 3) 
 
 
 
 

Пояснение 4) 
 
 
 
 
 

Пояснение 5) 

 
 Рис. 8-33 Функциональные клавиши лицензирования модулирующих сигналов 
 
 Пояснения к рис. 8-33 

1) Add Waveform To First Available Slot – Эта функциональная клавиша позволяет вам добавить 
выбранный вами модулирующий сигнал в первый доступный слот (см. стр. 147). 

2) Replace Waveform In Slot – эта функциональная клавиша позволяет вам заменить модулирующий 
сигнал в выбранном слоте (см. стр. 148). 

3) Clear Waveform From Slot – Эта функциональная клавиша удаляет модулирующий сигнал из 
выбранного слота. 

4) Lock Waveform In Slot – Эта функциональная клавиша позволяет вам заблокировать модулирующий 
сигнал в слоте. По истечении пробного периода необходимо заблокировать модулирующий сигнал в 
слоте, чтобы можно было его воспроизводить (см. стр. 148). 

5) Goto Slot – Эта функциональная клавиша позволяет вам выбрать определенный слот, где вы можете 
добавлять, заменять или удалять модулирующие сигналы. Вы можете также выбрать слот с помощью 
клавиш со стрелками на передней панели или путем прокрутки до слота (см. стр. 147). 

Обращайтесь к Справочнику по командам SCPI  
за описанием соответствующих команд лицензирования. 
 
Для выяснения функций клавиш пользуйтесь встроенной 
справкой по клавишам, как описано в разделе 3.2. 
 

стр. 148  
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Mode > Dual ARB > More > Waveform Licensing > Add Waveform to First Available Slot 
 или 
Mode > Dual ARB > More > Waveform Licensing > Replace Waveform in Slot 

 
 
 Рис. 8-34 Функциональные клавиши лицензирования модулирующих сигналов 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

      ПРИМЕЧАНИЕ        
Модулирующие сигналы, лицензированные с опцией 2хх, нельзя поменять на другие. Как только слот 
будет заблокирован, лицензия на сигнал в этом слоте становится бессрочной и не подлежит отзыву или 
замене. 

Эта функциональная клавиша  
выделяется серым цветом, если  
если модулирующий сигнал уже  
лицензирован или не требует  
лицензирования. 
 

Для выбора сигнала  
пользуйтесь клавишами со  
стрелками, чтобы выделить  
файл сигнала, затем нажмите  
функциональную клавишу  
Add Waveform. 
 

За описанием соответствующих  
команд SCPI обращайтесь  
к Справочнику по   
программированию. 
 
 

Модулирующий сигнал, подлежащий добавлению или замене, можно выбрать из памяти BBG,  
внутренней памяти генератора сигналов, или USB-накопителя. 

 
 

Эта функциональная клавиша  
выводит на экран каталог  
сегментов модулирующего  
сигнала, который хранится во  
внутренней памяти (Int Storage) 
или на USB-накопителе  
(USB Media). 
 
Эта функциональная клавиша  
выводит на экран каталог  
модулирующих сигналов,  
занесенных в память BBG. 
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Mode > Dual ARB > More > Waveform Licensing > Lock Waveform in Slot 

 
 
Mode > Dual ARB > More > Waveform Licensing > More > More 

 

Нажмите эту функциональную  
клавишу для воспроизведения  
модулирующего сигнала  
в выделенном слоте. 

Нажмите эту функциональную  
клавишу для поиска  
в памяти модулирующего  
сигнала, который был добавлен  
в этот слот, независимо от его  
имени. Если поиск окажется  
безрезультатным, то это  
означает, что исходный  
модулирующий сигнал удален  
из памяти и не может быть  
восстановлен. 

 
 Рис. 8-35 Функциональные клавиши лицензирования модулирующих сигналов 

Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2 
 
Таблица 8-6 Сообщения состояния слота лицензирования модулирующих сигналов 

Столбец Status Значение Примечания 

Available Этот слот никогда не был занят внесенным  
в него модулирующим сигналом. 

Первоначально доступны 50 слотов для каждой опции 25хх.  
Первоначально доступны 5 слотов для каждой опции 22хх. 

Locked MM/DD/YY Этот слот заблокирован и не допускает  
дальнейших изменений. 

Модулирующий сигнал в этом слоте лицензирован для  
неограниченного воспроизведения на этом генераторе  
сигналов. 

Remaining Trial  
Time: HH:MM 

Этот слот находится в пробном периоде в 
течение 48 часов с момента добавления 
модулирующего сигнала. 

В течение пробного периода допускается воспроизведение, 
удаление и замена другим сигналом модулирующего сигнала  
в этом слоте. 

Lock: Required Пробный период для этого слота истек, но 
слот не заблокирован. 

Слот можно очистить или поместить в него другой модулиру-
ющий сигнал, однако невозможно воспроизводить сигнал, 
пока слот не будет заблокирован. Пробный период истек. 

 

Нажмите эту функциональную клавишу, чтобы подтвердить, что вы хотите заблокировать модулирующий  
сигнал в слоте для бессрочного лицензирования. Если файл модулирующего сигнала еще не занесен во  
внутреннюю память, то появится предупредительное сообщение (см. пункт 4 описания процедуры на стр. 150). 
 
Эта функциональная клавиша отображается, если не будет найден файл модулирующего сигнала  
во внутренней памяти генератора сигналов. Нажмите эту функциональную клавишу, чтобы сохранить файл  
модулирующего сигнала во внутренней памяти и активизировать функциональную клавишу Confirm Locking  
Waveform. См. описание пункта 4 на стр. 150. 
 

За описанием соответствующих команд SCPI  
обращайтесь к Справочнику по программированию. 
 

Нажмите эту функциональную клавишу после ввода определенного  
номера слота с помощью цифровой клавиатуры на передней панели. 
 

 Нажмите эту функциональную клавишу, чтобы перейти к первому слоту. 

 

Нажмите эту функциональную клавишу, чтобы перейти к первому доступному слоту. 

 
Нажмите эту функциональную клавишу, чтобы перейти к последнему слоту.  
Номер слота зависит от количества установленных в приборе опций лицензирования. 
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Пример: Лицензирование модулирующего сигнала Signal Studio 
Описанная ниже процедура вносит файл модулирующего сигнала в лицензионный слот и блокирует слот 
для неограниченного воспроизведения этого сигнала. 
1. Нажмите клавиши Mode > Dual ARB > More > Waveform Utilities > Waveform Licensing. 
 На экране появляется каталог файлов Catalog of BBG Segment Files in BBG Memory. 

2. С помощью клавиш со стрелками выделите и выберите подлежащий лицензированию файл. 
3. Нажмите клавишу Add Waveform, чтобы внести выбранный сигнал в первый доступный слот. 
 

 
 
 Рис. 8-36 Добавление модулирующего сигнала 
 
 Пояснение к рис. 8-36 

Выбранный модулирующий сигнал вносится в первый доступный слот. Отсчет пробного времени для 
этого слота начинается с момента внесения в него модулирующего сигнала. 
В течение 48-часового пробного периода можно воспроизводить и заменять модулирующий сигнал 
сколько угодно раз. По истечении пробного времени лицензионный статус слота меняется на Lock Re-
quired, после чего становится невозможным воспроизведение сигнала, пока не будет заблокирован 
слот. 

  см. рис. 8-34 

см. Пояснение 

 
Здесь мы видим пустую область Status в строке файла  

N7602B-WFM1; при этом активна функциональная клавиша  
Add Waveform, указывая на то, что этот модулирующий сигнал  
подлежит лицензированию. 
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4. Приступите к лицензированию сигнала. 
а) Нажмите функциональную клавишу Lock Waveform in Slot. 

Появляется сообщение *** Waveform Lock Warning!!! ***.  
Если вы хотите убедиться в том, что правильно выбрали сигнал для лицензирования, нажмите 
клавишу Return. 

  
 Рис. 8-37 Предупредительное сообщение о блокировке сигнала 
 

б) Нажмите функциональную клавишу Confirm Locking Waveform. 
 Лицензионный статус слота меняется на Locked MM/DD/YY. 
в) Если файл модулирующего сигнал не был ранее скопирован во внутреннюю память, то появится 

предупреждение: *** Waveform Backup Required!!! ***. 
г) Сделайте резервную копию файла этого модулирующего сигнала на USB-накопителе или на 

компьютере, прежде чем нажимать клавишу Backup Waveform to Int Storage. (Если этот файл 
будет потерян или стерт на генераторе сигналов, то его невозможно будет восстановить). 

Функциональная клавиша Confirm Locking Waveform остается  
недоступной, пока файл сигнала не будет занесен во внутреннюю память. 

  
Нажмите эту функциональную клавишу, чтобы сохранить файл  
модулирующего сигнала во внутренней памяти и активизировать  
функциональную клавишу Confirm Locking Waveform. 
 

 Рис. 8-38 Функциональная клавиша Backup Waveform to Int Storage 

  ПРЕДОСТЕРЕЖЕНИЕ    
Важно, чтобы вы сделали резервную копию файла сигнала, который вы лицензируете. Не храните 
резервную копию на генераторе сигналов. Если будут утрачены или удалены все копии файлов 
модулирующих сигналов, то невозможно будет восстановить их или возобновить лицензию. 
Обращайтесь к разделу 3.8. 
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Предупредительные сообщения при лицензировании сигналов 

 

Это стандартное предупреждение появляется 
каждый раз, когда вы выбираете сигнал для 
блокировки.  Это сообщение указывает, что один из 
доступных "лицензионных слотов" будет 
использован от опции 2хх. 

ОБЯЗАТЕЛЬНО сделайте резервные копии фай-
лов модулирующих сигналов в отдельной 
энергонезависимой памяти на случай исчезно-
вения файлов из внутренней памяти прибора. 

 
Это предупреждение появляется при попытке 
заблокировать файл сигнала, который еще не 
занесен во внутреннюю память или на USB-
накопитель (т.е. невозможно заблокировать сигнал, 
если его файл не записан в энергонезависимую 
память). Нажмите функциональную клавишу Back-
up Waveform To Int Storage. 
 
 
 
Это предупреждение появляется при неудачной 
попытке сохранения файла сигнала во внутренней 
(энергонезависимой) памяти или на USB-накопи-
теле вследствие недостаточного размера 
свободной памяти или других проблем с 
устройством памяти. 
 
 
 
Это предупреждение появляется, когда не удается 
найти файл сигнала в памяти BBG или во 
внутренней памяти прибора. Вы должны убедиться 
в том, что файл сигнала хранится в памяти 
прибора, прежде чем сможете заблокировать его. 

 
 Рис. 8-39 
 



Глава 11: Специальная цифровая модуляция (опция 431)  

Руководство по эксплуатации    154   N5171B, N5172B, N5181B, N5182В 
 

11 Специальная цифровая модуляция (опция 431) 

Прежде чем приступать к изучению информации, изложенной в этой главе, вы должны освоить основные опе-
рации работы с генератором сигналов. Если вы недостаточно освоили такие функции, как установка уровня 
мощности или частоты, обращайтесь к главе 3 и ознакомьтесь с информацией, изложенной в этой главе. 
Здесь описаны функции, которые имеются только у векторных генераторов сигналов Agilent серии Х с 
опцией 431. Опция 431 требует наличия опции 653 или 655 (N5172B) либо опции 656 или 657 (N5182B). 
Глава 11 состоит из следующих разделов: 
11.1 Специальная модуляция – стр. 152 
11.2 Создание и применение битовых файлов – стр. 160 
11.3 Работа с формами пакетных сигналов – стр. 163 
11.4 Применение генератора сигналов произвольной формы – стр. 167 
11.5 Применение фильтров FIR со специальной модуляцией – стр. 178 
11.6 Изменение параметров фильтра FIR с помощью табличного редактора FIR – стр. 183 
11.7 Дифференциальное кодирование – стр. 186 

11.1 Специальная модуляция 
Генератор сигналов обеспечивает два режима работы для формирования специальной модуляции – режим 
специальной модуляции ARB (сигналы произвольной формы) и режим специальной модуляции в реальном 
времени. Режим специальной модуляции ARB имеет встроенные форматы модуляции (такие, как NADC или 
GSM) и предварительно заданные типы модуляции (такие, как BPSK и 16QAM), которые можно 
использовать для формирования сигнала. Режим специальной модуляции в реальном времени можно 
использовать построения специальных форматов данных с помощью встроенных псевдошумовых 
последовательностей или специальных пользовательских файлов наряду с различными типами модуляции 
и различными встроенными фильтрами (например, фильтрами Гаусса или Найквиста). 
Оба режима работы применяются для формирования комплексных сигналов с цифровой модуляцией, 
которые моделируют коммуникационные стандарты с возможностью изменения существующих цифровых 
форматов, определения или создания сигналов с цифровой модуляцией, а также внесения искажений 
сигналов. 

11.1.1  Генератор специальных модулирующих сигналов произвольной формы 
Режим специальной модуляции ARB (сигналы произвольной формы) предназначен для внеканальных 
тестовых применений. Этот режим можно применять для генерирования форматов данных, которые 
имитируют хаотический коммуникационный трафик, а также для формирования возбуждающего сигнала 
при испытании компонентов. Другие возможности генератора сигналов произвольной формы: 
 конфигурирование сигналов с одной или несколькими несущими (можно сконфигурировать до 100 

несущих); 
 создание файлов модулирующих сигналов с помощью органов управления на передней панели 

генератора сигналов. 
Файлы модулирующих сигналов, созданные в виде случайных данных, можно использовать для формиро-
вания возбуждающего сигнала при испытании компонентов, где измеряется такая характеристика 
устройств, как мощность в соседнем канале (АСР). При включении генератора сигналов произвольной 
формы автоматически создается файл AUTOGEN_WAVEFORM, который вы можете переименовать и 
занести в энергонезависимую память генератора сигналов. Этот файл можно будет впоследствии загрузить 
во временную память и воспроизводить с помощью сдвоенного проигрывателя сигналов произвольной 
формы (Dual ARB Waveform Player). 
За дополнительной информацией обращайтесь к разделам 8.1 и 1.2. 
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11.1.2  Генератор специальных модулирующих сигналов в реальном времени 
Режим модуляции в реальном времени имитирует одноканальную связь с применением заданных 
пользователем типов модуляции вместе с пользовательскими фильтрами FIR и определенными 
значениями частоты следования символов. Данные можно загружать от внешнего источника в память 
PRAM или подавать в реальном масштабе времени через внешний вход. Режим I/Q-модуляции в реальном 
масштабе времени позволяет также генерировать предустановленные форматы данных, например, PN9 
или FIX4. Непрерывный поток данных, который генерируется в этом режиме, можно использовать для 
анализа битовых ошибок приемника. Этот режим ограничен одной несущей.  
Режим специальной модуляции в реальном времени: 
 имеет больше типов данных и типов модуляции, чем режим генератора сигналов произвольной формы; 
 поддерживает специальные групповые форматы I/Q-модуляции; 
 позволяет генерировать непрерывные псевдошумовые последовательности для измерения коэффици-

ента битовых ошибок (BERT). 
 не требует затрат времени на построение формы сигнала при изменении параметров сигнала. 
 

 
 
 Рис. 11-1 Функциональные клавиши специальной модуляции ARB 

 раздел 8.1 

 см. рис. 11-6 
 
 

 раздел 8.19 

 
 глава 12 

 подраздел 11.4.6 

 раздел 8.9 

 раздел 8.6 

 подраздел 8.1.8 

Вводит в действие текущие установки параметров  
пользовательской модуляции ARB. 
 

Эта функциональная клавиша  
изменяется в зависимости от  
выбранного типа модуляции. 
 

 стр. 154 

 подраздел  
11.4.6 
 

Доступна только тогда,  
когда Multicarrier = Off. 
 

Доступна только тогда,  
когда Multicarrier = On. 
 

Для выяснения функций клавиш пользуйтесь 
встроенной справкой по клавишам,  
как описано в разделе 3.2. 
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Mode > ARB Custom Modulation > Single Carrier Setup 

  
 
 
 Рис. 11-2 Функциональные клавиши быстрой настройки (Quick Setup) 
  

Имя этой  функциональной клавиши  
указывает выбранный в данный момент  
стандарт модуляции. 
 

Нажмите  функциональную клавишу Symbol Rate  
и установите нужное значение частоты следования  
символов с помощью цифровой клавиатуры. 

 

Default – Эта функциональная  
клавиша выбирает следующие  
принятые по умолчанию  
установки параметров: 
Modulation Type = QPSK. 
Symbol Rate = 1 Msps. 
Filter = Root Nyquist  и 
Filter  Alpha = 0.5 
 

При выборе одного из этих предустановленных  
стандартов модуляции автоматически задаются  
принятые по умолчанию значения компонентов 
настройки (в том числе фильтр, частота 
следования символов и тип модуляции). 

 

 

Для выяснения функций клавиш пользуйтесь встроенной справкой  
по клавишам, как описано в разделе 3.2. 
 

 стр. 155 
 

 раздел 11.5 

 стр. 156 

  подраздел 11.4.4 
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 Рис. 11-3 Функциональные клавиши Mod Type 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

 раздел 11.5 

 стр. 154 

 стр. 156 

 подраздел 11.4..2 

Эти карты символов используют  
поэлементное отображение  
в коде Грея. 
 

Устанавливает глубину  
амплитудной манипуляции  
(ASK). 
 

Эти карты символов  
согласуются с  

картами символов  
в программе VSA. 
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Таблица 11-1 Форматы специальной модуляции и их применение 

Формат модуляции Применение 
MSK, GMSK GSM, CDPD 
BPSK  
QPSK 

Дальняя космическая телеметрия, кабельные модемы  
Спутниковая связь, CDMA, NADC, TETRA, PHS, PDC, LMDS, DVB-S,  
кабельная связь (возвратный тракт), кабельные модемы, TFTS 

OQPSK 
FSK 

CDMA, спутниковая связь  
DECT, пейджинг, мобильные данные RAM, AMPS, CT2, ERMES,  
наземная мобильная радиосвязь, общественная безопасность 

8, 16 VSB Североамериканское цифровое телевидение (ATV), радиосвязь, кабельная связь 
8PSK Спутниковая связь, воздушные суда 
16 QAM СВЧ цифровая радиосвязь, модемы, DVB-C, DVB-T 
32 QAM Наземное СВЧ оборудование, DVB-T 
64 QAM DVB-C, модемы, широкополосные распределительные устройства, MMDS 
256 QAM Модемы, DVB-C (Европа), цифровое видео (США) 
 
 

Mode > ARB Custom Modulation > Single Carrier Setup > Store Custom Dig Mod State 

 
 Рис. 11-5 Функциональные клавиши сохранения состояния специальной цифровой модуляции 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
  

 подраздел 11.4.3 

Каталог отображает ранее занесенные в память  
файлы цифровой модуляции (DMOD). 
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 Рис. 11-6 Функциональные клавиши специальной модуляции в реальном времени 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
 

 раздел 8.1 

 подраздел 11.1.1 

 раздел 8.19 

 глава 12 
 стр. 158 

 раздел 11.7 

 глава 9 

 глава 10 

 раздел 8.9 

 раздел 8.6 

 Вводит в действие текущие установки  
 параметров специальной модуляции  
 в реальном времени. 
 

 Открывает меню, в котором вы можете 
 установить параметры формы пакетных  
сигналов. 
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Mode > Real-Time Custom Modulation > Modulation Setup 

 
 
 
 Рис. 11-7 Функциональные клавиши установки параметров модуляции 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
  

 стр. 159 

 раздел 11.5 

 подраздел  
 11.2.1 
 

Эта метка функциональной клавиши показывает  
выбранную в данный момент модуляцию. 
 

Нажмите функциональную клавишу Symbol  
Rate и введите нужное значение с помощью  
цифровой клавиатуры. 

Принятое по умолчанию (начальное) значение  
максимального диапазона частоты следования  
символов зависит от стандарта модуляции,  
выбранного с помощью функциональной  
клавиши Quick Setup. 

 

 

При выборе одного из этих предустановленных стандартов  
модуляции автоматически задаются принятые по умолчанию 
значения компонентов настройки (в том числе фильтр,  
частота следования символов и тип модуляции). 
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 Рис. 11-8 Функциональные клавиши типа модуляции 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

 стр. 158 

 раздел 11.5 

 раздел 11.2 

 подраздел  
 11.4.5 
 
 подраздел  
 11.4.5 

Эти карты символов используют  
поэлементное отображение  
в коде Грея. 
 

Эти карты символов  
согласуются с  

картами символов  
в программе VSA. 
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11.2 Создание и применение битовых файлов 
Описанная ниже процедура показывает, как применять редактор битовых файлов (Bit File Editor) 
для создания, редактирования и сохранения в памяти пользовательских файлов для передачи данных в 
режиме I/Q-модуляции в реальном времени. В этом примере создается пользовательский файл в 
специальном формате цифровой связи. 
Пользовательские файлы (файлы заданных пользователем данных) можно создавать на дистанционном 
компьютере и перемещать в генератор сигналов для последующего изменения, либо создавать и изменять 
с применением редактора битовых файлов генератора сигналов.  
Эти пользовательские файлы могут затем передаваться в виде непрерывного потока данных согласно 
протоколу активного формата либо передаваться в качестве данных для специальной модуляции ARB или 
модуляции в реальном времени. 

      ПРИМЕЧАНИЕ        
За дополнительной информацией о создании файлов пользовательских данных обращайтесь к Руководству 
по программированию (Agilent Signal Generators Programming Guide). 
 
Mode > Real-Time Custom Modulation > Modulation Setup 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
Нажмите эту клавишу, чтобы выбрать псевдослучайную 
последовательность и определить, следует ли ее инвертировать. 
 
 
 
Нажмите эту клавишу, чтобы выбрать комбинацию единиц или нулей. 
 
Нажимайте эту клавишу, чтобы создать, выбрать и редактировать 
файлы для использования в битовой комбинации. 
 
 
 
 
 
Нажмите эту клавишу, чтобы выбрать файл Pattern RAM (PRAM). 

Файлы PRAM представляют собой двоичные массивы в байтовом 
формате. Каждый байт содержит бит данных (младший разряд, бит 0), 
бит пакетного сигнала (бит 2) и бит выхода Event 1 (бит 6). Внутренний 
формат PRAM содержит 4 байта для каждого байта PRAM.  

Файлы PRAM полезны для определения специальных структур 
кадрирования с фиксированными данными. 

 
 Рис. 11-9  Функциональные клавиши выбора данных 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
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11.2.1  Создание пользовательского файла 
Обращение к табличному редактору 
1. Нажмите клавишу Preset. 
2. Нажмите клавиши Mode > Real-Time Custom Modulation > Modulation Setup > Data > User File > Create 

File. 
Это открывает редактор битовых файлов (Bit File Editor), который содержит три столбца  
(Offset, Binary Data и Hex Data), а также индикаторы позиции курсора (Position) и имени 
(Name), как показано на следующем рисунке. 

 

  
Смещение  
в формате Hex 

Двоичные  
данные 

Индикатор позиции  
курсора  
(в формате Нех) 

Шестнадцатиричные  
данные 

Индикатор имени файла 

 

 Рис. 11-10   Дисплей битовых файлов 

      ПРИМЕЧАНИЕ        
Когда вы создаете новый файл, ему по умолчанию присваивается имя UNTITLED, UNTITLED1 и так далее. 
Тем самым предотвращается перезапись предыдущих файлов. 

Ввод битовых значений 
1. Обратитесь к следующему рисунку. 
2. Введите показанные ниже 32-битовые значения. 
 

  
Введите эти битовые значения Индикатор позиции курсора  Шестнадцатиричные данные 
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11.2.2  Переименование и сохранение пользовательского файла 
В этом примере показано, как сохранить в памяти пользовательский файл. Если вы еще не создали 
пользовательский файл, то выполните операции, описанные выше в подразделе 11.2.1. 
1. Нажмите клавиши More (1 of 2) > Rename > Editing Keys > Clear Text. 
2. С помощью буквенных клавиш и цифровой клавиатуры введите имя файла (например, USER1). 
3. Нажмите клавишу Enter. 
 Теперь пользовательский файл переименован и занесен в каталог памяти Bit под именем User1. 

11.2.3  Вызов пользовательского файла 
В этом примере показано, как вызвать пользовательский файл из каталога памяти. Если вы еще не создали 
пользовательский файл и не сохранили его в памяти, то выполните операции, описанные выше в 
подразделах 11.2.1 и 11.2.2. 
1. Нажмите клавишу Preset. 
2. Нажмите клавиши Mode > Real-Time Custom Modulation > Modulation Setup > Data > User File. 
3. Выделите файл USER1. 
4. Нажмите функциональную клавишу Edit File. 
 Открывается файл USER1 в окне редактора битовых файлов. 

11.2.4  Внесение изменений в имеющийся пользовательский файл 
В этом примере показано, как внести изменения в имеющийся пользовательский файл данных. Если вы 
еще не создали пользовательский файл, не сохранили его в памяти и не вызвали его из памяти, то 
выполните операции, описанные выше в подразделах 11.2.1, 11.2.2 и 11.2.3. 

Перемещение по битовым значениям 
1. Нажмите клавиши Return > Goto > 4 > C > Enter. 

Это перемещает курсор в битовую позицию 4С в таблице, как показано на этом рисунке. 
 
 Изменяется индикатор позиции 

  
 Курсор перемещается в новую позицию 

 Рис. 11-2 Перемещение по битовым значениям 
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Инвертирование битовых значений 
1. Нажмите клавиши 1011.  
 Это инвертирует битовые значения в позициях от 4С до 4F. Обратите внимание на то, что шестнадцати-

ричное значение в этой строке изменилось на 76DB6DB6, как показано на следующем рисунке. 
 

  
 Инвертированы биты от 4С до 4F Изменилось шестнадцатиричное значение 

 Рис. 11-13  Инвертирование битовых значений 

11.2.5  Применение битовых ошибок к пользовательскому файлу 
В этом примере показано, как применять битовые ошибки к пользовательскому файлу. Если вы еще не 
создали и не сохранили в памяти пользовательский файл данных, то выполните процедуры, описанные 
выше в подразделах 11.2.1 и 11.2.2. 
1. Нажмите клавишу Apply Bit Errors. 
2. Нажмите клавиши Bit Errors > 5 > Enter. 
3. Нажмите клавишу Apply Bit Errors.  
 Обратите внимание на то, что обе функциональные клавиши Apply Bit Errors изменяют значение, 

поскольку он связаны между собой. 

11.3 Работа с формами пакетных сигналов 
Вы можете изменять форму кривых нарастания и спада с помощью редакторов Rise Shape и Fall 
Shape. Каждый редактор позволяет вам ввести до 256 равномерно распределенных во времени значений, 
определяющих форму кривой. После того, как будут заданы эти значения, они подвергаются повторной 
дискретизации для создания кривой кубической сплайн-аппроксимации, которая проходит через все точки 
выборки. 
Табличные редакторы Rise Shape и Fall Shape доступны для модулирующих сигналов в режиме 
специальной I/Q-модуляции в реальном времени. 

11.3.1  Описание формы пакетных сигналов 
Принятая по умолчанию форма пакетного сигнала для каждого формата реализуется согласно стандартам 
для выбранного формата. Однако вы можете изменять следующие аспекты формы пакетного сигнала: 
Время нарастания (Rise Time) – это выраженный в символах или битах интервал времени, в течение 
которого пакетный сигнал нарастает от минимума –70 дБ (0) до полной мощности (1). 
Время спада (Fall Time) – это выраженный в символах или битах интервал времени, в течение которого 
пакетный сигнал спадает от полной мощности (1) до минимума –70 дБ (0). 
Задержка нарастания (Rise Delay) – это выраженный в символах или битах интервал времени, 
характеризующий задержку начала нарастания пакетного сигнала. Задержка нарастания может быть как 
отрицательной, так и положительной. Ввод отличного от нуля значения задержки смещает точку полной 
мощности в ту или иную сторону относительно начала первого полезного символа. 
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Задержка спада (Fall Delay) – это выраженный в символах или битах интервал времени, характеризующий 
задержку начала спада пакетного сигнала. Задержка спада может быть как отрицательной, так и 
положительной. Ввод отличного от нуля значения задержки смещает точку полной мощности в ту или иную 
сторону относительно конца последнего полезного символа. 
Задаваемая пользователем форма пакетного сигнала (User Burst Shape) – до 256 вводимых 
пользователем значений, которые определяют форму кривой во время нарастания или спада. Эти значения 
могут изменяться от 0 (нулевая мощность) до 1 (полная мощность) и масштабируются линейно. После того, 
как будут заданы эти значения, они подвергаются повторной дискретизации для создания кривой 
кубической сплайн-аппроксимации, которая проходит через все точки выборки. 
 
 Значения, заданные пользователем 

 
Время  

 
Максимальные значения времени нарастания и спада зависят от следующих факторов: 
 частота следования символов; 
 тип модуляции. 
Когда задержка нарастания и спада равна нулю, форма пакетного сигнала стремится синхронизировать 
точку максимальной мощности с началом первого действительного символа и с окончанием последнего 
действительного символа таймслота. На следующем рисунке показан пакетный сигнал в кадре EDGE с 
задержкой нарастания 0 и задержкой спада +1 бит. 
 

  
 Задержка нарастания = 0 Задержка спада = +1 бит 

 
Микропрограмма генератора сигналов вычисляет оптимальную форму пакетного сигнала на основе 
установок параметров, которые вы выбрали для модуляции. Вы можете дополнительно оптимизировать 
форму пакетного сигнала для выравнивания с модуляцией. 

Значения, заданные пользователем 

М
ощ

но
ст

ь 

Время  
спада 

 

Задержка  
спада 

 

Время  
нарастания 

 

Задержка  
нарастания 

 

Кадр EDGE 

Пакетный сигнал 

Таймслот EDGE 

Пакетный сигнал 

Таймслот № 4 

Время  
нарастания 
 

Время  
спада 
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Например, если вы разрабатываете новую схему модуляции, выполните следующие процедуры: 
 Скорректируйте модуляцию и фильтрацию, чтобы установить желаемый спектр. 
 Скорректируйте задержки нарастания и спада пакетного сигнала, а также значения времени нарастания 

и спада для таймслотов. 
Если вы обнаружите, что при включении режима пакетирования увеличивается модуль вектора 
погрешности (EVM) или мощность в соседнем канале (АСР), то вы можете скорректировать форму 
пакетного сигнала для устранения этих проблем. 
 
Mode > Real-Time Custom Modulation 

  
 Рис. 11-14  Функциональные клавиши настройки формы пакетных сигналов 

11.3.2  Создание пользовательской кривой формы пакетного сигнала 
Эта процедура показывает, как вводить значения выборок кривой формы нарастания и получать их зер-
кальное отображение для описания формы спада при создании симметричной формы пакетного сигнала. 

Обращение к табличному редактору 
1. Нажмите клавишу Preset. 
2. Нажмите клавиши Mode > Custom > Real Time Custom Modulation > Burst Shape. 
3. Нажмите клавиши More > Define User Burst Shape > More (1 of 2) > Delete All Rows > Confirm Delete Of 

All Rows. 

Ввод значений выборок 
Введите значения выборок согласно следующей таблице: 

Rise Shape Editor (Редактор формы кривой нарастания) 
Выборка Значение Выборка Значение 
0 0.000000 4 0.830000 
1 0.400000 5 0.900000 
2 0.600000 6 1.000000 
3 0.750000   
 
1. Выделите значение (1.000000) для выборки 1. 
2. Нажмите клавиши .4 > Enter. 
3. Нажмите клавиши .6 > Enter. 
4. Введите остальные значения для выборок 3 ÷ 6 согласно этой таблице. 
5. Нажмите клавиши Return > Edit Fall Shape > Load Mirror Image of Rise Shape > Confirm Load Mirror 

Image of Rise Shape.  
 Это изменяет значения точек кривой спада на зеркальное отображение точек кривой нарастания, как 

показано на следующем рисунке. 

Для выяснения функций клавиш пользуйтесь встроенной  
справкой по клавишам, как описано в разделе 3.2. 
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 Рис. 11-15  Зеркальное отображение формы кривой нарастания 

Вывод на экран формы пакетного сигнала 
Нажмите функциональную клавишу Display Burst Shape. 
На экране появляется график кривой нарастания и спада, как показано на рис. 11-16. 
 

  
 Рис. 11-16  Форма пакетного сигнала 
 
Чтобы вернуть форму пакетного сигнала в состояние, принятое по умолчанию, нажмите клавиши Return > 
Return > Return > Confirm Exit From Table Without Saving > Restore Default Burst Shape. 

11.3.3  Сохранение в памяти пользовательской кривой формы пакетного сигнала 
1. Нажмите клавиши Define User Burst Shape > More (1 of 2) > > Load/Store > Store To File. 
 Если активная область ввода занята именем файла из каталога памяти Catalog of SHAPE Files, 

нажмите клавиши Editing Keys > Clear Text. 
2. Введите имя файла (например, NEWBURST) с помощью буквенных клавиш и цифровой клавиатуры. 

 Максимальная длина имени файла составляет 23 символа (буквенно-цифровые и специальные символы). 
3. Нажмите клавишу Enter. 
 Содержание текущих табличных редакторов Rise Shape и Fall Shape сохраняется в каталоге 

памяти Catalog of Shape Files. Эту форму пакетного сигнала можно теперь использовать для 
адаптации модуляции к вашим требованиям или в качестве основы для создания новой формы 
пакетного сигнала. 
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11.3.4  Вызов из памяти пользовательской кривой формы пакетного сигнала 
После того, как вы сохраните в каталоге памяти файл пользовательской формы пакетного сигнала, вы 
сможете вызвать его из памяти для применения в специальной цифровой I/Q-модуляции в реальном 
времени. 
В этом примере используется занесенный в память файл пользовательской формы пакетного сигнала. 
Если вы еще не создали и не сохранили в памяти такой файл, то выполните процедуры, описанные в 
подразделах 11.3.2 и 11.3.3. 
1. Нажмите клавишу Preset. 
2. Нажмите клавиши Mode > Real Time Custom Modulation > Burst Shape > Burst Shape Type > User File. 
3. Выделите файл интересующей вас формы пакетного сигнала (например, NEWBURST). 
4. Нажмите клавишу Select File. 
 Теперь выбранный файл формы пакетного сигнала применяется к текущему состоянию цифровой I/Q-

модуляции в реальном времени. 

11.4 Применение генератора сигналов произвольной формы 
В этом разделе описано построение файлов модулирующих сигналов произвольной формы (ARB), 
содержащих специальную цифровую модуляцию для испытания электронных компонентов. 
 
Mode > ARB Custom Modulation > Single Carrier Setup 

 
 
 Рис. 11-17  Внесение специальной модуляции в модулирующий сигнал 

11.4.1  Применение предустановленных наборов параметров специальной  
цифровой модуляции 

Выбор предустановленного набора параметров EDGE 
1. Нажмите клавишу Preset. 
2. В меню ARB Custom Modulation (стр. 153) нажмите клавиши Single Carrier Setup > Quick Setup > EDGE. 

Генерирование модулирующего сигнала 
Нажмите клавишу Digital Modulation Off On. 
Включается генерирование модулирующего сигнала с предустановленным набором параметров EDGE, 
выбранным на этом этапе. Дисплей переключается на Dig Mod Setup: EDGE. Во время генерирования 
модулирующего сигнала отображаются вспомогательные индикаторы DIGMOD и I/Q, а во временную 
память (BBG) заносится предустановленный набор параметров цифровой модуляции. Теперь ВЧ несущая 
модулируется этим сигналом. 

Наименование этой функциональной  
клавиши обновляется для отображения  
текущего типа модуляции. 
 

подраздел 11.4.4 

  стр. 155 

  раздел 11.5 

 стр. 156 

Для выяснения функций клавиш пользуйтесь встроенной 
справкой по клавишам, как описано в разделе 3.2. 
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Конфигурирование выхода ВЧ сигнала 
1. Установите частоту выходного ВЧ сигнала на 891 МГц. 
2. Установите амплитуду выходного сигнала на –5 дБм. 
3. Нажмите клавишу RF On/Off. 
Теперь на выходе RF OUTPUT генератора сигналов действует предустановленный сигнал EDGE. 

11.4.2  Создание пользовательского набора параметров цифровой модуляции 
В ходе этой процедуры вы узнаете, как начать с цифровой модуляции NADC с одной несущей и изменить 
ее для создания специального сигнала с пользовательской установкой типа модуляции, частоты 
следования символов и фильтрации. 
 
Mode > ARB Custom Modulation > Single Carrier Setup 

 
 
 Рис. 11-18  Установка параметров фильтра цифровой модуляции 
 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
 

подраздел 11.4.2 

 подраздел 11.4.4 

Наименование этой функциональной клавиши 
обновляется для отображения текущего типа модуляции. 
 

Эта функциональная клавиша  
устанавливает форму фильтра 
 

Эта функциональная клавиша 
устанавливает параметр   
полосы частот фильтра  
(Alpha).  
Принятое по умолчанию  
значение параметра Alpha 
изменяется в зависимости от 
выбора стандарта модуляции 
(раздел 11.5) и типа  
модуляции (стр. 155). 

 
Открывает меню  
для выбора фильтра IS-95 
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Mode > ARB Custom Modulation > Single Carrier Setup > Modulation Type > Select 

 
 
 Рис. 11-19  Изменение типа цифровой модуляции 
 
 Пояснение к рис. 11-19 

Select User I/Q и Select User FSK – Эти функциональные клавиши открывают меню для выбора 
имеющегося файла пользовательской I/Q-модуляции или пользовательской модуляции FSK, которые 
можно применить к текущему типу модуляции. 

Выбор набора параметров цифровой модуляции 
1. Нажмите клавишу Preset. 
2. В меню ARB Custom Modulation (стр. 153) нажмите клавиши Single Carrier Setup > Quick Setup > NADC. 

Изменение типа модуляции и частоты следования символов 
1. В меню ARB Custom Modulation (стр. 153) нажмите клавиши Single Carrier Setup > Modulation Type > 

Select > PSK > QPSK and OQPSK > QPSK. 
2. Нажмите клавиши Return > Symbol Rate > 56 > ksps. 

Выбор фильтра 
1. В меню Setup Mod (стр. 168) нажмите клавиши Filter > Select > Nyquist. 
2. Нажмите клавиши Return > Return. 

Генерирование модулирующего сигнала 
Нажмите клавишу Digital Modulation Off On. 
Включается генерирование пользовательского модулирующего сигнала с набором параметров цифровой 
модуляции NADC с одной несущей, созданного, как описано выше. Дисплей переключается на Dig Mod 
Setup: NADC. Во время генерирования модулирующего сигнала отображаются вспомогательные инди-
каторы DIGMOD и I/Q, а во временную память (BBG) заносится пользовательский набор параметров 
цифровой модуляции. Теперь ВЧ несущая модулируется этим сигналом. 

Примечание:  
Это вторая  
страница  
меню PSK. 
 

Примечание:  
Это вторая  
страница  
меню QPSK. 
 

 
 
 
см. Пояснение 

 

Для выяснения функций клавиш пользуйтесь встроенной 
справкой по клавишам, как описано в разделе 3.2. 
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За указаниями по сохранению этого пользовательского набора параметров цифровой модуляции NDAC в 
каталоге энергонезависимой памяти обращайтесь к подразделу 11.4.3. 

Конфигурирование выхода ВЧ сигнала 
1. Установите частоту выходного ВЧ сигнала на 835 МГц. 
2. Установите амплитуду выходного сигнала на 0 дБм. 
3. Нажмите клавишу RF On/Off.  
Теперь на выходе RF OUTPUT генератора сигналов действует заданный пользователем сигнал NDAC. 

11.4.3  Сохранение в памяти пользовательского набора параметров цифровой  
модуляции 

Эта процедура показывает, как сохранить в энергонезависимой памяти пользовательский набор 
параметров цифровой модуляции с одной несущей. Если вы не создали такой пользовательский набор 
параметров, обращайтесь к подразделу 11.4.2. 

 
Каталог отображает файлы DMOD, которые были ранее занесены в память пользователем. 

 Рис. 11-20  Сохранение в памяти пользовательского набора параметров цифровой модуляции 
 
1. Вернитесь в меню верхнего уровня ARB Custom Modulation, где первой функциональной клавишей 

является клавиша Digital Modulation Off On. 
2. В меню ARB Custom Modulation (см. выше) нажмите клавиши Single Carrier Setup > Store Custom Dig 

Mod State > Store To File. 
Если в таблице уже есть имя файла из каталога Catalog of DMOD Files, занимающее активную 
область ввода, нажмите клавишу Clear Text. 

3. С помощью буквенных клавиш и цифровой клавиатуры введите имя файла (например, NADCQPSK) 
длиной не более 23 символов. 

4. Нажмите клавишу Enter. 
Теперь в энергонезависимую память заносится пользовательский набор параметров цифровой 
модуляции с одной несущей. 

раздел 3.3 

Эти клавиши управляют  
таблицей файлов DMOD  
во внутренней памяти. 
 

Для выяснения функций клавиш пользуйтесь встроенной 
справкой по клавишам, как описано в разделе 3.2. 
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      ПРИМЕЧАНИЕ        
Установки выходной амплитуды ВЧ сигнала, частоты и рабочего состояния прибора не сохраняются в 
памяти в качестве части данных файла пользовательского набора параметров цифровой модуляции. 

11.4.4  Вызов из памяти набора параметров пользовательской цифровой модуляции 
Эта процедура показывает, как вызвать из энергонезависимой памяти набор параметров пользовательской 
цифровой модуляции.  
Если вы еще не создали и не сохранили в памяти пользовательский набор параметров цифровой 
модуляции с одной несущей, то выполните процедуры, описанные выше в подразделах 11.4.2 и 11.4.3, 
затем выполните предустановку генератора сигналов, чтобы удалить из временной памяти ARB 
занесенный в нее файл модулирующего сигнала пользовательской цифровой модуляции. 
 
Mode > ARB Custom Modulation > Single Carrier Setup > Quick Setup 

  
 Рис. 11-21  Вызов из памяти набора параметров пользовательской цифровой модуляции 
 
1. В меню Quick Setup нажмите клавишу Custom Digital Mod State. 
2. Выделите нужный файл (например, NADCQPSK). 
3. Нажмите клавиши Select File > Return. 
4. Нажмите клавишу Digital Modulation Off On, чтобы выделить On. 
Прибор восстанавливает во временной памяти модулирующий сигнал пользовательской цифровой 
модуляции. После генерирования модулирующего сигнала он будет для доступен для модуляции на 
выходе ВЧ сигнала. 
За указаниями по конфигурированию выхода ВЧ сигнала обращайтесь к описанию под заголовком 
"Конфигурирование выхода ВЧ сигнала" на стр. 168. 

Для выяснения функций клавиш  
пользуйтесь встроенной справкой по 
клавишам, как описано в разделе 3.2. 
 

 
Загружает выделенный файл  
в память прибора. 
 

Эти клавиши управляют  
таблицей файлов DMOD  
во внутренней памяти. 
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11.4.5  Задание параметров модуляции 
Вы можете построить уникальную модуляцию с помощью двух инструментов: табличного редактора FSK и 
табличного редактора !/Q. Эти таблицы заносят данные в определенные абсолютные состояния модуля-
ции. Для занесения переходов между состояниями имеется дифференциальный табличный редактор. 

Построение асимметричной модуляции FSK с помощью табличного редактора FSK 
Вы можете воспользоваться табличным редактором FSK для создания пользовательской асимметричной 
модуляции FSK (до 16 уровней), затем применить эту пользовательскую модуляцию FSK к одному из 
стандартов модуляции. В качестве примера создадим мешающий сигнал для измерения избирательности 
пейджеров FLEXTM по соседнему каналу. Для этого построим в табличном редакторе FSK четырехуровне-
вую модуляцию FSK со значениями девиации частоты 4,8 кГц и 1,6 кГц, как показано на рис. 11-22. Затем 
используем этот сигнал для модуляции передачи данных PN15. В протоколе FLEXTM каждый уровень в 
четырехуровневой модуляции FSK представляет двухбитовую последовательность. 

Создание непрерывного четырехуровневого сигнала FSK 
Используйте эту процедуру, чтобы создать четырехуровневый сигнал FSK для измерения избирательности 
пейджеров FLEXTM по соседнему каналу. 
1. Нажмите клавишу Preset на генераторе сигналов. 
2. Нажмите клавиши Mode > Real-Time Custom Nodulation > Modulation Setup > Modulation Type > De-

fine User FSK. 
3. Введите в табличный редактор FSK значения девиации частоты, показанные на рис. 11-22. 
4. Сохраните файл как 4FSK. Нажмите клавиши Load/Store > Store To File > 4FSK > Enter. 
5. Загрузите этот файл. Нажмите клавиши Load from Selected File > Confirm Load From File. 
6. Включите специальную модуляцию. Нажмите клавиши Return > Return > Return > Real-Time Custom On. 
7. Установите частоту на значение несущей частоты для соседнего канала. 
8. Установите желаемое значение амплитуды. 
9. Нажмите клавишу RF On. Теперь можно изменять амплитуду мешающего сигнала для измерения 

характеристик объекта испытаний. 
 

Mode > Real-Time Custom Nodulation > Modulation Setup > Modulation Type > Define User FSK 

  
 

Четырехуровневая модуляция FSK 

10 = несущая + 4800 Гц 
11 = несущая + 1600 Гц 
01 = несущая – 1600 Гц 
00 = несущая – 4800 Гц 

+4,8 кГц 

+1,6 кГц 

несущая 

–1,6 кГц 

–4,6 кГц  

 

Для выяснения функций  
клавиш пользуйтесь встроенной 
справкой по клавишам, как  
описано в разделе 3.2. 
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Преобразование значений I/Q с помощью табличного редактора I/Q 

  
 
 Рис. 11-23  Карта созвездия I/Q 

В большинстве систем цифровой радиосвязи частота несущей 
зафиксирована, поэтому следует рассматривать только фазу и 
магнитуду. Фазу и магнитуду символа можно представить 
отдельной точкой на плоскости I/Q.  
I означает синфазную составляющую, а Q – квадратурную состав-
ляющую. 
Путем модуляции несущей на одну из нескольких предопределен-
ных позиций на плоскости I/Q вы можете передавать закодирован-
ную информацию. Каждая позиция или состояние отображает 
определенную битовую комбинацию, которая может быть декоди-
рована приемником. Результат нанесения состояний решающей 
точки у каждого символа на плоскость I/Q называется картой 
созвездия I/Q. Вы можете создать уникальный сигнал путем 
внесения вашей диаграммы созвездия в табличный редактор I/Q, 
как показано на рис. 11-24. Табличный редактор имеет также 
функцию графического отображения, которая обеспечивает 
быструю визуальную проверку ожидаемого созвездия I/Q. 

 
 Mode > Real-Time Custom Nodulation > Modulation Setup > Modulation Type > Define User I/Q 

  
 Рис. 11-24  Табличный редактор I/Q 
 
Используя эти гибкие возможности, вы можете создавать уникальные схемы модуляции. Например, вы 
можете легко реализовать круговую структуру созвездия (которую называют STAR QAM) и сохранить ее в 
памяти для последующей загрузки в генератор модулирующих сигналов I/Q в реальном времени. Как 
показано на рис. 11-25, структура STAR QAM имеет 16 состояний, или символов. Каждый символ задается 
четырьмя битами данных. Таким образом, диаграмма и таблица равнозначны. 

Создание схемы модуляции STAR QAM 
1. Нажмите клавишу Preset на генераторе сигналов. 
2. Нажмите клавиши Mode > Real-Time Custom Nodulation > Modulation Setup > Modulation Type > De-

fine User I/Q. 
3. С помощью цифровой клавиатуры и клавиш со стрелками введите значения I и Q, представленные на 

рис. 11-25. Нажмите клавишу Display IQ Map, чтобы проверить ваш ввод и скорректировать (если нужно) 
ошибки ввода. 

4. Нажмите клавиши Return > Store To File > Clear Text. 
5. Включите специальную модуляцию. Нажмите клавиши Return > Return > Return > Real-Time Custom On. 
6. Присвойте файлу имя STAR и нажмите клавишу Enter. 
7. Загрузите файл. Выделите имя STAR и нажмите клавишу Load from Selected File > Confirm Load From 

File. 

Для выяснения функций  
клавиш пользуйтесь встроенной 
справкой по клавишам, как  
описано в разделе 3.2. 
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8. Включите специальную модуляцию. Нажмите клавиши Return > Return > Return > Real-Time Custom On. 
9. Установите желаемые значения частоты и амплитуды. 
10. Нажмите клавишу RF On. 

  
 Рис. 11-25  Диаграмма и таблица схемы модуляции STAR QAM 
 
На рис. 11-26 показана установка параметров модуляции и отображение карты состояний I/Q. 
 

  
 Рис. 11-26  Установка параметров модуляции и отображение карты состояний I/Q 

Рекомендации по построению схем модуляции 
 Карта состояний ограничена в общей сложности до 16 уровней сигналов для комбинаций I и Q. 

Показание в правой части таблицы отслеживает количество использованных уровней I и Q. Уровни 
представляют собой значения I или Q. На рис. 11-27 показан сигнал SPSK, сформированный двумя 
разными способами. Сигнал SPSK на рис. 11-27 использует пять из 16 возможных значений I/Q на левой 
карте состояний и четыре из 16 возможных значений I/Q на правой карте состояний I/Q. 

 Согласно этому примеру, генератор модулирующих сигналов I/Q в реальном времени поддерживает 
симметричное созвездие 256QAM, но не поддерживает асимметричное созвездие 256QAM, поскольку 
асимметрия требует больше, чем 16 значений I/Q. 

 Совсем не требуется, чтобы уровни были расположены равномерно или симметрично в плоскости I/Q. 
Например, возможны оба варианта модуляции 16QAM, показанные на рис. 11-28. 
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 Рис. 11-27  Два способа формирования сигнала 8PSK 
 
 

  
 Рис. 11-28  Карты состояний I/Q модуляции 16QAM с равномерными и неравномерными уровнями 

11.4.6  Создание пользовательского набора параметров цифровой модуляции  
с несколькими несущими 

В ходе этой процедуры вы узнаете, как изменить предустановленный набор параметров цифровой 
модуляции с несколькими несущими путем создания пользовательского состояния цифровой модуляции 
EDGE с тремя несущими. 

Создание набора параметров цифровой модуляции с несколькими несущими 
1. Нажмите клавишу Preset. 
2. Нажмите клавиши Mode > ARB Custom Modulation > Multicarrier Off On на On. 
3. Нажмите клавиши Multicarrier Setup > Select Carrier and Initialize Table > Carrier Setup > EDGE > Done. 

Изменение отстройки частоты несущей 
1. Выделите значение Freq Offset для несущей в строке 2 (500.000 kHz). 
2. Нажмите клавиши –625 > kHz. 

Изменение мощности несущей 
1. Выделите значение Power для несущей в строке 2 (0.00 dB).  
2. Нажмите клавиши –10 > dB. 
 Теперь вы имеете сигнал пользовательской модуляции EDGE с двумя несущими (с несущей при 

отстройке частоты –625 кГц и с уровнем мощности –10,00 дБм) – см. иллюстрацию дисплея на 
следующей странице. 

  



Глава 11: Специальная цифровая модуляция (опция 431)  

Руководство по эксплуатации    178   N5171B, N5172B, N5181B, N5182В 
 

 
 Рис. 11-29  Создание набора параметров цифровой модуляции с несколькими несущими 
 
 Пояснение к рис. 11-29 

Apply Multicarrier – Эта функциональная клавиша становится активной после внесения изменений в 
таблицу Multicarrier Setup или в значения меню Multicarrier (т.е. Carrier Setup, # of Carriers, Freq Spacing 
или Carrier Phases). 

 

 

 
Для выяснения функций клавиш 
пользуйтесь встроенной справ-
кой по клавишам, как описано в 
разделе 3.2. 
 
 
Если цифровая модуляция уже 
включена, то вы должны нажать 
функциональную клавишу Apply 
Multicarrier, чтобы ввести в 
действие изменения и генериро-
вать новый сигнал цифровой 
модуляции на основе обновлен-
ных значений. 

Генерирование модулирующего сигнала 
Нажмите клавиши Return > Digital Modulation Off On. 
Это генерирует сигнал с пользовательским состоянием модуляции EDGE с несколькими несущими. На 
дисплее индицируется Dig Mod Setup: Multicarrier (Modified). Во время генерирования 
сигнала отображаются вспомогательные индикаторы DIGMOD и I/Q и заносится во временную память 
новое состояние пользовательской цифровой модуляции EDGE с несколькими несущими. Теперь этот 
сигнал модулирует ВЧ несущую. 

 
 
  см. Пояснение 

Для выяснения функций клавиш пользуйтесь 
встроенной справкой по клавишам, как описано в 
разделе 3.2. 
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За указаниями по сохранению в памяти этого пользовательского набора параметров модуляции EDGE с 
несколькими несущими обращайтесь к подразделу 11.4.7. 

Конфигурирование выхода ВЧ сигнала 
1. Установите частоту выходного ВЧ сигнала на 890,01 МГц. 
2. Установите амплитуду выходного сигнала на –10 дБм. 
3. Нажмите клавишу RF On/Off. 
Теперь на выходной соединитель RF OUTPUT подается заданный пользователем сигнал EDGE с 
несколькими несущими. 

11.4.7  Сохранение в памяти пользовательского набора параметров цифровой  
модуляции с несколькими несущими 

Следуйте описанию этой процедуры, чтобы сохранить в энергонезависимой памяти пользовательский 
набор параметров цифровой модуляции с несколькими несущими. 
Если вы еще не создали пользовательский набор параметров цифровой модуляции с несколькими 
несущими, то выполните процедуру, описанную выше в подразделе 11.4.6. 
 

 
 
 Рис. 11-30  Функциональные клавиши сохранения в памяти пользовательского набора параметров 
 
 Пояснение к рис. 11-30 

Fixed – Для всех несущих устанавливается нулевая фаза. 
Random – Для всех несущих устанавливается случайное значение фазы. 

 
1. Вернитесь в меню верхнего уровня ARB Custom Modulation, где первой функциональной клавишей 

является клавиша Digital Modulation Off On. 
2. Нажмите клавиши Multicarrier Setup > More > Load/Store > Store To File. 

Если в таблице уже есть имя файла из каталога Catalog of MDMOD Files, занимающее активную 
область ввода, нажмите клавишу Clear Text. 

3. С помощью буквенных клавиш и цифровой клавиатуры введите имя файла (например, EDGEM1) длиной 
не более 23 символов. 

4. Нажмите клавишу Enter. 
Теперь в энергонезависимую память заносится пользовательский набор параметров цифровой модуляции 
с несколькими несущими. 

      ПРИМЕЧАНИЕ        
Установки выходной амплитуды ВЧ сигнала, частоты и рабочего состояния прибора не сохраняются в 
памяти в качестве части данных файла пользовательского набора параметров цифровой модуляции. 

см. Пояснение 

подраздел 3.3.2 

Для выяснения функций клавиш 
пользуйтесь встроенной справ-
кой по клавишам, как описано в 
разделе 3.2. 
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11.4.8  Применение изменений к активному набору параметров цифровой  
модуляции с несколькими несущими 

Если изменения в табличный редактор Multicarrier Setup внесены в то время, когда используется 
формат цифровой модуляции (клавиша Digital Modulation Off On установлена на On), то вы должны ввести 
изменения в действие, прежде чем будет генерироваться обновленный сигнал. 
Из табличного редактора Multicarrier Setup нажмите клавишу Apply Multicarrier, чтобы ввести 
изменения в действие и получить генерирование нового сигнала пользовательской цифровой модуляции с 
несколькими несущими на основе обновленных значений параметров. 

11.5 Применение фильтров FIR со специальной модуляцией 
Фильтры с конечной импульсной характеристикой (FIR) можно применять для коррекции переходов между 
решающими точками у символов в генерируемых модулирующих сигналах. 
 

 
 Рис. 11-31  Меню Filter 
 

Доступно только тогда, когда выбран   
фильтр Root Nyquist или Nyquist. 

Доступно только тогда, когда  
выбран фильтр Gaussian. 

Применяется только  
к модуляции Dual ARB  
(см. раздел 8.1) 
 

Эта клавиша заменяет текущий фильтр FIR  
на заводские установки параметров фильтра,  
принятого по умолчанию для текущего типа  
модуляции. 

 

Эта функциональная клавиша  
изменяется в зависимости от  

выбранного типа фильтра 
 

Для выяснения функций клавиш пользуйтесь встроенной 
справкой по клавишам, как описано в разделе 3.2. 
 

 подраздел 11.5.2 
Открывает  
меню выбора  
фильтра IS-95. 
 
 раздел 11.6 
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11.5.1  Описание фильтров FIR 
Фильтры с конечной импульсной характеристикой (FIR) применяются для ограничения ширины полосы 
частот на входе модуляторов I и Q. Существует несколько различных типов фильтров FIR. Стандарты 
NADC, PDC, PHS и TETRA предписывают применение корневого фильтра Найквиста в передатчике и в 
приемнике. Комбинированная характеристика эквивалентна фильтру Найквиста. Фильтр Найквиста имеет 
импульсную характеристику, которая "звенит" на частоте синхронизации данных, поэтому появляются нули 
во всех решающих точках символов, за исключением точки, которая находится в центре импульсной 
характеристики. Поскольку каждый символ вызывает нулевой отклик на всех нежелательных решающих 
точках, то здесь не может быть межсимвольной интерференции (ISI). Параметр Alpha у фильтров 
Найквиста характеризует точку среза частотной характеристики, на которой отклик фильтра равен нулю. 
Чем ближе параметр  Alpha к нулю, тем круче спад частотной характеристики фильтра. Параметр Alpha 
обеспечивает прямую оценку ширины полосы частот, занимаемой системой, которая вычисляется по 
формуле: 
 Ширина занимаемой полосы частот = частота следования символов  (1 + ) 
Стандартами NADC и TETRA предписывается значение  = 0,35. Стандартами PDC и PHS предписывается 
значение  = 0,50. Для каждого из этих стандартов генератор сигналов Agilent серии Х обеспечивает 
корневой фильтр Найквиста с предписанными значениями параметра Alpha в качестве принятого по 
умолчанию предмодуляционного фильтра. На рис. 11-32 показана импульсная характеристика фильтра 
Найквиста с различными значениями . 
Обратите внимание на то, что точка половинной амплитуды всегда соответствует половине частоты 
следования символов. Поскольку вся информация содержится в половине ширины полосы частот, 
соответствующей данной частоте следования символов, то параметр Alpha является мерой 
дополнительной ширины занимаемой полосы частот. 
Другим типом фильтра FIR, который предписывается стандартами GSM и DECT, является гауссовский 
фильтр. Гауссовские фильтры обычно имеют более выраженную межсимвольную интерференцию, чем 
фильтры Найквиста, однако у них лучше характеристика избирательности по соседнему каналу для 
сигналов с постоянной амплитудой модуляции (например, MSK), когда невозможна фильтрация I и Q по 
Найквисту. Аналогом параметра Alpha у этих фильтров является параметр BbT (произведение Bandwidth–
Bit–Time). Стандартом GSM предписывается значение BbT = 0,30, а стандартом DECT – значение BbT = 
0,50. Для каждого из этих стандартов генератор сигналов Agilent серии Х обеспечивает гауссовский фильтр 
предписанным значением параметра BbT в качестве принятого по умолчанию предмодуляционного фильтра. 
 

  
 Рис. 11-32  Импульсная характеристика фильтра Найквиста 
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Выбор фильтра и значений параметров Alpha и BbT 
В зависимости от конкретных требований к системе у вас может возникнуть необходимость в замене 
фильтра или в изменении параметров Alpha и BbT. Параметр Alpha можно изменять в диапазоне от 0 до 1, 
а параметр BbT – в диапазоне от 0,1 до 1. 
Чтобы изменить значение Alpha, действуйте следующим образом: 
1. Нажмите клавишу Preset. 
2. Нажмите клавиши Mode > Real-Time Custom Modulation > Modulation Setup > Filter > Select Nyquist > 

Filter Alpha. 
3. Введите новое значение в интервале от 0 до 1. Нажмите клавишу Enter. 
4. Чтобы восстановить принятые по умолчанию значения параметров фильтра, нажмите клавишу Restore 

Default Filter. 

      ПРИМЕЧАНИЕ        
Чтобы изменить параметр BbT, нажмите клавиши Mode > Real-Time Custom Modulation > Modulation 
Setup > Filter > Select Gaussian > Filter BbT. 
Введите новое значение в интервале от 0,1 до 1. 

11.5.2  Создание пользовательского фильтра FIR с помощью табличного редактора 
FIR 

В этой процедуре применяется табличный редактор FIR Values для создания и сохранения в памяти 
8-символьного взвешивающего фильтра типа sinc function с коэффициентом избыточности выборок 4. 

Обращение к табличному редактору 
1. Нажмите клавишу Preset. 
2. Нажмите клавиши Mode > ARB Custom Modulation > Single Carrier Setup > Filter > Select > Nyquist. 
3. Нажмите клавиши Filter > Define User FIR. 
4. Нажмите клавиши More 2 of 2 > Delete All Rows > Confirm Delete of All Rows. 
Это выводит на экран редактор табличных значений, как показано на рис. 11-33. 
 
Mode > ARB Custom Modulation > Single Carrier Setup > Filter > Define User FIR > More >  
> Delete All Rows > Confirm Delete of All Rows 

  
 Рис. 11-33  Создание пользовательского фильтра FIR с помощью табличного редактора FIR 

Этот пункт активен только тогда,  
когда таблица коэффициентов FIR  
содержит минимум два видимых  
значения. 
 

Открывает меню, которое  
позволяет вам выбрать и  
загрузить файл  
во временную память  
(см. раздел 3.3). 

 

 

подраздел 8.14.1 
 

Для выяснения функций клавиш 
пользуйтесь встроенной справкой по 
клавишам, как описано в разделе 3.2. 
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      ПРИМЕЧАНИЕ        
Фильтры модуляции обычно являются реальными и должны иметь коэффициент избыточности выборок 
(OSR) 2 или выше. 
Корректирующие фильтры обычно являются комплексными и должны иметь коэффициент избыточности 
выборок (OSR), равный 1 (только Dual ARB). 

Ввод значений коэффициентов 
1. Нажмите функциональную клавишу Return, чтобы перейти на первую страницу табличного редактора. 
2. С помощью курсора выделите поле Value для коэффициента 0. 
3. С помощью цифровой клавиатуры введите первое значение (–0.000076) из таблицы 11-1. При нажатии 

цифровых клавиш появляются соответствующие цифры в поле ввода. Если вы сделаете ошибку, то ее 
можно исправить с помощью клавиши забоя Bk Sp.  

4. Продолжайте вводить значения из таблицы, пока не введете все 16 значений. 

Таблица 11-2 

 

Дублирование первых 16 коэффициентов с помощью зеркальной таблицы 
У взвешивающего фильтра типа sinc function вторая половина коэффициентов идентична первой половине, 
но в обратном порядке. Генератор сигналов обеспечивает функцию зеркальной таблицы, которая 
автоматически дублирует имеющиеся коэффициенты в обратном порядке. 
1. Нажмите клавишу Mirror Table. Теперь автоматически генерируются последние 16 коэффициентов 

(коэффициенты 16 ÷ 31) и выделяется первый из этих коэффициентов (№ 16), как показано на рис. 
11-34. 

 
Значения коэффициентов таб-
лицы FIR могут быть приня-
тыми по умолчанию завод-
скими значениями либо могут 
быть введены пользователем. 

 
Пользуйтесь меню Goto Row для перемещения по строкам и внесения  
изменений в таблицу коэффициентов FIR Values. 

 Рис. 11-34 

Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 
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Установка коэффициента избыточности выборок 

      ПРИМЕЧАНИЕ        
Фильтры модуляции должны быть реальными и иметь коэффициент избыточности выборок (OSR) 2 или 
выше. 
Коэффициент избыточности выборок (OSR) представляет собой количество коэффициентов фильтра на 
каждый символ. Приемлемый диапазон значений составляет от 1 до 32; максимальная комбинация 
символов и коэффициента избыточности выборок, допускаемая табличным редактором, составляет 1024. 
Однако аппаратная часть генератора сигналов реально допускает до 32 символов, коэффициент 
избыточности выборок от 4 до 16, и 512 коэффициентов фильтра. Поэтому если вы введете более 32 
символов или более 512 коэффициентов фильтра, то прибор не сможет использовать такой фильтр. Если 
коэффициент избыточности выборок отличается от внутреннего оптимального значения, то фильтр 
автоматически переключится на оптимальный коэффициент избыточности выборок. 
В этом примере нужное значение OSR равно 4 (принято по умолчанию), поэтому здесь не требуется 
никаких действий. 

Графическое отображение характеристики фильтра 
Генератор сигналов обладает способностью отображения характеристик фильтра как во временной, так и в 
частотной области. 
1. Нажмите клавиши More 1 of 2 > Display Filter > Display FFT (быстрое преобразование Фурье). 

На дисплее отображается график результата быстрого преобразование Фурье (см. рис. 11-35). 

  
 Рис. 11-35 
 
2. Нажмите клавишу Return. 
3. Нажмите клавишу Display Impulse Response. 

Теперь отображается график импульсной характеристики (см. рис. 11-36). 

  
 Рис. 11-36 
 
4. Нажмите клавишу Return, чтобы вернуться к клавишам меню. 



Глава 11: Специальная цифровая модуляция (опция 431)  

Руководство по эксплуатации    185   N5171B, N5172B, N5181B, N5182В 
 

Сохранение файла фильтра в памяти 
Чтобы сохранить файл фильтра в памяти, действуйте следующим образом: 
1. Нажмите клавиши Load/Store > Store To File. На экране появляется каталог файлов FIR с индикацией 

доступного размера памяти. 
2. Присвойте файлу имя FIR_1 и сохраните его в памяти, как описано в разделе 8.2. 
Файл FIR_1 является первым файлом в списке. (Если вы ранее занесли в память другие файлы FIR, то их 
имена перечисляются ниже имени файла FIR_1). В списке отображается тип файла (FIR) и его размер 
(268 байт). Отображается также размер использованной памяти (40kB used). Количество файлов, которые 
можно сохранить, зависит от размера файлов и от размера использованной памяти. См. рис. 11-37. 
 

  
Каталог отображает файлы FIR, которые были ранее занесены в память пользователем. 

 Рис. 11-37 
 
Память содержит также файлы состояний прибора и файлы развертки по списку. 
Теперь можно использовать этот фильтр для создания пользовательского (специального) формата 
модуляции, а также в качестве основы для разработки нового фильтра. 

11.6 Изменение параметров фильтра FIR с помощью табличного  
редактора FIR 

Фильтры FIR, файлы которых хранятся в памяти генератора сигналов, можно модифицировать с помощью 
табличного редактора FIR. Вы можете загрузить табличный редактор FIR с коэффициентами из 
пользовательских файлов FIR, хранящихся в энергонезависимой памяти, или из одного принятых по 
умолчанию файлов FIR. Тогда вы сможете изменить значения и сохранить в памяти новые файлы. 

Эти клавиши управляют  
таблицей файлов DMOD  
во внутренней памяти. 
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11.6.1  Загрузка принятого по умолчанию гауссовского фильтра FIR 

 
 Рис. 11-38  Загрузка принятого по умолчанию гауссовского фильтра FIR 
 
1. Нажмите клавишу Preset. 
2. Нажмите клавиши Mode > ARB Custom Modulation > Single Carrier Setup > Quick Setup > NADC.  
3. Нажмите клавиши Filter > Define User FIR > More 1 of 2 > Load Default FIR > Gaussian. 
4. Нажмите клавиши Filter BbT > 0.300 > Enter. 
5. Нажмите клавиши Filter Symbols > 8 > Enter. 
6. Нажмите клавишу Generate. 

      ПРИМЕЧАНИЕ        
Реальный коэффициент избыточности выборок во время модуляции автоматически выбирается 
прибором. Выбирается значение от 4 до 16 в зависимости от частоты следования символов, количества 
битов на символ у данного типа модуляции и количества символов. 

Для выяснения функций клавиш пользуйтесь встроенной   
справкой по клавишам, как описано в разделе 3.2. 
 

Эти функциональные клавиши  
выбирают функцию окна  

(функцию аподизации)  
для фильтра. 
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7. Нажмите клавиши Display Filter > Display Impulse Response.  
 Отображается график импульсной характеристики (см. рис. 11-39). 

  
 Рис. 11-39  Отображение импульсной характеристики 
 
8. Нажмите клавишу Return. 

11.6.2  Изменение коэффициентов фильтра 
1. С помощью клавиш мл стрелками выделите коэффициент 15. 
2. Нажмите клавиши 0 > Enter. 
3. Нажмите клавишу Display Impulse Response. 
 Отображение графика (см. рис. 11-40) может оказаться полезным средством выявления неполадок. В 

данном случае по графику видно, что неправильно установлено значение коэффициента, в результате 
чего искажается форма гауссовской импульсной характеристики. 

 

  
 Рис. 11-40  Отображение импульсной характеристики с измененными коэффициентами 
 
4. Нажмите клавишу Return. 
5. Выделите коэффициент 15. 
6. Нажмите клавиши 1 > Enter. 

11.6.3  Сохранение файла фильтра в памяти 
Максимальная длина имени файла составляет 23 символа (буквенно-цифровые и специальные символы). 
1. Нажмите клавиши Return > Load/Store > Store To File. 
2. Присвойте файлу имя NEWFIR2. 
3. Нажмите клавишу Enter. 
Текущее содержание редактора значений FIR сохраняется в файле в каталоге памяти. В каталоге файлов 
FIR появляется новый файл. 
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11.7 Дифференциальное кодирование 
Дифференциальное кодирование представляет собой метод цифрового кодирования, согласно которому 
двоичное значение обозначается изменением сигнала, а не конкретным состоянием сигнала. Двоичные 
данные в любой заданной пользователем I/Q-модуляции или модуляции FSK можно кодировать с помощью 
дифференциального кодирования в процессе модуляции через смещения таблицы символов, заданные в 
карте дифференциальных состояний (Differential State Map). 
Рассмотрим, к примеру, принятую по умолчанию у генератора сигналов I/Q-модуляцию 4QAM. При 
пользовательской модуляции, основанной на принятом по умолчанию шаблоне 4QAM, табличный редактор 
I/Q Values содержит данные, которые отображают четыре символа (00, 01, 10 и 11), нанесенные на 
плоскость I/Q с использованием двух особых значений 1.000000 и –1.000000. На следующем рисунке 
проиллюстрирована модуляция 4QAM в табличном редакторе I/Q Values. 

  
 
Ниже показана карта состояний I/Q при модуляции 4QAM. 
 

Второй символ 
Данные = 00000001 

Особые значения: –1, +1 
 
 
 
 
 
 

 
 
 
 
 
 

Третий символ 
Данные: 00000010 

Особые значения: –1, –1 

 

 

Первый символ 
Данные = 00000000 
Особые значения: +1, +1 
 
 
 
 
 
 
 
 
 
 
 
 
Четвертый символ 
Данные = 00000011 
Особые значения: +1, –1 

 
Дифференциальное кодирование использует смещения в таблице символов для кодирования 
пользовательских схем модуляции. Редактор Differential State Map (карта дифференциальных 
состояний) используется для внесения значений смещения таблицы символов, что в свою очередь 
вызывает переходы через карту состояний I/Q (I/Q State Map) на основе их ассоциированного значения 
данных. Всякий раз, когда модулируется значение данных, значение смещения, хранящееся в карте 
дифференциальных состояний, используется для кодирования данных путем перехода через карту 
состояний I/Q в направлении и на расстояние, определяемые значением смещения таблицы символов. 
Ввод значения +1 вызывает переход на одно состояние вперед по карте состояний I/Q, как показано на 
следующей иллюстрации.  
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      ПРИМЕЧАНИЕ        
Следующие иллюстрации карты состояний I/Q показывают все возможные переходы состояний, 
использующих конкретное значение смещения таблицы символов. Реальный переход из одного состояния в 
другое зависит от состояния, при котором начинается модуляция. 
В качестве примера рассмотрим следующие значения данных и смещения таблицы символов. 

Таблица 11-3 

Данные 00000000 00000001 00000010 00000011 
Значение смещения +1 –1 +2 0 
 

      ПРИМЕЧАНИЕ        
Количество битов на символ можно выразить следующей формулой. Это выражение является округляющей 
функцией, поэтому если значение х содержит дробную часть, то х округляется до следующего целого числа. 

  
Здесь х – количество битов на символ, y – количество дифференциальных состояний. 
 

Значение данных: 00000000 
Смещение таблицы символов: +1 

Переход на одно состояние вперед 

 
 

Значение данных: 00000001 
Значение таблицы символов: –1 

Переход на одно состояние назад 

 
 

Значение данных: 00000010 
Смещение таблицы символов: +2 

Переход на два состояния вперед 

 

Значение данных: 00000011 
Смещение таблицы символов: 0 

Нет перехода 

 
 
Применительно к заданной пользователем (и принятой по умолчанию) карте I/Q 4QAM, начиная с первого 
символа (данные 00), на следующем рисунке показаны переходы дифференциального кодирования для 
потока данных (в двухбитовых символах) 0011100001.   
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1-й символ 5-й символ 

  
2-й символ  4-й символ 
 
 
Значение данных Смещение таблицы символов 

  00   +1 

  01   –1 

  10   +2 

  11   +0 

Как можно видеть, первый и четвертый символы, имеющие одинаковое значение данных (00) формируют 
одинаковый переход состояния (на одно состояние вперед). В дифференциальном кодировании значения 
символов не определяют расположение; они определяют направление и дистанцию перехода по карте 
состояний I/Q. 

11.7.1  Применение дифференциального кодирования 
Табличный редактор Differential State Map (карта дифференциальных состояний) позволяет вам 
изменять карту дифференциальных состояний, ассоциированную с пользовательской I/Q-модуляцией и 
пользовательской модуляцией FSK. В этой процедуре показано, как создать пользовательскую I/Q-
модуляцию, затем сконфигурировать, ввести в действие и применять дифференциальное кодирование к 
пользовательской модуляции. За дополнительной информацией обращайтесь к описанию на стр. 186. 

Конфигурирование пользовательской I/Q-модуляции 
1. Нажмите клавишу Preset. 
2. Нажмите указанные ниже клавиши, как это требуется для вашего типа формата. 
Для формата Custom ARB 
Нажмите клавиши Mode > ARB Custom Modulation > Single Carrier Setup > Modulation Type > Select > 
More 1 of 2 > Define User I/Q > More > Load Default I/Q Map > QAM > 4QAM. 
Или эту альтернативную последовательность клавиш: 
Нажмите клавиши Mode > ARB Custom Modulation > Single Carrier Setup > Quick Setup (нужный формат) 
> Modulation Type > Select > More > Define User I/Q > More 1 of 2 > Load Default I/Q Map > QAM > 4QAM. 
Это загружает принятую по умолчанию I/Q-модуляцию 4QAM и отображает ее в табличном редакторе 
значений I/Q. Принятая по умолчанию I/Q-модуляция 4QAM содержит данные, которые отображают четыре 
символа (00, 01, 10 и 11), нанесенные на плоскость I/Q с использованием двух особых значений (1.000000 и 
–1.000000). Эти четыре символа будут прослеживаться в процессе модуляции значениями смещения 
таблицы символов, ассоциированными с каждым символом данных (см. рис. 11-41). 

  
 Рис. 11-41 

3-й символ 

Данные  
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Обращение к редактору карты дифференциальных состояний 
Нажмите функциональную клавишу Configure Differential Encoding. Это открывает табличный редактор 
Differential State Map, как показано на рисунке. В этот момент вы видите данные для первого 
символа (00000000) и курсор, готовый для ввода значения смещения. Теперь вы подготовлены к созданию 
пользовательского дифференциального кодирования для пользовательской (принятой по умолчанию) I/Q-
модуляции 4QAM (см. рис. 11-42). 

Данные Область ввода значений смещения таблицы символов 

  
 Рис. 11-42 

Редактирование карты дифференциальных состояний 
1. Нажмите клавиши 1 > Enter. Это кодирует первый символ путем добавления смещения 1 таблицы 

символов. Этот символ вращается вперед на карте состояний на значение 1, когда модулируется 
значение данных 0. 

2. Нажмите клавиши +/– > 1 > Enter.  Это кодирует второй символ путем добавления смещения –1 таблицы 
символов. Этот символ вращается назад на карте состояний на значение 1, когда модулируется 
значение данных 1. 

      ПРИМЕЧАНИЕ        
В этот момент модуляция имеет один бит на символ. Для первых двух значений данных (00000000 и 
00000001) значащими являются только последние биты (соответственно 0 и 1). 

3. Нажмите клавиши 2 > Enter. Это кодирует третий символ путем добавления смещения 2 таблицы 
символов. Символ вращается вперед на карте состояний на 2 значения, когда модулируется значение 
данных 10. 

4. Нажмите клавиши 0 > Enter. Это кодирует четвертый символ путем добавления смещения 0 таблицы 
символов. Символ не вращается на карте состояний, когда модулируется значение данных 11. 

      ПРИМЕЧАНИЕ        
В этот момент модуляция имеет два бита на символ. Для значений данных 00000000, 00000001, 
00000010 и 00000011 значения символов составляют соответственно 00, 01, 10 и 11. 

Применение пользовательского дифференциального кодирования 
Нажмите клавиши Return > Differential Encoding Off On. Это применяет специальное дифференциальное 
кодирование к пользовательской модуляции. 

      ПРИМЕЧАНИЕ        
Обратите внимание на то, что рядом с надписью Differential State Map на дисплее появилась 
надпись (UNSTORED). Карты дифференциальных состояний связаны с пользовательской модуляцией, для 
которой они были созданы. 
Чтобы сохранить в памяти специальную карту дифференциальных состояний, вы должны сохранить в 
памяти пользовательскую модуляцию, для которой она была разработана. В противном случае данные 
смещений таблицы символов очищаются, когда вы нажмете функциональную клавишу Confirm Exit From 
Table Without Saving при выходе из табличного редактора I/Q или FSK. 
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13 Работа в обстановке секретности 

Если вы работаете с прибором в обстановке секретности, то вам может понадобиться информация о том, 
как очистить память и удалить из нее секретные данные в соответствии с опубликованными стандартами 
Министерства обороны США и других компетентных органов. 
Такие указания применительно к генераторам сигналов MXG и EXG содержатся в документе формата PDF 
"Security Features and Document of Volatility" (описание функций защиты информации). Этот документ не 
входит в состав документации на прилагаемом к прибору компакт-диске, однако его можно скачать с сайта 
компании Agilent Technologies, как описано ниже. 
В этом документе содержатся следующая информация: 
 Термины и определения секретности 
 Типы приборной памяти 
 Очистка памяти и удаление секретных данных (функции Erase All и Sanitize All) 
 Удаление данных о перманентных установках параметров 
 Применение функции скрытого дисплея (см. также раздел 13.2) 
 Деклассификация неисправного прибора 

13.1 Как получить описание функций защиты информации 
1. Зайдите на сайт: http://www.agilent.com/find/security. 
2. Чтобы найти и скачать упомянутый выше документ, выберите обозначение модели "N5182B", "N5181B", 

"N5172B" или "N5171B", затем нажмите экранную кнопку "Submit". 

13.2 Применение функции скрытого дисплея 
Эта функция защищает прибор от вмешательства постороннего персонала, исключая для него возможность 
наблюдения информации на экране и изменения текущей конфигурации с передней панели. Когда 
задействована эта функция, экран очищается, отображается лишь сообщение *** SECURE DISPLAY 
ACTIVATED *** , как показано ниже на рис. 13-1; при этом блокируются клавиши на передней панели.  
Чтобы задействовать эту функцию, нажмите клавиши Utility > Display > More > Activate Secure Display > 
Confirm Secure Display. 
После того, как будет задействована эта функция, необходимо будет выключить и снова включить прибор, 
чтобы восстановить нормальное функционирование дисплея и клавиш на передней панели. 
 

 
 Рис. 13-1 Экран генератора сигналов в режиме скрытого дисплея 
 

http://www.agilent.com/find/security
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14 Устранение неполадок 

Эта глава состоит из следующих разделов: 
14.1 Дисплей – стр. 191 
14.2 Блокировка органов управления у генератора сигналов – стр. 191 
14.3 Выход ВЧ сигнала – стр. 191 
14.4 Развертка – стр. 194 
14.5 Сохранение данных во внутренней памяти – стр. 194 
14.6 Сохранение данных на USB-накопителе – стр. 195 
14.7 Предустановка (Preset) – стр. 195 
14.8 Сообщения об ошибках – стр. 195 
14.9 Тестирование прибора с передней панели – стр. 196 
14.10 Описание самопроверки – стр. 196 
14.11 Лицензии – стр. 198 
14.12 Взаимодействие с компанией Agilent Technologies – стр. 198 

14.1 Дисплей 
Слишком темный экран 
Возможно, установлена минимальная яркость. Обратитесь к рисунку на стр. 22, чтобы найти 
функциональную клавишу регулировки яркости (Brightness) и отрегулировать яркость. 

Экран становится черным при применении USB-накопителя 
Отсоединение от прибора USB-накопителя, когда прибор только начинает обращаться к нему, может 
вызвать потемнение экрана. Выключите прибор и снова включите его. 

14.2 Блокировка органов управления у генератора сигналов 
 Проверьте, не находится ли генератор сигналов в режиме дистанционного управления (когда на дисплее 

отображается вспомогательный индикатор R). Чтобы выйти из режима дистанционного управления и 
разблокировать органы управления на передней панели, нажмите клавишу Local Cancel/(Esc). 

 Проверьте, не находится ли генератор сигналов в состоянии местной блокировки, препятствующей 
управлению прибором с передней панели. За информацией о местной блокировке обращайтесь к 
Руководству по программированию (Programming Guide). 

 Когда на экране отображается прогресс-индикатор, это означает, что прибор занят выполнением 
текущей операции. 

 Выполните предустановку генератора сигналов. 
 Выключите питание прибора и снова включите его. 

14.3 Выход ВЧ сигнала 
14.3.1  Отсутствует выходной ВЧ сигнал 
 Проверьте состояние индикаторного светодиода RF ON/OFF (показан на стр. 11). Если он не светится, 

нажмите клавишу RF On/Off, чтобы включить выход. 
 Проследите за тем, чтобы амплитуда была установлена в пределах рабочего диапазона. 
 Если прибор занимается воспроизведением модулирующего сигнала, проверьте правильность установки 

полярности и маршрутизации маркеров (см. раздел 8.5). 

14.3.2  Отключается питание прибора 
Если не работает блок питания прибора, то он требует ремонта или замены. Если вы не можете 
отремонтировать прибор, отправьте его в сервисный центр компании Agilent Technologies для ремонта (см. 
раздел 14.11). 
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14.3.3  Отсутствует модуляция на выходе ВЧ сигнала 
Проверьте состояние индикаторного светодиода Mod On/Off и функциональной клавиши <модуляция> Off 
On. Светодиод должен светиться, а функциональная клавиша должна быть установлена на On. См. также 
раздел 3.7. 
В случае цифровой модуляции у векторного генератора сигналов проследите за тем, чтобы был включен 
внутренний I/Q-модулятор (при этом на дисплее должен отображаться вспомогательный индикатор I/Q). 
При применении внешнего источника модуляции убедитесь в том, что он включен и работает в пределах 
допустимых для генератора сигналов значений параметров. 

14.3.4  Слишком низкий уровень мощности выходного ВЧ сигнала 
 Если в области дисплея AMPLITUDE отображается вспомогательный индикатор OFFS, то следует 

устранить смещение. Нажмите клавиши Amptd > More 1 of 2 > Amptd Offset > 0 > dB. 
 Если в области дисплея AMPLITUDE отображается вспомогательный индикатор REF, то следует 

выключить режим работы с опорным значением: 
1. Нажмите клавиши Amptd > More > Amptd Ref Off On на Off. 
2. Установите нужный уровень выходной мощности. 

 Если вы применяете генератор сигналов с внешним смесителем, обращайтесь к подразделу 14.3.7. 
 Если вы применяете генератор сигналов с анализатором спектра, обращайтесь к подразделу 14.3.6. 
 Если включена импульсная модуляция, отключите функцию автоматической стабилизации мощности 

(ALC) и проверьте, находится ли длительность импульсов в допустимых пределах. 

14.3.5  Искажение выходного сигнала 
Когда вы редактируете и снова сохраняете в памяти сегмент последовательности модулирующих сигналов, 
последовательность автоматически не обновляется значением RMS, которое хранится в ее заголовке. Это 
может вызвать искажение выходного сигнала. Выведите на экран данные заголовка последовательности и 
вычислите заново значение RMS (см. раздел 8.4). 

14.3.6  Исчезновение сигнала при работе с анализатором спектра 
  ПРЕДОСТЕРЕЖЕНИЕ    
Во избежание повреждения прибора или ухудшения его характеристик не допускайте превышения 
максимально допустимого уровня 33 дБм (2 Вт) мощности обратного сигнала на ВЧ входе. См. также 
документ Tips for Preventing Signal Generator Damage на сайте www.agilent.com. 
Воздействие мощности обратного сигнала может вызвать проблемы с ВЧ выходом, когда вы применяете 
генератор сигналов с анализатором спектра, который не имеет преселектора. В этом случае следует 
отключить функцию автоматической стабилизации мощности (ALC). 
На некоторых частотах на входной ВЧ порт анализатора спектра может просачиваться сигнал гетеродина 
на уровне +5 дБм. Если разность значений частоты гетеродина и ВЧ несущей меньше ширины полосы 
частот ALC, то обратный сигнал гетеродина может вызвать амплитудную модуляцию выходного ВЧ сигнала 
генератора сигналов. Частота этой нежелательной амплитудной модуляции равна разности значений 
частоты гетеродина анализатора спектра и несущей на выходе генератора сигналов. 
Проблемы обратного сигнала можно решить путем применения одного из режимов работы генератора 
сигналов без автоматической стабилизации мощности: режима ALC Off или режима Power Search (глава 5). 

14.3.7  Исчезновение сигнала при работе со смесителем 
  ПРЕДОСТЕРЕЖЕНИЕ    
Во избежание повреждения прибора или ухудшения его характеристик не допускайте превышения 
максимально допустимого уровня 33 дБм (2 Вт) мощности обратного сигнала на ВЧ входе. См. также 
документ Tips for Preventing Signal Generator Damage на сайте www.agilent.com. 
Для предотвращения исчезновения сигнала на ВЧ выходе генератора сигналов при работе со смесителем 
на малом уровне сигнала следует установить на выход аттенюатор и увеличить амплитуду выходного ВЧ 
сигнала. 

http://www.agilent.com/
http://www.agilent.com/
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Влияние обратного сигнала на автоматическую стабилизацию мощности 
На этом рисунке показана конфигурация, в которой генератор сигнал подает низкоамплитудный сигнал на 
смеситель. 

 
 
Стабилизированный внутри генератора уровень выходного ВЧ сигнала (уровень ALC) составляет –8 дБм. 
На смеситель подается сигнал гетеродина с уровнем +10 дБм, причем ослабление сигнала гетеродина на 
входе смесителя составляет 15 дБ. Таким образом, сигнал гетеродина на уровне –5 дБм проникает на 
выход генератора сигналов и попадает на внутренний детектор системы ALC. 
В зависимости от частоты может сложиться ситуация, в которой на детектор поступает почти вся мощность 
обратного сигнала с частотой гетеродина. Поскольку детектор реагирует на суммарную мощность 
независимо от частоты, это приводит к уменьшению уровня сигнала ВЧ на выходе генератора сигналов 
вследствие действия системы ALC. В данном примере мощность поступающего на детектор обратного 
сигнала превышает уровень ALC, что может привести к исчезновению сигнала на выходе генератора 
сигналов. 

Решение проблемы обратного сигнала 
На этом рисунке показана аналогичная конфигурация, но с дополнительным аттенюатором 10 дБ между 
выходом генератора и сигналов и входом смесителя. 

  
 
Уровень ALC увеличивается до +2 дБм; при этом на выходе аттенюатора (т.е. на входе смесителя) 
действует уровень ВЧ сигнала –8 дБм, как и в предыдущем примере. В сравнении с исходной 
конфигурацией здесь уровень ALC больше на 10 дБ, в то же время аттенюатор ослабляет на 10 дБ 
обратное прохождение сигнала от смесителя на выход генератора сигналов. В данной конфигурации на 
детектор подается сигнал с уровнем +2 дБ, а не –15 дБ, как при нежелательном просачивании сигнала 
гетеродина. Разница в 17 дБ между уровнями полезного сигнала и паразитного сигнала вызывает 
смещение уровня выходного сигнала генератора не более, чем на 0,1 дБ. 

Смеситель 

Сигнал ПЧ 

Уровень сигнала  
гетеродина = +10 дБм 
 

Просачивание сигнала  
гетеродина = –5 дБм 
 

Выходной ВЧ  
сигнал  = –8 дБм 

 

Уровень ALC  
= –8 дБм 

 

Управление выходом  
генератора сигналов 

Детектор  
измеряет  
уровень  

ALC   
–8 дБм 

 

Детектор  
измеряет  
обратную  
мощность   

–5 дБм 
 

 Гетеродин 

Смеситель 

Сигнал ПЧ 

Уровень сигнала  
гетеродина = +10 дБм 
 

Просачивание сигнала  
гетеродина = –5 дБм 
 

Выходной ВЧ  
сигнал  = –8 дБм 

 

Уровень ALC/ 
ВЧ сигнал  
= +2 дБм 

 

Управление выходом  
генератора сигналов 

Детектор  
измеряет  
уровень  

ALC   
+2 дБм 

 

Детектор  
измеряет  
обратную  
мощность   
–15 дБм 

 

 Гетеродин 
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14.4 Развертка 
14.4.1  Не выключается развертка 
Нажмите клавиши Sweep > Sweep > Off. 

14.4.2  Развертка застопорилась 
Текущее состояние развертки индицируется темным прямоугольником (см. раздел 3.6). Если вам кажется, 
что развертка застопорилась, проверьте следующее: 
1. Включите развертку нажатием одной из указанных ниже последовательностей клавиш: 

Sweep > Sweep > Freq 
Sweep > Sweep > Amptd 
Sweep > Sweep > Waveform (только у векторных генераторов сигналов) 

2. Если задействован режим однократной развертки, нажмите функциональную клавишу Single Sweep. 
3. Если запуск развертки (индицируется функциональной клавишей Sweep Trigger) не установлен в 

режим Free Run, то установите его в режим Free Run, чтобы проверить, не заблокирована ли развертка 
отсутствием сигнала запуска. 

4. Если поточечный запуск развертки (индицируется функциональной клавишей Point Trigger) не 
установлен в режим Free Run, то установите его в режим Free Run, чтобы проверить, не заблокирована 
ли развертка отсутствием сигнала поточечного запуска. 

5. Установите время выдержки (Dwell Time) на одну секунду, чтобы выяснить, не установлено ли слишком 
малое или слишком большое время выдержки, из-за чего кажется, что развертка застопорилась. 

6. Проследите за тем, чтобы ступенчатая развертка или развертка по списку содержала не менее двух 
точек. 

14.4.3  Неправильное время выдержки при развертке по списку 
1. Нажмите клавиши Sweep > More > Configure List Sweep. 
2. Проверьте правильность установки значений времени выдержки при развертке по списку. 
3. Если заметите неправильные значения, скорректируйте их. 

Если значения являются правильными, переходите к следующему пункту. 
4. Нажмите клавишу More и убедитесь в том, что функциональная клавиша Dwell Type List Sweep 

установлена на Sweep. 
 Если выбран вариант Step, то генератор сигналов выполняет развертку по списку с использованием 

установки времени выдержки для ступенчатой развертки вместо развертки по списку. 
См. также раздел 3.6. 

14.4.4  Данные развертки по списку исчезли из вызванного регистра 
Данные развертки по списку не сохраняются в качестве части набора параметров прибора в регистре 
состояний прибора. Поэтому у генератора сигналов действует только текущая установка параметров 
развертки по списку. Вы можете сохранить данные развертки по списку в каталоге прибора (см. подраздел 
3.8.4). 

14.4.5  Не изменяется амплитуда при ступенчатой развертке или развертке по списку 
Проверьте, установлен ли тип развертки на развертку амплитуды (Amptd); амплитуда не изменяется при 
развертке частоты (Freq) или при установке типа развертки на Waveform. 

14.5 Сохранение данных во внутренней памяти 
Набор параметров прибора занесен в память, но регистр пуст или содержит не те данные 
Если вы попытались использовать номер регистра, который пуст или содержит не те данные, вызовите 
регистр 99. Если выбрать номер регистра > 99, то генератор сигналов автоматически сохранит набор 
параметров (состояние) прибора в регистре 99. См. также подраздел 3.8.6. 
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14.6 Сохранение данных на USB-накопителе 
Прибор распознает подключение USB-накопителя, но не отображает файлы 
Если данный USB-накопитель работает с другими приборами или компьютерами, но не читается на этом 
приборе, то он просто может быть несовместимым с этим генератором сигналов. Попробуйте другой USB-
накопитель.  
Сведения о совместимых USB-накопителях вы можете найти на сайте http://www.agilent.com/find/mxg. 

14.7 Предустановка (Preset) 
Генератор сигналов не реагирует на нажатие клавиши Preset 
Если генератор сигналов не реагирует на нажатие клавиши Preset, то возможно, что он находится в режиме 
дистанционного управления, в котором блокируются клавиши на передней панели. Чтобы выйти из режима 
дистанционного управления и разблокировать клавиатуру, нажмите клавишу Local Cancel/(Esc). 

При нажатии клавиши Preset выполняется пользовательская предустановка 
Это поведение является результатом применения обратно совместимой команды SCPI. Чтобы 
восстановить нормальное поведение прибора, пошлите команду :SYST:PRESet:TYPE NORM. 
За описанием команд SCPI обращайтесь к Справочнику по командам SCPI (SCPI Command Reference). 

14.8 Сообщения об ошибках 
События генерируют не более одного типа ошибок. Например, событие, которое генерирует ошибку 
запроса, не генерирует ошибку, специфичную для устройства, ошибку исполнения или командную ошибку. 
Ошибки запроса (от –499 до –400) указывают, что управление очередью вывода обнаружило проблему с 
протоколом обмена сообщениями, описанную в главе 6 стандарта IEEE 488.2. Ошибки в этом классе 
устанавливают бит ошибок запроса (бит 2) в регистре статуса событий (IEEE 488.2, раздел 11.5.1). Эти 
ошибки соответствуют ошибкам протокола обмена сообщениями, описанными в стандарте IEEE 488.2, 6.5. 
В таком случае: 
 либо предпринималась попытка считывания данных из очереди вывода, когда вывод отсутствовал или 

был отложен,  
 либо потеряны данные в очереди вывода. 
Ошибки, специфичные для устройства (от –399 до –300, от 201 до 703 и от 800 до 810) указывают на 
неправильное выполнение устройством операции вследствие аномального состояния оборудования или 
микропрограммы. Эти коды используются также для ошибок, возникающих при самопроверке. Ошибки в 
этом классе устанавливают бит ошибок, специфичных для устройств (бит 3), в регистре статуса событий 
(IEEE 488.2, раздел 11.5.1). 
Строка <error_message> для положительной ошибки не определяется системой SCPI. Положительная 
ошибка указывает, что прибор обнаружил ошибку внутри системы GPIB, в аппаратной части или 
микропрограмме прибора, во время переноса блока данных или во время калибровки. 
Ошибки исполнения (от –299 до –200) указывают, что обнаружена ошибка приборным блоком контроля 
исполнения. Ошибки в этом классе устанавливают бит ошибок исполнения (бит 4) в регистре статуса 
событий (IEEE 488.2, раздел 11.5.1). В таком случае: 
 либо следующий за заголовком элемент <PROGRAM DATA> был классифицирован устройством как 

находящийся за пределами допустимого входного диапазона, или иным образом несовместим с 
возможностями устройства, 

 либо допустимое программное сообщение не исполнено надлежащим образом вследствие некоторого 
состояния устройства. 

Сообщения об ошибках исполнения подаются после завершения операций округления и оценки выражения. 
Например, округление элемента численных данных не считается ошибкой исполнения. 
Командные ошибки (от –199 до –100) указывают, что синтаксический анализатор прибора обнаружил 
синтаксическую ошибку IEEE 488.2. Ошибки в этом классе устанавливают бит командных ошибок (бит 5)  в 
регистре статуса событий (IEEE 488.2, раздел 11.5.1). В таком случае: 

http://www.agilent.com/find/mxg
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 либо синтаксический анализатор прибора обнаружил синтаксическую ошибку IEEE 488.2 (было получено 
сообщение control-to-device, что является нарушением стандарта IEEE 488.2. Возможные нарушения 
включают в себя элемент данных, который нарушает форматы приема у устройства, или тип элемента 
данных, неприемлемый для устройства), 

 либо был принят неопознанный заголовок. Это включает в себя неправильные специфичные для 
устройств заголовки и неправильные или неприемлемые общие команды IEEE 488.2. 

14.9 Тестирование прибора с передней панели 

 

 
 
 
 
 
Устанавливает выбранный цвет у всех пикселей 
дисплея. Чтобы вернуться к нормальному режиму 
отображения, следует нажать любую клавишу. 
 
 
Проверка мигания светодиодов RF On/Off, Mod 
On/Off и More 
 
Отображает карту клавиатуры. При нажатии клавиши 
индицируется ее местоположение. 
 
Правильное функционирование: 
до упора против часовой стрелки = –10 
до упора по часовой стрелке = 10 

 
Для выяснения функций клавиш пользуйтесь встроенной справкой по клавишам, как описано в разделе 3.2. 

14.10  Описание самопроверки 
Самопроверка представляет собой последовательность внутренних тестов, которые проверяют различные 
функции генератора сигналов. Самопроверку можно инициировать также через дистанционный Web-
интерфейс. За дополнительной информацией на этот счет обращайтесь к Руководству по 
программированию (Programming Guide). 
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 Пояснения к рисунку  

1) View Details – Отображает подробную информацию о выделенном тесте. См. стр. 30. 
2) Loop Selected – Запускает цикл выбранных тестов до возникновения неполадки. 
3) Go To Test – Открывает меню Go To. Добавляет навигационные клавиши в меню Self Test. 

Для выяснения функций клавиш пользуйтесь встроенной 
справкой по клавишам, как описано в разделе 3.2. 
 

Запускает автоматическую  
диагностическую   
самопроверку. 
 

Под заголовком Self Test  
Summary отображается  
текущее состояние  
самопроверки. 
 
Открывает таблицу, в которой  
пользователь выбирает  
конкретные тесты и смотрит 
подробности на экране  
Test Editor. 
 

см. Пояснение 1) 
 
Выполняет выделенную  
операцию. 
 
Выбирает или отменяет  
выделенную операцию. 
 
Выбирает или отменяет  
все операции. 
 
Выполняет все   
выбранные операции. 
 

см. Пояснение 2) 

см. Пояснение 3) 
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14.11  Лицензии 
Прекращает действовать лицензия, основанная на времени 
 Возможно, дата и время в приборе были установлены с опережением, что привело к фиктивному 

истечению срока действия лицензии. 
 Возможно, дата и время в приборе были установлены с отставанием, превышающим 25 часов, в 

результате чего прибор игнорирует лицензии, основанные на времени. 
Обращайтесь к подразделу 2.1.4, где содержатся предупредительные указания в отношении установки 
даты и времени. 

Невозможно загрузить лицензию, основанную на времени 
Возможно, дата и время в приборе были установлены с отставанием, превышающим 25 часов, в результате 
чего прибор игнорирует лицензии, основанные на времени. 
Обращайтесь к подразделу 2.1.4, где содержатся предупредительные указания в отношении установки 
даты и времени. 

14.12  Взаимодействие с компанией Agilent Technologies 
 Содействие в задачах испытаний и измерений, информация о местных представительствах компании 

Agilent Technologies: http://www.agilent.com/find/assist 
 Принадлежности и документация: http://www.agilent.com/find/X-Series_SG 
 Новые выпуски микропрограммного обеспечения: http://www.agilent.com/find/upgradeassistant 
Если у вас нет доступа к Интернету, обращайтесь к местному представителю компании Agilent Technologies. 

      ПРИМЕЧАНИЕ        
При переписке или при общении по телефону указывайте номер модели генератора сигналов и его полный 
серийный номер. Эта информация позволит представителю компании Agilent Technologies определить, 
находится ли ваш прибор на гарантии. 

Возврат прибора изготовителю для ремонта или технического обслуживания 
1. Соберите как можно больше информации, характеризующей неисправность генератора сигналов. 
2. Позвоните по телефону регионального офиса Agilent (список телефонов можно найти на странице 

http://www.agilent.com/find/assist). 
 Если у вас нет доступа к Интернету, обращайтесь к местному представителю компании Agilent Technolo-

gies. 
После обмена информацией о генераторе сигналов и его состоянии вы получите информацию о том, где 
можно отправить ваш прибор для ремонта. 

3. Отправляйте прибор в его штатной (первоначальной) упаковке (если она сохранилась) или в 
аналогичной упаковке, обеспечивающей надлежащую защиту прибора во время перевозки. 

 

http://www.agilent.com/find/assist
http://www.agilent.com/find/X-Series_SG
http://www.agilent.com/find/upgradeassistant
http://www.agilent.com/find/assist
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15  Технические характеристики 
Метрологические и технические характеристики генераторов сигналов N5171B и N5172B. 

 
Частотные характеристики 

Частотные характеристики генераторов приведены в таблице 3. 
Таблица 3 

Частотные характеристики 
Диапазон частот Опция 501 (только для N5171B) 

Опция 503 
Опция 506 

от 9 кГц до 1 ГГц 
от 9 кГц до 3 ГГц 
от 9 кГц до 6 ГГц 

Полосы частот Диапазон частот N 
1 от 9 кГц до 5 МГц 1 (цифровой синтезатор) 
1 от 5 МГц до 250 МГц 1 
2 от 250 МГц до 375 МГц 0,25 
3 от 375 МГц до 750 МГц 0,5 
4 от 750 МГц до 1500 МГц 1 
5 от 1500 МГц до 3000,001 МГц 2 
6 от 3000,001 МГц до 6000 МГц 4 

N - показатель, используемый для облегчения поиска определенной характеристики 
Дискретность установки частоты 0,01 Гц 

Пределы допускаемой относительной 
погрешности установки частоты 

 2,1·10-6 (только для N5171B, N5172B) 

 1,3·10-7 (только для N5181B, N5182B) 

Частота внутреннего опорного 
кварцевого генератора 

10 МГц 

 
Параметры выходной мощности 
 

Максимальный уровень выходной мощности в диапазоне частот приведен в таблице 4. 
Таблица 4 

Диапазон частот 

Максимальный уровень выходной мощности, дБм 
N5171B, N5172B N5181B, N5182B 

Стандартное 
исполнение Опция 1EА Стандартное 

исполнение Опция 1EА 

от 9 кГц до 10 МГц 
от 10 МГц до 3 ГГц 
от 3 ГГц до 5 ГГц 
от 5 ГГц до 6 ГГц 

+13 
+18 
+16 
+16 

+17 
+21 
+18 
+18 

+13 
+18 
+16 
+16 

+17 
+24 
+19 
+18 

 
Пределы допускаемой абсолютной погрешности установки уровня выходной мощности, 

дБ, в диапазоне частот приведены в таблице 5. 
Таблица 5 

Диапазон частот Установленный уровень мощности, дБм 
от +21 до -60* от -60 до -110 от -110 до -127** 

от 100 кГц до 5 МГц 
от 5 МГц до 3 ГГц 
от 3 ГГц до 6 ГГц 

± 0,8 
± 0,6 
± 0,6 

± 0,9 
± 0,8 
± 1,1 

– 
± 1,5 
± 1,6 

* для генераторов N5181B, N5182B уровень мощности от +24 до -60 
** для генераторов N5181B, N5182B с опцией 1ЕQ 

 
 

Дискретность установки мощности        0,01 дБ. 
Полное выходное сопротивление         50 Ом. 
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Спектральные характеристики 
 

Уровень гармонических составляющих относительно основного немодулированного 
сигнала в диапазоне частот приведен в таблице 6. 
Таблица 6 

Диапазон частот 
Уровень гармонических составляющих, дБ, не более 

Стандартное исполнение 
(менее +4 дБм) 

Опция 1EА 
(менее +12 дБм) 

от 9 кГц до 3 ГГц -35 -30 
 
Уровень негармонических составляющих относительно основного немодулированного 

сигнала в диапазоне частот приведен в таблице 7. 
Таблица 7 

Диапазон частот 

Уровень негармонических составляющих, дБ, не более 
(отстройка от несущей более 10 кГц) 

N5171B, N5172B N5181B, N5182B 
Стандартное 
исполнение  

Стандартное 
исполнение  

Опции  
UNX и UNY 

от 5 МГц до 250 МГц 
от 250 МГц до 750 МГц 
от 750 МГц до 1,5 ГГц 

от 1,5 ГГц до 3 ГГц 
от 3 ГГц до 6 ГГц 

-75 
-75 
-72 
-66 
-60 

-75 
-87 
-87 
-81 
-75 

-75 
-96 
-92 
-86 
-80 

 
Уровень фазовых шумов для генераторов N5181B, N5182B в стандартном исполнении и с 

опцией UNX приведен в таблице 8. 
Таблица 8 

Частота 

Уровень фазовых шумов, дБ/Гц 
(отстройка от несущей на 20 кГц) 

N5181B, N5182B 
Стандартное исполнение  Опция UNX 

менее 250 МГц 
250 МГц 
500 МГц 

1 ГГц 
2 ГГц 
3 ГГц 
4 ГГц 
6 ГГц 

-129 
-140 
-135 
-131 
-124 
-123 
-118 
-116 

-140 
-144 
-143 
-141 
-135 
-131 
-118 
-117 
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Уровень фазовых шумов для генераторов N5181B, N5182B с опцией UNY приведен в 
таблице 9. 
Таблица 9 

Частота Уровень фазовых шумов, дБ/Гц, при отстройке от несущей на 
10 Гц 100 Гц 1 кГц 10 кГц 100 кГц 

249 МГц 
250,1 МГц 
500 МГц 

1 ГГц 
2 ГГц 
3 ГГц 
4 ГГц 
6 ГГц 

-93 
-96 
-89 
-87 
-79 
-74 
-73 
-69 

-103 
-104 
-98 
-93 
-85 
-81 
-79 
-76 

-130 
-127 
-125 
-123 
-114 
-112 
-110 
-107 

-139 
-144 
-139 
-141 
-135 
-132 
-130 
-126 

-138 
-147 
-145 
-140 
-134 
-131 
-127 
-125 

 
Характеристики частотной, фазовой и амплитудной модуляций (опция UNT) 
 

Характеристики частотной модуляций (ЧМ) генераторов приведены в таблице 10. 
Таблица 10 

Характеристика Значение 
N5171B, N5172B N5181B, N5182B 

Максимальное значение девиации в режиме ЧМ N×10 МГц N×4 МГц 
Дискретность установки девиации частоты 
(наибольшее значение) 0,1% или 1 Гц 

Пределы допускаемой абсолютной погрешности 
установки девиации частоты (частота модуляции  
1 кГц, девиация менее N×50 кГц) 

± 2% от установленной девиации + 20 Гц 

 
Характеристики фазовой модуляций (ФМ) генераторов приведены в таблице 11. 

Таблица 11 

Характеристика 
Значение 

Установки полосы пропускания 
Нормальная Широкополосная 

Максимальное значение девиации фазы  
в режиме ФМ N × 5 рад N × 0,5 рад 

Частотная характеристика (3 дБ) от 0 до 1 МГц от 0 до 4 МГц 
Дискретность установки девиации фазы 0,1% от установленной девиации фазы 

 
Характеристики амплитудной модуляций (АМ) генераторов приведены в таблице 12. 

Таблица 12 
Характеристика Значение 

Максимальный коэффициент амплитудной 
модуляций (КАМ) 100 % 

Дискретность установки КАМ 0,1% 
Пределы допускаемой абсолютной погрешности 
установки КАМ (частота модуляции 1 кГц, КАМ 
менее 80 %) в диапазоне частот: 
   менее 5 МГц 
   от 5 МГц до 2 ГГц 
   от 2 МГц до 3 ГГц 

 
 
 

± 1,5 % от установленного КАМ + 1% 
± 3 % от установленного КАМ + 1% 
± 5 % от установленного КАМ + 1% 

Примечание – выходная мощность генераторов в режиме АМ на 6 дБ меньше максимальных 
выходных значений мощности при температуре окружающей среды от 20 до 30 °С 
 



Глава 15: Технические характеристики  
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Основные технические характеристики генераторов приведены в таблице 13. 
Таблица 13 

Характеристика Значение 

Номинальные параметры сети питания переменного тока 100 – 120 В (50/60/400 Гц) 
220 – 240 В (50/60 Гц) 

Потребляемая мощность, В·А, не более: 
   генераторов N5171B, N5181B 
   генераторов N5172B, N5182B 

 
160 
300 

Габаритные размеры (ширинавысотаглубина), мм 458  88  508 
Масса, кг, не более: 
   генераторов N5171B, N5181B 
   генераторов N5172B, N5182B 

 
13,6 
15,9 

Условия эксплуатации:  
– нормальная температура окружающего воздуха, °С 
– рабочая температура окружающего воздуха, °С 
– относительная влажность, %, не более 
– атмосферное давление кПа (мм рт. ст.) 

 
от плюс 15 до плюс 25 

от 0 до плюс 55 
90 

84 – 106,7 (630 – 800) 
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Глоссарий 

ARB Arbitrary waveform generator – генератор сигналов произвольной формы 
AWG 1) Arbitrary waveform generator – генератор сигналов произвольной формы 

2) Additive white Gaussian noise – аддитивный белый гауссовский шум 
BBG Media Baseband generator media – память генератора модулирующих сигналов. 

Временная (энергозависимая) память, в которой хранятся файлы модулирующих 
сигналов для воспроизведения или редактирования. 

C/N Carrier-to-noise ratio – отношение несущая/шум 
CW Continuous wave – непрерывный (немодулированный) сигнал 
DHCP Dynamic host communication protocol – протокол динамической конфигурации хоста 
Dwell Time Время выдержки. В ступенчатой развертке (см. подраздел 3.6.2) это время, в 

течение которого устанавливается сигнал, и вы можете выполнить измерение до 
того, как развертка переместится в следующую точку. 

EVM Error vector magnitude – модуль (магнитуда) вектора погрешности. Это модуль 
мгновенной векторной разности между идеальным опорным сигналом и 
измеряемым сигналом. 

Filter Factor Alpha Это параметр "альфа" фильтра. Он применяется только к фильтру Найквиста и 
корневому фильтру Найквиста. 

Filter Factor BbT Это параметр Bandwidth-bit-time, аналогичный параметру "альфа". Он применяется 
только к гауссовскому фильтру. Стандартом GSM регламентировано значение BbT 
= 0,3, а стандартом DECT – значение BbT = 0,5. 

Gaussian Filter Гауссовский фильтр не обладает межсимвольной интерференцией (ISI). 
Разработчики систем беспроводной связи должны решать, какой уровень ISI 
можно считать допустимым, и учитывать это в сочетании с шумами и помехами. 
Гауссовский фильтр имеет форму кривой Гаусса как во временной, так и в 
частотной области, причем он не "звенит", как корневой фильтр Найквиста. 
Эффекты этого фильтра во временной области являются относительно короткими, 
и каждый символ существенно взаимодействует (или вызывает ISI) только с 
предыдущим и следующим символом. Это снижает тенденцию к взаимодействию 
для конкретной последовательности символов, что облегчает построение 
усилителей и повышает их эффективность. 

GPIB General purpose interface bus – интерфейсная шина общего назначения. Это 8-
битовая параллельная шина, которая обычно применяется с измерительным 
оборудованием. 

IF Intermediate frequency – промежуточная частота (ПЧ) 
Int Media Internal media – внутренняя память. Постоянная (энергонезависимая) память 

генератора сигналов, где хранятся файлы модулирующих сигналов. 
IP Internet protocol – протокол сетевого уровня из набора протоколов TCP/IP, широко 

применяемый в сетях Ethernet. 
LAN Local area network – локальная сеть 
LO Local oscillator – гетеродин 
LXI LAN eXtension for Instrumentation – платформа измерительного оборудования, 

основанная на технологии промышленного стандарта Ethernet, и предназначенная 
для обеспечения модульной структуры и гибкости у систем небольшого и среднего 
масштаба. См. также http://www.lxistandard.org.  

Modulation Format Формат модуляции: Custom modulation, Two Tone или Multitone 
Modulation Mode Режим модуляции: Dual ARB, Custom modulation, Two Tone или Multitone 
Modulation Standard Стандарт модуляции. Относится к стандартному формату сотовой связи (т.е. 

NADC, PDC, PHS и т.д.) 
 
  

http://www.lxistandard.org/
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Modulation Type Тип модуляции. Относится к различным типам созвездий I/Q (т.е. PSK, MSK, FSK, 
C4FM и т.д.) 

Non-volatile media Постоянная (энергонезависимая) память, например, USB-накопитель. 
Nyquist Filter Фильтр Найквиста (называется также косинусным фильтром). Особенностью этих 

фильтров является "звон" импульсной характеристики на частоте следования 
символов. Соседние символы не взаимодействуют друг с другом в решающих 
точках символов, поскольку отклик равен нулю во всех решающих точках символов 
за исключением точки, которая находится в центре импульсной характеристики. 

Persistent Перманентный параметр, на который не влияют операции предустановки (Preset), 
пользовательской предустановки (User Preset) и выключения питания. 

Point-to-point Time У ступенчатой развертки (подраздел 3.6.2) это сумма значений, установленных для 
времени выдержки, времени обработки, времени переключения и времени 
установления. 

Rectangular filter Прямоугольный фильтр, близкий к идеальному фильтру нижних частот. Эти 
фильтры имеют очень крутую характеристику спада. Полосу пропускания 
устанавливают равной частоте следования символов в сигнале. Ввиду конечного 
количества коэффициентов фильтр имеет предустановленную длину и не 
является истинно идеальным. Возникающий в результате этого выброс в области 
спада частотной характеристики эффективно минимизируется окном Хемминга. 
Рекомендуется применять этот фильтр для достижения оптимального значения 
АСР (мощность в соседнем канале). Для этого фильтра рекомендуется длина 
символов 32 или больше. 

Root Nyquist filter Корневой фильтр Найквиста (называется также корневым косинусным фильтром). 
Особенностью этих фильтров является "звон" импульсной характеристики на 
частоте следования символов. Соседние символы не взаимодействуют друг с 
другом в решающих точках символов, поскольку отклик равен нулю во всех 
решающих точках символов за исключением точки, которая находится в центре 
импульсной характеристики. Эти фильтры эффективно фильтруют сигнал без 
размывания символов в решающих точках. Это важно для передачи информации 
без ошибок, вызываемых межсимвольной интерференцией (ISI). Отметим, что ISI 
присутствует все время, за исключением решающих точек символов. 
Последовательное соединение двух таких фильтров реализует функцию передачи 
фильтра Найквиста. Один из этих фильтров находится в приемнике, другой в 
передатчике, поэтому система в целом характеризуется нулевой межсимвольной 
интерференцией. 

RMS Root mean square – среднеквадратическое значение. Эффективное значение 
сигнала переменного напряжения (эквивалентное постоянное напряжение, 
необходимое для выделения эквивалентного количества тепла в данном 
резисторе). Для синусоидального  сигнала RMS = 0,707  пиковое значение.  

TCP Transmission Control Protocol – протокол управления передачей (основной протокол 
транспортного уровня в наборе протоколов Ethernet и Internet). 

Terminator Обозначение единицы измерения (например, Hz или dBm), завершающее ввод. 
Например, для ввода 100 Hz терминатором является Hz. 

USB Universal serial bus – универсальная последовательная шина.  
См. также http://www.usb.org 

User FIR Пользовательский фильтр с конечной импульсной характеристикой. Заданный 
пользователем набор значений коэффициентов. Каждая строка в таблице 
значений FIR содержит одно значение коэффициента. Количество значений 
коэффициентов в списке должно быть кратным выбранному коэффициенту 
избыточности выборок. Каждый коэффициент применяется к обоим 
составляющим: I и Q. 

Volatile media Временная (энергозависимая) память, содержание которой не сохраняется при 
выключении питания (например, память BBG). 

 

http://www.usb.org/

